Version 4.0
OWNER’S MANUAL

EN

Getting Started with DME Designer
In this manual the abbreviation “DME” refers to the DME64N/DME24N/DME8i-C/DME8o-C/DME4io-C/
DME8i-ES/DME8o-ES/DME4io-ES. The abbreviation “DME Satellite” refers to the DME8i-C/DME8o-C/
DME4io-C/DME8i-ES/DME8o-ES/DME4io-ES.
Your DME, SP2060, ICP1 and the DME Designer software, let you build a custom audio system
installation that can support an incredible variety of conditions. You can build an entire system from
input to output with the DME Designer software, then send the system data to the DME and SP2060
which become independent processors.
An amazing variety of applications are possible, including audio installations, sub-mixing, speaker
system control, matrix/routing, and multi-effect processing.
NOTE
Here the abbreviation “DME” does not include the “DME32.”

NOTE
This manual is based on the English version of operating system. Illustrations, command names, window names, and similar
information are from that version. Some items may differ from what you see on the computer screen, depending on which
operating system you are using.

SPECIAL NOTICES
• The software and this Owner’s Manual are the exclusive copyrights of Yamaha Corporation.
• Copying of the software or reproduction of this manual in whole or in part by any means is
expressly forbidden without the written consent of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and the
software.
• The company names and product names in this Owner’s Manual are the trademarks or registered
trademarks of their respective companies.
• The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may
appear somewhat different from the screens which appear on your computer.
• Future upgrades of application and system software and any changes in specifications and
functions will be announced separately.
• Windows® is the registered trademark of Microsoft® Corporation.

2

DME Designer Owner’s Manual

The DME Audio System Network
In an audio system including one or more DME units and/or SP2060 units, the “control space” is
logically organized using the concepts of “Area”, “Zone”, and “Device Group”. The space covered by
the entire system is the “Area”, while independent sonic spaces within that Area are called “Zone”.
A group of DME or SP2060 units assigned to the same function are considered a “Device Group”.
An Area is comprised of one or more Zones, and each Zone can include up to 32 Device Groups.
A single Device Group can include as many as 16 devices. Each Device Group has one “Group
Master”.
NOTE
Meter response may deteriorate as the number of meters displayed in a single device group in DME Designer increases. In
such cases meter response can be improved by dividing the device group.
See “Zone Window” (page 298) for details on deleting devices from a device group.

NOTE
DME and SP2060 units cannot be combined in the same Device Group.

NOTE
All devices in a Device Group must be on the same subnet.

NOTE
A single device group cannot be controlled from multiple computers (multiple instances of DME Designer).

Area

Zone1

Device Group1

Zone1

Device Group1

Device1
(Group Master)

Zone2

Device Group2

Device2
(Slave)
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The DME Designer Software Application
The DME Designer software application provides a convenient, central interface for the creation and
control of DME-based audio systems.
By connecting the computer on which the DME Designer application is running to a Group Master it
becomes possible to control multiple devices simultaneously.
With DME Designer, DME audio systems can be designed and configured via a comprehensive blockdiagram interface on the computer screen.

The main concepts used in the creation of DME audio systems are “Components”, “Configurations”,
“Preset Parameters”, and “Scenes”.

 Components
Any independent signal-processing block, such as an equalizer, compressor, input/output module, or
external device control object is a “Component”.

 Configurations
A “Configuration” is group of components, including their placement and interconnections.

 Preset Parameters
The set of parameters for all components in a Configuration is know as the Configuration’s “Preset
Parameters”.
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 Scenes
A Configuration and its Preset Parameters are a “Scene”.

Composition of scene
Configurations

Scenes
Scenes1

MATRIX MIXER

Scenes2

COMP/LIMITER PARAMETRIC EQ

DELAY

2WAY
CROSSOVER

8 BAND

COMP/LIMITER PARAMETRIC EQ

DELAY

2WAY
CROSSOVER

Preset
Parameters
DELAY

PARAMETRIC EQ COMP/LIMITER

GATE

DELAY

PARAMETRIC EQ COMP/LIMITER

GATE

DELAY

PARAMETRIC EQ COMP/LIMITER

GATE

DELAY

PARAMETRIC EQ COMP/LIMITER

GATE

16 x 8

Scenes999

Example: GATE
• Attack
• Decay
• Range
• Threshold
• Key in
• Hold

= Components

DME settings as well as Configuration and Preset Parameter settings are sent from the DME Designer
application running on the computer to the Device Master via USB or Ethernet, allowing each device
to function as a separate processor, independently from the computer. It is also possible to keep the
DME Designer application on line and control the devices in real time.
It is possible to use the DME Designer to create Configurations that include multiple devices when the
appropriate devices are connected.
Although it is possible to have multiple Zones in an Area, multiple Device Groups in a Zone, and
multiple Scenes and Configurations in a Device Group, only one Area, Zone, Device Group and
Configuration can be active and editable via the DME Designer at any one time. The active elements
are known as the Current Zone, Current Device Group, Current Scene, and Current Configuration.
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Data Handled by a DME Audio System
 DME Data Structure
Common Overall Data
Scene Link Settings

Settings required for linked scene operation between multiple
groups.

Data for Each Device Group
User Defined Button Settings

Settings required for component parameter control from the
DME64N/DME24N or ICP1 panel.
Up to 24 parameters can be registered for control.

Global Parameter Link Settings

Settings required for linked operation of the same types of
parameters between multiple devices.

Data Used by the Scene Manager
MIDI program Change Settings

Settings required to allow scene selection via MIDI commands.

Scenes

The information required to switch audio data processing
setups.
Scenes include configurations and preset data.
The Scene Manager facilitates registration and management of
scene data.
Up to 999 scenes can be registered, and registered scenes are
managed by their scene numbers.

Data for Each Device
Configurations

A combination of the audio signal processing, audio input/
output, and external device control components and their
interconnections, created to create the desired audio system.

Local Parameter Link
Settings

Settings that allow linked operation between similar types of
internal DME parameters.

Component Link
Settings

Settings that allow linked operation between similar types of
internal DME components.

External Device
Settings

Settings required to allow control of component parameters from
external devices.
Independent settings are required for each device.
The external devices that can be used are as follows:
•
•
•
•
•

Preset Parameters

MIDI Controller (MIDI Control Change, Parameter Change).
GPI Controller.
DAW Controller.
AMX, Crestron, and other remote controllers.
PM5D or other compatible mixing console (controlling DME
internal head amp)

The settings for the components in a configuration.
Audio processing setups can be switched by changing the
preset parameters.
Components included in the preset parameter set are as follows:
• GEQ, MatrixMixer, and other audio signal processing
components.
• Internal AD/DA (DME24N), Cascade (DME64N), and Mini-YGDAI
card I/O components*.
• Components for external devices such as the AD8HR and AD824
remote head amplifiers.

Wave file

Audio files to be played back by the Wav File Player.

File Storage

Project files and other file types can be stored.

* Some settings not included.
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 SP2060 Data Structure
Common Overall Data
Scene Link Settings

Settings required for linked scene operation between multiple devices.

Data for Each Device
Scenes

Configurations

Local Parameter Link
Settings
Preset Parameters

The information required to switch audio data processing setups.
Scenes include configurations and preset data, The last Library name
recalled is specified.
The Scene Manager facilitates registration and management of scene
data.
Up to 99 scenes can be registered for 12 preset areas and 87 user
areas, and registered scenes are managed by their scene numbers.
A combination of the audio signal processing, audio input/output, and
external device control components and their interconnections, created
to create the desired audio system.
Settings that allow linked operation between similar types of internal
SP2060 parameters.
The settings for the components in a configuration.
Audio processing setups can be switched by changing the preset
parameters.
Preset parameters can be recalled by SP2060 units, but not edited.

Data for Each Component
Library

Settings specific to the speakers to be used.
In addition to the preset data provided, settings can be created by the
DME Designer.
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External Device (MIDI, GPI, DAW, AMX/Crestron, controlling DME internal head amp)

One DME unit/Device Group
Device Group

Output

Input
Microphone
Mixer
External Head Amp
etc...

Notes

Power Amp
Processor
etc...

Audio signal
Control signal
Data explanation
Setting preset parameters

User Defined Button

Scene Manager

LCD Display Assigned Parameter
Dome Low
Crossover: Output Low: Level
Dome Mid
Dome Hi

Crossover: Output Mid: Level
Crossover: Output High: Level
(No Assign)
(No Assign)
(No Assign)

....

No.

Scene Name

Configuration

Preset Parameters

001
002

All On
Opening

Output Processor for Dome
Output Processor for Dome

All On
BGM & MC

003

Band Set 1

Output Processor for Dome

Band 1

004
005

Band Set 2
Band Set 3

Output Processor for Dome
Output Processor for Dome

Band 2
Band 3

006
....

...

...
Specifies the configuration
and preset parameters combination.

Specifies the parameter to be changed.

Configuration

Preset parameters for output processor

Output Processor for Dome

All On Component value
Delay

MY8-AE
(Input)

EQ

Delay

EQ

Dyn

CrossOver

BGM & MC
MY8-AE
(Output)

Band 1
Set the value
Band 2
Band 3

Local parameter link settings
External device settings

Two DME units/Device Group (When one DME unit doesn’t provide sufﬁcient processing power, up to 16 DME units can be used)
External Device (MIDI, GPI, DAW, AMX/Crestron, controlling DME internal head amp)

DME#1

Device Group

Input
Microphone
Mixer
External Head Amp
etc...
Input

Output

DME#2
Output

Power Amp
Processor
etc...

Notes
Audio signal
Control signal
Data explanation
Setting preset parameters

For DME#1
For DME#2

Scene Manager
User Defined Button
LCD Display
Dome Low

Assigned Parameter
#1: Crossover: Output Low: Level

No.
001

Scene Name
All On

For DME#1
Configuration
Output Processor for Dome

Dome Mid
Dome Hi
Hall Low
Hall Mid
Hall Hi
....

#1: Crossover: Output Mid: Level
#1: Crossover: Output High: Level
#2: Crossover: Output Low: Level
#2: Crossover: Output Mid: Level
#2: Crossover: Output High: Level

002
003
004
005
006
....

Opening
Band Set 1
Band Set 2
Band Set 3
...

Output Processor for Dome
Output Processor for Dome
Output Processor for Dome
Output Processor for Dome
...

Preset parameters
All On
BGM & MC
Band 1
Band 2
Band 3

For DME#2
Configuration
Output Processor for Hall
Output Processor for Hall
Output Processor for Hall
Output Processor for Hall
Output Processor for Hall
...

Selects the parameter to be
edited from two DME units.
DME#1
Configuration
Output Processor
for Dome

Preset parameters

DME#2
Configuration
Output Processor
for Hall

All On

All On
BGM & MC

Band 1

Band

Local parameter link settings
Band 3

External device settings

Specifies the parameter to be linked between DME units.

Global Parameter Link
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Preset parameters

BGM & MC

Local parameter link settings
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BGM & MC
Band
Band
Band

Specifies the configuration and preset
data combination in each DME

Band 2
External device settings

Preset parameters
All On

NOTE
Separate SP2060 units normally handle scenes independently, but the Scene Link function can be set from the DME
Designer to allow linked scene operation. See “Scene Link Manager” on page 151.
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Main Changes from V1.0 to V1.1
 Main Panel Window
• Instead of the former Parameter Link function, there are now two functions: a Global Link function
that links parameters within all DMEs in a zone and a Local Link function that links parameters
within a single DME unit. (page 94)
• The Synchronization function can now not only send data from DME Designer to the DME unit,
but can also synchronize by reading data from the DME unit. (page 97)
• Scene Increment/Decrement and Time Adjustment can now be assigned in the GPI input
function. (page 114)
• DME unit events can now be recorded by the Event Logger function and displayed in the Event
Logger window. (page 177)
• The time for executing an event can now be set by using the Event Scheduler function.
(page 139)
• Parameters in the current configuration can now be listed on the display and printed out by using
the Parameter List function. (page 144)
• The Wav File Manager can manage Wave files played by the Wav File Player. (page 151)
• Settings can be made by the DAW Control function that are used for controlling DMEs from a
DAW controller. (page 157)
• DME unit data can now be saved as a backup file by using the Backup function. (page 157)

 Designer Window
• The port name display can now be switched between long name display and short name display.
(page 206)
• DME64N cascade connections can now be set. (page 221)
• Priority items can now be set when compiling configurations by using the [Compile Priority]
function in the “Preferences” dialog box. (page 220)
• Delay time can now be displayed for each component by using the Show Signal Delay function.
(page 305)
• Monitoring points can now be edited by using the “Monitoring Point List” dialog box. (page 306)
• The status of connections in a configuration can now be analyzed in advance by using the
Analyze function, without connecting the DME unit. (page 308)
• You can now set the action that occurs when you double-click a user module object. You can also
turn user module security ON or OFF, and set a password. (page 246)
• Libraries with component parameters saved in them can now be recalled from the context menu
for a component object. (page 236)
• A new rule for wiring prohibits connections to terminals that would short the terminator.

 Component Editor/Component
• A status bar has been added to the component editor. It displays the component name,
component ID, and parameter IDs for parameters that are being edited. (page 320)
• A Snap function has been added that records parameters in the editor temporarily. Parameter
sets can then be switched by using the Snap buttons. (page 362)
• The meter’s peak hold function can now be turned ON or OFF. (page 359)
• A Wav File Player component has been added for playing Wave files. (page 430)
• An effect component called SPX has been added that supports many different effect
applications, such as reverb, delay, and modulation effects, along with complex combinations of
multiple effects. (page 471)
• A Slot Out component editor has been added. (page 488)
• An Undo/Redo function is now available when using the design mode. It can undo the most
recent operation (control movement/resize/deletion).
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Changes from V1.1 to V1.2
 Main Panel Window
• The synchronization algorithm has been refined for faster synchronization.
• Synchronization now can be executed from DME to DME Designer without any break in the
sound.
• In the following cases, synchronization can be executed from DME Designer to DME without any
break in the sound:
The second or later synchronization after starting DME Designer* and when differences in data
between the DME and DME Designer are limited to parameters within components, AD824/
AD8HR/DME24N AD/DA setting data, or Mini-YGDAI card setting parameters.
* If the file was saved when DME Designer was closed, there will be no break in sound even in the first
synchronization after saving.

• Compile speed has been increased.
Up to three times faster when AutoDelayCompensation is turned On.
Up to two times faster when AutoDelayCompensation is turned Off.
• Synchronization is possible when no Mini-YGDAI card or a different Mini-YGDAI card is installed
in the DME unit (a confirmation message will appear).
• An option to automatically close the dialog after synchronization has been added. (page 99)
• A progress bar has been added to the Synchronization dialog. (page 51)
• A message appears to warn when synchronization will cause muting.
• The following operations can be performed while on line:
- Scene storage.
- Scene name changes.
- Fade ON/OFF and Fade Mode changes.
- Fade time changes.
- Parameter link setting changes.
• When a scene store is executed, that scene becomes the current scene.
• Wave files can be saved as DME data files, and are included in import/export operations.
(page 44)
• Wave files can be saved in the Wav file library.
• Event Log events can be output via GPI. (page 79)
• The on-line indicator appears as a button which can be used to switch between on-line and
off-line. (page 59)
• Scene edits cause the EDIT indicator to appear. (page 57)
• An auto file save function (Auto Save, post synchronization) has been added. (page 73)
• Different zones can be specified for use by different users. (page 158)
• Scene parameters related to User Defined Button, Program Change, GPI In and GPI Out can be
set via the Scene Manager. (page 82)
• [Select All] and [Clear All] buttons have been added to the Scene Manager Recall Safe dialog
box. (page 86)
• User Control can be created for individual users as well as security levels. (page 91)
• A Remote Control Setup List has been added. (page 139)
This list can be used to make detailed settings for a new software protocol that allow the DME to
be controlled from AMX, Crestron, and similar devices.
Refer to the “DME-N Remote Control Protocol Specifications” document for details about the
communication protocol. Information about the “DME-N Remote Control Protocol Specifications”
document can be found at the Yamaha pro Audio website (URL below).
http://www.yamahaproaudio.com/
• It is possible to specify whether listed events will be executed by the Event Scheduler.
(page 139)
DME Designer Owner’s Manual
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• The order of same-time events can be changed in the Event Scheduler. (page 139)
• Exceptions can be specified for Event Scheduler execution day/time. (page 107)
• Event Scheduler execution times can be specified in 1-second increments. (page 106)
• Head amp gain and Mini-YGDAI Card can be set via GPI, MIDI, User defined Button, DAW
Control.
• Parameter values, scene recall, GPI output, Wave file playback, and head amp gain can be set
via the User Defined Buttons. (page 132)
• The Component Lock function dialog is separate from the Parameter List dialog. (page 150)
• Shortcuts can be freely set as required. (page 156)
• Files can be saved in the DME unit. (page 70)
• A [Close All Editor Windows] button has been added to the Window menu. (page 69)
• External head amp parameters will be recognized by the DME unit when either the DME or the
external head amp (AD824, AD8HR) are turned on. Execute a scene recall to send DME settings
an external head amp.
• This manual is now separate from the DME Designer installer, and can not be accessed from the
DME Designer menus.

 Designer Window
• The following operations can be carried out via the shortcut keys.
- Navigator
- Activate Navigator
- Activate Toolkit
- Activate Design Window
- Select Left Port and Start Wiring
- Select Right Port and Start Wiring
- Wire Auto Single to Right
- Wire Auto Multi to Right
- Wire Auto Single to Left
- Wire Auto Multi to Left
- Delete Wire
• It is now possible to simultaneously edit multiple objects of the same type.
Example: Change the thickness or color of multiple wires at once.
• Files related to user modules (user module files, library files, user module editor files) can be
combined and exported/imported as a single file.
• Port colors can be independently specified for each port type. (page 219)
• Default wire thicknesses and types can be independently specified for each port type.
• An automatic hot-spot connection function has been added. (page 285)
• Port display has been added to External Device, Picture, DME, and ICP1 objects.
• When drawing wires the keyboard cursor keys can be used to move the mouse cursor, and the
<Enter> key can be used to create nodes.
• When drawing wires <Shift> key plus <> key and <Shift> key plus <> key combinations can
be used to automatically connect horizontally-aligned hot spots.
• DME object ports can be freely specified.
• Compilation of configurations with loop connections is possible when Auto Delay Compensation
is On.
• The name has been changed from “Foot Monitor” external device to “Floor Monitor.”
• Addition External Device types have been provided.
• External Devices can be double-clicked to open a file saved by other applications. (page 233)
• Picture objects can be double-clicked to open a specified editor. (page 249)
• Text objects can be double-clicked to open a specified editor. (page 252)
12
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• User module port labels can be edited. (page 246)
• Graphics can be placed to represent user modules. (page 247)
• The Legend field automatically resizes to accommodate project names and titles of different
lengths.
• A Generic “MY-Others” setting has been provided to accommodate third-party Mini-YGDAI
cards.

 Component Editor Window
• Undo and Redo are now shortcut compatible.
• A scroll bar appears when the size of the component editor window is reduced.
• The size and position of the component editor window are memorized.
• An option to allow mouse-over zooming of the edit box has been added. (page 323)
• A [Back] button that allows switching between related parent and child windows has been
added. (page 320)
• A [Close All Editor Windows] button has been added to the contextual menu.
• Source Selector, Speaker Processor, Limiter, Slot In, Cascade In, and Cascade Out components
have been added.
• The Delay algorithm has been revised. (page 399
- LEVEL and MUTE are effective when Delay is Off for each channel.
- The name of the overall Delay [On] parameter has been changed to [All Bypass].
Input Input
Mute Level
IN

On Mute Level
Delay

Input Input
Mute Level
Delay On

IN

On Mute Level
Delay

OUT

Delay All Bypass
OUT

• The bus send level range for Delay, Matrix, and Matrix Mixer components has been changed to
-∞ through 0.0 dB.
• Snap copy is possible. (page 363)
• Snap can be retained until the application is quit or another file is opened.
• Security status is displayed in the user module editor status bar.
• Multiple controllers can be selected by clicking while holding the <Ctrl> key when the editor is in
the design mode. (page 337)
• [Picture], [Text], [Box], [Ellipse], and [Frame] have been added to the tool palette of the user
module editor and user control editor design mode. (page 325)
• Controller properties can be accessed by double-clicking controllers in the user module editor or
user control editor design mode. (page 344)
• Picture and Text objects can be clicked to open a specified editor in the user module editor or
user control editor.
• The User Module Editor and User Control Editor offer a greater range of customization options for
color, size. etc., of the placed controls.

 MIDI Setup
• A MIDI Setup minimize function has been added.

 V1.2 Precautions
• When using project files (*.daf) created by version 1.1.5 or earlier, synchronize from the DME
Designer to the DME unit for the first synchronization.
• Project files (*.daf) created using version 1.2 will not open properly on version 1.1.

DME Designer Owner’s Manual
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Changes from V1.2 to V2.0
 General
• Support added for DME8i-C/DME8o-C/DME4io-C, SP2060 units and MY16-CII.
• “Device Groups”, or groups of the same type of device, have been added at the lowest Zone
level.
• It is now possible to have one master device per device group rather than one master device per
zone. This means that it is possible to have multiple master devices in a single zone.
• Group masters can now be assigned regardless of the IP address. This makes it possible to have
multiple device groups at a single network address.
• Configurations can be created and deleted for each device group.

 Component
• A Feedback Suppressor component has been added. (page 419)
• The Speaker Processor component PEQ “Q” parameter now goes to “63”. (page 464)

 Main Panel Window
• Firmware and component data can now be updated simultaneously. (page 186)
• A Recovery Update function that allows recovery from program corruption has been added.
(page 188)
• A Component Link function that allows simultaneous linking of all component parameters has
been added. (page 94)
• Scene Link function that allows simultaneous control of multiple devices in different device
groups has been added. (page 151)
• A Protect function has been added to the scene manager. (page 82)
• Card settings are no longer included in scene data.
• A Utility window has been added to allow editing of device utility settings. (page 167)
• The Local Parameter Link display order has been changed. (page 94)
• Parameter Link operation can now be turned on or off for each device group. (page 94)
• Compilation and analysis is now possible even if no connections have been made.
• Navigator window hide/show can now be selected from the main window.
• The Event Logger can now display only the event data for a specified device. (page 75)
• The GPI terminal names have been changed from [CH] to [PORT].

 Designer Window
• A hand tool for window movement has been added. The hand tool can be selected via the hand/
arrow icon in the toolbar, or from the [Tools] menu. The hand tool can also be temporarily
selected by holding the spacebar on your keyboard.
• Window magnification and reduction can now be controlled via the mouse wheel while holding
the keyboard “Ctrl” key.
• Horizontal scrolling can be controlled via the mouse wheel while holding the keyboard “Shift” key.
• The Edit Mode on/off can now be changed from the tool bar. (page 192)
• Scene information now appears in DME objects, and the Scene Manager can be launched from
the scene information display. (page 82)
• An [On-line] button has been added to DME objects, and synchronization is now possible.
(page 59)
• Sampling frequency display has been added to the resource meter window. (page 196)
• Sampling frequency display has been added to the configuration window status bar. (page 301)
• The sampling frequency is now displayed during analysis.
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• Double-clicking the component name now opens the properties window.
• Organization of the Tool Kit window has been changed. (page 198)
• A [Draw Image] checkbox that displays or hides the worksheet background image file has been
added to the Sheet properties. (page 263)
• [Configuration Manager] has been added to the contextual menu that appears when a DME or
SP2060 object is right-clicked. (page 217,page 226)
• [Recall Component Library] and [Store Component Library] now appear in the contextual menu
that appears when a component is right-clicked, even when the Edit Mode is OFF.
• The Compile Settings can now be edited for each DME unit. (page 220)
• Only one Zone window is now provided for multiple configurations.
• The [Export DXF] and [Preferences] commands have been moved from the [Print] menu to the
[Tools] menu.
• [Configuration] has been changed to [Configuration Manager] in the [Tools] menu.
• When [Prohibit Diagonal Connections] in the [Tools] menu is active it is possible to select 2
diagonal points and those points will automatically be connected by a combination of horizontal
and vertical wires.

 Component Editor Window
• A [Level Meter Enable] command that displays or hides the meter values has been added to the
contextual menu. Hiding the meters can result in increased communication speed in some
cases. (page 360)
• A [Display Order] function that allows the order of the controllers to be changed as required has
been added to the User Control Editor and User Module Editor. (page 325)
• An [Add Component to Component Link] command has been added to the controller contextual
menu.(page 360)
• The registered group is now displayed in the [Add Parameter to Parameter Link] submenu of the
contextual menu of controllers registered for Parameter Link operation.(page 368)
• Increased speed when selecting and dragging a large number of controllers in the User Control
Editor and User Module Editor
• It is now possible to switch from the Navigator window to Zone display while online.

 V2.0 Precautions
Please use DME Designer V2.0 with DME64N/24N V2.0 or later, DME8i-C/DME8o-C/DME4io-C V2.0
or later, and SP2060 V1.1 or later.
See the Yamaha Pro Audio website for compatibility details (http://www.yamahaproaudio.com/).
When DME64N/24N and DME8i-C/DME8o-C/DME4io-C are used together in the same device
group, faster communication speed as well as smoother DME Designer meter display can be
obtained by assigning a DME8i-C/DME8o-C/DME4io-C unit as the device group master.

DME Designer Owner’s Manual
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Changes from V2.0 to V3.0
 General
• DME8i-ES/DME8o-ES/DME4io-ES support.
• The DME Designer and DME-N Network Driver installers have been combined, so the
appropriate DME-N Network Driver version is now installed automatically with the DME Designer
application.
• The following connections to the Slave DME units are now possible when a DME Satellite unit is
assigned as the Device Group Master:
- USB/Ethernet connection to the computer (DME Designer).
- Cascade connection to control from the PM5D console (DME64N only).

 Component
• Ambient Noise Compensator component added (page 379).
• Audio Detector component added (page 381).
• Auto Gain Control component added (page 382).
• Auto Mixer II component added (page 431).
• Simple Mixer component added (page 450).
• Room Combiner component added (page 460).
• Matrix Mixer and Router component variations added.

 Main Panel Window
• To allow project information to be easily reproduced on a different computer, it is now possible to
export and import all necessary files at once, rather than only project files with the “.daf”
extension (page 45).
• A Device Information window that lists the status of all devices has been added (page 190).
• It is now possible to individually set each user control to determine whether it will open
automatically when the project file is opened (page 91).
• In accordance with the above change, the Startup User Control item has been removed from the
Security dialog box.
• It is now possible to assign Direct Parameter Value to the GPI input function, and assign Direct
Parameter Value and Audio Detector to the GPI output function (page 112, page 122).
• An option that automatically saves the project file (.daf extension) in the DME unit when going
online has been added (page 98).
• It is now possible to control internal DME-24N/DME8i-C/DME4io-C/DME8i-ES/DME4io-ES head
amps from a PM5D or other compatible mixing console (page 141).
• Remote control from AMX, Crestron, and similar controllers is now possible via Ethernet
connection only for DME Satellite units. (page 171).
• The display format of the parameter values displayed in the Remote Control Setup List and
Parameter List dialog box can now be switched between the internal settings and the values
displayed in the editor windows (page 139, page 147).
• The Event Logger window can now display additional error messages shown on the DME display
panel (page 80).
• It is now possible to set the DME unit so that the internally stored event log is not erased
(page 77).
• Improvements have been made to the additional error message information shown in the Event
Logger window.
• The DME unit internal clock and DME Designer time display now support daylight saving time
(DST) (page 180).
• Firmware updates can now be applied to entire device groups, for improved speed and
efficiency.
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 Designer Window
• It is now possible to set a “clear” background color for text, box, and ellipse objects (page 252,
page 254, page 256).
• Password entry is now required when opening a User Module Properties dialog box or saving/
exporting in a user module to which security has been applied.
• Linked software applications can now be launched from the Slot component contextual menu
(page 240).
• User module templates that use the same library are now categorized and displayed as user
module groups (page 310).
• Image files are now included in User Module exports.
• Component and parameter links can now be copied when DME objects, components, and user
modules are copied/pasted or duplicated.
• Parameter links are now saved when User Module data is saved/exported.
• When already-placed picture files are replaced, they will be updated and displayed correctly
without the need to restart the DME Designer application.

 Component Editor Window
• [Line] and [Scene Recall] tools have been added to the User Module Editor and User Control
Editor design modes, allowing placement of lines and scene recall buttons (page 332).
• In the User Module Editor and User Control Editor it is now possible to convert placed sliders to
knobs, and vice-versa (page 343).
• More options are available for customizing the controls listed below in the User Module Editor
and User Control Editor:
- A property dialog box has been added for sliders, allowing customization of direction, scale,
color, size, and other parameters (page 345).
- Level meter size can be customized (page 347).
- A property dialog box has been added for slider level meters, allowing customization of
direction and size (page 348).
- Knob color and knob background color can be customized (page 344).
- Text background color can be customized (page 352).
- A property dialog box has been added for indicators, allowing customization of color and size
(page 348).

 V3.0 Precautions
Use DME Designer V3.0 only with DME64N/24N V3.0 or later, DME Satellite V3.0 or later, and/or
SP2060 V1.2 or later. Refer to the Yamaha Pro Audio website (http://www.yamahaproaudio.com/)
details on combinations.
When combining DME64N/24N and DME Satellite units in a device group, be sure to assign a DME
Satellite unit as the device group master. Synchronization cannot be performed if a DME64N/24N is
assigned as the device group master.
When using the Windows Vista operating system, use only USB-MIDI Driver V3.0 or later, and DMEN Network Driver V1.2 or later.
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Changes from V3.0 to V3.5
 Component
• Program Ducker component added (page 412).
• (V3.5.1) During installation it is possible to select and install speaker library data for third-part
speakers into the Speaker Processor component library.

 Main Panel Window
• MIDI Setup has been discontinued. Communication ports can now be directly selected via the
[Setup] menu [Communication Port] item. (page 155)
• (V3.5.1) [SP2060 Backup] has been added to the main panel window [Hardware] menu, allowing
internal SP2060 data to be transferred to a computer for backup. Multiple SP2060 units can be
restored from the backup data. (page 184)

 Designer Window
• Improvements in the compiler algorithm achieve greater DSP resource utilization efficiency.
(page 98, page 305, page 308)
• MY16-ES64, MY16-EX, and MY16-MD64 I/O cards can now be specified for slot installation.
• The TX6n/TX5n/TX4n, ACD1, SB168-ES, IMX644, IPA8200, and NEXO products can now be
specified as external devices. V3.5.1 adds the IM8, MSR250, and other devices.
• When cascade connecting DME64N units across device groups, unit numbers are automatically
assigned when a connection is made between the [CAS IN] and [CAS OUT] terminals in the
Zone window.

 Others (Firmware V3.09 changes)
• When controlling DME units remotely from a PM5D using the DME Control function, it is now
possible to set an ID number other than “2” for the group master DME unit. In this case the PM5D
firmware must be updated to V2.20 or later.
• It is now possible to replace the default DME64N/24N startup screen (normally the model name)
with an original graphic file. (page 71)

 V3.5 Precautions
Use DME Designer version V3.5 with DME64N/24N or DME Satellite units running firmware version
between V3.0 and V3.8, and SP2060 units running firmware version V1.2 or later. Refer to the
Yamaha Pro Audio website (http://www.yamahaproaudio.com/) details on combinations.
When combining DME64N/24N and DME Satellite units in a device group, be sure to assign a DME
Satellite unit as the device group master. Synchronization cannot be performed if a DME64N/24N is
assigned as the device group master.
When using the Windows Vista operating system, use only USB-MIDI Driver V3.0 or later, and DMEN Network Driver V1.2 or later.
When using the Windows 7 operating system, use only USB-MIDI Driver V3.0.4 or later, and DME-N
Network Driver V1.2.1 or later.
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Changes from V3.5 to V3.8
 New Features
• The DME64N/24N (V3.8x or later) can now be controlled via Ethernet connection from certain
external control devices.
• The DME64N/24N (V3.8x or later) can now be assigned as the device group master when the
device group is formed by combining the DME64N/24N (V3.8x or later) and the DME Satellite.
• A new [Show Unconnected Node] button which displays unconnected nodes has been added
into the Designer window toolbar.
• The window sizes of User Control Editor/User Module Editor can now be enlarged more than the
display resolution of computers. When a size is set that is larger than the display resolution of
computers in the “User Control Editor Settings” dialog box which can be selected in the context
menu, a scroll bar is displayed.
• New library data has been added into the Preset Library of the Speaker Processor.
• The following devices can now be set for the external devices: M7CL-48ES, DSR series, S5, NSAW series, NS-IC series, KMS-710, CD-S300RK, CD-C600RK, Gooseneck Microphone and
Boundary Microphone.

 Changes
• The layout of the Remote functions and MIDI functions have been changed through revisions of
the operation of the Utility dialog.

 Fixed Bugs
• Fixed problems in which the Remote Control settings were not applied to the DME Designer
appropriately when synchronizing.
• Fixed a problem in which the meter laid out in User Control might not move.
• Fixed a problem in which the window might not be displayed when the external display status
was changed.
• Fixed a problem in which the parameters of both Recall Safe and Global Link, might not be
displayed appropriately when Scene Recall was executed.

 V3.8 Precautions
• Use DME Designer version V3.8.0 with DME64N/24N or DME Satellite units running firmware
version V3.0 or later, and SP2060 units running firmware version V1.2 or later.
• Use the latest DME Designer to update the DME firmware to the latest version.
• DME Designer cannot be used to update firmware version 3.5 or earlier to version 3.8 or later, or
to downgrade from version 3.8 or later to version 3.5 or earlier (this does not apply to the SP2060
or ICP1). Contact your Yamaha dealer.
• Save an up-to-date DME project file (*.daf). Don’t update unless an up-to-date “.daf” file has
already been saved on your computer. Without the “daf” file, you will not be able to restore DME
operation.
• When DME64N/24N units running firmware version 3.5 or earlier and DME64N/24N or DME
Satellite units running firmware versions 3.8 or later are combined in the same device group,
DME64N/24N units running firmware version 3.5 or earlier cannot be designated as the group
master.
• If the Program Ducker component is used, both DME firmware and DME Designer versions must
be V3.5 or later.
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Changes from V3.8 to V4.0
 New Features
• The MY4-AEC card can now be selected for I/O card slots. AEC components, which are available
when the card is installed, have been added.
• The “Partial Recall” function has been added. Scenes can now be recalled on a per component
basis. By utilizing both Recall Safe and the new Partial Recall functions, components to be
recalled or not recalled can now be selected precisely.
• Configurations can now be duplicated in the “Configuration Manager” window.
• In the Main Panel window, configuration names are now displayed, and configurations may be
selected.
• The VS4, VS6, and NS-IC600 can now be specified as external devices.

 Changes
• The Remote V3.5 tab and the MIDI V3.5 tab in the “Utility” dialog box have been deleted.
• The [Cancel] button has been added in the “Project File has been modified. Save?” dialog box
which is displayed before closing DME Designer to cancel closing procedure.

 Fixed Bugs
• Fixed a problem in which SP2060 configurations could be edited when the “Configuration
Manager” dialog box was opened via [Tools] menu [Configuration Manager] item.
• Fixed a problem in which configurations could be edited while online when the “Configuration
Manager” dialog box was opened via the context menu displayed by right clicking a DME object
in the Designer window.
• Fixed a problem in which the compiling procedure would occasionally complete successfully
even though an error should occur when an IN port was connected to multiple OUT ports.
• Fixed a problem in which the compiling procedure would occasionally not complete when
compiling was executed on a complex configuration with multiple SPX components.
• Fixed a problem in which the compiling procedure would occasionally not complete when
compiling was executed on a complex configuration having an SPX component with an output
connected to any other component.
• Fixed a problem in which the [+48V Master] indicator didn't light in the AD8HR component editor.
• Fixed a problem in which DME Designer could occasionally freeze when closing the application
by means other than clicking [Exit] in the [File] menu of the Main Panel window.
• Fixed a problem in which parameter links remained functional for parameters of different types
which should not be linked after the effect type was changed for an SPX component having
linked parameters.
• Fixed problems in which Scene Store and Recall functions might not work when Parameter Link
settings were no longer appropriate due to editing the Configuration.

 V4.0 Precautions
• Use DME Designer V4.0 with DME64N/24N or DME Satellite units running firmware V4.0 or later,
and SP2060 units running firmware V1.2 or later.
• Use the latest DME Designer to update the DME firmware to the latest version.
• DME Designer V4.0 cannot be used to update firmware V3.5 or earlier to V4.0 or later, or to
downgrade from V4.0 or later to V3.5 or earlier (this does not apply to the SP2060 or ICP1).
Contact your Yamaha dealer.
• The DME firmware V3.8 can be updated to V4.0 using DME Designer V4.0.
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Chapter 1 Before Using
Installing DME Designer
To use DME Designer, you must first install the software on the computer. Before you can connect the
DME Designer software to the DME or SP2060 unit, you must first install the USB MIDI Driver or the
DME-N Network Driver, according to how you will be connecting, and then make the appropriate
settings.
For instructions about the installation and setup for the DME Designer and DME-N Network Driver, and
about the installation for the USB-MIDI Driver, see the “DME Setup Manual.”
NOTE
Initial settings for DME Satellite units must be transferred via USB-MIDI, so it is necessary to properly install the USB-MIDI
Driver.

Starting DME Designer
The DME Designer software is started from the [Start] menu. DME Designer is used with one user
logged on. The user logs on when the software is started.

 DME Designer Start Up and Logon (When Auto-Logon Is Not Set)

1 Click [Start]  [All Programs]  [YAMAHA OPT Tools]  [DME Designer]  [DME
Designer].
The “Log On” dialog box will be displayed.

NOTE
Automatic log-on is the default setting. If the automatic logon feature is enabled, the “Log On” dialog box will not be
displayed when the application is started. Instead, the auto-logon user will be logged on automatically. See page 31
for information about auto-logon.
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2 Click the [] at the right of the [User] box, and select the user.
If no user has been created, only [Administrator] will appear in the list. When starting DME
Designer for the first time after installing, select [Administrator].

3 Enter the password into the [Password] box.
Enter the password set for the user.
If no password has been set, leave the password box blank when you log on.

4 Click the [OK] button.
DME Designer starts up.

 When Automatic Logon Has Been Set (page 31)
If automatic logon has been set, the “Log On” dialog box will not be displayed. The user set for
automatic logon will be logged on.
With automatic log on, even if a password is set for a user, it will not be requested during log on.
This is useful when logging on a specific user.

 Starting by Opening a Project File
DME Designer starts when a project file with a saved configuration is opened. When the project file
is opened, DME Designer is started with the window configuration that was in place when the file
was last saved.
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Closing DME Designer
To close DME Designer, click [Exit] on the [File] menu of the Main Panel window. It can also be closed
by clicking the [Close] button on the Main Panel window.

1 Click [Exit] on the Main Panel window [File] menu.
When you try to close DME Designer, “Project File has been modified. Save?” will be displayed in a
dialog box.
NOTE
Sometimes the “Project File has been modified. Save?” dialog box will not be displayed.

2 To save the file, click [Yes]. To close without saving, click [No]. To cancel the
operation, click [Cancel].
If you click [Yes], the File Save dialog box will be displayed.
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Chapter 2 DME Designer Overview
Names and Functions of the Windows
The DME Designer software has several windows, including the Main Panel window, Designer window,
Component Editor window, Resource Meter window, and others.
Main Panel Window

Designer Window

Component Editor Window

Resource Meter Window

Main Panel Window
Menus and buttons are available in the Main Panel window. The current DME Designer environment,
including the active zone, device group and scene the currently logged on user name, and the
connection status to the DME unit are displayed on the right side of the Main Panel window.
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Designer Window
The Designer window displays several different windows. First among them is the Area window, where
you can manage the entire system. The Area window includes one or more Zone windows, which in
turn include one or more DME or SP2060 units that are used to build a zones within the area. Next is
the Configuration window, where you create the internal configuration of each DME or SP2060 unit.
Within the Configuration window are the User Module windows, where you can assemble often-used
components into templates the Toolkit window, which displays objects used in the other windows as
the basic building blocks for sound designs; and the Navigator window, which lets you grasp the
overall status of the system at a glance.
Zone Window

Configuration Window

Navigator Window

Toolkit Window

 Area Window
The Area window is used for designing areas, which manage the entire system. While at least one
zone is included within an area, multiple zones can be arranged there.

Zones
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 Zone Window
The Zone window is used to design zones within the area. A zone is a more concrete blueprint that
includes at least one DME or SP2060. It shows the DME’s connections with other devices and the
wiring between them. You can create multiple zones.
The DME and SP2060 units and connected devices are arranged in each Zone window, creating
configurations.

Configurations

 Configuration Window
The Configuration window is used to design the internal configuration of each DME unit contained
in the Zone window. By arranging and connecting components in the Configuration window, you
can create things like complex processors or matrix mixers, that determine the actual internal
structure that operates each DME unit.

Components

 User Module Window
The User Module window is used for designing user modules that can be arranged in the
Configuration window. You can create original modules by combining multiple examples of oftenused components. When you save these modules as templates you can recall them easily
whenever you want.
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 Toolkit Window
The Toolkit window displays the objects that you can use in each window that can be displayed in
the Designer window. Those windows are the Area, Zone, Configuration, and User Module
windows. The Toolkit displays different objects, according to the currently active window. To place
an object in a window, double-click it in the Toolkit window where it is displayed or drag it to the
currently active window.

 Navigator Window
The Navigator window displays the area, zones, configurations, and components in a hierarchal
fashion that lets you check their status as a whole. When editing offline, you can click an area
name, zone name, or configuration name to make that window active. Clicking a component name
will open the component editor window for that component.

 Resource Meter Window
This window provides an indication of component usage for each DME unit currently placed in the
Configuration window. The usage percentage increases as the number of components increases. The
component usage percentage is shown in graph form for each DME unit.
The window appears simultaneously with the designer window, and can be used as a component
usage guide while creating configurations. The sampling frequency for each DME unit is also
displayed. Please note that the sampling frequency of the DME unit itself will also affect the usage
percentage.
NOTE
In configurations that have a large number of connections, compilation might not be possible in some cases even if the
resource meter reading is less than 100%. To determine whether compilation is possible we recommend using the “Analyze”
dialog box (page 308) prior to actual compilation.

NOTE
This window is not displayed for SP2060 units.

 Objects and Components
“Object” is the name for the parts that are arranged in the various design windows, such as the
Area, Zone, Configuration, and User Module windows. Objects are always laid out in the Toolkit
window. Only the appropriate objects for each window are displayed. The blocks displayed at the
higher level of the Toolkit window in particular are called “components.” This refers to each type of
processor that operates the DME. “Object” normally refers to Picture, Text, Ellipse and other items
that are used after connecting them by wire to the various components.
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Component Editor
The blocks that are arranged in the configuration window are called “components.” When you
double-click on a component block arranged in the Configuration window, the Component Editor
window will open. There you can edit the parameters for that component. The types of parameters
displayed will differ, depending on the component.

Component Editor
(Stereo Compressor)

Component

Window Operations
Operations in all windows are the same as for normal Windows applications. The windows are
controlled with the [Minimize], [Maximize/Restore], and [Close] buttons at the upper right of the title
bar. DME Designer is closed by clicking the [Close] button on the Main Panel window.
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Users and Security
You can create multiple users in DME Designer and set the functions that are available to each user.
Although users who will design and put together installations must be able to use all the functions of
DME Designer, users who will only operate the system can be restricted to functions that will not allow
them to accidentally change the settings.
DME Designer is used with one user at a time logged on. To change the user, click the [File] menu 
[Log Off] command on the Main Panel window.

About Users
To use DME Designer, you must logon when you start the software. Except for the first time the
software is started or when separate settings are made for the first time, you can logon by specifying
the name and password for a user that has been set as the administrator. The administrator can build
the system as a whole, or apply function limitations that let other people edit. Administrators or other
people that can use DME Designer are called “users.” The user name for the currently logged on user
appears below [User] on the Main Panel window.

Currently Logged On User Name

The default user, named [Administrator], is set to use all of the functions. Immediately after DME
Designer is installed, [Administrator] is the only user, and there is no password set.
Multiple users can be created. When the system administrator creates multiple users, restrictions can
be applied separately for each one of them. A user with restrictions applied can edit using only the
functions the administrator enables for him.
The place to create, setup, and delete users is the “Security” dialog box. See “Scene Manager” on
page 157.

Automatic Logging On
With the auto-logon function, you can have a specified user automatically logged on when the
application is started. If you enable the auto-logon feature, the specified user will be logged on when
the application is started, without displaying the “Log On” dialog box.
Auto-logon is set from the “Security” dialog box. See “Scene Manager” on page 157.
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Logging On
The “Log On” dialog box is displayed whenever the application is started or a user is logged off.
Whenever one user is already logged on, another user cannot be logged on. To log on as another
user, first log off the currently logged on user.
NOTE
Unless you specifically want to restrict access, we recommend enabling automatic logon. If the access password is
forgotten or lost it will not be possible to logon or operate the system.

NOTE
If the automatic logon feature is enabled, the “Log On” dialog box will not be displayed when the application is started.
Instead, the auto-logon user will be logged on automatically.

 The “Log On” dialog box

1
2
3

5

1 [User]
From the list, select the user you want to log on as.

2 [Password] Box
Enter the password.

3 [OK] Button
Log on as the selected user.

4 [Exit] Button
When the application is started, and the “Log On” dialog box is displayed, there is an [Exit]
button. This closes the application without logging on a user.

5 [Cancel] Button
When the “Log On” dialog box is displayed after a user is logged off, there is a [Cancel] button
instead of an [Exit] button. This cancels the logoff. The original user will continue to be logged
on.

 Logon Procedure

1 Click [] at the right of the [User].
A drop-down list of user names will be displayed.

2 Click the user you want to log on.
3 Enter the password into the [Password] box.
When you type in the password box, the characters you enter will display as asterisks (*).

4 Click the [OK] button.
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Logging Off
Logoff is used when changing users. When you log off, the document currently being edited is closed,
and the “Log On” dialog box is displayed so you can log on the next user. Log off with the [Log Off]
command on the [File] menu in the Main Panel window.

1 Click the [File] menu  [Log Off] command on the Main Panel window.

Log on the next user in the “Log On” dialog box.
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Files Used by the DME DESIGNER
The following files are used by the DME designer application.
Name

Description

Extension

Project File

Stores information relating to the entire project.

.daf

DME Data File

Stores information for independent DME or SP2060 units.

.ddf

Library File

Stores component parameters.

.cel

Stores user control parameters.

.ucl

Stores user module parameters.

.uml

Stores user modules.

.umf

Stores SP2060 libraries.

.llf

Wave List File

Stores the Wav File Manager list.

.dwl

DME Backup File

Stores DME or SP2060 backup data to a file.

.dbk

SP2060 Backup File

Stores SP2060 unit data as SP2060 Backup file.

.spb

DME Designer All File

Stores the project file, library data files, and all DME Designer settings at
once.

.dme

Project Files
Systems built with DME Designer are saved as project files. Project files have “.daf” as the extension
for their filenames.
These files include settings for the area, zones, device groups, configurations, and each parameter.

Since only one project file can be open at a time, before you can open a second file, the first one must
be closed.
The commands for opening project files, creating new ones, and saving them, are found in the [File]
menu of the Main Panel window.

Creating New Project Files
Project files are created using the [File] menu  [New] command in the Main Panel window.

1 Click [File] menu  [New] in the Main Panel window.
Since the currently open project file must be closed before a new one can be created, a “Project
file has been modified. Save?” dialog box will be displayed.

2 To save the file, click [Yes]. the File Save dialog box will be displayed.
If you click [Yes], the File Save dialog box will be displayed.
A new project file will be created.
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Saving Project Files
Project files are saved using the [File] menu  [Save] and [Save As] commands in the Main Panel
window. The [Save] command overwrites the previously saved version of the file. The [Save As]
command lets you give a new name to the file before saving it. When you save the file with a new
name, you can protect it with a password.

 The “Save As” Dialog Box
When you click the [File] menu  [Save As] command in the Main Panel window, the “Save As”
dialog box is displayed. Except for some [Security] options, this dialog box is the same as the
normal Windows dialog box for saving files.
2 [Up One Level] Button
3 [Create New Folder] Button
4 [Views] Button

1

5

6
7
8
9
)
!

@
#

1 [Save In]
Specify the folder for saving the file. The folder name is displayed in this box. Click the [] on
the right to move to another folder.
The large box below displays the contents of the folder in this box.

2 [Up One Level] Button
Moves to the folder one level higher in the hierarchy.

3 [Create New Folder] Button
Creates a new folder in the folder currently being displayed.

4 [Views] Button
Changes the way the folder content list is displayed. If you click this button, a menu appears
that lets you change the arrangement and display format of the files in the list.

5 List
This box displays the contents of the folder shown in the [Save In] box. Only files belonging to
the type selected in the [Save As Type] box will be displayed.

6 [File Name] Box
Enter the filename. If the currently open file has already been saved, its name will be already
entered in this box. To save using a different filename, change the name here.
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7 [Save as type]
Selects the format for the file you are saving. When saving project files including Wave files set
for Wav File Player, select “Project File with wave (*.daf)”. Otherwise, select “Project File (*.daf)”.

8 [Security]
Protects files with a password. If you check here, you will be able to enter settings in the [ID],
[Password], and [Confirm Password] boxes.

9 [ID] Box
Enter the ID that has been set for the file. The currently logged on user name will be preentered, but you can change it. This need not be the same as a user name.

) [Password] Box
Enter the password that has been set for the file. You can enter up to 256 alphanumeric
characters. The characters you enter will be displayed as asterisks (*) in the [Password] box.

! [Confirm Password] Box
Enter the password once again to confirm it. Enter the same password as was entered into the
[Password] box. The characters you enter will be displayed as asterisks (*), the same as in the
[Password] box.
NOTE
When someone attempts to open a password-protected project file, the application will request an ID and password.
If they are not entered correctly, the file cannot be opened. Be careful to avoid mistakes when entering the ID and
password. The password cannot be reissued and the ID and password cannot be changed. Be careful not to forget
them.

@ [Save] Button
Saves the project file.
If the characters entered into the [Password] and [Confirm Password] boxes were not the same,
a “Password is different” dialog box will be displayed. Click the [OK] button and reenter the
correct password in the [Password] and [Confirm Password] boxes.

# [Cancel] Button
Cancel the file save process.
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 Saving Project Files

1 Click [File] menu  [Save] in the Main Panel window.

If there is a file already saved with the same name, it will be overwritten.
When saving a project file for the first time, you must name the file before saving it. The “Save
As” dialog box will open, the same as when clicking the [File] menu [Save As] command. Enter
a filename and specify the folder where the file will be saved.

 Saving a File with a New Name
With the [File] menu [Save As] command in the Main Panel window, you can save the currently
open file with a new filename. When saving for the first time, this creates a new file. A file that has
already been saved with a name will be saved as a separate file.

1 Click [File] menu  [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

2 Enter a filename into the [File name] box.
3 Specify the folder where the file will be saved.
4 Click the [Save] button.
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 Protecting a Project File with a Password
When you save a project file with a new name, you can set a password and protect the file. If a
password is set, an ID and password will be requested when the file is opened.
The security settings for a file cannot be changed by resaving the file with the same name. They
can only be changed when saving the file with a new name using the [Save As] command. Once
set, the ID and password cannot be changed. To change the ID and password for passwordprotected project files, use the [Save As] command to save the file as a new one with a different
name.

1 Click [File] menu  [Save As] in the Main Panel window.
The “Save As” dialog box will be displayed.

2 Place a checkmark for [Security] in the file save dialog box.
3 Enter an ID into the [ID] box.
The name of the currently logged on user will be automatically entered into the [ID] box. To
change it, enter another ID into the box.
When using [Save As] to save a password-protected file, the dialog box will be displayed with
the ID and password boxes automatically filled in with the ID and password that were assigned
to the original file. To change the ID and password, enter new ones into the boxes.

4 Enter the desired password into the [Password] box.
You can enter up to 256 alphanumeric characters for the password. The characters you enter
will be displayed as asterisks (*) in the [Password] box.

5 Enter the same characters into the [Confirm Password] box as were entered into the
[Password] box.
The characters you enter will be displayed as asterisks (*) in the [Password] box.

6 Click the [Save] button.

When saving a password-protected file without changing the name, the same ID and password
will be set (the ID and password cannot be changed).
Using the [Save] command, you cannot password protect an already saved project file that was
not already password protected. To set a password for a file that is not already password
protected, save it as a separate file using the [Save As] command.

38

DME Designer Owner’s Manual

Chapter 2 DME Designer Overview

Opening Project Files
Project files are opened using the [File] menu  [Open] command in the Main Panel window. Since
the currently opened project file must be closed before another one can be opened, a “Project file has
been modified. Save?” dialog box may be displayed.

 [Open] Command
Project files are opened using the [File] menu  [Open] command in the Main Panel window.

1 Click [File] menu  [Open] in the Main Panel window.
A “Project file has been modified. Save?” dialog box may be displayed.

2 Click the [Yes] or [No] button.
The “Open” dialog box will be displayed.

3 Selects the file to be opened.
4 Click the [Open] button.
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 Opening a Project File That Has Security Set
If security is set for a project, the “Enter ID & Password” dialog box will be displayed when you click
the [Open] button in the “Open” dialog box.

Enter the ID and password for the file into the [ID] and [Password] boxes, and click the [OK]
button.
If you enter an incorrect ID or password and click the [OK] button on the “Enter ID & Password”
dialog box, the “Wrong ID or password!” dialog box will be displayed.

Click the [OK] button and enter the correct ID and password the “Enter ID & Password” dialog box.

 Opening a Project File from the “Recently Used Files” List
Recently used project files are displayed on the [File] menu in the Main Panel window. If you click
one of the filenames, you can open that project file.

Recently Used Files

If security is set for a project file, the “Enter ID & Password” dialog box will be displayed if that file is
selected from the recently used files list. Enter the ID and password to open the file.
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 Double-Click the Icon for the Project File
When you double-click the icon for the project file, the file will open. If DME Designer is not started,
it will start. After logon, the project file will open.
Just as when you use the [Open] command, if DME Designer is already started, the currently open
project file must be closed before another one can be opened. Therefore, a “Project file has been
modified. Save?” dialog box will be displayed.
NOTE
Sometimes the “Project file has been modified. Save?” dialog box will not be displayed.

If security is set for the project file, the “Enter ID & Password” dialog box will be displayed. Enter
the ID and password to open the file.

Closing Project Files
You cannot have multiple project files open simultaneously in DME Designer. To close the currently
open project file, you can create a new project file or open another project file.

DME Data File
You can import or export parameters for a DME or SP2060 that is arranged in a configuration file.
Parameters for a single DME or SP2060 unit in the current configuration (the one being edited) are
saved as a file. Saved parameters can be imported into another project file.
Files with parameters saved in them are called “DME Data Files.” These files have “.ddf” as the
extension for their filenames.
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DME Data Import
This imports DME data file settings into a DME or SP2060 included in the current configuration.

1 Activates the DME or SP2060 configuration layout to be imported.
If multiple configurations are available, the DME or SP2060 configuration layout to be imported can
be selected via the Navigator window.

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Import
Device Configuration].
A submenu will be displayed. The DME groups and SP groups included in the current configuration
will be displayed on a submenu.

3 Select the device group to which the DME or SP2060 is to be imported from the submenu.
DME and SP2060 units cannot be used assigned to the same device group.
NOTE
DME and SP2060 units cannot be combined in the same Device Group.

4 On the submenu, click on the DME or SP2060 into which you will import settings.
The “Open” dialog box will be displayed.

5 Select the DME data file and click the [Open] button.
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 [Import Device Configuration] Submenu
The device groups included in the current configuration, as well as the DME or SP2060 units
included they contain, will be displayed in the [Import Device Configuration] submenu.

Select [Create New Group] to create a new device group
[Create New DME] creates a new DME and imports settings.
NOTE
Only users for whom the [Operation Security]  [Edit] checkbox in the “Security” dialog box has been checked can
import DME data. For information about user security levels, see “Scene Manager” on page 157.

NOTE
If DME data file import was not possible, a “DME file import failed.” message will be displayed.
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DME Data Export
This exports parameters from a DME or SP2060 included in the current configuration and saves them
as a file.

1 Activates the DME or SP2060 configuration layout to be exported.
If multiple configurations are available, the DME or SP2060 configuration layout to be exported can
be selected via the Navigator window.

2 Click the [File] menu in the Main Panel window, and move the mouse cursor over [Export
Device Configuration].
A submenu will be displayed. The DME groups and SP groups included in the current configuration
will be displayed on a submenu.

3 On the submenu, click on the DME or SP2060 from which you will export settings.
The “Save As” dialog box will be displayed.

4 Enter the filename.
Determines whether a selected file type will be exported along with a wave file.

5 Specify the folder where the file will be saved, then click the [Save] button.
NOTE
Library data is not contained in the DME data files exported from SP2060.
Refer to “SP2060 Library Manager” on page 153.
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 [Export Device Configuration] Submenu
The DMEs or SP2060s included in the current configuration will be displayed on the [Export Device
Configuration] submenu.

Library Files
Component Editor, User Control Editor, and User Module Editor parameters can be stored to and
recalled from library files. Refer to “Library Files” on page 325.
The library data for a single SP2060 unit can be imported or exported as required. Refer to “SP2060
Library Manager” on page 153.

DME Designer All Files
The project file and all DME Designer settings related to the project file can be managed as a DME
Designer All file. DME Designer All files have a “.dme” extension.
DME Designer All files include the settings listed below:
• Project file
• Library files
• User module files
• Wave files
• Picture files
• All DME Designer settings
DME Designer All files are a convenient way to move project data and DME settings you have created
from one computer to another. The DME Designer All import and export commands are provided in the
Main Panel Window [File] menu.
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Importing DME Designer All Files
NOTE
Only users with Administrator access can import DME Designer All files.

1 Click [Import DME Designer All File] in the Main Panel Window [File] menu.
Since the imported data will overwrite the existing DME Designer settings, the confirmation
message shown below will appear.

2 Click [OK] to continue with the import procedure, or [Cancel] to abort the import.
If you click [OK] the “Open” dialog box will appear.

3 Select the DME Designer All file you want to import.
4 Click the [Open] button.
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5 The “Save Project File in DME Designer All File” dialog box will appear, allowing you to save
the imported project file.
For details on saving project files refer to “Saving Project Files” on page 35.

6 If security is set for the file the “Enter ID & Password” dialog box will appear. Enter your ID
and password, and click [OK].

The imported files are stored in the folders listed below.
Name

Folder

Project File

Specified in step 5.

Library Files

The “Library” folder in the folder specified by the [Contents Folder] item in the Main
Panel Window “Preferences” window.

Wave Files

The “Wav” folder in the folder specified by [Contents Folder].

Picture Files

The “image” folder in the folder specified by [Contents Folder].
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Exporting DME Designer All Files

1 Click [Export DME Designer All File] in the Main Panel Window [File] menu.
The “Select File for Export” dialog box will appear. Check the checkboxes of the files you want to
export. To select all the available files click the [Select All] button, or click [Clear All] to uncheck all
the files.

NOTE
• Only wave and image files used by the currently open project file will be displayed. All user module templates will be
displayed under TemplateUserModule.
• The project file and image files will always be exported, so their checkboxes cannot be removed. The DME Designer
settings will also always be exported, so they are not displayed here.

2 Check the file(s) to be exported and click [OK].
The “Save As” dialog box will appear. This is the same as the “Save As” dialog box used when
saving project files, and details can be found in the “Saving Project Files” section on page 35.

3 Enter a file name, destination folder and, if necessary, security settings including ID and
password, then click the [Save] button.
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Configuration Creation Procedure
The configuration is a design diagram that determines the DME configuration. Transferring this data
causes the DME to operate. Follow the procedure below to create a DME Designer configuration.
SP2060 configurations can be selected from scene preset data, but cannot be edited.
NOTE
Configurations can be created only when the DME unit is offline. To transfer the data, you must first go into online status. The
procedure for going online is given later in this document.

1 Creating a New Project.
When you start DME Designer, a new project is created. If another project file is already open, use
the [File] menu  [New] command in the Main Panel window to create a new file.
“Main Panel Window Menu”  [File] menu  [New] (page 60)

2 Zone Settings.
Zone names are set, and zones are added and deleted using the “Zone Manager” dialog box.
See “Adding, Deleting, and Renaming a Zone” on page 291.

3 DME, ICP, External Device Layout.
Position the required DME, ICP, and other external devices in the Designer window, set the device
groups for the DME and ICP units, and set the properties.
See “Device Group Selection” on page 276,
“Designer Window” on page 193,
“Objects” on page 210,
“Design Window Shared Settings and Operations” on page 268.

4 Configuration Settings.
Configurations can be named, added, and deleted via the “Configuration” dialog box.
See “Adding, Deleting, and Renaming a Configuration” on page 295.

5 Placing Components.
Place components and user modules in the Configuration window.
See “Configuration Window” on page 301,
“User Module” on page 309,
“Types of Components” on page 371.

6 Component Logical Connections.
Use wires to connect the components and user modules you placed in the Configuration window.
See “Drawing and Editing Wires” on page 279.

7 Setting Parameters.
Edit the component parameters in the component editor.
See “Component Editor Window” on page 319.

8 Setting User Defined Button
Parameters can be assigned to function keys F1 through F6 in the DME unit.
See “User Defined Button (User Defined Parameters)” on page 132.

9 Storing Scenes.
Store the scene using the [Tools] menu  [Scene Manager] command in the Main Panel window.
See “IP Address Setup” on page 82.
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Online
You can connect the DME or SP2060 unit to your computer and transfer configurations, scenes and
parameters created in DME Designer into the DME or SP2060 unit. You can also read data from the
DME or SP2060 unit into DME Designer, synchronizing it with the status of the DME or SP2060 unit.
Because Synchronization presupposes that the DME or SP2060 unit can communicate with the
computer where DME Designer is installed, the necessary drivers (USB-MIDI or DME-N Network
Driver) must be installed, and appropriate settings must be made for each driver and for DME
Designer communication port.
NOTE
Because there are no scene settings when the DME unit is purchased, the configuration and scene information created in
DME Designer must first be transferred.

NOTE
A maximum of 32 device groups can be online.

1 DME Unit and Computer Connection.
Connect the DME unit and computer using a USB cable or an Ethernet cable.
See separate DME or SP2060 unit Owner's Manual for details.

2 Communication Driver Installation.
Install the USB-MIDI driver or DME-N Network driver in the computer.
See separate “DME Setup Manual” for details.

3 Communication Driver Setup.
Make the necessary settings for the communication driver installed in the computer. If the driver is
set up already, check the settings before going online.
See separate “DME Setup Manual” for details.

4 Making Communication Port Settings in DME Designer.
The port for each device group master can be selected via the “Communication Port” dialog box. If
the driver is set up already, check the settings before going online.
“Communication Port” dialog box (page 155)
NOTE
Slave DME64N/DME24N units connected via Ethernet and ICP1 units cannot be set.

NOTE
Only USB x-1 can be selected for a DME Satellite unit connected via USB.

5 Storing and Checking Scenes.
When moving online, the lowest scene must be stored. You can check if a scene is stored using the
“Scene Manager” dialog box.
NOTE
Since the SP2060 has scene preset data this confirmation is not necessary.

See “Scene Manager” on page 82.
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6 Recalling Scenes.
When going online, the scene will be recalled. Its scene number must be displayed in [Scene
Number], and its scene name will be displayed in Scene Name. If [--------] is displayed of [Scene
Name], the scene will be recalled.
NOTE
Since the SP2060 has scene preset data this confirmation is not necessary.

NOTE
When the scene device group display mode is “ALL” the scene link name will be displayed. Select a DME group to
display the DME group scene name.

Main Panel Window  “Current Scene” (page 57)
See “Scene Manager” on page 82.

7 Display the “Synchronization” dialog box.
Click [Synchronization] in the [Tools] menu or the large [Synchronization] button on the toolbar.
When the dialog box opens, a list of connected DME and SP2060 units will be obtained.
DMEs and SP2060s connected to the computer are displayed in the [Network] list.

NOTE
When requesting the “Synchronization” dialog box, a one-time alert will be displayed if the Communication Port settings
have not been made. After clicking the [OK] button on the alert, a dialog will open. At this time, you can make the
needed settings in the displayed dialog box, and then again display the “Synchronization” dialog box.

8 Device Group Selection
Select the device group to be synchronized from the [Group] list in the [Synchronization] window.
NOTE
Only one device group can be online in one operation.
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9 IP Address Selection
The DMEs and SP2060s included in the current device group are displayed in the [Designer] list in
the “Synchronization” dialog box. Click the [IP Address] box, then select the DME or SP2060 unit IP
address that matches the DME or SP2060 currently in the DME Designer.
NOTE
Click [] to display the IP addresses of all similar devices in the area.

10 Going Online.
Clicking the [Go On-line] button displays a dialog box where you can decide the synchronization
method.
NOTE
An alert will be displayed if no scene has been recalled.

Click the [DME Designer  Device] direction button.
Transfer of the configuration will begin, and DME Designer will be synchronized with the unit.
If there are many zones, this process may take time.
NOTE
When a configuration has already been transferred to a DME unit, we recommend using the [DME Designer <- Device]
button for synchronization. The transfer time is faster than using the [DME Designer -> Device] button. If the
configuration has been edited, however, synchronization can only be achieved by using the [DME Designer -> Device]
button.
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When going online is finished, the [Go On-line] button will be grayed out, and the Main Panel
window [On-line] button will light up. At this point if the [Store Project File into DME after
synchronization] item is checked, the project file will be automatically transferred to the DME unit
and stored. And if the [Close this window after synchronization] item is checked, the window will
close automatically.
NOTE
It may not be possible to go online if a scene has not been stored when [Recall Safe] is selected.

To go off line, click either the [On-line] button in the main panel window, or the [Go Off-line] button
in the “Synchronization” dialog box.
NOTE
If the IP address of the DME device is changed after the device has been synchronized with DME Designer, it will be
necessary to re-transfer the configuration data. The “Full Resync” operation forces a re-transfer of all configuration data,
and can be initiated by clicking the [Go On-line] button while holding down the [Ctrl] key.

NOTE
If LAN cable connections are changed while DME Designer is running, the DME units will continue to attempt to connect
to the original computer. If it is necessary to switch computers, either quit DME designer before changing the
connections or set the Port parameter to No Assign.
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Names and Functions of the Windows
The Main Panel window is the main window of DME Designer.
Current Zone

Current Device Group

Current Configuration

Title Bar
Menu Bar
Tool Buttons (Small)
Tool Buttons (Large)

Current Scene

Log On User

[Mute] Button

Communication
Status

Title Bar
“DME Designer” is displayed on the title bar.

Menu Bar
Commands that can be executed in the application are collected into categories on the menu bar.
When you click one of the categories, a list of commands is displayed.
Also, the name of the currently open project file is displayed at the right. When a new project file has
been opened, or has not yet been saved, “Untitled” will be displayed for the file name.

Tool Buttons (Small)
Frequently used commands are arranged here as buttons. When a command cannot be used, its
button will be grayed out.
[Open File] Button
[Save File] Button
[Undo] Button
[Undo History] Button
[Redo] Button

[Port] Button
[User Control Manager] Button
[Clock] Button
[Parameter Link] Button
[MIDI] Button
[GPI] Button
[Word Clock] Button
[User Defined] Button

 [Open File] Button
Opens project files.
 [Open] on the [File] menu (page 61)
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 [Save File] Button
Saves the project file currently being edited.
 [Save] on the [File] menu (page 61)

 [Undo] Button
Undoes the most recent edit operation.
 [Undo] on the [Edit] menu (page 63)

 [Undo History] Button
Opens the “Undo History” dialog box. Undoes multiple operations.
[Undo History] on the [Edit] menu (page 63)

 [Redo] Button
Restores operations undone with the [Undo] button back to their original condition.
[Redo] on the [Edit] menu (page 63)

 [User Defined] Button
Opens the “User Defined Button” dialog box.
 See “[User Defined Button]” on page 132.

 [Word Clock] Button
Opens the “Word Clock” dialog box.
 See “[Word Clock]” on page 177.

 [GPI] Button
Opens the “GPI” dialog box.
 See “[GPI]” on page 112.

 [MIDI] Button
Opens the “MIDI” dialog box.
 See “[MIDI]” on page 125.

 [Parameter Link] Button
Opens the “Parameter Link” dialog box.
 See “[Parameter Link]” on page 94.

 [Clock] Button
Opens the “Clock” dialog box.
 See “[Clock]” on page 180.

 [User Control Manager] Button
Opens the “User Control Manager” dialog box.
 See “[User Control]” on page 325.

 [Communication Port] Button
Opens the “Communication Port” dialog box.
 See “Communication Port” dialog box on page 155.
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Tool Button (Large)
[Synchronization] Button
[User Control] Button
[Show/Hide Designer] Button

[Event Logger] Button
[Event Scheduler] Button

[Show/Hide Navigator] Button

 [Show/Hide Designer] Button
Displays or hides the Designer window.

 [Show/Hide Navigator] Button
Displays or hides the Navigator window.

 [User Control] Button
Works the same as the [User Control] command on the [View] menu. Clicking this button displays a
menu.

User Control will be display there, the user control window will be displayed.
If you click [New User Control], the “New User Control” dialog box opens.

 [Synchronization] Button
Opens the “Synchronization” dialog box.
 See “Synchronization” Dialog Box on page 98.

 [Event Logger] Button
Opens the “Event Logger” window.
 See “Event Logger” Window on page 75.

 [Event Scheduler] Button
Opens the “Event Scheduler” dialog box.
 See “Event Scheduler” Dialog Box on page 101.

Current Zone
Displays the name of the active zone. A list where you can select a zone is displayed when you press
the [].
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Current Scene
Displays information about the current scene. You can switch between scenes.
[Change displayed Scene]
(displays DME groups/SP2060s)

[Scene Number]

[Scene Name]

[Scene Manager] Button

 [Change Display Scene]
Selects the information to be displayed. When “All” is selected scene link information is displayed
in [Scene Number] and [Scene Name]. When a DME group or SP2060 is selected scene
information is displayed in [Scene Number] and [Scene Name].
Refer to “Scene Manager” on page 82 for information on scenes, and “Scene Link Manager” on
page 151 for information on scene linking.

 [Scene Number]
Displays the number of the current scene or scene link. A list where you can select a scene or
scene link is displayed when you press the []. The EDIT indicator will light when a parameter has
been edited after recalling or storing a scene.

NOTE
Press <Ctrl> key and <+> key simultaneously recall the next scene and press <Ctrl> key and <-> key simultaneously recall
the previous scene. These settings can be changed via the Shortcut keys dialog box (page 156).

 [Scene Name]
Displays the name of the current scene or scene link.

 [Scene Manager] Button
Opens the “Scene Manager” dialog box.

DME Designer Owner’s Manual

57

Chapter 3 Main Panel Window

[User] (Logged On User)
Currently Logged On
User Name

[Security] Button

 Currently Logged On User Name
Displays the currently logged on user name.

 [Security] Button
Opens the “Security” dialog box.

Current Device Group

Displays the name of the currently active device group. Click [] to display a list that allows selection
of a different device group.

Current Configuration

Displays the name of the currently active configuration. Click [] to display a list that allows selection
of a different configuration.

 [Mute] Button

Mute OFF

Mute ON

Turns ON and OFF the DME mute button for the current device group.
To turn it ON, press the <Shift> key while clicking. If you click the button while it is OFF without
pressing the <Shift> key, the following message will be displayed: “Click the Mute Button with the
Shift Key.”
To turn it OFF, click on the button. There is no need to press the <Shift> key.
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 Communication Status
Displays the status of communication between the group master of the current device group and
the computer.
Message Transmit/Receive Indicator

On-line Button

[On-line] Button
When the group master of the current device group is connected to a computer, clicking this button
alternately switches the unit's on-line/off-line status. The indicator will light when the DME unit is online.

Message Transmit/Receive Indicators
• [Rx]
Lights when MIDI messages from the group master of the current device group are received
by DME Designer.

• [Tx]
Lights when MIDI messages are transmitted from DME Designer to the group master of the
current device group.
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Main Panel Window Menu
[File] Menu

 [New]
Creates a new project. When a new project is created, the current project will be closed.
A confirmation message asking “Project file has been modified. Save?” will be displayed.

[Yes] Button
Saves the currently open project.
If the currently open file was already given a name and saved, that saved file will be overwritten.
The “Save As” dialog box will be displayed for files that have not yet been saved. In this dialog box,
you can name the file when you save it.

[No] Button
Closes the project without saving it. If the file has already been given a name and saved, the most
recently saved version will remain as is. If the project has not been given a name and saved, it will
be lost.

[Cancel] Button
Cancels creation of a new project.
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 [Open]
Opens saved project files. Because the currently open project will be closed, a confirmation
message asking “Project file has been modified. Save?” will be displayed.
When you select this command, the “Open” dialog box will be displayed. Select the project file you
want to open and click the [Open] button.

If security is enabled for the project file, the “Enter ID & Password” dialog box will be displayed.
Enter the ID and password to open the file and click the [OK] button. The project file will open.

 [Save]
Overwrites an already saved project file with the current changes. If the file is being saved for the
first time, the “Save As” dialog box will be displayed.
 See “Project Files” on page 34.

 [Save as]
Saves the current project file as another file with a new name or in a new location. When you select
this command, the “Save as” dialog box will be displayed.
 See “Project Files” on page 35.

 [Import DME Designer All File]
Imports DME Designer All files (.dme extension).
 See “Importing DME Designer All Files” on page 46.

 [Export DME Designer All File]
Exports the DME Designer All file (.dme extension).
 See “Exporting DME Designer All Files” on page 48.

 [Import Device Configuration]
Imports parameters for a device that is arranged in a configuration file.
 See “DME Data Import” on page 42.
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 [Export Device Configuration]
Exports parameters of a device that is arranged in a configuration file.
 See “DME Data Export” on page 44.

 DME File Storage
Opens the “DME File Storage” dialog box.
 See “DME File Storage” on page 70.

 Recently Used Files
Displays recently saved files. If you click one of the file names, you can open that file.

 [Preferences]
Opens the “Preferences” dialog box.
 See “Preferences” on page 72.

 [Log Off]
Logs off the currently logged on user. Because the currently logged on user must be logged off
before a new one can be logged on, the “Log On” dialog box will be displayed so you can log on
the next user.
 See “Users and Security” on page 31.

 [Exit]
Closes “DME Designer.” A confirmation message asking “Project file has been modified. Save?”
will be displayed. To save, click [Yes]. To close without saving, click [No.]
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[Edit] Menu

 [Undo]
Undoes a single operation. The name of the operation that will be undone by [Undo] is displayed in
the command name. You can also select the commands that come after that.
When [Undo] is not possible, the command will be grayed out.

 [Redo]
Returns to the status before the [Undo] command was executed. The name of the operation that
will be restored by [Redo] is displayed. You can [Redo] only as many operations as were undone
with the [Undo] command. When [Redo] is not possible, the command will be grayed out.

 [Undo History]
Opens the “Undo History” dialog box. Undoes multiple operations. Also deletes the history of
operations.

1

2
3

4

1 List
Displays all operations performed so far, in order starting with the oldest. You can select an
operation by clicking on it.

2 [OK] Button
Undoes all operations below the one selected on the list. The operation selected on the list does
not get undone.

3 [Close] Button
Closes the dialog box.

4 [Delete All] Button
Deletes the entire history of operations displayed on the list. When an operation is deleted from
the list, it cannot be undone.
Operations undone from the [Undo History] can be re-executed one-by-one using [Redo].
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[View] Menu

 [Designer]
Displays or hides the Designer window.

 [Event Logger]
Displays the network event log.
Not displayed if selected while the network event log is showing.
 See “Event Logger” on page 75.

 [User Control]
This opens User Control.
The user controls that can be opened by the currently logged on user are displayed on a submenu.
If you click [New User Control] on the submenu, the “New User Control” dialog box opens.
 See “User Control/User Module Editor” on page 325.
NOTE
Controls that are not available to the currently logged-on user are not shown in the menu.

NOTE
The User Controls that are displayed when the DME Designer is launched can be set on the “User Control Manager”
dialog box.
 See ““User Control Manager” Dialog Box” on page 91, page 325.

 [Navigator]
Displays or hides the Navigator window.
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[Tools] Menu

 [Scene Manager]
Opens the “Scene Manager” dialog box.
 See “Scene Manager” on page 82.

 [User Control Manager]
Opens the “User Control Manager” dialog box.
 See “User Control” on page 91, page 325.

 [Parameter Link]
Opens the “Parameter Link” window.
 See “Parameter Link” on page 94

 [Synchronization]
Opens the “Synchronization” dialog box.
 See “Synchronization (DME Designer and Unit Synchronization)” on page 97.

 [Event Scheduler]
Opens the “Event Scheduler” dialog box.
 See “Event Scheduler” on page 101

 [Wav File Manager]
Opens the “Wav File Manager” dialog box.
 See “Wav File Manager” on page 108.

 [GPI]
Opens the “GPI” dialog box.
 See “GPI” on page 112.

DME Designer Owner’s Manual

65

Chapter 3 Main Panel Window

 [MIDI]
Opens the “MIDI” dialog box.
 See “MIDI” on page 125.

 [User Defined Button]
Opens the “User Defined Button” dialog box.
See “User Defined Button (User Defined Parameters)” on page 132.

 [DAW Control]
Opens the “DAW Control” dialog box.
 See “DAW Control” on page 136.

 [Remote Control Setup List]
Opens the “Remote Control Setup List” Dialog box.
 See “Remote Control Setup List” on page 139.

 [Internal HA Control]
Opens the “Internal HA Control” dialog box.
 See “Internal HA Control” on page 141.

 [Parameter List]
Opens the “Parameter List” dialog box.
 See “Parameter List” on page 144.

 [Component Lock]
Opens the “Component Lock” dialog box.
 See “Component Lock” on page 150.

 [Scene Link Manager]
Allows scene link setup.
See “Scene Link Manager” on page 151.

 [SP2060 Library Manager]
Allows setup of SP2060 libraries.
 See “SP2060 Library Manager” on page 153.
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[Setup] Menu

 [Communication Port]
Opens the “Communication Port” dialog box.
See “Communication Port Setup” on page 155.

 [Shortcut Keys]
Opens the “Shortcut Keys” dialog box.
 See “Shortcut Keys” on page 156.

 [Security]
Opens the “Security” dialog box.
 See “Security (Creating Users and Making User Settings)” on page 157.

[Hardware] Menu

 [Network Setup]
Opens the “Network Setup” dialog box.
 See “Network Setup” on page 165.

 [Utility]
Opens the “Utility” dialog box.
See “Utility” on page 167.

 [Word Clock]
Opens the “Word Clock” dialog box.
See “Word Clock” on page 177.
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 [Monitor Out]
Opens the “Monitor Out” dialog box.
 See “Monitor Out” on page 179.

 [Clock]
Opens the “Clock” dialog box.
 See “Clock” on page 180.

 [Language]
Opens the “Language” dialog box.
 See “Language Settings” on page 182.

 [Backup]
Opens the “Backup” dialog box.
 See “Backup” on page 183.

 [SP2060 Backup]
Opens the “SP2060 Backup” dialog box.
 See “SP2060 Backup” on page 184

 [Firmware Update]
Updates the DME, SP2060, or ICP1 firmware.
 See “DME Firmware Update” on page 186.

 [Device Information]
Opens the “Device Information” dialog box.
 See “Device Information” on page 190.
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[Window] Menu

Displays the open windows. Click a window name to bring that window to the front.

 [Close All Editor Windows]
Closes all editor windows.
NOTE
Each design windows within the Designer window can be switched using the [Window] menu in the Designer window.

[About] Menu

 [About DME Designer]
Displays information about this application.
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DME File Storage
Allows management of DME files. Project files can be managed on the DME, eliminating the need to
manage them on the computer. Project files can be managed on a DME unit without the need for a
computer. Since project files are necessary to allow synchronization of DME and SP2060 units, we
recommend that you save your project files to the DME unit for enhanced reliability.
Click [DME File Storage] in the [File] menu to display the “DME File Storage” dialog.
NOTE
Does not apply to SP2060 units

NOTE
If the file name is to include Japanese characters, select “Japanese” via the “Language” dialog box (page 182). If the file
name is to include non-English Latin characters (Latin-1), select “English/German/French/Spanish”. Inappropriate
combinations of file names and Language settings can make files unreadable in some cases.

Names and Functions

 Zone List
Select the desired zone and device group and DME from the list.

 File List
A list of the files stored on the selected DME.

 [Send] Button
Transfers selected files from the computer to the DME.

 [Receive] Button
Transfers selected files from the DME to the computer.

 [Delete] Button
Deletes selected files from the DME.

 [Close] Button
Closes the dialog box.
NOTE
Synchronization may become impossible if the [Remaining Memory] value (the amount of remaining DME memory)
becomes too small. If this occurs, delete unwanted scenes or files to increase the amount of available memory.

70

DME Designer Owner’s Manual

Chapter 3 Main Panel Window

Replacing the DME64N/24N startup screen
The screen image appearing when the DME64N/24N starts up can be replaced with a graphic file of
your choice in the following way. This function allows you to display a desired startup screen-for
example, one that includes your facility's name and logo.

 Preparing the graphic data
Create the desired graphic data at a size of 160 x 48 dots in black-and-white bitmap format
(extension .bmp) and save it as a file with the name “opening.bmp.”

 Replacing the graphic data
Transmit the graphic file (“opening.bmp”) to the DME unit using the DME File Storage function from
the DME Designer. This image will be displayed at the startup screen from the next time when the
DME starts up.
NOTE
• To restore the default startup screen, create a dummy file and change the name to “blank.bmp.” and storage it in the same
way as above. The default startup screen will be displayed from the next time when the DME starts up.
• The file transmitted to the DME unit using the DME File Storage function will be automatically erased after completing the
internal configuration. This means the file is not stored on the DME unit.
• Compatible graphic files are limited to black-and-white bitmap format at a size of 160 x 48. Other graphic files cannot be
displayed.
• The “Copyright” indication at the bottom of the screen cannot be erased.
• Only the DME64N/24N is compatible with this function. The ICP1 is incompatible.
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Preferences
When you click the [Preferences] command on the [File] menu in the Main Panel window, the
“Preferences” dialog box is displayed. Here you can make environmental settings for using DME
Designer.

Names and Functions
 [Application] Tab
Here you can set the general usage environment.

On Startup
Selects the action when the application starts up or a user logs on.

• [Load the last file opened]
Opens the last opened file. If the file cannot be found because it was moved, deleted, or its
name was changed, a new project will be opened.

• [Create an empty file]
Opens a new project.

• [Load File & Synchronization]
Opens the last opened file and synchronizes with the DME or SP2060 unit.

Contents Folder
Specifies the folder in which common files that are not project dependent are saved. Click the
[Browse] button to locate and specify the folder. The files listed below are saved in the specified
folder.
•
•
•
•

User module template files
All types of library files
Wave files
Graphic files
NOTE
If the folder is changed, files that were stored in the previous folder will not be automatically moved or copied to the new
folder. To carry the files over to the new folder, export the files as “DME Designer All” before changing the folder, then reimport the files after the new folder has been specified.
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Auto Save
Set up the automatic file save feature.
This setting has no effect when the file being worked on has not previously been saved, or the
computer is online.

• [Enable]
Auto save of project files being worked on will occur when checked. The file will be
overwritten, but the Undo history will not be cleared.

• [Interval in minutes]
Specifies the auto-save interval in minutes.

[Confirm Scene Store]
Place a checkmark here to have a confirmation message displayed when storing a scene.

[Save after synchronization]
If a save is performed after the DME Designer is synchronized to the DME or SP2060 unit, the next
synchronization will be significantly faster because one the difference needs to be synchronized.
Check this checkbox to specify auto-save after the DME Designer is synchronized to the DME or
SP2060 unit.

 [Component Editor] Tab
Sets up operation of the Component Editor knobs, sliders, and edit boxes.

Knob Mode
Sets how the knobs operate.

• Circular
The knob is dragged following its shape, as though you were drawing a circle.

• Linear
As you drag the knob to the upper, the value increases. Dragging it down decreases the value.
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Slider Mode
Sets the action that occurs when you click on the scale located under the sliders.

• Ramp
When the fader bar is clicked the knob will move a preset amount in the corresponding
direction.

• Touch
The slider does not move without directly touching it, even if you click the mouse button.

• Jump
The slider jumps to the location where you click.

Edit Box Zoom
When “On” the edit box will enlarge on mouse-over.

Edit Box Font
When “On” the edit box will enlarge on mouse-over.
NOTE
This is the font when the box is enlarged, not the font that is used when the box is at it's smallest size. The text may bleed
beyond the box with some fonts.

NOTE
To make a finer setting, press the <Shift> key while dragging the slider.
If you click a slider while pressing the <Ctrl> key, the setting will return to its default value.

 Common to All Tabs
[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Event Logger
Click [Event Logger] in the [View] menu to open the “Event Logger” window. This window displays the
DME unit event log, and it allows specifying the log file to be stored on the computer as well as the log
file to be store in the DME unit.
If the window is opened while online the event log is automatically retrieved from the DME unit and
displayed as a list in the “Event Logger” window. New events are displayed in real time while the
window is opened and the system is online. If [Enable Logging] in the “Log Setup” dialog box is ON,
the event data will be written to the computer log file at the same time.
NOTE
Does not apply to SP2060 units.

NOTE
Only users for whom the [View Log Window] checkbox in the “Security” dialog box has been turned ON can display the
“Event Logger” window. The default setting for this parameter is OFF.

NOTE
The events you wish to display in the Event Logger window must be set in advance in the “Event Log List” dialog box.

NOTE
Up to 1,536 events can be stored in the DME unit, while the maximum number of events that can be displayed in the “Event
Logger window is 12,288. When the DME unit even log becomes full, further events cannot be stored. When the DME event
log does become full, use the “Get Log” dialog box to retrieve the event log and then click the [DME Log Clear] button to
clear the DME unit log as necessary. If the “Event Logger” window event log becomes full, the oldest events are
automatically deleted to make room for new events.
Periodically make [Enable Logging] in the “Log Setup” dialog box active so that the event log is saved as a file on the
computer. This operation will automatically clear the DME unit event log.

Names and Functions
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 DME List
• [Date]
Displays the date the event occurred. (Example Display: 2004-08-24)

• [Time]
Displays the time the event occurred.

• [Type]
Displays the event type and icon.
There are three event types:
(Warning): Warning event
(Error): Error event
(Information): Other events

• [Zone]
Displays the name of the zone in which the event occurred.

• [Group]
Displays the name of the device group in which an event has occurred.

• [DME]
Displays the name of the DME in which the event occurred.

• [Event]
Displays the content of the event.

[Log Setup] Button
Displays the “Log Setup” dialog box (page 77). Here you can make Event Log settings.

[Get Log] Button
When offline, this opens the “Get Log” dialog box (page 78). The event log data can be taken from
the DME units, and written to a file on the computer.

[Zone]
Selects the zone, device group and device for which events will be displayed. Only events from the
selected device will be displayed in the window. If [All] is selected, events will be displayed for all.

Display button (Information/Warning/Error)
•

[Display Information] Button
Switches between displaying and hiding Information events.
When turned ON, Information events are displayed in the “Event Logger” window.

•

[Display Warning] Button
Switches between displaying and hiding Warning events.
When turned ON, Warning events are displayed in the “Event Logger” window.

•

[Display Error] Button
Switches between displaying and hiding Error events.
When turned ON, Error events are displayed in the “Event Logger” window.

[Clear Screen] Button
Clears the event log from the “Event Logger” window. The DME unit event log is not cleared.
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“Log Setup” dialog box
Click the [Log Setup] button in the “Event Logger” window to display the “Log Setup” dialog box. Here
you can make Event Log settings. These settings apply to the system as a whole.

 [Enable Logging]
Turns the function that writes the event log to a file ON or OFF.
When the checkbox is checked the event log is saved to a file, and the saved event log is cleared
from the DME unit.
If the checkbox is unchecked the DME event log is saved in the DME unit.
When checked, it is set in the [Enable Logging] frame.

Record _ days per log file
Sets the number of days recorded into a single log file. When the specified number of days is
exceeded, a new log file is created, and future log events are recorded there.
When “1” is set for the number of days at 10:00 AM, information will be recorded in the same file
until the next day at 9:59 AM. The number of days counted is cleared and a new log file is created
when the system goes online, or when the “Log Setup” dialog box is closed by changing the
settings such as the number of days or the log file folder, and then clicking the [OK] button.

Automatically delete log files after _ days
When a check is placed here, log files exceeding the specified number of days are automatically
deleted. Specifies the number of days after which log files are automatically deleted.

Log file folder
Specify the folder for saving log files. Clicking the [Browse] button opens the standard operating
system dialog box for specifying folders. Here you can select a folder.
Log files are saved with the following file name: “LOG + Start_Date.txt”.
If there is a file with the same name already in the specified folder, a number will be affixed to the
end of the file name, and it will be saved as a separate file. (Example: LOG20040824-2.txt)

 [Display Event]
Displays events with checks next to them. This operates together with the [Display Information],
[Display Warning], and [Display Error] buttons in the “Event Logger” window. You can place
checks next to multiple events.

 [Display Log Buffer Full Message]
This applies to DME64N/24N units in all zones. When checked, if the DME event log becomes full a
“Log Buffer Full” message will appear on the display of the corresponding DME unit.

 [Log List Setup] Button
Sets events sent from the DME units. Clicking here displays the “Event Log List” dialog box.
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 [OK] Button
Applies any setting changes and closes the window.

 [Cancel] Button
Closes the window without changing any settings.

“Get Log” dialog box
Click the [Get Log] button in the “Event Logger” window while offline to open the “Get Log” dialog box.
The event log can be retrieved from the DME unit while offline and saved as a file on the computer.

 DME List
Displays the IP addresses and types of DME units included in the device group. Click the DME
from which to obtain events by placing a check next to it.

 [Output File Name]
Sets the file name and save location for the log file. Clicking the [Browse] button opens the file
select dialog box, where you can select a file.

 [DME Log Clear]
Clears (erases) logs in the DME units checked. When you click this button, a confirmation dialog is
displayed.

 [OK] Button
Applies any setting changes and closes the window.

 [Cancel] Button
Closes the window without changing any settings.
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“Event Log List” Dialog Box
Click the [Log List] button in the “Log Setup” dialog box to open the “Event Log List” dialog box. This
allows selection of the events to be stored in each DME unit. Events not selected here will not be
saved either in the DME unit or to a log file.

 [Zone]
If you click here, a list will be displayed. Specifies a zone.

 [DME]
If you click here, a list will be displayed. Specifies DMEs.

 [Event]
Selects the events to be logged.

 [Type]
Selects the event type for each event: [Information]/[Warning]/[Error].

 [GPI OUT]
Specifies the port for event-triggered GPI output. If the same GPI port is specified for multiple
events GPI output will be produced when any of the specified events occurs.

 [OK] Button
Applies any setting changes and closes the window.

 [Cancel] Button
Closes the window without changing any settings.
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Event Log List
The event logs that can be retrieved from the DME unit as well as their content and countermeasures
are listed below.
Displayed Messages

80

Contents/Countermeasures

Communication between PC and DME ended.

Communication between the computer and DME (device group
master) has stopped. Check cable connections and router/hub
operation.

Communication between PC and DME started.

Communication between the computer and DME (device group
master) has started.

Communication between mixer (PM5D) and DME
ended.

Communication between the mixing console (PM5D) and DME
(device group master) has stopped. Check cable connections.

Communication between mixer (PM5D) and DME
started.

Communication between the mixing console (PM5D) and DME
(device group master) has started.

Communication between master DME and slave
[IP:*.*.*.*] DME ended.

Communication between the device group master DME and
slave (IP Address: *.*.*.*) has stopped. Check cable
connections and router/hub operation.

Communication between master DME and slave
[IP:*.*.*.*] DME started.

Communication between the device group master DME and
slave (IP Address: *.*.*.*) has started.

Scene [***] recalled.

Scene number *** has been recalled.

Scene [***] stored.

Scene number *** has been stored.

DME Designer to DME unit synchronized.

A configuration has been transferred from DME Designer to the
DME unit and synchronized.

MUTE was turned on. [IP:***]

DME (IP Address: *.*.*.*) turned the MUTE function ON.

MUTE was turned off. [IP:***]

DME (IP Address: *.*.*.*) turned the MUTE function OFF.

Input gain too high. AD [ChannelNo.*]
Input gain too high. [SlotNo.*, ChannelNo.*]
Input gain too high. CobraNet [ChannelNo.*]
Input gain too high. EtherSound [ChannelNo.*]

The input signal (slot number/channel number will be displayed)
has exceeded the clipping level.
Reduce the input signal level or head amplifier gain.

Output level too high. DA [ChannelNo.*]
Output level too high. [SlotNo.*, ChannelNo.*]
Output level too high. CobraNet [ChannelNo.*]
Output level too high. EtherSound [ChannelNo.*]

The output signal (slot number/channel number will be
displayed) has exceeded the clipping level.
Reduce the output signal level.

Scene store failure.

The scene data is protected.
This may have been set by the administrator to prevent
unwanted data changes due to improper operation. To change
this setting turn “Protect” OFF in the “Scene Manager” dialog
box.

Word clock unlocked.

An appropriate word clock is not being received or cannot be
detected.
Re-check the word clock connections and the “Word Clock”
dialog box settings.

Word clock not synchronized. [Slot] (Slot*,
Channel */*)
Word clock not synchronized. [WC INl]
Word clock not synchronized. [Cascade IN]
Word clock not synchronized. [Cascade OUT]

The received word clock (input connector/slot number/channel
number will be displayed) is not synchronized with the DME
word clock.
Revise the “Word Clock” dialog box settings so that an external
word clock that is in sync with the DME word clock is received.

External word clock changed. [Fs=(*)kHz]

The external word clock (frequency: *kHz) has been changed.

Internal word clock changed. [Fs=(*)kHz]

The internal word clock (frequency: *kHz) has been changed.
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Displayed Messages

Contents/Countermeasures

Communication between DME is busy and load
is applied.

Heavy network traffic is causing communication delays.
Check the devices connected to the network. It may be
advisable to reduce the number of devices connected to the
network. If the current link mode is 10Base-T, it may be
advisable to upgrade to 100Base-TX

No Battery.

The backup battery is completely depleted or not connected.
The current settings will be lost and the default settings restored
when the power is turned off. Cease operation immediately and
contact your Yamaha dealer.

Low Battery.

The backup battery is running low.
This will not affect operation immediately, but if operation is
continued current settings may be lost and the default settings
restored. Contact your Yamaha dealer as soon as possible.

MIDI buffer full.

The MIDI receive buffer is full.
Too much MIDI data may have been received.

Flash ROM full.

The flash memory used for data storage is full.
Delete unneeded configurations, presets, and/or wave files.

GPI IN reception. [PortNo. *, AD(0-1023)= *]

A control signal (Level: *) has been received at the GPI IN
terminal (Port number: *).

GPI OUT transmission. [PortNo. *->HIGH]
GPI OUT transmission. [PortNo. *->LOW]

A high or low level control signal has been sent via the GPI OUT
terminal (Port number: *).

Panel Unlocked.

Panel lock has been disengaged.

Panel Locked.

Panel lock is engaged so panel operations cannot be
performed.
Panel operation may have been locked by the administrator to
prevent unwanted data changes due to improper operation. To
unlock the panel press and hold the [CANCEL] button for longer
than 2 seconds.

The power was turned on.

DME power has been turned on.

Communication between external AD unit and
DME ended.

Communication between the external head amp unit and DME
device has stopped.
Check cable connections.

External device control buffer full.

The receive buffer for control commands from external devices
has become full.
Too much control may have been received.

Invalid password.

An incorrect password has been entered via the panel.
If you have forgotten the correct password contact your Yamaha
dealer.

Current Settings lost.

The memory has been erased and current settings have been
lost.
Try a scene recall. If that doesn’t rectify the problem contact
your Yamaha dealer.

Network hardware error.

A network device error has occurred.
Contact your Yamaha dealer.

Duplicate IP address.

Duplicate IP address.
Set IP addresses so that no two devices with the same address
are connected to the network.

DSP power shortage.

Audio input/output has been muted due to insufficient DSP
resources.
This can occur if a configuration created for 48kHz word clock is
run at 96kHz. To ensure full word clock operation, create
configurations with word clock set to 96kHz.
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Scene Manager
Scenes
Configuration contents can be given a name and saved as “Scenes.” Saving scenes is called “Scene
Store.” Parameter settings in the configuration for each site used can be stored multiple times and
recalled and used when needed. There are 999 scene memories available. When a scene is stored,
DME and SP2060 parameters are saved as “preset parameters.” Presets are automatically created
when a scene is stored.
Bringing back a scene (making a scene the current scene) is called “scene recall.” Scenes are
recalled using the [] button next to the current scene on the Main Panel window or by using the
“Scene Manager” dialog box.

 “Scene Manager” Dialog Box
Click either the [Tools] menu [Scene Manager] item or the “Scene Link Manager” window [Scene
Manager] button to open the “Scene Manager” window that allows editing of scene data. Scene
names, security levels, and presets can be changed and copy/pasted as required. The DME
scene memory is comprised of 999 user memories, while the SP2060 has 12 preset memories and
87 user memories. The preset memories are read-only, while settings and changes can be stored
to the user memories as required.
NOTE
Security for the Logged On User
The currently logged on user can store, recall, or edit scenes that have a security level equal to or lower than his or her
own. User security levels are set with the [Edit]  [Store/Recall/Edit] item in the “Security” dialog box.

NOTE
There is no [OK] button or [Cancel] button in the “Scene Manager” dialog box. To close the dialog box, click the [Close]
button at the upper-right of the dialog box.
Changes from storing/recalling scenes or editing, such as changing names or contents, will be applied immediately.
With the dialog box open, you can make the Designer window active and add components or change parameters.
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Names and Functions
[Copy] Button
[Cut] Button

[Insert] Button

[Paste] Button

[Recall Settings] Button

[Clear] Button

List
[Scene Link] Button

[Detail] Button
[Store] Button
[Recall] Button

 DME Group/SP2060 Selection
Selects a DME group or SP2060.
NOTE
The selected DME group or SP2060 is linked with the current device group.

 List
Displays the contents of the scene.

Scene No.
Displays the scene number. Click here to select a scene.

Name
Displays the name of the scene. Click the [Name] box to enter a scene name. Up to 18 characters
can be entered.
If the scene has not been stored, “[No Data]” will be displayed. A name can be entered when a
scene is stored. The default names are “Scene001,” “Scene002,” etc. The three-digit number is the
same as the scene number (displayed in [Scene Number]) for the stored scene.
NOTE
The SP2060 display can only display up to 16 single-byte characters. Some characters that appear correctly on the DME
Designer may change when displayed on the SP2060 display. For example, a backslash character will appear as a yen
symbol on the SP2060 display.
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Configuration
Displays the configuration name. If the scene has not been stored, a hyphen (-) will be displayed.

Edit Security
Displays the scene edit security levels. Clicking here will display a list where you can change these
security levels. Only levels at or below the security level of the currently logged on user are
displayed in the list. Scenes are stored with the same security level as the user, but their store and
edit security levels can be set lower if required.

Recall Security
Displays the scene recall security level. Clicking here will display a list where you can change the
security level. Only levels at or below the security level of the currently logged on user are
displayed in the list. Scenes are stored with the same security level as the user, but their recall
security levels can be set lower if required.

Fade
It sets whether fade is applied (ON) or not (OFF) when a scene is recalled.
When “ON” the faders in fader components will “fade” to their new settings according to the
specified fade mode and fade time when a scene is recalled. This only applies to fader
components.
NOTE
The fade function cannot be simulated in DME Designer.

Fade Mode
Sets the fade mode. You can select “All” or “Selected.”
If you select “All,” all channels using Fader components in their configuration will be affected. Even
when multiple components are used, all channels are targeted. If you select “Selected,” the only
channels affected will be those for which the Fade switch in the component editor has been set to
ON.
NOTE
The Fade switch for each channel is set to OFF by default. The fade effect will not be applied, even if Fade=ON and
Fade Mode=Selected is selected. To apply the effect, you must set the Fade switch to ON for the channels where you
need it.
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Fade Time
Sets the fade time: i.e. the time it will take fader parameters to reach their new settings when a
scene is recalled. The changes are smooth and continuous. If only the presets in the recalled
scene are set when that scene is recalled, the volume will be adjusted while the sound from the
previous scene is playing, until the new level is reached If the configuration also changes, the
volume will rise from silence until it reaches the new value. This can be set from zero to 60 seconds,
in 0.1 second increments.

Protect
Turns the Protect function ON or OFF.
When ON scene data cannot be deleted, overwritten, edited, or renamed.
NOTE
Right-click in the list and use the contextual menu that appears to set User Defined Button, Program Change, GPI In, or
GPI Out for the scene.

Partial Recall
Partial Recall sets created in the [Partial Recall] tab (page 87) accessed from the “Recall Settings”
dialog box can be selected for each scene.

 [Cut] Button
Cuts the scene selected on the list. The button will be grayed out and cannot be used when the unit
is online or when an SP2060 preset is being used.

 [Copy] Button
Copies the scene selected on the list. The button will be grayed out and cannot be used when the
unit is online.

 [Paste] Button
Pastes the contents of the cut or copied scene into the scene selected on the list. Cuts the scene
selected on the list. The button will be grayed out and cannot be used when the unit is online or
when an SP2060 preset is being used. The selected scene will be overwritten.

 [Insert] Button
Inserts the contents of the cut or copied scene into the location of the scene selected on the list.
The selected scene and those below are moved down by one. For example, if “Door_Open” was
stored as scene number “005,” and selected when the [Insert] button was clicked, the inserted
scene would become scene number “005,” and “Door_Open” would be moved to scene number
“006.”

Click the [Insert]
button

If a scene is stored in the lowest scene on the scene memory list, the button will be grayed out and
the insert function will not be available. Delete the contents of the lowest scene before attempting
to use the insert function.
NOTE
Move the scene data to a different scene memory when you don’t want to erase the contents of the lowest scene.
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 [Clear] Button
Deletes the contents of the scene selected on the list. The button will be grayed out and cannot be
used when the DME unit is online or when an SP2060 preset is being used.
If the preset parameters included in a scene are not used in another scene, a “Delete preset?”
message will be displayed.

If the preset parameters are not needed, click the [OK] button. If you click the [Cancel] button, the
preset parameters will not be deleted. Whichever you click, the scene itself will be deleted.
NOTE
The [Cancel] button on the “Delete Preset?” message does not cancel the [Clear] for the scene. It merely cancels
deletion of the presets.

 [Recall Settings] Button
This button opens the “Recall Settings” dialog box.

Recall Safe and Partial Recall
Recall Safe and Partial Recall parameters can be set up so that only specified components are
recalled, or specified components are omitted, with a scene is recalled. Recall Safe specifies the
components that will be omitted (i.e. not recalled) when a scene is recalled. Recall safe settings
can be made independently for each configuration, and apply to all scenes that use the same
configuration.
Conversely, Partial Recall specifies the components that will be recalled when a scene is recalled.
Partial Recall “sets” can be saved for use with single or multiple scenes.
The Recall Safe and Partial Recall settings are accessed via the [Recall Safe] and [Partial Recall]
buttons, respectively.

[Recall Safe] Tab
The components that will not be recalled when a scene is recalled are selected via this tab.

Component

Component Tree
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• Component Tree
Displays all components included in the scene. Check the checkboxes to the left of the
components that you do not want to recall when a scene is recalled.
NOTE
Components that are checked in the [Recall Safe] tab component tree will not be recalled. If you want all
components to be recalled there is no need to make any settings in this tab.
This function is useful when you want most of the scene’s components to be recalled normally while preventing
specified components from being recalled.

[Partial Recall] tab
In this tab you can select only the components you want to be recalled when a scene recall
operation is carried out. All other (unchecked) components will not be recalled. The selections
made here can be saved a sets. Saved sets can be used with multiple scenes, copied, and edited
as required.

Component

Partial Recall List

Component Tree

• Component Tree
Displays all components included in the scene. Check the checkboxes to the left of the
components that you want to be recalled when a scene is recalled.

• Partial Recall List
Displays the sets of Partial Recall components settings that have been saved. Up to 64 Partial
Recall sets can be saved for each configuration. Saved sets can be selected via the “Partial
Recall” menu in the “Scene Manager” dialog box.
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Click the [Add] button to create a new set with all components selected.
Click the [Delete] button to delete the currently selected set from the list.
Right-clicking in the Partial Recall list displays a contextual menu that provides access to the
following operations:
Add: Add a new set with all components selected (same function as the [Add] button).
Delete: Deletes the currently selected set (same function as the [Delete] button).
Cleanup: Deletes sets that are not being used in the current scene.
Rename: Allows a new name to be entered for the selected set.
Copy: Copies the contents (component selections) of the currently selected set.
Paste: Pastes copied contents to the currently selected set.
Duplicate: Creates a duplicate copy of the currently selected set.
NOTE
Appropriate icons appear to the left of Partial Recall set names when the set is being used by a scene, and when the
scene the set is being used by is protected. Partial Recall sets that are being used in a scene cannot be deleted.

The set is being used by a protected scene
The set is being used by a scene

NOTE
Partial Recall sets cannot be created or edited while online.

Common Tab Functions
• [Select All] Button
Checks all components.

• [Clear All] Button
Unchecks all components.

• [OK] Button
Applies any settings that have been made and closes the dialog box.

• [Cancel] Button
Closes the dialog box without applying or saving any settings.
NOTE
If the same component is checked in both the Recall Safe and Partial Recall tabs, the Recall Safe function takes
priority and that component will not be recalled.

NOTE
When a scene that includes Local Link or Component Link settings made via the Parameter Link window (page 94) is
recalled, the linked parameters are recalled.
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 [Store] Button
Stores the contents of the current configuration into the scene selected in the list. If an empty scene
is selected and the contents stored there, a new scene is created. If a scene is already stored in
the selected scene number, it will be overwritten. If [Confirm Scene Store] is checked on the
[Application] tab of the “Preferences” dialog box, a confirmation message will be displayed before
the scene is stored.
NOTE
The currently logged on user can store scenes at a security level equal to or lower than his or her own only.

NOTE
When the computer and DME/SP2060 unit are online, a scene stored in the DME Designer will also be stored on the DME
or SP2060 unit, regardless of the DME or SP2060 settings.
The DME64N/24N utility display Misc. page [Scene Store] setting only affects store operation from the DME panel
controls.

When a scene is stored, the configuration parameters at that time are saved as “preset
parameters.” Preset parameters are created automatically.

 [Recall] Button
Recalls the scene selected in the list and makes it the current scene.
NOTE
The currently logged on user can recall scenes at a security level equal to or lower than his or her own only.

 [Detail] Button
Expands the dialog box and displays a preset parameters list. If you click the preset parameters
list while it is displayed, the preset parameters list will be hidden. When the dialog box is opened,
its status will be the same as the last time it was closed.
NOTE
Not available for SP2060 groups.

[Del] Button
[Store] Button
[New] Button
[Del Unused] Button

DME

Preset Parameters
DME
Preset Parameters

[Detail] Button

Preset Parameters List
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 Preset parameters List
Displays the preset parameters for each DME unit in the scene selected in the list. When another
scene is selected on the list, the contents of the preset parameters list will be changed.
You can change the preset parameters used in the scene by clicking the radio buttons to the left of
the preset parameters names. You can also create, delete, and store preset parameters or change
their names.

DME
Displays the DME. Below the DME there are [Slot], [Component], and [AD]. If there are preset
parameters below them, a [+] button will be displayed. When you click the [+] it becomes a [-] and
the presets are displayed.

Preset parameters
Displays DME preset parameters.
If you click the preset parameters name, selecting the text that is there, you can change the preset
parameters name. When preset parameters are automatically created when a scene is stored, they
are named “Preset001,” “Preset002,” and so on. preset parameters created with the [New] button
are named “New Preset.”
You can select the preset parameters used in a scene by clicking the radio buttons to the left of the
preset parameters names.

 [Del] Button
Deletes the preset parameters selected on the preset parameters list.
NOTE
Presets used in a scene cannot be deleted.

 [Store] Button
Stores the current parameter status in the preset parameters selected in the preset list. The
contents of the selected preset parameters will be overwritten.

 [New] Button
Stores the current status and creates a new preset parameters. The newly created preset
parameters is named “New Preset1”, “New Preset2” etc.

 [Del Unused] Button
Deletes unused preset parameters from DME units in the selected device group.

 [Scene Link] Button
Opens “Scene Link Manager” dialog box.
Refer to “Scene Link Manager” on page 151
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User Control
User Controls
You can create an original control by arranging knobs and sliders in the component editor. Controls
you create are called “user controls.”
Those created user controls are displayed in the [View]  [User Control] submenu in the Main Panel
window
Refer to “User Control Editor/User Module Editor” on page 325 for information on user control editing.

“User Control Manager” Dialog Box
When you click [User Control Manager] on the [Tools] menu, the “User Control Manager” dialog box is
displayed. This dialog box displays a list of user controls included in the configuration of the current
device group. There they can be created or deleted. You can also edit the name and security level of
user controls here.
NOTE
Security for the Logged On User
The currently logged-on user can create and edit the user controls of all users at lower security levels as well as the controls
specified for that user. Available user controls are displayed in the User Control manager dialog box that can be accessed
through the [User Control] sub-menu of the main panel window [View] menu.
The user control security level for each user is set with [Operation Security]  [User Control Level] in the “Security” dialog
box. For information about user security, see page 157.

Names and Functions

NOTE
Only controls available to the currently logged on user are shown in the list.

 Open
If this checkbox is checked, the user control will open automatically when the project file is opened.
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 Name
Displays the names of the user controls. Clicking here will select the characters in the name,
allowing you to change it.

 Security Level
Displays the security level set for each user control.
Clicking here will display a list where you can change the security level.

 User
Displays the name of the user specified in User Control.
Clicking here will display a list of the available users.
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 [New] Button
Creates new user controls. Clicking here displays the “New User Control” dialog box.

Enter the User Control name in the [Name] box.

[User Level]/[User Name]
Use the radio buttons to the left to select security-level or user dependent control.

• [User Level]
Select a security level from the drop-down list.

• [User Name]
Check a checkbox.
Click [OK] to create the specified User Control setup.

[Open User Control at startup]
If this checkbox is checked, the user control will open automatically when the project file is opened.

 [Delete] Button
Deletes the user control selected on the list.

 [OK] Button
Accepts the changed settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing the settings.
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Parameter Link
About Parameter Links
You can group parameters of the same type and link them. These groups are called “Parameter
Links.” When one parameter in a parameter link group is changed, all parameters in the parameter link
group will change in the same way.
There are three parameter link types: global links, local links and component links. Global links link
parameters for DMEs within a device group. Local links and component links link parameters that are
included for a single DME.
NOTE
Parameters can not apply to multiple groups.

NOTE
When a library is recalled, the linked parameters in other components will not change even if parameter linking is enabled.

Groups can be created and parameters added to groups in the user control/user module control
editor and component editor. For information about creating parameter links, see “Creating Parameter
Links” on page 368.
You can check the status of parameter links and edit them in the Parameter Link window.

Parameter Link Window
When you click [Parameter Link] in the [Tools] menu, the “Parameter Link” window is displayed. You
can also display the window by selecting [Open Parameter Link] from the context menu displayed in
the user control/user module editor and component editor.

Names and Functions
[Global Link] button/[Local Link]/[Component Link] buttons

[Global Link] button/[Local Link] button/[Component Link] button
Switches the window display.

• Global Link
Links to the parameters of multiple DME units in the zone.
NOTE
Recall Safe and Partial Recall settings (page 86) do not apply to linked parameters when a scene is recalled.

NOTE
Because there is a large load on the network, the maximum number of Global Links will be limited to eight.
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• Local Link
Links to the parameters of one DME unit.
NOTE
When a scene is recalled using Recall Safe or Partial Recall settings (page 86), linked parameters will be recalled
with the same settings.

• Component Link
Links component parameters of the same type within a single DME unit.
NOTE
When a scene is recalled using Recall Safe or Partial Recall settings (page 86), linked parameters will be recalled
with the same settings.

NOTE
Component Link cannot be used with SPX components.

Parameter Link Group List
Displays a hierarchical list of parameter link group and the parameters that belong to them.
When a parameter link group name is selected, the controls that belong to that parameter link
group are selected.

• Group Name
You can select a parameter link group name by clicking on it. Clicking the selected parameter
link group name again will select the characters in the name, allowing you to change it.
Clicking the plus (+) or minus (-) sign to the left of the parameter link group name displays or
hides items that belong to that parameter link group.
You can delete a parameter link group by selecting it and pressing the <Delete> key. You can
also delete a parameter link group by right-clicking on the parameter link group name and
selecting [Delete] in the context menu that is displayed.

• DME Icon
Displays the DME that includes the parameters that belong to a parameter link group. The
components can be displayed or hidden by clicking the plus (+) or minus (-) signs for the
DME icon. The parameters, Min, and Max can be displayed or hidden by clicking the plus (+)
or minus (-) signs for the component.

• Link
Click to turn ON or OFF. Turn OFF to disable parameter linking.
Component linking for multiple parameters can be turned ON or OFF via the contextual menu
that appears when the group name is right-clicked.
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• Keep Offset
Click to urn ON or OFF. When “ON” the parameter offset is maintained so that when any
parameter in the group reaches its minimum or maximum value, further decrease or increase
is not possible.
Keep Offset for multiple parameters can be turned ON or OFF via the contextual menu that
appears when the group name is right-clicked.

• Parameter
Displays the parameters that belong to a parameter link group. You can display or hide
minimum and maximum values for a parameter by clicking the plus (+) or minus (-) signs.
You can delete a parameter from a parameter link group by selecting the parameter name and
pressing the <Delete> key.
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.
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Synchronization
(DME Designer and Unit Synchronization)
The DME or SP2060 unit and DME Designer are synchronized by Synchronization. The DME or
SP2060 operates according to the configuration and scene information transferred during this
process.
This Synchronization is used when transferring the configuration in DME Designer and when
controlling the DME or SP2060 unit in real time.
NOTE
Because Synchronization presupposes that the DME or SP2060 unit can communicate with the computer where DME
Designer is installed, the necessary drivers (USB-MIDI or DME-N Network Driver) must be installed, and appropriate settings
must be made for the driver and for DME Designer communication ports (page 155).
For information about driver installation and settings, see “DME Setup Manual”. For DME Designer communications settings,
see “Online” (page 50).

NOTE
Because there are no scene settings when the DME unit is purchased, the configuration and scene information in DME
Designer must first be transferred.

NOTE
When combining DME64N/24N and DME Satellite units in a device group, be sure to assign a DME Satellite unit as the
device group master. Synchronization cannot be performed if a DME64N/24N is assigned as the device group master.

NOTE
For information about the online procedure, see “Online” (page 50).

Online and Offline
When a DME or SP2060 unit is connected to the computer and synchronized with DME Designer, its
status is called “Online.” When a DME or SP2060 unit is not physically connected to the computer or
is not synchronized even when it is connected, its status is called “Offline.” You can check the online/
offline status and message transmission in [Communication Status] in the Main Panel window.

 Online
Sends configurations created in DME Designer to the DME or SP2060 unit and reads data from the
DME or SP2060 unit, so that the DME unit configuration is reflected in the DME Designer
configuration. You can also control the DME or SP2060 in real time from DME Designer. Operations
performed in the DME Designer control editor are reflected in the DME or SP2060 unit, and
operations on the DME or SP2060 side are reflected in DME Designer.
You can not perform configuration editing using the Designer while online.

 Offline
The communication status becomes offline when editing configurations.

 Switching Between Online and Offline
You can switch between online and offline in the “Synchronization” dialog box.
NOTE
For information about the online procedure, see “Online” (page 50).
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“Synchronization” Dialog Box
When you click the [Synchronization] command on the [Tools] menu, the “Synchronization” dialog box
is displayed. The data from the current device group in the Designer is synchronized with the DME or
SP2060 unit.
Here you can make settings for synchronizing the unit in DME Designer one-on-one with the DME or
SP2060 that actually exists on the network.
NOTE
When synchronization is executed the connections, components, and other data are automatically checked as part of the
compilation process. A progress bar will appear during compilation, but in some cases it may not exactly match the progress
of the compilation process. Also, the appearance of the progress bar is no guarantee that compilation will be completed
successfully. If compilation continues for an inordinately long period of time, click the [Abort] button to stop processing. Try
eliminating unnecessary components and connections, and replacing components that place a heavy load on resources
with more efficient ones, then compile again.

NOTE
The Analyze function (page 308) can be used to check whether there are any problems with component layout or
connections without having to actually connect the DME unit. This is a convenient way to check for compile errors that might
occur at the time of synchronization.

NOTE
Once a configuration has been analyzed or compiled successfully, subsequent analysis or compilation will run quicker
unless changes are made to the configuration. Also, if you save the project file the analysis/compilation data is saved as well.

Names and Functions
[Go On-line]Button

[Designer]

Message Area

[Close This window
after synchronization]
checkbox
[Store Project File into DME
after synchronization]
checkbox
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 [Group] List
Allows selection of a device group to be synchronized.

 [Go On-line] Button
This button will be grayed out when the software is online.
Clicking the button displays a dialog box where you can decide the synchronization method.

[DME Designer  Device] button
A consistency check is performed between the data in the current device group and the DME or
SP2060 data, then the communication status changes to online. Transmits data from the DME
Designer to the DME or SP2060 unit and synchronizes the two.

[DME Designer  Device] button
Data from the DME or SP2060 unit is read into DME Designer. Current data stored in the DME or
SP2060 unit, such as scenes, are read into DME Designer. The configurations in the DME unit and
DME Manager must identical to allow synchronization. If the configuration has been edited,
synchronization can only be achieved by using the [DME Designer -> Device] button. SP2060
configurations cannot be edited, so synchronization is always possible.
NOTE
If the IP address of the DME device is changed after the device has been synchronized with DME Designer, it will be
necessary to re-transfer the configuration data. The “Full Resync” operation forces a re-transfer of all configuration data,
and can be initiated by clicking the [Go On-line] button while holding down the [Ctrl] key.

NOTE
For details on backing up the DME or SP2060 data as a file, refer to “Backup” on page 183.

NOTE
Project files can also be saved internally in the DME unit using the DME File Storage function (page 70). Synchronization
to DME or SP2060 units requires a project file. We recommend saving the project file to the DME unit itself to ensure that
the file is always available.

 [Go Off-line] Button
Clicking this button changes from online to offline. While offline, this button will be grayed out.

 [Close] Button
Closes the dialog box.

 [Close this window after synchronization] Checkbox
When this checkbox is checked the dialog window will close automatically after synchronization.

 [Store Project File into DME after synchronization] Checkbox
When this checkbox is checked the project file (.daf extension) will be automatically saved in the
DME unit after synchronization.
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 Designer
The Designer list displays DME or SP2060 units arranged in the currently valid device group in the
DME Designer.
The unit in the DME Designer is matched with a recognized IP address, and they are compared
one-to-one.

Device Name

IP Address Select Box

DME Name
Displays the names of DME or SP2060 units included in the project.
When multiple DMEs and SP2060s of the same type are arranged in a zone window, it is a good
idea to change the name of each one.

IP Address Select Box
Matches the units in the Designer with recognized IP addresses. Click the [IP Address] column [V]
button to see a list of the IP addresses of all devices of the same type in the area. If the unit is a
DME24N, IP addresses for all DME24N devices in the area will be displayed on the list.
If you click the title bar with “IP Address” written on it (pale []/[] mark appears), you can line
them up vertically.

 Network
The devices currently connected to the network are displayed in the Network list. To keep
consistency with the Designer list on the left side, the status of DMEs on the network is displayed.

Device Icon

IP Address
• Device Icon
Displays DME, SP2060 and ICP1 devices connected to the network. The device group master
DME or SP2060 icon is red. Icons for slave DMEs and SP2060s are blue. DMEs and SP2060s
and ICP1 devices with no relation to DMEs and SP2060s in Designer have gray icons.

• IP Address
Displays the DME or SP2060 IP address.

 Message Area
Displays a message that synchronization is in progress.
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Event Scheduler
“Event Scheduler” Dialog Box
When you click [Event Scheduler] in the [Tools] menu, the “Event Scheduler” dialog box is displayed.
This sets the scheduling for events. You can schedule events by specifying the date, time, and the
action to execute. You can set up schedules for events to be executed at a specified time, and events
that are to be repeated periodically. Periodic events are those that repeat each year, month, week, or
day. Up to 50 events can be scheduled. Scheduling can be set separately for each device group.
Settings and changes are sent to the DME unit during online status.
Scene changes, parameter changes, GPI output, and Wave file playback can all be scheduled.
NOTE
Does not apply to SP2060 units

NOTE
Only users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON can edit scheduling settings.

Names and Functions

 Event View
Displays registered scheduling events. When periodic events (cyclical events) are first displayed
together, they are displayed in order of date.
The order of same-time events can be changed by dragging and dropping.
Click to select an event.

 [No.]
Displays the event number. Numbers are added from the top in order.
This function will not be executed if the checkbox is not checked.

 [Name]
Displays the event names. Clicking an event will select it, allowing you to change its name. There is
no limit to the number of characters.
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 [Operation]
Displays the function that will be executed when the event starts.

 [Date]
Displays the event start date.
Periodic events are displayed as shown below, with an icon and text that indicate a periodic event.

• [January 1 every year]
Each New Year's Day

• [First Monday of January every year]
First Monday in January each year

• [Day 1 every month]
First day of each month

• [Second Monday of every month]
The second Monday of each month.

• [Monday every week]
Each week on Monday

• [Every day]
Every day

 [Time]
Displays the time for starting the event.

 Group List
selects the device group for which events are to be specified/displayed. Only events for the
selected device group will appear in the window.

 [Enable Event Scheduler]
Enables the scheduled events.

 [Add] Button
Adds an event. Clicking here displays the “Add Event” dialog box. If the maximum of 50 events has
already been registered, this button is grayed out.

 [Remove] Button
Deletes the event selected on the list. This button is grayed out when no event is selected.

 [Edit] Button
Lets you edit the selected event. Displays the “Edit Event” dialog box. This button is grayed out
when no event is selected.

 [Copy] Button
Copies the selected event. This button is grayed out when no event is selected.

 [Paste] Button
Pastes the copied event. The event is added. This button is grayed out when no event has been
copied.
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 [Clock setup] Button
Opens the “Clock” dialog box to set the DME internal clock.
 See “Clock” on page 180.

 [Apply] Button
Applies any current setting changes.

 [OK] Button
Applies any setting changes and closes the window.

 [Cancel] Button
Closes the window without changing any settings.

[Add Event (Edit Event)] Dialog Box
The dialog box is displayed when you click on the [Add] or [Edit] button in the “Event Scheduler”
dialog box. Here you can add or edit a scheduling event.

 [Event Name] Box
Enter the event name. There is no limit to the number of characters.
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 [Event Operation]
Set the operation that is executed when the event starts.

[Operation]
When you click this button, a list of events is displayed. Specify the operation that is executed
when the event starts.
The following four items are on the list:

• [Scene Change]
Changes the scene.

• [Parameter Value Edit]
Changes a parameter.
NOTE
If user module security is enabled, the components are not displayed. However, parameters displayed in the user
module editor are displayed here.

• [GPI Out]
Sends GPI output.

• [Play Wav File]
Allows initiation of Wave file playback.

[Operation Setting]
The content changes according to the event selected for [Operation].

• When [Scene Change] is selected:

Select the scene to be recalled from the [Scene] list. Stored scenes are displayed in the list.

• When [Parameter Value Edit] is selected:

[Scene]
Select a scene from the list.
If the DME unit's current scene differs from the scene specified in event scheduling, the scheduled
scene will be recalled. If the DME unit's current scene is the same as the scene specified in event
scheduling, the scheduled scene will not be recalled.

[DME Unit]
From the list, select the DME unit to which this scheduled event will apply. The DMEs included in the
zone are displayed in the list.
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[Component]
Select the component that has the parameter to be changed. The list displays the components
arranged for the DME that is selected in the [DME Unit] box.

[Parameter]
Select the parameter that will change. Parameters for the component that is selected in the
[Component] box are displayed in a list.

[Value]
Set a value for the parameter. Change the parameter using the spin buttons or the slider on the right.

• When [GPI Out] is selected:

[DME]
From the list, select the DME where you will be making settings.
[Port1]/[Port2]/[Port3] ...
Set [ON], [OFF], or [---] for each port. If it is set to [OFF], the [LOWHIGH] port outputs
[HIGHLOW] signal, the [HIGHLOW] port outputs [LOWHIGH] signal.

• When [Play Wav File] is selected:

[Scene]
Select a scene from the list.

[Wave]
Select a Wave file from the list.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a Wav File
Player is included in the DME configuration.

DME Designer Owner’s Manual

105

Chapter 3 Main Panel Window

 [Event Schedule]
Set the year/month/date to start the event.

Calendar
Sets the date the event will start.
Change the year and month using the [<] and [>] buttons. Click on a day to set that date. February
29 can be set on the calendar, where it appears every four years (each leap year).

[Time]
Sets the time the event will start.
Click the hour and minute, then set numerical values using the spin boxes.
Only the time is set for periodic events.

[Repeating Event]
When a check is placed here, the event becomes a periodic event, and the calendar is ignored.

• [Year]/[Month]/[Week]/[Day]/[Hour]
Set the period for the event, using the radio buttons to the left.

• [Day]/[Day of the week]
Set the conditions on the right side. Select [Day]/[Day of the week], and set the date and other
information. The items that can be set vary according to the selected period.

When the event period is [Year]
All settings can be made.

When the event period is [Month]
If [Day] is selected, only the date can be set.
If [Day of the Week] is selected, settings such as “the third Sunday” or “the first Monday” can be
made.

When the event period is [Week]
Only [Day Of The Week] can be selected. Set the day of the week.

When the event period is [Day]/[Hour]
Condition settings on the area on the right are not needed.

[Exception] Button
Opens the “Event Exceptions” dialog box.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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 [Event Exceptions]
Specifies “exception” year/month/day and time settings at which events will not be executed.

The available settings will depend on the event cycle.

• When the event cycle is [Year]
Only the [Year] setting is available.

• When the event cycle is [Month]
Only the [Month] and [Week] setting is available.

• When the event cycle is [Week]
Only the [Month], [Week] and [Day] settings are available.

• When the event cycle is [Day]
Only the [Month], [Week], [Day], and [Day of the week] settings are available.

• When the event cycle is [Hour]
Only the [Month], [Week], [Day], [Day of the week], and [Hour] settings are available.
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Wav File Manager
When you click [Wav File Manager] on the [Tools] menu, the “Wav File Manager” dialog box is
displayed. Here you can manage playback settings for Wave files played in the Wav File Player. This is
set for each DME. The setting can be made only when in offline status. Up to 100 Wave files can be
managed.
If a Wave file is added that exceeds the memory limit, a warning message will be displayed.
NOTE
Does not apply to SP2060 units

NOTE
These settings can be edited only by users for whom the [Edit] checkbox in the “Security” dialog box has been turned ON.

NOTE
Only Wave files with file names of 31 characters or less, (including the extension) can be registered. Check the Wave file
name beforehand. Change the name if it has 32 or more characters, including the extension.

NOTE
When saving project files including Wave files, select “Project File with wave (*.daf)” in the file save dialog box.

Names and Functions

 [DME]
From the list, select the DME where you will be making settings.
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 [Wave File]
Displays the Wave file information. Settings can be made here as well.

[No.]
The Wave file number is displayed in the leftmost column. Numbers are added from the top in
order.

[List Name]
You can set up to 27 characters as a label separate from the Wave file name. The Wave file name is
displayed here by default.

[File Name]
Up to 31 characters are displayed as the wave file name.

[Size]
Displays Wave file size information. The units vary, depending on the file size. The size is displayed
to the first decimal.
Size

Display

Up to 1023 bytes

0.X KB

1024 bytes to 1023.9 kilobytes

XXX.X KB

1024 kilobytes or more

X.X MB

[Repeats]
Sets the number of repeats for playback.
Clicking here will display a list where you can select the number of times.
Select [0] to [98] or [INFINITY].
Since external input cannot be edited, [---] is displayed.

[Interval]
Sets the time until the next playback when [Repeats] is set to a value higher than 1. If you click
here, a list will be displayed. You can set [0] to [99].
Since external input cannot be edited, [---] is displayed.

[Auto Start]
Turns automatic playback ON or OFF. When ON, playback begins automatically when the file is
loaded.
If you click here, a list will be displayed. Select [ON] or [OFF].

[Next No.]
Specifies the number for the Wave file to be played next.
If you click here, a list will be displayed. Select the number for the Wave file to be played next.

• [Stop]
This stops playback after this Wave file is finished playing, without specifying the next wave
file.
Since external input cannot be edited, [---] is displayed.

 [Store] Button
Saves the current settings in the “Wav File Manager” dialog box in a file, as a library. Clicking here
displays the file save dialog box.
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 [Recall] Button
Reads a saved library.
Clicking this button displays a menu. A menu displays library files saved in the folder that has been
set as the Contents Folder. Click the library to be read.

[Open File Dialog]
Displays the file select dialog box. You can select a library file that is saved in the folder set as the
Contents Folder, and read it.

 [Add] Button
When you click here, External Input and the file select list is displayed.
To add a Wave file, select the row to which it is to be added and click the [Add] button.
It is also possible to add Wave files by dragging and dropping the files from the desktop directly
onto the list in the “Wav File Manager” window.

[Wave File]
The file selection dialog box is displayed, where you can select a Wave file.
If the selected table already has data, an overwrite confirmation message is displayed.

[External Input]
Sets [External Input].
You can select multiple Wave files. If multiple files are specified, they are added after the selected
table. If a Wave file is registered to the number being added, it will be overwritten.
The following Wave file formats are supported: 48, 44.1, 24, 22.05 kHz, 16bit/8bit, Mono/Stereo. If a
file is selected with a format different than these, a message is displayed that says the file cannot
be used.
There is an upper limit to size beyond which a file cannot be used. This limit varies according to the
format. If the size of the selected file is beyond the limit, a message is displayed that says the file
cannot be used.
Maximum Size Per File and Playback Time

8bit
22.05 kHz
16bit
8bit
24 kHz
16bit
8bit
44.1 kHz
16bit
8bit
48 kHz
16bit

DME64N/24N
(Memory Limit: 25.8M)

DME Satellite
(Memory Limit: 11.8M)

Mono

3.6 Mbyte

174 sec

1.3 Mbyte

65 sec

Stereo

7.3 Mbyte

174 sec

2.7 Mbyte

65 sec

Mono

7.3 Mbyte

174 sec

2.7 Mbyte

65 sec

Stereo

14.7 Mbyte

174 sec

5.5 Mbyte

65 sec

Mono

4.0 Mbyte

174 sec

1.5 Mbyte

65 sec

Stereo

8.0 Mbyte

174 sec

3.0 Mbyte

65 sec

Mono

8.0 Mbyte

174 sec

3.0 Mbyte

65 sec

Stereo

16.0 Mbyte

174 sec

6.0 Mbyte

65 sec

Mono

7.3 Mbyte

174 sec

2.7 Mbyte

65 sec

Stereo

14.7 Mbyte

174 sec

5.5 Mbyte

65 sec

Mono

14.7 Mbyte

174 sec

5.5 Mbyte

65 sec

Stereo

25.8 Mbyte

153 sec

11.0 Mbyte

65 sec

Mono

8.0 Mbyte

174 sec

3.0 Mbyte

65 sec

Stereo

16.0 Mbyte

174 sec

6.0 Mbyte

65 sec

Mono

16.0 Mbyte

174 sec

6.0 Mbyte

65 sec

Stereo

25.8 Mbyte

140 sec

11.8 Mbyte

64 sec

NOTE
The values in the above chart are all approximate. Playback time will also vary according to the Wave file format.

NOTE
When a Wave file is played back while the DME is set to operate at 88.2 kHz or 96 kHz, only the OUT1 output of the Wav
File Player will be delivered via the Left channel. There will be no output from OUT2.
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 [Remove] Button
Deletes settings from the selected line. This button is grayed out when no Wave file is selected in
the list.

 [Move Up] Button
Moves the selected line up one. It is switched with the line immediately above.
The button will be grayed out if nothing is selected in the list, or if [No. 1] is selected in the list.

 [Move Down] Button
Moves the selected line down one. It is switched with the line immediately below.
The button will be grayed out if nothing is selected in the list, or if [No. 100] is selected in the list.

 [Play] Button
Plays the selected Wave file on the computer. Allows monitoring and checking of the Wave file.

 [Stop] Button
Stops playback of the Wave file.

 [Remaining Memory]
Displays the amount of available Wave file memory.

 [OK] Button
Updates the settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing the settings.
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GPI
About GPI
GPI is an abbreviation for General Purpose Interface. Using GPI input and output, DMEs can be
remotely controlled from custom-made controllers or external equipment. The number of GPI ports
depends on the type of device. Sets GPI input/output for each DME.
Using GPI input data, you can switch DME scenes and change component change component
parameters.
Refer to the DME owner’s manual for information on making GPI connections and other hardwarerelated issues.
NOTE
Only users for whom the [Operation Security]  [Edit] checkbox has been checked can make GPI settings.

NOTE
This cannot be set when online.

NOTE
Does not apply to SP2060 units

GPI Input/Output Setup Example
 Control Faders (Levels and On) via a CP4SF
A CP4SF control panel connected to the GPI terminal can be used to control the faders (Level and On
parameters) of Fader and Mixer components.
By assigning the component's Level and On parameters via the Parameter Value Edit function in the
GPI IN field it becomes possible to use the CP4SF faders and switches to control the assigned Level
and On parameters. If the port assigned to the Level parameter is set to [Min]=-INFINITYdB,
[Max]=10.00dB, [Terminal]= , the parameter will be controlled in proportion to the input voltage (=
fader position). The minimum input voltage will produce a level setting of -∞dB, and the maximum
input voltage will produce a level setting of 10.00dB. If the port assigned to the On parameter is set to
[Min]=OFF, [Max]=ON, [Terminal]= , the parameter will toggle between ON and OFF each time the
input voltage goes from low to high (= the moment that the switch is pressed).
By assigning the component's On parameter via the Parameter Value Edit function in the GPI OUT
field, the CP4SF switch LED can be toggled by the ON parameter. If [Terminal] is set to , a high level
will be output when the On parameter is on, lighting the LED.
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 Control Source Selection via a CP4SW
A CP4SW control panel connected to the GPI terminal can be used to switch the channel source of
Source Selector (Position 4) components.
Assign the Source Selector component's Position parameter via the Parameter Value Edit function in
the GPI IN and GPI OUT fields and set the parameter values ([Max] in the GPI IN field, and [Threshold]
in the GPI OUT field) to 1 through 4 for the corresponding ports. The CP4SW switches will then select
the corresponding channel sources, and the corresponding switch LED will light.
[Terminal] in the GPI IN field cannot be altered. If [Terminal] in the GPI OUT field is set to , a high
level voltage will be output and the LED will light when the Position parameter matches the [Threshold]
setting.

“GPI” Dialog Box
When you click the [GPI] command on the [Tools] menu, the “GPI” dialog box is displayed. Sets GPI
input/output for the DME.

Names and Functions
[DME]

GPI IN

GPI OUT

[Apply]
Button

[Cancel]
Button
[OK]
Button
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 [DME]
From the list, select the DME where you will be making settings.

 Configuration
The current configuration name will be displayed.

 GPI IN
The DME64N has 16 GPI IN channels, and the DME24N/DME Satellite has 8 GPI IN ports.
These settings determine which DME parameters will be controlled by input received at each
individual GPI IN port. The port numbers are shown in the leftmost column.

[Function]
Specifies the function to be controlled by GPI input. Click to see a list from which you can choose
the function to be assigned to the corresponding GPI IN port.
The ten available functions are: [No Assign], [Parameter Value Edit], [Direct Parameter Value],
[Scene Change], [Scene Increment], [Scene Decrement], [Mute], [GPI Lock], [Time Adjustment],
[Play Wav File].
The [Parameter], [Min], [Max], and [Terminal] items will change according to the selected function.

• [No Assign]
No function assigned. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Min], [Max], and [Terminal] items are not available.

• [Parameter Value Edit]
Allows component parameters to be changed via GPI input.
In this case [Parameter] is used to select the parameter to be controlled.
[Min] and [Max] specify the range over which the parameter can be changed.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

and
specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
and
specify on/off control of 2-state parameters via an external switching device.
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The parameter value changes in proportion to the voltage applied to the GPI input.
The minimum voltage applied to GPI IN will produce the specified [Min] parameter value, and the
maximum voltage applied to GPI IN will produce the specified [Max] parameter value, with
intermediate voltages produced the corresponding intermediate parameter values.
Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.
Max. voltage applied to GPI IN

[Max] parameter value

[Min] parameter value
Min. voltage applied to GPI IN

The parameter value changes in inverse proportion to the voltage applied to the GPI input.
The minimum voltage applied to GPI IN will produce the specified [Max] parameter value, and the
maximum voltage applied to GPI IN will produce the specified [Min] parameter value, with
intermediate voltages produced the corresponding intermediate parameter values.
Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.
Max. voltage applied to GPI IN

[Min] parameter value

[Max] parameter value
Min. voltage applied to GPI IN

The specified [Min] and [Max] parameter values are alternately selected each time the voltage
applied to GPI IN rises from below to above the median voltage.*
Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
[Max] parameter

[Min] parameter value

[Max] parameter value

The specified [Min] and [Max] parameter values are alternately selected each time the voltage
applied to GPI IN drops from above to below the median voltage.*
Example: Relationship between the voltage applied to GPI IN and the Fader Level when [Fader Level]
is set in the [Parameter] box.
[Min] parameter value

[Max] parameter value

[Min] parameter value

Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN

• [Direct Parameter Value]
Sets component parameters to a specified value. Select the parameter to be set via
[Parameter], and [Max] sets the parameter value. [Min] and [Terminal] are unavailable.
When the voltage at the GPI input changes from below to above the median voltage, the
parameter is set to the value specified by [Max].
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• [Scene Change]
GPI input can be used to recall a specified scene.
[Parameter] specifies the number of the scene to be recalled.
[Min] and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN rises
from below to above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
Trigger

The scene specified by [Parameter] will be recalled each time the voltage applied to GPI IN drops
from above to below the median voltage.*
Trigger
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN

Same as

.

Same as

.

• [Scene Increment]
GPI input can be used to increment the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
The scene number will be incremented each time the voltage applied to GPI IN rises from below to
above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
Trigger

The scene number will be incremented each time the voltage applied to GPI IN drops from above to
below the median voltage.*
Trigger
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
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• [Scene Decrement]
GPI input can be used to decrement the scene number.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

The scene number will be decremented each time the voltage applied to GPI IN rises from below to
above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
Trigger

The scene number will be decremented each time the voltage applied to GPI IN drops from above to
below the median voltage.*
Trigger
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN

Same as

.

Same as

.
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• [Mute]
GPI input can be used to engage or disengage the DME mute function.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
Mute will be ON when the voltage applied to GPI IN is above the median voltage*, and OFF when the
voltage is below the median.
Max. voltage applied to GPI IN
Mute ON
Median voltage
Mute OFF

Mute OFF

Min. voltage applied to GPI IN

Mute will be OFF when the voltage applied to GPI IN is above the median voltage*, and ON when the
voltage is below the median.
Max. voltage applied to GPI IN
Mute OFF
Median voltage
Mute ON

Mute ON

Min. voltage applied to GPI IN

Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN drops from
below to above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
ON

OFF

ON

Mute will be alternately turned ON and OFF each time the voltage applied to GPI IN rises from above
to below the median voltage.*
ON

OFF

ON

Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
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• [GPI Lock]
GPI Lock can be turned on or off via GPI input. When GPI Lock is ON, all GPI inputs other than
the one being used for GPI Lock control are locked and input will be ignored.
[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.

GPI lock will be ON when the voltage applied to GPI IN is above the median voltage*, and
OFF when the voltage is below the median.
Max. voltage applied to GPI IN
Lock ON
Median voltage
Lock OFF

Lock OFF

Min. voltage applied to GPI IN

GPI Lock will be OFF when the voltage applied to GPI IN is above the median voltage*, and
ON when the voltage is below the median.
Max. voltage applied to GPI IN
Lock OFF
Median voltage
Lock ON

Lock ON

Min. voltage applied to GPI IN

GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN drops
from below to above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
ON

OFF

ON

GPI Lock will be alternately turned ON and OFF each time the voltage applied to GPI IN rises
from above to below the median voltage.*
ON

OFF

ON

Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
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• [Time Adjustment]
GPI input can be used to adjust the DME internal clock as follows:
Internal clock time

Time after adjustment

0~14 seconds

Returned to 0 seconds

15~29 seconds

Advanced to 30 seconds

30~44 seconds

Returned to 30 seconds

45~59 seconds

Advanced to 0 seconds

[Parameter], [Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
and
specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
and
specify on/off control of 2-state parameters via an external switching device.

The internal clock time will be adjusted each time the voltage applied to GPI IN rises from below to
above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
Trigger

The internal clock time will be adjusted each time the voltage applied to GPI IN drops from above to
below the median voltage.*
Trigger
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
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• [Play Wav File]
GPI input can be used to initiate playback of the specified Wave file.
[Parameter] specifies the Wave file to be played. Files specified by the Wav File Manager can
be selected. Wave files can only be selected if a Wav File Player is included in the DME
configuration.
[Min], and [Max] are not available.
[Terminal] determines how the GPI input voltage will affect the specified parameter.
and
specify continuous control of continuously-variable parameters from an external
fader, knob, or similar device.
and
specify on/off control of 2-state parameters via an external switching device.
The specified Wave file will be played each time the voltage applied to GPI IN rises from below to
above the median voltage.*
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN
Trigger

The specified Wave file will be played each time the voltage applied to GPI IN drops from above to
below the median voltage.*
Trigger
Max. voltage applied to GPI IN
Median voltage

Min. voltage applied to GPI IN

Same as

.

Same as

.

* “Median voltage” refers to the voltage halfway between the maximum and minimum voltages detectable by the GPI
input terminals. Refer to the DME owner’s manual for details on GPI voltages.
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 GPI OUT
The DME64N has sixteen GPI OUT ports, the DME24N has eight, and the DME Satellite has four.
These settings determine which DME parameter values will be output via each individual GPI IN
ports. The ports numbers are shown in the leftmost column.

[Function]
Specifies the function to be transmitted via a GPI output.
The six available functions are: [No Assign], [Parameter Value Edit], [Scene Change], [GPI Lock],
[Direct Parameter Value], and [Audio Detector].
The [Parameter], [Threshold], [Terminal], and [Polarity] items will change according to the selected
function.

• [No Assign]
No function assigned, and no GPI output will occur. This is the default setting.
Select [No Assign] to clear an assigned function.
The [Parameter], [Threshold], [Terminal], and [Polarity] items are not available.

• [Parameter Value Edit]
Allows component parameter values to be output via GPI.
[Parameter] selects the parameter to be output via the GPI OUT terminals.
[Threshold] specifies the parameter threshold value.
[Terminal] and [Polarity] determine how the GPI voltage will be output in response to
parameter changes.
Terminal

Polarity

GPI Output

Ignored

When value of the specified parameter is above the threshold level the output
will be high, and when below the threshold level the output will be low.

Ignored

When value of the specified parameter is below the threshold level the output
will be high, and when above the threshold level the output will be low.
A pulse*1 will be output when the value of the parameter changes from below
to above the threshold.
A pulse*1 will be output when the value of the parameter changes from above
to below the threshold.
A pulse*2 will be output when the value of the parameter changes from below
to above the threshold.
A pulse*2 will be output when the value of the parameter changes from above
to below the threshold.
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• [Scene Change]
The recall status of the specified scene is transmitted via GPI output.
[Parameter] specifies the scene for which the recall status is to be output.
[Threshold] and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.
Terminal

GPI Output
When the current scene is the same as the scene specified by [Parameter] the output will be
high, and when different the output will be low.
When the current scene is the same as the scene specified by [Parameter] the output will be
low, and when different the output will be high.
A pulse*1 will be output when the current scene is the same as the scene specified by
[Parameter].
A pulse*2 will be output when the current scene is the same as the scene specified by
[Parameter].

• [GPI Lock]
The GPI Lock status is transmitted via GPI output.
[Parameter], [Threshold], and [Polarity] are not available.
[Terminal] determines how the GPI voltage will be output in response to parameter changes.
Terminal

GPI Output
When GPI Lock is ON the output will be high, and when OFF the output will be low.
When GPI Lock is ON the output will be high, and when OFF the output will be low.

• [Direct Parameter Value]
GPI output is produced when a component parameter reaches a specified value. [Parameter]
sets the parameter name. [Threshold] sets the parameter value. [Polarity] is unavailable.
[Terminal] specifies the type of GPI output produced.
Terminal

GPI Output
A high level is output when the value specified by [Parameter] is equal to [Threshold].
A low level is output when the value specified by [Parameter] is equal to [Threshold].
Pulse waveform 1 (*1) is output at the instant the value specified by [Parameter] becomes
equal to [Threshold].
Pulse waveform 2 (*2) is output at the instant the value specified by [Parameter] becomes
equal to [Threshold].

• [Audio Detector]
The audio signal status detected by the Audio Detector component is output via GPI OUT.
[Parameter] selects the Audio Detector component that will produce GPI output according to
the detected audio signal status. [Terminal] and [Polarity] specify the type of GPI output
produced.
Terminal

Polarity

GPI Output

Ignored

High level while an audio signal is detected, low level while no audio signal is
detected.

Ignored

High level while no audio signal is detected, low level while an audio signal is
detected.
Pulse waveform 1 (*1) is output when the status changes from no audio signal
detected to audio signal detected.
Pulse waveform 1 (*1) is output when the status changes from audio signal
detected to no audio signal detected.
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Terminal

Polarity

GPI Output
Pulse waveform 2 (*2) is output when the status changes from no audio signal
detected to audio signal detected.
Pulse waveform 2 (*2) is output when the status changes from audio signal
detected to no audio signal detected.

*1 Pulse waveform 1

*2 Pulse waveform 2

HI

HI

LO

LO
250msec

250msec

Event Scheduler
Event Schedule is shown when [GPI OUT] is set in “Event Scheduler.”
See “Event Scheduler” on page 101.

User Defined Button
User Defined Button is shown when [GPI OUT] is set in “User Defined Button.”
See “User Defined Button (User Defined Parameters)” on page 132.

Event Logger
Event Log is shown when [GPI OUT] is set in “Event Logger.”
See “Event Logger” on page 75.

[Apply] Button
Applies any current setting changes.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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MIDI
When you click the [MIDI] command on the [Tools] menu, the “MIDI” dialog box is displayed. Here you
can make remote control and other settings.
NOTE
Does not apply to SP2060 units

Names and Functions

 Common to All Tabs
DME
From the list, select the DME where you will be making settings.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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[Control Change] Tab
Assigns components to control change for each DME. You can change DME parameters by sending
control change messages from external equipment.
You can assign to control change numbers 1-31, 33-95, and 102-119.
NOTE
Because control change numbers 0 and 32 are used for bank select MSB, numbers 96-101 are RPN/NRPN related, and
120-127 are used for mode messages, they cannot be used for component assignment.

 Control Change List
The control change numbers and current settings are displayed in the list in the center.

No.
Displays the control change numbers.

Component
Displays the assigned components. Control changes that have no component assigned to them
are blank. If you click here, a list will be displayed. Usable components are on the list. Click the
component name to select it.
NOTE
If user module security is enabled, the components are not displayed. However, parameters displayed in the user
module editor are displayed here.
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Parameter
Set the assigned component link parameter.
When you click here, a list of parameters included in the component is displayed. Select the
parameter you want to assign.

Min/Max
Sets the range of operation for the parameter. The current values for the [Min] (lower limit) and
[Max] (upper limit) are displayed. If you click here, a slider will be displayed. The range and
parameter units that can be set will vary, depending on the parameter selected in the [Parameter]
box.
You can change the parameter by dragging the slider. To make a finer setting, press the <Shift>
key while dragging the slider. The value for the parameter will be shown while you are dragging the
slider. When you finish dragging and release the mouse button, the slider will disappear.
The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag
the right edge, the [Max] will change.

 [Clear] Button
Clears assignments for the selected control change numbers.

 [Clear All] Button
Clears assignments for all control change numbers.
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[Program Change] Tab
Assigns scenes to program control change numbers 1 through 128. Switches scenes when program
changes are received. These settings are shared by all DMEs in the device group. Up to 999
assignments can be made. Scenes above number 128 are assigned by changing banks.

 Program Change Event
Program numbers and the scenes assigned to them are displayed in a list.

No.
This displays program numbers from 1 to 128.

Scene
Displays the scene number and name of the assigned scene. Program changes that have no
scene assigned to them are blank.
When you click here, a list of scenes is displayed. Select the scene you want to assign.

 [Clear All] Button
Clears all scene assignments.

 [Clear] Button
Clears the scene assignment for the program number selected in the list, so that no scene is
assigned to that number.
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 [Assign All] Button
Assigns all scenes in order starting from program number 1.

 Bank Select LSB
The bank is changed when assigning scenes numbered 129 and higher. Eight banks can be used,
numbered from zero to seven. Click the [] and select the bank where you will make settings.

[Parameter Change] Tab
Specifies the parameter to be controlled by parameter change commands for each address. Up to
128 can be set.
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 Parameter Change List
The current settings are displayed in the list in the center.

No.
This displays the parameter change numbers.

Component
Assigns components. If you click here, a list will be displayed. Assignable components are on the
list. Click the component name to select it.

Parameter
Set the assigned component link parameter.
When you click here, a list is displayed of parameters included in the component selected in the
[Component] box.
Select the parameter you want to assign.
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Min/Max
This sets the parameter range. The current values for the [Min] (lower limit) and [Max] (upper limit)
are displayed. The range and units that can be set will vary, depending on the parameter selected.
If you click here, a slider will be displayed.
You can change the parameter by dragging the slider. To make a finer setting, press the <Shift>
key while dragging the slider. The value for the parameter will be shown while you are dragging the
slider. When you finish dragging and release the mouse button, the slider will disappear.
The same slider is displayed whether you click the [Min] box or the [Max] box. The black part is the
parameter range. If you drag the left edge of the black part, the [Min] value will change. If you drag
the right edge, the [Max] will change.

 [Clear] Button
Clears the assignment for the parameter change selected in the list, so that nothing will be
assigned to it.

 [Clear All] Button
Clears all parameter change assignments.
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User Defined Button (User Defined Parameters)
User Defined Parameters
Parameters that the user can operate using function keys <F1> through <F6> in the DME64N/24N unit
or ICP1 are called “User Defined Button.” Frequently changed parameters can be assigned in
advance to any of 24 (four pages times six) presets, and operated on the DME64N/24N unit or ICP1
even if DME Designer is not being used.
This function sets parameters in DME Designer that can be called by these function keys <F1>
through <F6>.
In DME Designer, user defined parameter settings are made using the “User Defined Button” dialog
box. The user defined parameter settings are shared between device group configurations.

“User Defined Button” Dialog Box
When you click [User Defined Button] in the [Tools] menu, the “User Defined Button” dialog box is
displayed.
NOTE
Does not apply to SP2060 units

 Names and Functions

 [Group]
Select the device group to be set up from the list.

 [1]/[2]/[3]/[4] Tabs
Switches the set to which settings will apply. You can set up to six function keys in each set. The
user defined parameters set on a single tab are displayed on one page in the DME64N/24N unit or
ICP1 main screen.

Function Keys
The function keys are displayed in the leftmost column of the table. When you enter text for [LCD
Display], a short name with up to eight characters will be created and displayed to the right of the
function key.
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Function
Specifies the function to be assigned to the function keys.

• [No Assign]
No assignment. Select this option to clear an assigned function.

• [Parameter Value Edit]
Allows the parameter specified in the [Parameter] field to be changed.
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

• [Direct Parameter Value]
Allows the value of a parameter to be set directly. The target parameter is specified in the
[Parameter] field, and the value to be set is specified in the [Max] field.
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

• [Scene Change]
Allows scene recall. The scene to be recalled is specified in the [Parameter] field.

• [GPI OUT]
Allows GPI output. The GPI setting is made in the [Parameter] field.

• [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a
Wav File Player is included in the DME configuration.
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Parameter
Sets the parameter assigned to each function key. If you click here, a list will be displayed. This list
displays the parameters that are included in the current configuration. Select the parameter you
want called by the function key.

LCD Display
Sets the text displayed on the DME unit or ICP1. Click the [LCD Display] box and enter text. Up to
23 characters can be entered into the [LCD Display] box.
After you confirm the name by pressing the <Enter> key, a short name will be created and
displayed in the function key area as follows: “F1 [shortnam].” The short name will also be
displayed in the DME unit or ICP1 main display. A short name is automatically created with up to
eight characters for display as the user defined parameter name on the DME unit or ICP1 main
screen

Min, Max
Sets the lower and upper limits for a parameter.

 [Clear] Button
Clears assignments for the selected function keys. This is the same as “No Assign.”

 [OK] Button
Accepts the changed settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing the settings.
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Setting User Defined Parameters
Set the user defined parameter.

1 Create a configuration.
2 Click [User Defined Button] in the [Tools] menu.
The “User Defined Button” dialog box will be displayed.

3 Click one of the tabs numbered [1] through [4] to select the set of user defined parameters
you will assign your parameters to.
The four tabs correspond to the pages on the DME unit or ICP1 main screen.

4 Click the [Parameter] box for the function key to which you will assign the parameter.
A list of parameters included in the current configuration will be displayed.

5 Select the parameter to assign to the function key.
6 Click the [LCD Display] box and enter text for the user defined parameter name.
The [LCD Display] box can accept up to 23 characters, but only eight characters can be displayed
in the DME unit or ICP1 main screen. When making a user defined parameter name, the first eight
characters should be understandable.
Note
When making multiple registrations, you can save time by first setting just the [Parameter] box for all keys, then setting
the [LCD Display] box names. When you enter a user defined parameter name into an [LCD Display] box and press the
<Enter> key to confirm it, the next [LCD Display] box down will be selected, and you can enter text there immediately.

DME Designer Owner’s Manual

135

Chapter 3 Main Panel Window

DAW Control
When you click [DAW Control] on the [Tools] menu, the “DAW Control” dialog box is displayed. Here
you can make settings for when the DME64N/24N is controlled from a DAW controller. This is set for
each zone configuration. The setting can be made only when in offline status.
NOTE
DAW Control can be set on DME64N/24N units only.

NOTE
DAW control editing can be performed only by users for whom the [Edit] security checkbox has been checked.

Names and Functions

 [DME]
From the list, select the DME64N/24N where you will be making settings.

 [DAW Type]
Select the DAW type. The available settings are: MIDI, DAW(Type1), and DAW(Type2).
The [DAW Type] parameter has the same function as Protocol in the “Utility” dialog box MIDI tab.
MIDI: Use this setting when any MIDI device other than a general purpose ProTools controller (HUI
protocol) or general-purpose Logic or Cubase controller (Mackie control protocol) is to be connected.
DAW (Type1): Use this setting when a general purpose ProTools controller (HUI protocol) is to be
connected.
DAW (Type2): Use this setting when a general purpose Logic or Cubase controller (Mackie control
protocol) is to be connected.

 DAW Control Table
The following can be set for each channel from 1 to 64: [Function], [Controller], [Label], [Parameter].
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[Function]
Selects the function that will be changed by the DAW controller. If you click here, a list will be
displayed.

• [No Assign]
Makes no assignments. Select this when you are erasing an already set assignment.

• [Parameter Value Edit]
Allows the parameter of the component specified in the [Parameter] field to be changed.
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

• [Scene Change]
Recalls a scene. The scene is recalled even if the current scene, and the one changed by the
DAW controller, are the same.
When a selection has been made, [SCENE] is displayed in the [Label] field. The last scene is
set in the [Parameter] field.

• [Scene Increment]
Sets the scene increment. Recalls the next valid scene after the current scene.
When a selection has been made, [SINC] is displayed in the [Label] field.

• [Scene Decrement]
Selects the scene decrement. Recalls the next valid scene before the current scene.
When a selection has been made, [SDEC] is displayed in the [Label] field.

• [Mute]
Sets all mute. Mute is set ON and OFF by the DAW controller.
When a selection has been made, [MUTE] is displayed in the [Label] field.

• [Component]
Changes the component parameters. Selectable component names that are arranged in the
configuration are displayed in a list.
When selected, the first parameter included in the component is set in the [Parameter] field.

• [GPI Lock]
Assigns GPI Lock. GPI Lock is set ON and OFF by the DAW controller.
When a selection has been made, [LOCK] is displayed in the [Label] field.

• [Play Wav File]
Allows initiation of Wave file playback. The Wave file setting is made in the [Parameter] field.
Wave files set by the Wav File manager can be specified. Files can not be selected unless a
Wav File Player is included in the DME configuration.
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[Controller]
Selects a controller from the list when [Parameter Value Edit] is set in [Function]. [Switch], [Fader],
or [Knob] can be selected.

[Label]
Enter a label. Double-click to enter the text. You can enter up to 16 characters of text. Set the value
with the <Enter> key, or cancel it with the <ESC> key.
NOTE
If [Scene Change], [Scene Increment], [Scene Decrement], [Mute], or [GPI Lock] is selected for [Function], the label
name is fixed.

[Parameter]
If [Scene Change], [Parameter Value Edit] or [Play Wav File], is set in [Function], set the
parameters.
If you click here, a list will be displayed.

• When [Scene Change] is set in [Function]
Displays scenes that can be selected.

• When [Parameter Value Edit] is set in [Function]
Selectable parameters are displayed.

• When [Play Wav File] is set in [Function]
Selectable Wave files are displayed.
To select a Wave file, the file must first be specified in the Wav File Manager and then the Wav
File Player must be placed in the DME configuration.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Remote Control Setup List
When you click the [Remote Control Setup List] command on the [Tools] menu, the “Remote Control
Setup List” dialog box is displayed.
Registers the parameters to be controlled from an external controller.
NOTE
DME V3.8 or later/DME Satellite units allow remote control via the [NETWORK] connector as well as via the [REMOTE]
connector. The port to be used is specified via the “Remote” tab of the “Utility” dialog box (page 172).

NOTE
For details about the communication protocol, refer to the “DME Remote Control Protocol Specifications” on the Yamaha Pro
Audio website (URL below).
http://www.yamahaproaudio.com/

NOTE
Does not apply to SP2060 units.

Names and Functions

[DME]
From the list, select the DME where you will be making settings.

[Function]
Select [No Assign], [Parameter Value Edit] or [Level Meter].

[Parameter]
Specifies the parameter to be controlled. A list of parameters will be displayed according to the
selection of [Function].
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.
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[Min]/[Max]
Displays the minimum and maximum values for the parameter.

[Type]
Selects a fader curve when level, etc., is select for [Parameter].
Select [dB] to directly control the level in dB, or [Curve Table] to use one of the DME fader curves
for level adjustment.

[Clear] Button
Clears the selected row.

[String Display]/[Numeric] Buttons
Switches the parameter value display format.
String Display: The value displayed in the editor windows.
Numeric: The internal value.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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Internal HA Control
The gain and phantom power (+48V) of the DME24N/DME8i-C/DME4io-C/DME8i-ES/DME4io-ES
internal head amplifiers can be controlled from a PM5D, and LS9 or other compatible mixing console.
The digital mixer communicates serially with one DME unit in a device group, and that DME unit
controls all other DME units in the group. Only one DME unit in a device group may be connected to a
digital mixer for direct serial communication. This can be a DME unit other than the group master or a
DME unit that does not have head amplifiers.
There are three possible ways to connect a DME unit to a digital mixer for serial communication: 1) via
the [REMOTE] connector, 2) via CobraNet, and 3) via EtherSound. In all cases it is necessary to set
the communication port that the DME unit will use, and if CobraNet or EtherSound are to be used it is
necessary to make the appropriate settings for those protocols as well.
It is also necessary to assign an ID to the internal head amp of the DME that is to be controlled
(page 146). Since AD8HR protocol is used for communication between the DME units and digital
mixer, the head amp IDs allow multiple DME units to be viewed and controlled as AD8HR head amps
from the mixer. Details on making the appropriate settings are provided on the following pages.
NOTE
• Only one mixer can be communicated serially within each device group.
• If the connection between DME series units is interrupted, communication with DME units with ID numbers higher than
that of the unit at which the interruption occurred will not be possible.
• The variable range of GAIN differs between the AD8HR and the DME series. You cannot use the mixer to specify a
value that exceeds the variable range of the DME series.
• If the DME unit that is communicating serially with the digital mixer is changed, or it’s internal head amp ID assignment
is changed, it will be necessary to restart the DME unit.
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Remote Connection
Connect the digital mixer to the [REMOTE] connector of one of the DME units, and set the port to be
used for head amp control to “Remote” via the [Internal HA Control] parameter in the “Remote” tab in
the “Utility” dialog box (page 172). Use an Ethernet cable connected to the [NETWORK] connectors to
make connections between DME series units.
D-SUB 9-pin Cable

REMOTE

REMOTE
Ethernet

DME24N

Network
Switch

DME8i-C
Digital Mixer

DME4io-C

DME8i-ES

DME4io-ES

NOTE
• Only control signals are transmitted and received via the REMOTE connection. Audio connections must be made
separately.
• Connection can also be made to the [REMOTE] connector of a DME unit with built-in head amplifiers.
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CobraNet Connection
Use a CobraNet interface card such as the MY16-CII to make CobraNet connections between the
digital mixer and DME units. Use an Ethernet cable connected to the [NETWORK] connectors to make
connections between DME series units. The port to be used for head amp control is specified via the
[Internal HA Control] parameter in the “Remote” tab in the “Utility” dialog box (page 172). Select “Slot
1” when the DME unit to be used for serial communication is a DME24N, “Slot 1” through “Slot 4” if it is
a DME64N, or “CobraNet” if it is a DME Satellite unit. The settings for all other DME units should be
“OFF”.
It is also necessary to match the CobraNet serial communication channels of the interface card
installed in the serially connected DME unit with that of the interface card in the digital mixer. Refer to
page 495 for DME8i-C/8o-C/4io-C information. Refer to the CobraNet Manager Lite for Yamaha
Owner’s Manual for more information on setting the MY16-CII. Set the serial channel for all other
devices to “OFF”.
CobraNet
Network
Switch

MY16-CII

MY16-CII
Ethernet

Network
Switch

DME24N

DME8i-C

DME4io-C
LS9

NOTE
When two MY16-CII or similar CobraNet interface cards are installed in an LS9-32 in order to control multiple DME units,
use the COMM PORT parameter in the LS9 EXTERNAL HA display to select the slot to be used.
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EtherSound Connection
 Digital Mixers Without a [REMOTE] Connector
Use an EtherSound interface card such as the MY16-ES64 to make EtherSound connections between
the digital mixer and DME units. Use an Ethernet cable connected to the [NETWORK] connectors to
make connections between DME series units.
The port to be used for head amp control via direct serial communication with a DME unit is specified
by the [Internal HA Control] parameter in the “Remote” tab in the “Utility” dialog box (page 172).
Select “Slot 1” when the DME unit to be used for serial communication is a DME24N, “Slot 3” or “Slot
4” if it is a DME64N, or “EtherSound” if it is a DME Satellite unit. The settings for all other DME units
should be “OFF”.
Use the AVS-ESMonitor software from AuviTran to specify the following EtherSound settings for both
the digital mixer’s interface card and the DME unit.
• Serial Communication mode: Unicast for bidirectional operation.
• AD8HR Remote Option: Mode 2
• Baud Rate: 38400
In order to turn serial communication off for the interface cards installed in all other DME units, set the
Serial Communication mode to “Slave”.

EtherSound

MY16-ES64
(mode 2)
MY16-ES64
(mode 2)
Ethernet

Network
Switch

DME24N

DME8i-ES

LS9

DME4io-ES

NOTE
• When installing an MY16-ES64 or similar EtherSound interface card in an LS9-32, be sure to install it in SLOT 1. Also
select “SLOT 1” using the COMM PORT parameter in the LS9 EXTERNAL HA display.
• DME24N units with firmware version V3.04 or later are compatible.
• You can download the AVS-ESMonitor software from the AuviTran website.
http://www.auvitran.com/
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 Digital Mixers With a [REMOTE] Connector
Connect the mixer’s [REMOTE] connector to the MY16-ES64 or similar EtherSound interface card via a
9-pin D-sub cross cable, and make the appropriate EtherSound connections between the interface
card and DME units. Use an Ethernet cable connected to the [NETWORK] connectors to make
connections between DME series units.
The port to be used for head amp control via direct serial communication with a DME unit is specified
by the [Internal HA Control] parameter in the “Remote” tab in the “Utility” dialog box (page 172).
Select “Slot 1” when the DME unit to be used for serial communication is a DME24N, “Slot 3” or “Slot
4” if it is a DME64N, or “EtherSound” if it is a DME Satellite unit. The settings for all other DME units
should be “OFF”.
Use the AVS-ESMonitor software from AuviTran to specify the EtherSound serial communication
settings for both the digital mixer’s interface card and the interface card installed in the serially
connected DME unit.
• Serial Communication mode: Unicast for bidirectional operation.
• Set the digital mixer’s interface card to “Mode 3,” and the DME unit to be used for serial
communication to “Mode 2.”
• Baud Rate: 38400
In order to turn serial communication off for the interface cards installed in all other DME units, set the
Serial Communication mode to “Slave”.

EtherSound

D-Sub 9-pin

MY16-ES64
(mode 2)
MY16-ES64
(mode 3)

Ethernet
MY16-EX64

Network
Switch

DME24N

DME8i-ES

Digital Mixer

DME4io-ES

NOTE
• DME24N units with firmware version V3.04 or later are compatible.
• You can download the AVS-ESMonitor software from the AuviTran website.
http://www.auvitran.com/
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Setting the Internal Head Amp ID
Click [Internal HA Control] in the [Tools] menu to open the “Internal HA Control” dialog box. ID
numbers for the internal DME head amplifiers that are to be controlled from the digital mixer are
assigned via this dialog box. The ID numbers are displayed as AD8HR IDs on the digital mixer. Click
on a [Device Label] field and select the target DME unit from the drop-down menu that appears.

Device Group Select Field
Selects the target device group.

[Device Label]
Selects the DME unit to which head amp control is to be applied.

[Insert] Button
Inserts an unassigned row at the currently selected DME in the list. The originally selected DME will
be moved to the next row.

[Clear] Button
Deletes the currently selected DME from the list.

[Clear All] Button
Clears all settings from the list.

[Move Up]
Moves the selected DME up one row in the list.

[Move Down]
Moves the selected DME one row down in the list.

[Utility] Button
Opens the “Remote” tab in the Utility dialog box. Select the DME unit to be used for serial
communication with the digital mixer and specify the port to be used for head amp control via the
[Internal HA Control] parameter.

[OK] Button
Applies the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without applying the setting changes.
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Parameter List
When you click [Parameter List] in the [Tools] menu, the “Parameter List” dialog box is displayed. A list
of parameters in the current configuration of the current zone are displayed. Here you can check
things like the parameter IDs. You can also print the list of parameters.
When the dialog box is opened or when a DME is selected from the [DME] list, the parameter values
are displayed.
NOTE
Does not apply to SP2060 units.

Names and Functions

 [DME]
From the list, select the DME where you will be making settings. Components in the selected DME
are displayed in the component list.

Component List
The components and user modules included in the DME, their IDs, and the component parameters
are displayed in hierarchal list. The AD and slot are also displayed.
NOTE
Components for user modules are also listed in a hierarchal display, but if user module security is enabled, the
components are not displayed. However, parameters displayed in the user module editor are displayed here.

[ID]
Displays the component or parameter ID.
The following is displayed for the parameter ID: “Element No. : X : Y : Parameter No. : Index No.”

[Value]
Displays the value for the parameter.

[Min]/[Max]
Displays the minimum and maximum values for the parameter.
NOTE
The displayed parameter values are those that were in effect when the dialog box was opened or when the displayed
DME was selected from the [DME] list. They cannot be changed here.
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 [Preview] Button
Prints a list of parameters. When you click this button a preview screen is displayed.

 [Save] Button
Saves the parameter list as a CSV file. When you click this button, the standard operating system
save dialog box is displayed.
NOTE
The CSV format is a comma delimited text file that can be read by many types of software, such as word processor,
spreadsheet, or database programs.

NOTE
The parameter values are saved in the display format selected by the [String Display] or [Numeric] button.

 [String Display]/[Numeric] Buttons
Switches the parameter value display format.
String Display: The value displayed in the editor windows.
Numeric: The internal value.

 [Close] Button
Closes the dialog box.

 Printing a List of Parameters
Prints all parameters for the component selected in the list, all parameters for the selected DME, or
all parameters for all DMEs.
When you click the [Preview] button, the dialog box display will change, and the print preview will
be displayed in the center. Buttons will be added to the upper part of the dialog box.

[Print] Button
Prints a list of parameters. Clicking here displays the “Print” dialog box. When you click the [Print]
button, printing begins.
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 [Setup] Button
Clicking here displays the “Print Setup” dialog box.
Here you can set the paper size, paper orientation, and font.

[Paper Size]
Select the paper size from the list.

[Orientation]
Set the orientation of the paper by clicking one of the radio buttons.

• [Portrait]
Prints on the paper with it oriented vertically.

• [Landscape]
Prints on the paper with it orientated horizontally.

[Font]
Displays the set font. Clicking the [Font] button displays the “Font” dialog box, where you can
change the font.

[Target]
Set the parameters to be printed by clicking one of the radio buttons.

• [Selected Component]
Prints all parameters for the component selected in the list.

• [Selected DME]
Prints all parameters for the selected DME.

• [All DME]
Prints all parameters for all DMEs.

[Close] Button
Ends the preview and returns the screen to the original dialog box.

[Prev] Button/[Next] Button
Switches the page being previewed when there are multiple pages. The [Prev] button goes to the
previous page. The [Next] button goes to the next page.
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Component Lock
Click [Component Lock] in the [Tools] menu to display the Component Lock dialog.]
NOTE
Does not apply to SP2060 units

Names and Functions

The component/user module names included in the DME will be displayed. AD and Slot will also be
displayed.
When the checkbox to the left of the component name is checked, the component is locked so that it
is not possible to change parameters from a PM5D or other external device controlling the DME unit
via the RS-422 interface. While the component is locked it is still possible to control the internal DME
head amps via the Internal HA Control function. The lock settings will be transferred to the DME when
the unit is placed on-line. The settings can only be changed while off-line.
NOTE
If user module security is enabled the components will not be displayed. Components displayed by the User Module Editor
will be displayed.

NOTE
Only users who's [Edit] box is checked can edit the lock status.

 [Select All] Button
Checks all component checkboxes.

 [Clear All] Button
Clears all component checkboxes.

 [OK] Button
Enters the settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without entering the settings.
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Scene Link Manager
Either click the [Scene Link Manager] item in the [Tools] menu, or the [Scene Link] button the “Scene
Manager” window to open the “Scene Link Manager” window.

“Scene Link Manager” Window
This window allows setup and recall of scene linking between DME groups and SP2060 units. Scene
linking makes it possible to simultaneously recall scenes on multiple DME groups and/or SP2060 units.
Up to 999 scene link setups can be specified.
NOTE
Only users with security status in which [Edit] is checked can edit this feature.

NOTE
This is a DME Designer feature and it does not affect scene recall or store operations carried out from the device panel or
external devices.

Names and Functions

 Scene Link Tree View
Displays the scene link name, DME group and/or SP2060 scene number, and scene name for each
Scene Link setup. Clicking on scene number or scene name opens a list from which a new
selection can be made. Click on the scene link name to edit it.

 [New] Button
Creates a new scene link setup. Enter a name and click the [OK] button to add a new scene link
setup.
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 [Delete] Button
Deletes the scene link setup currently selected in the scene link tree view. When clicked an “Are
you sure?” dialog will appear. Click the [Yes] button to delete the selected scene link setup.
Click the [No] button to abort the scene link delete operation. The [No] button will be grayed out
and inoperable if a scene link setup is not selected.

 [Copy] Button
Copies the selected scene link setup. The [Copy] button will be grayed out and inoperable if a
scene link setup is not selected.

 [Paste] Button
Pastes a cut or copied scene link setup to the currently selected scene link setup in the scene link
tree view. The selected scene link setup will be overwritten. The [Paste] button will be grayed out
and inoperable if no scene link setup has been cut or copied.

 [Cut] Button
Cuts the selected scene link setup. The [Cut] button will be grayed out and inoperable if a scene
link setup is not selected.

 [Insert] Button
Inserts a cut or copied scene link at the currently selected scene link position in the scene link tree
view. The selected scene link setup and all others below it will be moved down one position. The
[Insert] button will be grayed out and inoperable if no scene link setup has been cut or copied.

 [Move UP] Button
Moves the currently selected scene link setup up one position in the scene link view. The [Move
UP] button will be grayed out and inoperable if a scene link setup is not selected.

 [Move Down] Button
Moves the currently selected scene link setup down one position in the scene link view. The [Move
Down] button will be grayed out and inoperable if a scene link setup is not selected.

 [Recall] Button
Recalls the scene number specified for the currently selected scene link setup in the scene link
view to the corresponding devices. The [Recall] button will be grayed out and inoperable if a scene
link setup is not selected.
NOTE
Scenes can only be recalled in real time for DME and SP2060 units in an online device group.

 [Scene Manager] Button
Opens the “Scene Manager” window.

 [Close] Button
Closes the window.
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SP2060 Library Manager
Click the [SP2060 Library Manager] item in the [Tools] menu to open the “SP2060 Library Manager”
window.

“SP2060 Library Manager” Window
Allows editing of SP2060 Speaker Processor component libraries. Up to 60 libraries can be stored for
each component, and up to 360 libraries can be stored for each SP2060 unit
NOTE
Only users with security status in which [Edit] is checked can edit this feature.

 Names and Functions

 Speaker Processor List
Displays a list of the SP2060 units connected to the specified port.

 Library List
Library titles and library file names are displayed in this list. The default titles are the file names
minus the file extension. Click a title to edit it. Titles can be up to 23 characters in length, but the
SP2060 display will only show 16 characters. 2-byte characters can also be used, but they will not
appear on the SP2060 display.

 [Add File] Button
Adds a library file saved by the component editor (.cel extension) to the SP2060 selected in the
SP2060 list. When the [Add File] button is clicked the “Open” window will appear. Select a library
file and click the [Open] button to add the library.
The [Add File] button will be grayed out and inoperable if no SP2060 is selected.
Refer to the “Libraries” section on page 364 for information on component editor libraries.
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 [Delete File] Button
Deletes the selected library from the library list. When this button is clicked an “Are you sure?”
dialog box will open. Click the [YES] button to delete the selected library.
Click the [NO] button to abort the library delete operation.
The [Delete] button will be grayed out and inoperable if a library is not selected.

 [Move UP] Button
Moves the currently selected library up one position in the library list. The [Move UP] button will be
grayed out and inoperable if a library is not selected.

 [Move Down] Button
Moves the currently selected library down one position in the library list. The [Move Down] button
will be grayed out and inoperable if a library is not selected.

 [Duplicate] Button
Copies the library from the SP2060 selected in the SP2060 list to a different SP2060. When the
[Copy] button is clicked the “Duplicate” window will open. Select the destination SP2060 and click
the [OK] button to copy the library. Multiple destination SP2060 units can be selected.
Click the [Cancel] button to abort the library copy operation.
The [Copy] button will be grayed out and inoperable if no SP2060 is selected.

 [Import List] Button
Imports a library file (.llf extension) to the SP2060 selected in the SP2060 list. When the [Import List]
button is clicked the “Open” window will appear. Select a library file and click the [Open] button to
import all libraries included in the library file.
Click the [Cancel] button to abort the import operation.
The [Import List] button will be grayed out and inoperable if no SP2060 is selected.

 [Export List] Button
Exports and saves the library of the SP2060 selected in the SP2060 list as a library file (.llf
extension). When the [Export List] button is clicked the “Save As” window will appear. Select a file
format and click the [Save] button to save the library file. If you select the “Library List File” format
only the paths will be saved, and if you select the “Library List File with data” format the actual
library data will be saved to the file.
Click the [Cancel] button to abort the export operation.
The [Export List] button will be grayed out and inoperable if no SP2060 is selected.

 [Upload List] Button
Sends the SP2060 library to an SP2060 unit. When the [Export List] button is clicked the “Select
Device” window will open. Select an SP2060 and click the [OK] button to send the library. Multiple
destination SP2060 units can be selected.
Click the [Cancel] button to abort the send operation.
NOTE
The library is not sent to the SP2060 unit until the [OK] button is clicked even when the SP2060 unit is online. It can be
sent even when the SP2060 unit is offline.

 [Close] Button
Closes the window.
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Communication Port Setup
Click the [Communication Port] item in the [Setup] menu to open the “Communication Port” dialog
box. In this window you can set the communication port of the master current device to be used by the
DME Designer.
NOTE
Selects either the USB-MIDI Driver or DME-N Network Driver for the communication port. Refer to the “DME Setup Manual”
for driver installation and setup instructions.

NOTE
Only USB x-1 can be selected for a DME Satellite unit connected via USB.

“Communication Port” Dialog Box

[Tx]
Selects the driver communication port to be used for transmission.

[Rx]
Selects the driver communication port to be used for reception.

[Group]
Select the device group to be set up from the list.
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Shortcut Keys
Click [Shortcut Keys] in the [Setup] menu to display the “Shortcut Keys” dialog.

Names and Functions

Click to select the desired shortcut item.

 [Enter New Key]
If assigned, the current shortcut will be displayed.
A shortcut entered via the computer keyboard will be displayed.

 [OK] Button
Enters the settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without entering the settings.
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Security (Creating Users and Making User Settings)
When you click the [Security] command on the [Setup] menu, the “Security” dialog box is displayed.
Here you can create and delete users. You can also set the security level for each user. Users are
saved as DME Designer settings. You don’t need to create users for each file.

Auto-Logon User

 User Setting Restrictions
Various restrictions apply, depending on the security level of the user that is currently logged on.
• The currently logged on user can edit only users at a security level lower than his or her own.
• The currently logged on user cannot raise his or her own security level.

 [Administrator] User
The [Administrator] user is registered by default, and can use all functions. Immediately after DME
Designer is installed, there is no password set for the [Administrator] user.
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 Security Level
User security levels are set with the [Operation Security] item at the right of the “Security” dialog
box.
User Level
High

Level 1 User
Level 2 User
Low
Level 3 User
Level 4 User

Security Level Settings

You can allow or disallow editing and the ability to open windows or set controls.
Ten levels, 1 through 10, are set for scene storage/recall and user controls. Level 1 is the highest
level and 10 is the lowest. By default, level 1 is set for the [Administrator] user. Level 1 can be set
for the [Administrator] only. Users created by the [Administrator] directly below itself can be set at
levels 2 through 10. New users created subordinate to users at level 2 can be set at levels 3
through 10. New users can be created no higher than one level below the user that created them.
Scene sets the level for storing and recalling scenes. The logged on user can store or recall scenes
at levels equal to or lower than his or her own level. For example, a user at level 3 can recall scenes
set for scene recall at levels 3 through 10.
Levels are also set for user control. The logged on user can display or edit user controls at levels
equal to or lower than his or her own level.
The log-on user can use zones that are checked in the [View Zone] field.
Users with security level lower than level 2 form groups with a level-2 user as the leader.
Regardless of user security level, user controls and scenes created by users of a different group
cannot be used or edited.
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Names and Functions
[Enable Auto-Log On]
Enables auto-logon. If this checkbox is selected, the user displayed in the box to the right will be
logged on automatically when DME Designer is started. Auto-logon logs on the user without any
password entry.
Click the [] at the right of the box, and select the user for auto-logon from the displayed user list.
If auto-logon is turned OFF, the “Log On” dialog box will be displayed whenever the DME Designer is
started. Each time a user must be selected and a password entered in order to log on.
If auto-logon is changed from ON to OFF, “Confirmation of Current User” dialog box will be displayed.

Enter the user’s password into the [Password] box, and click the [OK] button.
If you click the [Cancel] button, auto-logon will remain ON.

 Auto-Logon User
Selects the user for auto-logon when [Enable Auto Log On] is checked.

The currently logged on user can set this command for users at a security level equal to or lower
than his or her own. If a user at a higher level is selected, a message that warns “Cannot access
higher user level.” will be displayed. Click the [OK] button.

To set auto-logon for a user at a security level higher than the currently logged on user, first log off
as the current user, then logon as a user at a higher security level.
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User List
The registered users are displayed here. The currently logged on user is displayed in bold text. Click
the name of the user whose settings you want to edit.

1
5

2

3

4

The [Administrator] is the user set by default, and it is used for administering the system. The
[Administrator] user has the highest level and can use all functions.
All new users are created at a level lower that the [Administrator] user, and are displayed below the
[Administrator].
If a user at level 2 and below has other users subordinate to him or her, a [+] or [-] button will be
displayed to the left of higher level user’s name on the list. Clicking the [+] or [-] buttons displays or
hides the users subordinate to that higher user.
The currently logged on user can create multiple users at lower levels.

1 Name
Displays the user names. The currently logged on user is displayed in bold text.

2 [Add User] Button
Adds a user subordinate to the user selected on the list. Clicking here displays the “Add User”
dialog box. Select the user that will be superior to the new user, then click this button.
If a user higher than the currently logged on user is selected, the button will be grayed out and
no user can be added.

3 [Remove User] Button
Deletes the user selected on the list. Only users at levels lower than the currently logged on user
can be deleted.
Furthermore, the currently logged on user cannot delete himself.

4 [Change] Button
Changes settings for the user selected on the list. Opens the “Change User Information” dialog
box. The contents of the dialog box are the same as the “Add User” dialog box.
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5 Operation Security
Sets the functions that can be used by the user selected on the [User List] to the left. Selecting
a checkbox enables use of the corresponding function.

• [Edit]
You can change the following settings: editing in the Designer window, user control edit, user
defined parameter edit, word clock, scene edit, GPI and MIDI.

• [View DME Design Window]
Allows display of the Designer window.

• [Control Component Editor]
Allows parameter editing in the component editor.

• [View Component Editor]
Allows display of the component editor.

• [Change Configuration]
Allows switching between configurations.

• [Synchronization]
Allows synchronizing with the DME or SP2060 unit.

• [View Log Window]
Displays the “Event Logger” window.

• [Scene Store/Recall Level]
Sets the level at which scenes can be stored and recalled. Click the [] and [] buttons or
enter a number into the box to set the level. While levels 1 through 10 are available, the range
of levels that can be actually set varies according to the level of the user doing the setting.
When a user is created, automatically this is set to “One level lower than the user above.” The
initially set level is the highest level that can be set for that user.

• [User Control Level]
Sets the user control level. Click the [] and [] buttons or enter a number into the box to set
a level from 1 through 10. While levels 1 through 10 are available, the range of levels that can
be actually set varies according to the level of the user doing the setting.
When a user is created, automatically this is set to “One level lower than the user above.” The
initially set level is the highest level that can be set for that user.

[OK] Button
Applies any setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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“Add User” Dialog Box/“Change User Information” Dialog
Box
When you click the [Add User] button in the “Security” dialog box, the “Add User” dialog box is
displayed. If you click the [Change] button in the “Security” dialog box, the “Change User Information”
dialog box is displayed.
The “Add User” dialog box is for setting a user name and password when adding a new user. You can
change user settings in the “Change User Information” dialog box. The contents of the dialog boxes
are the same.

“Add User” dialog box

“Change User Information” dialog box

 [Name] Box
Enter the user name. Enter a name different than other existing user names.

 [Password] Box
Enter the password. When you type in the password box, asterisks (*) will be displayed instead of
the characters you enter. If you do not want to set a password the user, leave the box blank.

 [Confirm Password] Box
Enter the password once again to confirm it. When you type in the password box, asterisks (*) will
be displayed instead of the characters you enter. If you do not want to set a password the user,
leave the box blank.

 [OK] Button
In the “Add User” dialog box, this creates new users according to the settings made there. In the
“Change User Information” dialog box, this applies the dialog box settings and changes the user
settings.

 [Cancel] Button
Cancels user creation or setting changes, and closes the dialog box.
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Creating Users
Users are created as follows:

1 Click [Security] on the Main Panel window [Setup] menu.
The “Security” dialog box will be displayed.
You can open the “Security” dialog box by clicking the [Security] button in the Main Panel window.

2 Select a user from the [User List] in the “Security” dialog box.
A user will be created subordinate to the selected user. [Administrator] can be selected only if the
logged on user is the [Administrator]. If there are multiple users, select the user that will be above
the new user.
Multiple users can be created subordinate to a single user.

3 Click the [Add User] button.
The “Add User” dialog box will be displayed.

4 Enter the user name into the [Name] box.
5 Enter the password into the [Password] box.
You can also create users with no password. If you do not want to set a password for the user, leave
the [Password] box blank.
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6 Enter the password into the [Confirm Password] box also.
If you do not want to set a password for the user, leave the [Confirm Password] box blank also.

NOTE
If the text entered into the [Password] and [Confirm Password] boxes is not the same, a “Different password!” message
will be displayed. Click the [OK] button and reenter the correct password in the [Password] and [Confirm Password]
boxes in the “Add User” dialog box.

7 Click the [OK] button.
This closes the “Add User” dialog box. The new user will be added to the “Security” dialog box list.

8 Set the security level for the user, using [Operation Security] in the “Security” dialog box.
When creating a new user, all the checkboxes in [Operation Security] will be turned OFF. Click and
turn ON the functions you want to permit the new user to use. [Scene Store/Recall Level] and [User
Control Level] will be set to one level lower than the user above the newly created user. The initially
set level will automatically be the highest level that can be set for that user. To lower the level, enter
a larger number in the box.
Click the [OK] button and the dialog will close. You can continue creating new users without
closing the dialog box.
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Network Setup
Click the [Network Setup] item in the [Hardware] menu to open the “Network Setup” window.
This window can be used to set the IP address and device group master/slave status of DME and
SP2060 units.
NOTE
These settings can be edited regardless of the current settings of the DME and SP2060 units. The DME Utility screen
Lock page and SP2060 Utility screen User Lock settings only apply to the device panels.

NOTE
DME64N/24N and SP2060 slave devices will not be displayed.

NOTE
The settings cannot be changed for devices in a device group that is online.

“Network Setup” Window
Names and Functions

 Communication Port List (Tx/Rx)
Selects the communication port for the device to be set up.

 Master/Slave
Displays and sets whether the DME or SP2060 unit connected to the port specified by the
“Communication Port” dialog box is the device group master or slave.
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 IP Address
Displays and sets the IP address of the DME or SP2060 unit connected to the port specified by the
“Communication Port” dialog box.
NOTE
If the IP address of the DME device is changed after the device has been synchronized with DME Designer, it will be
necessary to re-transfer the configuration data. The “Full Resync” operation forces a re-transfer of all configuration data,
and can be initiated by clicking the [Go On-line] button while holding down the [Ctrl] key.

NOTE
If the device group master IP address is changed and you are using the DME-N Network Driver, quit the DME Designer
and then restart it after changing the DME-N Network Driver settings.

NOTE
The subnet mask is fixed at “255.255.255.0”.

NOTE
Always use a local address (192.168.0.2. through 192.168.255.253) unless it is absolutely necessary to use a global
address. Consult with the network administrator if it is necessary to use a global address.

 Master ID
If the DME or SP2060 unit connected to the port specified by the “Communication Port” dialog box
is a slave device, the fourth octet of the of the device group master IP address is displayed and
can be edited here. This parameter is display only if the device is the device group master.
NOTE
Be sure to set the DME and SP2060 to a different device group.

 Link Mode
Displays and sets the link mode of the DME or SP2060 unit connected to the port specified by the
“Communication Port” dialog box.

 MAC Address
Displays the MAC address of the DME or SP2060 unit connected to the port specified by the
“Communication Port” dialog box.

166

DME Designer Owner’s Manual

Chapter 3 Main Panel Window

Utility
Click the [Utility] item of the [Hardware] menu to open the “Utility” window.

“Utility” Window
This window provides a variety of utility settings for DME and SP2060 units. These settings can be
made when the target unit is not only online but also offline. A password will be required to open this
window if the DME64N/24N Utility screen is locked.
NOTE
Only users with security status in which [Edit] is checked can edit Utility parameters.

Names and Functions

 Device Select Field (Device/Type Field)
Select the DME or SP2060 to be displayed or edited from the list.

 [Close] Button
Closes the window.
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 Info Tab

Displays basic information for the selected DME or SP2060 unit.

Version
Displays the firmware version number of DME or SP2060 unit.

Battery
Displays the battery status of DME or SP2060 unit.

Date/Time
Displays the date and time of the DME internal clock.

Daylight Saving Time
Displays the daylight saving time settings.

[Clock setup] Button
Opens the “Clock” dialog box to set the DME internal clock.
 See “Clock” on page 180.
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 Network Tab

Displays DME and SP2060 network information.

Master/Slave
Displays the device group master and slave.

Link Mode
Displays whether the network connection is via 10Base-T or 100Base-TX.

MAC Address
Displays the MAC address.

 Display Tab

Displays and allows editing of the DME64N/24N panel display.

LCD Contrast
Displays and sets the display contrast. The parameter range is 0 … 100%.

LCD Backlight
Displays and sets the display backlight status. The settings are “ON” or “OFF”.
ON: The display backlight is continuously on.
OFF: The display will light when a panel control is operated, but will go out 10 seconds after panel
operation stops.

Meter Fall Time
Displays and sets the meter fall time. The settings are “Slow” and “Fast”.
Slow: Slow meter fall time.
Fast: Fast meter fall time.
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 Lock Tab

Displays and allows editing of the DME64N/24N and SP2060 panel lock parameters.
Only the User Lock parameter is displayed and can be edited for SP2060 units. All other
parameters are displayed and can be edited for DME64N/24N units.

Utility
Displays and sets the Utility screen lock status. The settings are “Unlock” and “Lock”.
Unlock: The Utility screen can be opened without a password.
Lock: An 8-character password is required to open the Utility screen.
NOTE
The password is also required to switch from “Unlock” to “Lock” status.

Panel Lock Boot
Displays and determines whether the panel lock will be automatically engaged when the unit is
turned on. The settings are “Unlock” and “Lock”.
Unlock: The panel will not be locked when power to the unit is turned on.
Lock: The panel will be locked when power to the unit is turned on.

Panel Lock Target
Displays and sets the panel lock target. The settings are “Key Only” and “Key+GPI”.
Key Only: Only input via the panel controls will be locked.
Key+GPI: Input via the panel controls and GPI inputs will be locked.

User Defined Page Lock
Displays and sets the User Defined Button lock status for each page. The settings are “Unlock”
and “Lock”.
Unlock: The corresponding User Defined Button page will be displayed.
Lock: The corresponding User Defined Button page will not be displayed.

User Lock
Displays and sets the panel lock status. The settings are “Unlock” and “Lock”.
Unlock: Panel not locked.
Lock: Panel locked.
The following operations cannot be performed when the panel is locked:
• Parameter changes.
• Scene recall/store.
• Scene title editing.
• Scene protect changes.
• Library recall.
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 Misc Tab

Displays and sets parameters not provided in the other tabs.

Scene Store
Displays and sets whether scene store operations can be performed on a DME64N/24N unit. The
settings are “Enable” and “Disable”.
Enable: Scene store possible.
Disable: Scene store not possible.

Last Mem. Resume
Determines whether the scene number that was selected when the power was last turned off will
be recalled when the power is turned on, or whether the overall status of the unit when the power
was last turned off will be recalled when the power is turned on. The settings are “ON” and “OFF”.
ON: The status of the unit when the power was last turned off will be recalled.
OFF: The scene number that was selected when the unit was last turned off will be recalled.

Event Scheduler
Displays and sets whether the DME unit's Event Scheduler function is active or not. The settings
are “ON” and “OFF”.
ON: The Event Scheduler is active.
OFF: The Event Scheduler is not active.
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 Remote Tab

NOTE
The SP2060 and ICP1 are not supported.

DME Remote Control
Displays/sets the connector and connection type to be used for DME remote control protocol*
communication. If the selected terminal was previously assigned to a different function, a
confirmation message will appear. The available ports depend on the device.
DME64N/DME24N: OFF, Remote (RS-232C), Remote (RS-422), Network
DME Satellite: OFF, Remote, Network
OFF: Select “OFF” when this function is not to be used.
Remote (RS-232C): External controllers (AMX, Crestron, etc.) control the DME64N/24N via the
[REMOTE] connector using an RS-232C connection.
Remote (RS-422): External controllers (AMX, Crestron, etc.) control the DME64N/24N via the
[REMOTE] connector using an RS-422 connection.
Network: This setting allows the DME to be controlled via the [NETWORK] terminal. When
“Network” is selected it is also possible to select the port number to be used. The Ethernet port
to be used for remote control will be displayed in the “IP Port No.” field. Change the port as
necessary via the “Select IP Port No.” dialog box that appears when the [Select IP Port No.]
button is clicked.
Since the DME network connection will automatically be broken when the port is changed, DME
Designer will have to be re-launched.
Remote: External controllers (AMX, Crestron, etc.) control the DME Satellite via the [REMOTE]
connector connection.
NOTE
Switch the [REMOTE] terminal setting (RS-232C, RS-422) via the DIP switch on the rear panel of the DME Satellite.
* Refer to “DME Remote Control Protocol Specifications” Yamaha Pro Audio website:
(http://www.yamahaproaudio.com/)
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Internal HA Control
Displays/sets the connector to be used for internal head amp control. From a single digital mixer,
you can control the internal head amps of multiple DME series units within the device group. Set
this parameter only on the DME series units that is connected directly to the digital mixer, and turn
in “OFF” for other units. If the selected terminal was previously assigned to a different function, a
confirmation dialog will appear.
The available ports depend on the device.
DME64N: OFF, Remote (RS-422), Slot 1 through 4
DME24N: OFF, Remote (RS-422), Slot1
DME8i-C/DME8o-C/DME4io-C: OFF, Remote, CobraNet
DME8i-ES/DME8o-ES/DME4io-ES: OFF, Remote, EtherSound
OFF: Select “OFF” when this function is not to be used.
Remote (RS-422): Allows a digital mixer to control the DME64N/24N’s internal head amps via
the [REMOTE] connector using an RS-422 connection.
Slot1–Slot4: Allows a digital mixer to control the internal head amps via the specified expansion
slot.
Remote: Allows a digital mixer to control the DME Satellite’s internal head amps via the
[REMOTE] connector connection.
CobraNet: Allows a digital mixer to control the DME8i-C/DME8o-C/DME4io-C’s internal head
amps via the [CobraNet] connector connection.
EtherSound: Allows a digital mixer to control the DME8i-ES/DME8o-ES/DME4io-ES’s internal
head amps via the [EtherSound] connector connection.
NOTE
An ID must be assigned to the DME unit to be controlled. Refer to “Setting the Internal Head Amp ID ” (page 146) for
details on assigning device IDs.

NOTE
Change to RS422 via the rear-panel DIP switches to select “Remote” for a DME Satellite unit.

External HA Control
Displays/sets the type of connection to be used for external head amp control. If the selected
terminal was previously assigned to a different function, a confirmation dialog will appear.
The available ports depend on the device.
DME64N/DME24N: OFF, Remote (RS-422)
DME Satellite: OFF, Remote
OFF: Select “OFF” when this function is not to be used.
Remote: Allows connection to and control of an external head amp such as the AD8HR.
Always use this setting when a remote head amp unit (AD8HR, AD824) is connected.
NOTE
Change to RS422 via the rear-panel DIP switches to select “Remote” for a DME Satellite unit.

COM
Displays/sets the type of connection to be used for DME protocol communication. This is a Yamaha
maintenance function. Normally, set this to “OFF
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 MIDI Tab

Port
Selects the MIDI port to be used. If the selected terminal was previously assigned to a different
function, a confirmation dialog will appear. The available ports depend on the device.
DME64N: OFF, Remote(RS-232C), Remote(RS-422), MIDI, USB-1–2, Slot1–4
DME24N: OFF, Remote(RS-232C) , Remote(RS-422), MIDI, USB-1–2, Slot1
DME Satellite: OFF, Remote, USB-2
OFF: Select “OFF” when this function is not to be used.
Remote(232C): MIDI data will be received via the DME64N/24’s [REMOTE] connector using an
RS-232C connection.
Remote(422): MIDI data will be received via the DME64N/24’s [REMOTE] connector using an
RS-422 connection.
MIDI: The MIDI connector is the currently active MIDI port.
USB-1, USB-2: The corresponding USB port is selected for MIDI input.
Slot1–Slot4: A card installed in the corresponding I/O slot is currently selected for MIDI input.
Remote: The [REMOTE] connector of the DME Satellite is currently active MIDI port.
NOTE
When “Remote” is selected for a DME Satellite unit, be sure to change the [REMOTE] connector setting (RS-232C or
RS422) via the rear-panel DIP switches.
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Protocol
Displays/sets the protocol to be used for communication with devices connected via MIDI. The
available settings are: MIDI, DAW (Type1), and DAW (Type2).
MIDI: Use this setting when any MIDI device other than a general-purpose ProTools controller
(HUI protocol) or general-purpose Logic or Cubase controller (Mackie control protocol) is to be
connected.
DAW (Type1): Use this setting when a general purpose ProTools controller (HUI protocol) is to
be connected.
DAW (Type2): Use this setting when a general purpose Logic or Cubase controller (Mackie
control protocol) is to be connected.
NOTE
If the Protocol setting is changed while online, the DAW Type specified in the DAW Control dialog box will also change
accordingly.

NOTE
The following parameters are available when the Protocol parameter is set to MIDI.

MIDI CH
Sets the MIDI channel. This number is also used as the Parameter Change Device ID.

• [Tx]
Select the MIDI transmit channel from the list.

• [Rx]
Select the MIDI receive channel from the list.

Program Change/Control Change/Parameter Change
Sets transmit (Tx), receive (Rx), OMNI, and Echo for program change/control change/parameter
change. When ON, clicking turns this OFF. When OFF, clicking turns this ON. When OMNI is [ON]
channel messages are received regardless of the receive channel setting. When ECHO is [ON] the
input data is “echoed” (re-transmitted) via the output port that corresponds to the input port via
which it was received.
Program change, control change, and parameter change details can be set up via the “MIDI”
window [Program Change], [Control Change], and [Parameter Change] tabs, respectively.

DME Designer Owner’s Manual

175

Chapter 3 Main Panel Window

 GPI Tab

Calibrates the input voltage detection range for a DME unit GPI terminal.

[ALL] Checkbox
Automatically checks all channel checkboxes.

[Ch] Checkbox
These checkboxes specify the channels to be calibrated.

Calibration Information
Displays the input voltage in real time.

[Reset] Button
Resets the calibration of checked channels.

[Max] Button
Sets the current input voltage as the maximum input voltage for checked channels.
The specified maximum voltage is indicated by a red bar.

[Min] Button
Sets the current input voltage as the minimum input voltage for checked channels.
The specified minimum voltage is indicated by a blue bar.
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Word Clock
The signal that synchronizes all devices connected to the DME or SP2060 is called the “Word Clock.”
It uses the same frequency as the sampling frequency. The word clock is set for each DME or SP2060
in the “Word Clock” dialog box.
When you click [Word Clock] on the [Hardware] menu, the “Work Clock” dialog box is displayed.

Names and Functions

$MPDL*OGPSNBUJPO

4MPU*OGPSNBUJPO

$MPDL4UBUVT

r5IFOVNCFSPGDIBOOFMTWBSJFTBDDPSEJOHUPUIFDBSEJOTFSUFEJOUPUIFTMPU

 DME
From the list, select the DME or SP2060 where you will be making settings.

 Clock Information
Displays the word clock frequency for the DME or SP2060 selected in [DME].
The frequency of the operational word clock is displayed when the device is online.
When offline, the frequency information used at the time of compilation is displayed regardless of
the frequency of the device’s word clock. Click the [V] button to the right of the frequency display to
select the frequency of the operational word clock.
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 Card (Slot Information)
Displays the name of the card inserted into the slot.
Slot Number
Card Name

 Clock Status
The clock status is displayed using a color code:
Status

Meaning
Indicates that there is no input signal.
Indicates there is an input signal and sync is possible with the current word
clock.
Indicates there is an input signal but cannot sync with word clock (clocks are
different).
Indicates that there is no DME or SP2060 unit information.

 Internal/Word Clock/Cascade
You can select one of the following for the word clock:
Device Name

Slot

Internal

Word Clock

Cascade

Digital

DME64N

1~4

44.1kHz/48kHz/88.2kHz/96kHz

WC IN

IN/OUT

—

DME24N

1

44.1kHz/48kHz/88.2kHz/96kHz

WC IN

—

—

DME Satellite

—

CobraNet/EtherSound: 48kHz/96kHz

—

—

—

SP2060

—

96kHz

—

—

IN(*)

* This settings can only be made when the target unit is offline and the DIGITAL IN is selected as the input signal to the
SP2060 unit.

Clock buttons that are grayed out cannot be selected.

 [Close] Button
Closes the dialog box.
NOTE
You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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Monitor Out
When you click the [Monitor Out] command on the [Hardware] menu, the “Monitor” dialog box is
displayed. Sets the monitor output destination for monitoring point or probe monitor.
NOTE
Monitor Out can be set on DME64N/24N units only.

 [DME]
From the list, select the DME64N/24N where you will be making settings.

 Drop down list
From the list, select the monitor output port. You can select from the ports that are not connected in
the configuration window.

 [OK] Button
Accepts the changed settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing the settings.
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Clock
When you click the [Clock] command on the [Hardware] menu, the “Clock” dialog box is displayed
after the “Utility” window has been displayed once. Here you can set the DME internal clock. This can
be set only when online. The default is the computer date and time. The daylight saving time can also
be set.
NOTE
Does not apply to SP2060 units

 [Date/Time]
Sets the date via the left button and the time via the right button. Change the values via the up and
down arrow buttons at the right edge of the box.
NOTE
The date and time display format can be changed via the Windows control panel “Regional and Language Options” item.
This will also change the display format for the “Utility”, “Event Logger”, “Event Scheduler” and other dialog boxes.

 [Enable Daylight Saving Time]
When this checkbox is checked daylight saving time display is enabled. The [DST] indicator will also
appear in the Date field of the DME64N/24N display.

[Offset]
Sets the time offset for the daylight saving time period.

[Start Time]
Sets the time at which daylight saving time will start.

[End Time]
Sets the time at which daylight saving time will end. If the end time is the same as the start time,
check [Same as Start Time].
NOTE
Time settings may not register properly if the current time or daylight savings end time is set to within 2 hours of the
daylight savings start time, or if the current time or daylight savings start time is set to within 2 hours of the daylight
savings end time. Also, events set within 2 hours of the daylight savings start or end times may not be executed properly.
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[Day of the Week]
When checked the daylight saving time period can be specified by the day of the week. [Start] sets
the start day, and [End] sets the end day as the nth Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday, or Sunday of the month. For example, the first Sunday of April is specified as
[First] [Sunday] [April], and the last Sunday of October is specified as [Last] [Sunday] [October].

[Day]
Specifies the daylight saving time period by day. The [Start] and [End] day are specified as the day
of the month.

 [OK] Button
Applies any setting changes and closes the window.

 [Cancel] Button
Closes the window without changing any settings.
NOTE
You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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Language Settings
When you click the [Language] command on the [Hardware] menu, the “Language” dialog box is
displayed. This sets the language of scene names, User Defined parameter names, and labels that
will be shown on the DME64N/24N unit display. This setting also applies to the names of files saved
using the DME File Storage function.
NOTE
This setting does not apply to the SP2060. As for the DME Satellite, this setting only applies to the names of files saved using
the DME File Storage function.

Names and Functions

 [Language]
Select the language. [English/German/French/Spanish] and [Japanese] are in the list.

 [OK] Button
Accepts the changed settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing the settings.
NOTE
You can close the dialog box using the Close button, or by pressing <Esc> or <Alt>+<F4>.
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Backup
When you click the [Backup] command on the [Hardware] menu, the “Backup” dialog box is
displayed. Data in the DME or SP2060 is gathered in the computer and saved as a file. Backup files
are created for each DME or SP2060. You can also send the information saved in a file to a DME or
SP2060. Backup can be performed only when in offline status.
NOTE
If a backup file from a DME unit running firmware version V3.8 or later is loaded into a DME unit running a firmware version
earlier than V3.5, the Remote and MIDI control settings will not apply (all other settings will apply).

NOTE
Backup operations can be performed only by users for whom the [Edit] security checkbox has been checked.

NOTE
The event log can be retrieved from the DME unit in the “Event Logger” window.

 [Target DME]
The DME and SP2060 IP addresses and types are displayed for each device group. Check the
DME and/or SP2060 units from which data is to be obtained. Multiple DME and SP2060 units can
be checked.

 [Folder] Box
Specifies the folder that will be the destination for saving and reading operations. Clicking the
[Browse] button opens the folder select dialog box, where you can specify a folder.
The backup file name will be the DME’s IP address. If the folder is specified when sending DME
data, the file sent to the DME will be the file in the folder whose file name that matches the DME’s IP
address.

 [Load] Button
Sends the backed up file to the specified DME or SP2060.

 [Save] Button
Obtains data from the specified DME or SP2060, and saves it as a backup file.

 [Close] Button
Closes the dialog box.
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SP2060 Backup
Click [SP2060 Backup] in the [Hardware] menu to open the “SP2060 Backup” dialog box. Internal
SP2060 data can be transferred to a computer for backup, and the backup data can be used to
restore multiple SP2060 units. This makes it possible to set up a single SP2060 unit, and then
distribute the settings to a group of SP2060 units.
Backup can also be carried out using the “Backup” dialog box, but the “SP2060 Backup” dialog box
has the following differences:
• “SP2060 Backup” can only be used for SP2060 backup.
• Data from only one SP2060 can be backed up at a time, but that data can be used to
simultaneously restore multiple SP2060 units.
• Network settings are not affected when the data is restored.
NOTE
• Backup files cannot be edited using DME Designer.
• Backup/restore can only be carried out while offline.
• Only users for whom [Edit] security is checked (enabled) can perform backup and restore operations.
• If backup data is restored to an SP2060 unit running a firmware version prior to V1.3, the network settings will be changed.

 [Backup] Tab

Target
Displays the label and IP address of connected SP2060 units that are offline. One SP2060 unit can
be selected for backup.

[Designer <- SP2060] Button
The data is acquired from the specified SP2060 unit and saved as an SP2060 backup file (file
extension “.spb”).
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 [Restore] Tab

Target
Displays the label and IP address of connected SP2060 units that are offline. Check the SP2060
units to which the data is to be restored. Multiple SP2060 units can be selected.

[Designer -> SP2060] Button
Transmits and restores the SP2060 backup file (file extension “.spb”) to the specified SP2060 unit.
Backup files with the “.dbk” file extension stored in the “Backup” dialog box cannot be selected.
When the restore operation is finished the SP2060 unit will automatically restart. At this time please
also manually restart DME Designer.
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DME Firmware Update
You can update the DME or SP2060 unit, ICP1 firmware using the [Firmware Update] command on the
[Hardware] menu. When you move the mouse cursor over the [Firmware Update] command on the
[Hardware] menu, a submenu is displayed.

When you select [Program+Component] or [Recovery Update] on the submenu, the folder select
dialog box will be displayed.
When performing a firmware update, connect the DME or SP2060 unit, ICP1 and the computer.
When the DME or SP2060 unit, ICP1 update is finished, the DME or SP2060 unit, ICP1 will be
automatically restarted. You also need to restart DME Designer.
NOTE
When performing the DME or SP2060 unit firmware update, connect the DME or SP2060 unit and the computer by USB or
Ethernet. The USB-MIDI or DME-N Network Driver must be installed in the computer.

NOTE
To perform the ICP1 firmware update, the ICP1 and the device group master DME unit must be connected by Ethernet. In
addition, the device group master DME unit must be connected to the computer as described above.

NOTE
If the DME64N/24N has been updated from V1.07 or earlier to V1.10 or later, perform the update twice. Because the text
display data in the DME64N/24N unit is changed, text display for Japanese is not possible with one update only.

NOTE
It may be impossible to complete the firmware update, and “Error” may occur in the Status field if the [Remaining Memory]
value (the amount of remaining DME memory) (page 111) becomes too small. If this occurs, delete unwanted data such as
DME File Storage files, Library data, and scene data to increase the amount of available memory.

NOTE
You can download the latest firmware from the following Yamaha Pro Audio website.
http://www.yamahaproaudio.com/
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 [Program+Component]
Updates the DME/SP2060/ICP1 unit firmware.
NOTE
DME Designer cannot be used to upgrade firmware version 3.5 or earlier to version 3.8 or later, or to downgrade from
version 3.8 or later to version 3.5 or earlier (this does not apply to the SP2060 or ICP1). Contact your Yamaha dealer.

1 Select [Firmware Update]  [Program+Component] in the [Hardware] menu.
The folder select dialog box will be displayed.

2 Select the folder that contains the update file, then click the [OK] button.
The “Firmware Update” window will open. The names, firmware version numbers and IP
addresses of DME, SP2060 and ICP1 units in the current device group will be displayed in a list.
NOTE
All connected DME units are displayed in the Device field.

3 Check the DME, SP2060, or ICP1 unit you wish to update.
Clicking the checkboxes alternately turns the check mark on and off. The [Select All] button can
be used to check all DME, SP2060, and ICP1 units. The [Clear All] button removes the check
marks from all DME, SP2060, and ICP1 units.

4 When the DME, SP2060, and ICP1 units to be restored have been checked, click the
[Update] button.
The firmware update will begin.
When the restore update is complete the DME, SP2060, and ICP1 units will restart automatically.
It is also necessary to restart the DME designer.
NOTE
If a cable is disconnected or the power is interrupted during a firmware update operation, it may not be possible to
restart the unit after the update has finished and the conditions listed below may occur. If this happens it will be
necessary to carry out the Recovery Update procedure described below.
• “Recovery Update” appears on the DME64N/24N and/or ICP1 display.
• The DME Satellite “ERROR” indicator lights and the channel 2 PEAK indicator flashes.
• “Download Mode” appears on the SP2060 display.
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 [Recovery Update]
Recovers (restores) the DME, SP2060, or ICP1 firmware. If a cable is unplugged or the power is cut
off during a firmware update, the firmware may be corrupted and unable to launch. In such cases
the Recovery Update function can restore the firmware.

1 Disconnect the device which is to undergo the Recovery Update procedure from the
network, and connect it directly to the computer. Restart the firmware.

2 Launch DME Designer and make the necessary communication port settings.
(Page 155)

3 Select [Firmware Update]  [Recovery Update] from the “Hardware” menu.
The folder select dialog box will be displayed.

4 Select the folder that contains the update file, then click the [OK] button.
The “Firmware Update” window will open.
NOTE
All connected DME units are displayed in the Device field.

5 Check the DME, SP2060, or ICP1 unit to be restored.
Clicking the checkboxes alternately turns the check mark on and off. The [Select All] button can
be used to check all DME, SP2060, and ICP1 units. The [Clear All] button removes the check
marks from all DME, SP2060, and ICP1 units.

6

When the DME, SP2060, and ICP1 units to be restored have been checked, click the
[Update] button.
The firmware restore process will begin.
NOTE
During the restore process do not disconnect any USB or Ethernet cables, or turn the DME, SP2060, or ICP1 power
off. Doing so can result is loss of the DME Designer communication port settings.

When the restore update is complete the DME, SP2060, and ICP1 units will restart automatically.
It is also necessary to restart the DME designer.

7 Update the firmware in the normal way.
Select [Firmware Update]  [Program + Component] from the “Hardware” menu. (Page 187)
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 [MY4-AEC]
Update the firmware on an MY4-AEC Acoustic Echo Canceller card installed in a DME unit.

1 Select [Firmware Update]  [MY4-AEC] from the “Hardware” menu.
The “MY4-AEC Firmware Update” dialog box will appear.
NOTE
All connected DME units and MY4-AEC cards will appear in the “Device” column.

NOTE
The current MY4-AEC firmware version number is also displayed in this dialog box.

2 Check the checkbox for the DME unit in which the MY4-AEC card to be updated is
installed.
Clicking the checkbox alternately checks and un-checks it. Click the [Select All] button if you
want to select all connected DME units. Click the [Clear All] button to un-check all connected
DME units.

3 Click the [Update] button.
The folder selection dialog box will appear.

4 Select the folder that contains the update file and click [OK].
The MY4-AEC update process will begin. The DME unit will automatically restart twice during
the update process. The update process finishes when the second restart has completed.
When the update process has finished it will be necessary to restart DME Designer.
NOTE
Be carefully not to disconnect any USB or Ethernet cables, or interrupt the power supply during the update process.
Doing so can damage the MY4-AEC card and/or cause the DME Designer communication port settings to be lost.

NOTE
After the update check the firmware version number in the “MY4-AEC Firmware Update” dialog box to be sure that
the update has been successful.

NOTE
If insufficient [Remaining Memory] is available (the amount of memory available in the DME unit – page 111), it may
not be possible to complete the update process and an error message may appear in the Status field.
If this occurs you will need to delete unnecessary files (files stored using the DME File Storage function , libraries,
scenes) to make more memory available.
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Device Information
Click [Device Information] in the [Hardware] menu to open the “Device Information” dialog box.
The status of DME and SP2060 units connected to the network will be displayed as a list, even if they
are offline or a configuration has not yet been created. This capability allows centralized DME
management for effective troubleshooting and system maintenance.

 [Reboot]
If this checkbox is checked the [Reboot] button can be clicked to simultaneously reboot multiple
DME and SP2060 units.

 [Port]
Displays the name of the connected input/output port.

 [Group]
Displays the name of the device group when online.

 [Network Status]
Displays the online/offline status as an icon.

 [Device Label]
Displays the name assigned to the DME or SP2060 unit.

 [Type]
Displays the device type (DME64N, etc.).

 [Ver.]
Displays the firmware version number.

 [C/ES Ver.]
Displays the version number of CobraNet or EtherSound interface for DME Satellite units.

 [Master/Slave]
Displays the device group master/slave setting.

 [IP Address]
Displays the IP address.
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 [MAC Address]
Displays the MAC address.

 [Message]
Displays messages being displayed on the DME unit display panel. On the most recent message
is displayed.

 [Tree View] Checkbox
When checked slaves are displayed below the master in tree form. When unchecked the devices
are displayed as a list.

 [Utility] Button
Opens the “Utility” dialog box for the currently selected device in the list.

 [Event Log] Button
Opens the “Event Logger” dialog box for the currently selected device in the list.

 [Save] Button
Saves the information being displayed as a CSV file (comma-delimited text file).

 [Close] Button
Closes the dialog box.
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Editing Configurations
Configurations
Information about inputs/outputs, along with the arrangement of components and how they are
connected, is called a “configuration.” Configurations are created in the Designer window and sent
to the DME unit.
In the Designer window, configurations are designed using various design windows, such as the Area,
Zone, Configuration, and User Module windows. In each window a sheet is displayed, on which
objects can be arranged.

New Configurations
Multiple zones can be created for an area, multiple device groups can be created for a zone, and
multiple configurations can be created for a device group.
Zones can be added via the “Zone Manager” window, device groups can be added via the “Device
Group and Sampling Frequency Settings” window, and configurations can be added via the
“Configuration manager” window. Information about the “Zone Manager” window can be found in the
“Adding, Deleting, and Renaming a Zone” section on page 291, information on the “Device Group and
Sampling Frequency Settings” window can be found in the “Device Group Selection” section on
page 276, and information on the “Configuration Manager” window can be found in the “Adding,
Deleting, and Renaming a Configuration” section on page 295.

Security
Editing in the Designer window can be restricted based on the user security settings. Only users for
whom the [Operation Security]  [Edit] checkbox in the “Security” dialog box has been checked can
display the Designer window and edit configurations.
For information about the “Security” dialog box, see “Security (Creating Users and Making User
Settings)” on page 82.

Edit Mode
There is an “Edit Mode” in the Designer window when offline status. When the Edit Mode is ON,
configurations can be edited. When it is turned OFF, configurations cannot be edited. When online, the
Edit Mode is OFF.
NOTE
SP2060 configurations cannot be edited.
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 Edit Mode ON/OFF
The edit mode can be turned on or off via the [Edit Mode] command in either the [Tools] menu or
the contextual menu that appears when you right-click on the worksheet. You can also use the [Edit
Mode] button in the menu bar. To turn Edit Mode ON click the command, placing a checkmark to
the left of the command name. When there is a checkmark next to the command (when Edit Mode
is ON), clicking the command again removes the checkmark and turns OFF the Edit Mode.

Edit Mode=ON
When Edit Mode is ON, you can do configuration editing tasks such as arranging objects, making
connections, and changing properties.

Edit Mode=OFF
When Edit Mode is OFF, you can control the component editor, but cannot edit configurations.
When offline, Edit Mode is OFF.
NOTE
Only users for whom the [Operation Security]  [Edit] checkbox in the “Security” dialog box has been checked can turn
the Edit Mode ON.

Designer Window
You can display or hide the Designer window using the [Designer] command on the [View] menu in
the Main Panel window.
Navigator Window
Title Bar
Menu Bar
Toolbar

Toolkit Window

Design Window

Resource Meter
Window

Title Bar
“Designer” is displayed on the title bar. You can move the window by dragging the title bar. There are
[Minimize], [Maximize]/[Restore], and [Close] buttons at the right edge of the title bar.

Menu Bar
Commands that can be executed in the application are collected into categories on the menu bar.
When you click one of the categories, a list of commands is displayed.
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Toolbar
Frequently used commands are arranged here as buttons.
[Redo] Button
[Print] Button

[Navigator] Button

[Copy] Button

[Undo] Button

[Paste] Button

[Cut] Button

[Probe Monitor] Button

[Analyze] Button

[Show Signal Delay] Button

[Resource Meter] Button

[Arrow] Button

[Zoom In] Button

[Show Unconnected Node] Button
[Zoom To] Button

[Actual Size] Button

[Zoom Out] Button

[Hand] Button [Edit Mode] Button

 [Print] Button (page 203)
Prints the active design window.

 [Undo] Button (page 204)
Undoes the most recent edit operation.

 [Redo] Button (page 204)
Restores operations undone with the [Undo] button back to their original condition.

 [Cut] Button (page 204)
Cuts the selected object from the screen and moves it to the clipboard.

 [Copy] Button (page 204)
Copies the selected object to the clipboard.

 [Paste] Button (page 204)
Pastes data from the clipboard.

 [Navigator] Button (page 197)
Displays or hides the Navigator window.

 [Resource Meter] Button (page 196)
Displays or hides the Resource Meter window.

 [Analyze] Button (page 208)
Displays the “Analyze” dialog box, and analyzes the configuration.

 [Show Signal Delay] Button
The digital signal delay value is displayed in the Configuration window.
 “Show Signal Delay (Delay Display Value)” in “Configuration Window” (page 305)

 [Probe Monitor] Button
Turns the probe monitor ON or OFF.
 “Probe Monitor” in “Configuration Window” (page 303)
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 [Zoom Out]/[Zoom In]/[Actual Size]/[Zoom To] Buttons
These buttons correspond to the commands on the [View] menu with the same names. Changes
the magnification of the display on the screen.
 “[View] Menu” in “Designer Window Menus” (page 205)

 [Arrow] Button
The mouse cursor appears as crosshairs, and can be used to select objects.

 [Hand] Button
The mouse cursor appears as a hand shape, and can be used to click and “grab” the worksheet
for scrolling.

 [Show Unconnected Node] Button
Displays unconnected nodes.
 “Show Unconnected Node”(page 290)

 [Edit Mode] Button
Turns the edit mode ON or OFF.
 “Edit Mode” (page 195) in the “Configuration Editing” section.

Status Bar

DME ID/Component ID

Sampling Frequency

Sheet Size

Coordinates

 DME ID/Component ID
When the mouse pointer is moved over a DME device in the Zone window, the ID for that DME
device is displayed. When the mouse pointer is moved over a component in the Configuration
window, the ID for the component is displayed.

 Sampling Frequency
Displays the sampling frequency in the configuration window.

 Sheet size
Displays the size of the sheet in the active design window.

 Coordinates
Displays the coordinates of the mouse pointer any time it is within the design window. When
dragging an object, the coordinates displayed here refer to the upper left corner of the object
being dragged.
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Resource Meter Window
The Resource Meter can be displayed or hidden via the [Navigator] command in the [View] menu.
The Resource Meter window is displayed only when the Configuration window and User Module
window are active. Meters for the DSP memory usage percentage and the SPX resource usage
percentage are in the Resource Meter window. The sampling frequency of each DME unit is also
displayed.
NOTE
Not displayed in the SP2060 configuration window.

 DSP Memory Usage Percentage
When you are designing in the Configuration window, it gives you a yardstick for judging the total
usage percentage for DSP memory in the DME unit. In addition, the usage percentage varies
depending on the sampling frequency, even for the same component.
When the configuration is synchronized with the DME unit during online status, checks of
connections and component information begin automatically (this is called compiling). The actual
total usage percentage is calculated after this compiling operation. The usage percentage will vary
according to the number of connections and components. The Resource Meter window gives you
a precompile guideline for use while designing your configuration. An error may occur even when
the meter shows less than 100 percent, based on conditions such as the number of connections,
and type and number of components used. We recommend using the “Analyze” dialog box
(page 308) to check whether compilation will be successful before actually performing the
compilation.
NOTE
If a configuration is compiled at fs=44.1kHz or 48kHz, and the sampling frequency is then changed to 88.2kHz or 96kHz, it is
necessary to recompile at 88.2kHz or 96kHz. If this is not done some configurations may produce no sound. In such cases a
“DSP Power Shortage” message will be displayed on the DME unit.

 SPX Resource Usage Ratio
Displays the resource usage ratio for SPX components and Feedback Suppressor components
arranged in the configuration.

NOTE
The components that can be placed in the configuration window vary according to the device type. For details, see
“Component List” on page 372.

NOTE
If the [Matrix Mixer 64 input 64 output] or the [Matrix Mixer 64 input 32 output] components are placed in the DME64N
configuration window, you will not be able to use other components, even though the window does not reach 100 percent.
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Navigator Window
The Navigator window can be displayed or hidden via the [View] menu [Navigator] or the tool button
(large) [Show/Hide Navigator] button in the main window, or via the [View] menu [Navigator]
command in the designer window.
Gives a hierarchical display of the area, zones, and configurations, along with the DME devices, user
modules and components arranged within the configurations. This allows you to check the overall
status of your setup.
You can click the icon or name for an area, zone, configuration, DME device, user module, or
component to make each design window active.
NOTE
For user modules with security enabled, a password is requested when displaying the hierarchical display shown below.

Area
Zone
Device Group
Configuration
Device
User Module
Components included
in the User Module

Components

 [+]/[-]
The subordinate items are displayed or hidden using the [+]/[-] buttons to the left of the area,
zones, configurations, user modules, or DME devices. When the subordinate items are displayed,
the button changes to [-]. If you click this button, the subordinate items will be hidden. When the
subordinate items are hidden, the button changes to [+]. If you click this button, the subordinate
items will be displayed.
Subordinate items are also displayed and the button changes to [-] when you click on an area,
zone, configuration, user module, or DME device.

 Area
If you click the area the Area window becomes active.

 Zone
If you click a zone the Zone window becomes active. If another Zone window is open, zone will be
switched.
NOTE
When there are multiple configurations in a zone, click a configuration to switch configurations, not the zone.
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 Device Group
If a group is clicked the zone window of the clicked group will become active. If a window for
another zone is open at the time, zone will be switched.

 Configuration
If a configuration is clicked the clicked configuration will be selected.

 Device
If you click a device, a Configuration window will be opened for that unit. If that window is already
open, it will be displayed on top of any other windows.

 Component
Click a component and the component editor will open.

 User Module
The window specified by “User Module Properties [Double Click Action]” will open when clicked.

 Components Included in the User Module
Click a component in the user module and the component editor will be displayed.

Toolkit Window
The Toolkit displays objects that can be arranged in each design window. The displayed contents vary
according to which window is active.
 See “Objects” on page 210.

Displayed in the designer
window
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Displaying the Toolkit Window
You can display or hide the Toolkit window using the [Toolkit] command on the [View] menu. The
Toolkit displays objects that can be arranged in each design window. You can arrange objects in each
design window by dragging them from the Toolkit window or by double-clicking them in the Toolkit
window.
The objects are categorized by type and displayed here in a hierarchy. You can use the [+]/[-] buttons
to display or hide items below a particular level in the window. Click the [+] button to display the items
on the next level down, and the [-] button to hide them.

Moving the Toolkit Window
You can move the Toolkit window by dragging it. If you drag the window to right or left side, it will
remain fixed. If you drag it to other locations, it will float independently. When DME Designer is started
for the first time, the Toolkit window is displayed at the left side of the Designer window.
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Toolkit Window Types
The contents of the Toolkit window will vary, depending on which window is active.
Active Design Window

Toolkit Window

Area Window

Area Parts List

Zone Window

Device List

Configuration Window

Component List

User Module Window

Component List

The following objects are displayed in each window:
Component List
(Configuration
Window)

Component List
(User Module
Window)

Component





SPX Component





Area Parts List

Device List

DME



ICP




SP2060
External Device







User Module
Pictures









Text









Boxes









Ellipses









[Area Parts List]
The [Area Parts List] displays objects that can be arranged in the Area window. The same objects are
displayed in the [Area Parts List] submenu on the [Tools] menu or on the context menu that appears
when you right-click on the sheet.

NOTE
You can create multiple zones in an area. They are added using the menu bar [Tool] menu  “Zone” dialog box.
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[Device List]
The Device list displays objects that can be arranged in a Zone window (configuration). The same
objects are displayed in the [Device List] submenu on the [Tools] menu or on the context menu that
appears when you right-click on the sheet.

[Tools] menu

Toolkit window

[Device List] submenu on the [Tools] menu or
on the context menu

NOTE
Configurations are added using the menu bar [Tool] menu  “Configuration Manager” dialog box.

[Component List] (Configuration Window)
The Component List displays objects that can be arranged in Configuration windows. The same
objects are displayed in the [Component List] submenu on the [Tools] menu or on the context menu
that appears when you right-click on the sheet.

Toolkit window

[Tools] menu

[Component List] submenu
on the [Tools] menu
or on the context menu
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[Component List] (User Module Window)
The Component List displays objects that can be arranged in the User Module window. The same
objects are displayed in the [Component List] submenu on the [Tools] menu or on the context menu
that appears when you right-click on the sheet.

Toolkit window

[Tools] menu

[Component List] submenu
on the [Tools] menu
or on the context menu

Four Design Windows
The following design windows are available: the Area window, Zone window, Configuration window,
and User Module window. In each window there is a single sheet on which objects can be arranged.
Within the Designer window, you can simultaneously open and edit in the Area window, Zone Window,
Configuration window, and User Module window.
Configuration Structure and Four Design Windows
Area Window

Zone Window

Configuration Window

Component Editor
User Module Window

 Area Window
Used to design areas.
 See “Area Window” on page 297.

 Zone Window
Used to design zone configurations.
 See “Zone Window” on page 298.
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 Configuration Window
Used to design configurations for DME units arranged in a zone.
 See “Configuration Window” on page 301.

 User Module Window
Used to design user modules configurations. A module that combines a number of other
components, yet is treated as a single component, is called a “user module.” It is arranged in the
Configuration window.
 See “[Component List] (User Module Window)” on page 202.

Designer Window Menu
[Print] Menu
This menu provides commands for exporting configurations and printing windows.

 [Print Setup]
When you select this command, the “Print Setup” dialog box will be displayed. Sets the paper size
and orientation.
 “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 274)

 [Print Preview]
Displays a print preview of the active design window.
 “Print Preview” window in “Design Window Shared Settings and Operations” (page 275)

 [Print]
Prints the active window. When you select this command, the “Print” dialog box will be displayed.
 “Printing Each Design Window” in “Design Window Shared Settings and Operations” (page 274)

[“Print” dialog box]
Enter the number of copies to print into the [Number of Copies] box, and click the [Print] button.
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[Edit] Menu
This menu provides edit commands.

 [Undo]
Undoes the most recent edit operation. Repeatedly clicking this button will delete multiple
operations. When [Undo] is not possible, the command will be grayed out.

 [Redo]
Returns to the status before the [Undo] command was executed. If you repeatedly click this button,
it will redo multiple operations. If redo is not possible, the command will be grayed out.

 [Cut]
Cuts the selected object. Moves the selected object to the clipboard.

 [Copy]
Copies the selected object to the clipboard. The selected object remains as is.

 [Paste]
This command pastes the object on the clipboard into the active window. If there is no data on the
clipboard or if the object on the clipboard is not a type that can be pasted into the active window,
this command cannot be used.

 [Delete]
Deletes the selected object. The data on the clipboard does not change.
NOTE
There are some objects that cannot be deleted with the [Delete] command.

 [Select All]
Selects all objects in the active design window.

 [Duplicate]
Duplicates the selected object. The data on the clipboard does not change.

 [Display Order]
Changes the display order (in front or behind) of the selected objects.
 “Changing the Order” in “Design Window Shared Settings and Operations” (page 278)
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 [Edit Legend]
This command can be selected when an Area window, Zone window, or Configuration window is
active. It lets you edit the descriptive text (legend) displayed on the sheet in the Area window, Zone
window, or Configuration window. When this command is selected, the “Edit Legend” dialog box
will be displayed.
 “Legend (Descriptive Fields)” in “Objects” (page 260)

 [Properties]
Opens the “Properties” dialog box for the selected objects.
 See “Object Types” on page 210.

[View] Menu
Displays or hides the windows.

 [Toolbar]
Displays or hides the toolbar. A checkmark appears beside this menu item when the toolbar is
displayed.

 [Status Bar]
Displays or hides the status bar. A checkmark appears beside this menu item when the status bar
is displayed.

 [Area]/[Toolkit]/[Resource Meter]/[Navigator]
Displays or hides the Area window, Toolkit, Resource Meter, or Navigator window. A checkmark
appears to the left of the command name when a window is displayed.
The Resource Meter window is displayed only when the Configuration window and User Module
window are active.
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 [Full Screen]
Displays in full-screen mode. Displays the active design window (Area, Zone, Configuration, or
User Module window) exclusively, with it covering the entire screen.

A context menu appears wherever you right-click on the screen, containing the commands that are
needed at that location.
To return from the full-screen mode to the original display status, press the <Esc> key.

 [Port Long Name]
Switches the port name display of the slot components. When you select this command, a
checkmark appears next to it and long names are displayed. If you select this command when a
checkmark is next to it, the checkmark disappears and short names are displayed.

Long name
Short name

 [Zoom In]
Gives a closer view of an area displayed on the screen.

 [Zoom Out]
Widens the area displayed on the screen.

 [Zoom To]
Selects the display magnification from a submenu.

 [Actual Size]
Returns the display to normal dimensions.

 [Fit in Window]
Increases or decreases the display magnification so that the sheet exactly fits the current window.
The entire sheet will be visible.
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[Tools] Menu

 [Area Parts List]
This command can be used only when the Area window is active. A submenu displays the same
objects that are in the Toolkit window displayed while the Area window is active. Clicking an object
on the submenu, then clicking the Area window, places that object in the Area window.
 [Area Parts List] in “Toolkit Window” (page 200)

 [Device List]
This command can be used only when the Zone window is active. A submenu here displays the
same objects as the Toolkit window. Clicking an object on the submenu, then clicking the Zone
window, places that object in the Zone window.
 [Zone Device List] in “Toolkit Window” (page 201)

 [Component List]
This command can be used only when a Configuration window or User Module window is active.
A submenu here displays the same objects as the Toolkit window. Clicking an object on the
submenu, then clicking the Configuration/User Module window, places the object in that window.
 “Component List (Configuration Window)” in “Toolkit Window” (page 201), “Component List
(User Module Window)” in “Toolkit Window” (page 202)

 [Zone Manager]
Displays the “Zone Manager” dialog box. Here you can add, delete, or rename a zone.
 See “Adding, Deleting, and Renaming a Zone” on page 291.

 [Device Group Manager]
Displays the [Device Group Manager] window, allowing the device group to be changed.
 “Changing the Device Group” (page 293).
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 [Configuration Manager]
Displays the “Configuration Manager” dialog box. Here you can add, delete, or rename a
configuration.
 See “Adding, Deleting, and Renaming a Configuration” on page 295.

 [Save User Module]
This command can be used only when a User Module is selected in the Configuration window.
Saves a template for the selected user module.
 “User Module Manager” Dialog Box in “User Modules” (page 310)

 [User Module Manager]
Displays the “User Module Manager” dialog box. Changes the settings of, renames, or deletes a
user module saved as a template.
 “User Module Manager” Dialog Box in “User Modules” (page 314)

 [Show Signal Delay]
The digital signal delay value is displayed in the configuration window with sample units.
 “Show Signal Delay (Delay Display Value)” in “Configuration Window” (page 305)

 [Analyze]
Displays the “Analyze” dialog box, and analyzes the configuration.
 “Analyze (Configuration Analysis)” in “Configuration Window” (page 308)

 [Probe Monitor]
Turns the probe monitor ON or OFF. This command can be selected only when a Configuration
window or User Module window is active while in online status.
 “Probe Monitor” in “Configuration Window” (page 303)

 [Monitoring Point List]
Opens the “Monitoring Point List” dialog box. Registers points for monitoring with headphones.
 “Monitoring Point List” in “Configuration Window” (page 306)

 [Edit Mode]
Turns the edit mode ON or OFF.
 “Edit Mode” in “Editing Configurations” (page 192)
NOTE
Only users for whom the [Operation Security]  [Edit] checkbox in the “Security” dialog box has been checked can
select this command.

 [Sheet]
Opens the “Sheet Settings” dialog box. Sets the sheet size and background.
 “Sheet” in “Objects” (page 262)

 [Prohibit Diagonal Connections]
All connections will be drawn with horizontal and vertical wires only. Diagonal wires cannot be
drawn.
 “Drawing Settings” in “Drawing and Editing Wires” (page 282)

 [Grid]
Opens the “Grid” dialog box. Displays or hides the grid and sets the grid spacing.
 “Grid” in “Design Window Shared Settings and Operations” (page 270)
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 [Arrow]
The mouse cursor appears as crosshairs, and can be used to select objects.

 [Hand]
The mouse cursor appears as a hand shape, and can be used to click and “grab” the worksheet
for scrolling.

 [Show Unconnected Node]
Displays unconnected nodes.
 “Show Unconnected Node”(page 290)

 [Export DXF]
Exports the information in the active window and saves it as a DXF file, which is compatible with
CAD software sold by other companies.
 “Exporting the Design Window” in “Design Window Shared Settings and Operations” (page 271)

 [Preferences]
Displays the “Preferences” dialog box. Sets the line thickness and the design window edit
operations.
 “Preferences” in “Design Window Shared Settings and Operations” (page 268)

[Window] Menu
Arranges multiple windows. The lower part of the menu displays the names of currently open windows.
A checkmark appears next to the active window. When you click the name of a window, that window
becomes active.

 [Cascade]
Displays the windows overlapping one another.

 [Tile]
Displays the windows arranged side-by-side.
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Objects
Object Types
The devices, shapes, and wires that can be arranged in each design window are called “Objects.”
The following objects are available:
Name

Window Where It can be
Placed/Displayed

Explanation

Zone

Area

Zones

DME

Zones

DME and any cards inserted into its slots

ICP

Zones

User defined parameter control

SP2060

Zones

Speaker Processor

External Device

Area, Zones

External Device

Component

Configuration
User Module

User Module, Audio processor, Control parts

SPX Component

Configuration
User Module

SPX components

User Module

Configuration

Combination of components

Slot Component

Configuration

Internal DME I/O or installed I/O cards.

Pictures

All

Image

Text

All

Text box

Boxes

All

Box shape

Ellipses

All

Circular shape

Wires

All

Connecting wire, straight line shape

Legend

Area
Zones
Configuration

An area displayed on the sheet where descriptive
information is presented.

Sheet

--

One sheet per design window.

Various design elements, such as name, color and size, can be set in the “Properties” dialog box for
each object.
Size is set using the [Width] and [Height] boxes in the “Properties” dialog box. The maximum size
values that can be set may vary according to the sheet size and object position. You can set a size
that allows the object to fit in the sheet.

210

DME Designer Owner’s Manual

Chapter 4 Designer

Zone
There must be at least one zone in the Area window. Zones are added and deleted using the “Zone”
dialog box. Zones are not displayed in the Toolkit window or in the [Area Parts List] submenu in the
[Tools] Menu
If you right-click on the name of a zone object located in the Area window, a context menu will be
displayed.

 Zone Context Menu

NOTE
[Cut], [Copy], [Paste], and [Delete] are grayed out and cannot be selected.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Zone Properties” dialog box.
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 Zone Object Properties
When you select a zone in the Area window, then click the [Properties] command on the [Edit]
menu, the “Zone Properties” dialog box is displayed. Here you can set properties for zone objects.
The [Properties] command is also located on the context menu for zone objects.

[Text] Box
You can enter up to 100 English characters for the object name.
The object name is displayed in the rectangular box for the object. If there is a large number of
characters and the object’s shape is too narrow, all characters might not be displayed.

[Font] Button
Clicking here displays the “Select Font” dialog box. This sets the font used to display the object
name.
For information about the “Select Font” dialog box, see page 264.

[Color] Button
Clicking here displays the “Select Color” dialog box. This sets the color of the object name text.
For information about the “Select Color” dialog box, see page 265.

Text Position
Sets the location of the text. The list to the left sets the vertical position of the text. The list to the
right sets the horizontal position.

• Vertical Position
Select [Top], [Center], or [Bottom].

• Horizontal Position
Select [Left], [Center], or [Right].

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.
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[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

Raised

Sunken

Background Image
Sets background effects for the object.

• [Color] Button
Sets the color. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 265.

• [Image] Button
Displays an image inside the object. You can use image files in the following formats: BMP
(.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Clicking here displays the “Select Image”
dialog box. Specify an image file and set its display method.
For information about the “Select Image” dialog box, see page 267.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

DME
DMEs are arranged in the Zone window. If DME properties settings have been made for an expansion
card installed in one of the DME slots, the card will be displayed automatically.

DME24N

DME24N with no I/O card installed.

DME24N with an I/O card installed in
its expansion slot.
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DME64N

DME64N with no I/O cards connected in slots.

DME8i-C/DME8o-C/DME4io-C

DME8i-ES/DME8o-ES/DME4io-ES
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When I/O Cards Are Installed in DME Expansion Slots
When an I/O card is selected for an expansion slot in the DME properties, an I/O port is added for
the DME arranged in the Zone window. An I/O component block will be added to the configuration
window.
If [None] is selected for I/O cards in the DME properties, any I/O component blocks will also be
deleted automatically from the Configuration window. (Even if the I/O components are deleted, the
wiring will remain.)

DME64N block with card inserted in a slot and the Configuration window

When the DME64N Cascade Setting is Turned ON
When [Show Cascade Port on Configuration Window] is checked in the DME64N “DME Device
Properties” dialog box, the cascade I/O components will be displayed in the Configuration window.
If [Show Cascade Port on Configuration Window] is turned OFF in the DME64N “DME Device
Properties” dialog box, cascade I/O components will also be deleted automatically in the
Configuration window. (Even if the Cascade I/O components are deleted, the wiring will remain.)
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CobraNet Card/EtherSound Card
If the I/O card is a CobraNet card or EtherSound card a CobraNet icon or EtherSound icon will be
displayed in the DME object.

DME block with CobraNet card and Ether Sound card inserted

 Object Selection
To open a configuration window for a DME object arranged in the Zone window, first select it by
clicking on it, then double-click on it. If you right-click on the object, a context menu will be
displayed.

 Scene Info and [On-line] Button
DME objects include an object that provides scene info and an [On-line] button.

Scene Info

[On-line] Button

The scene info area displays the current scene number and name. Click the scene info area to
open the “Scene Manager” window.
The [On-line] button has the same function as the [On-line] button in the main panel window.
 “[On-line] Button” (page 59).
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 DME Object Context Menu
[Open Configuration Window]
Opens the Configuration window.
 See “Configuration Window” on page 301.

[Device Group Manager]
Opens the Device Group Manager window
 See “Device Group Manager” on page 293

[Configuration Manger]
Opens the Configuration Manager window.
 See “Configuration Manager” on page 295.

[Synchronization]
Opens the Synchronization window
 See “Synchronization
(DME Designer and Unit Synchronization)” on page 97

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the DME object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Scene]
Selects and recalls a scene from the submenu.

[Flash Unit LEDs]
When selected the DME front panel will flash, and will continue flashing until selected a second
time.
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[Output Level]
When you select this command, the “Output Level” dialog box will be displayed. This sets the DME
master volume.

[Properties]
Displays the “DME Device Properties” dialog box.

 DME Properties
To display the “DME Device Properties” dialog box, select a DME object, then click the [Properties]
command on the [Edit] menu. Here you can set DME properties.

DME24N

DME64N

DME Satellite
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[Label] Box
You can enter up to 100 English characters to display over the object.
NOTE
The name set in the [Label] box will be displayed on the list in the [Import]/[Export] menu commands, and on the list in
the dialog box. If there are multiple examples of the same DME, set different names for each so that you can distinguish
one from the other.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

Show Scene Display and On-line Indicator
When checked the current scene number and name and on-line indicator are displayed in the zone
window.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Port Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.
NOTE
For information about the “Select Color” dialog box, see page 265.
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I/O Card
Allows I/O card setup. [Slot1] ~ [Slot4] can be set up for a DME64N, while only [Slot] is available for
a DME24N. No I/O card setup is provided for the DME Satellite.

• [Select I/O Card]
Specifies the type of I/O card.
If you are using I/O cards other than Mini-YGDAI cards manufactured by Yamaha, and those
cards do no appear in the card list, select [MY-Others].

• [Card Label]
I/O card names having up to 100 characters can be entered here.

Port Style On Zone Window
Specifies how the DME ports appear in the zone window.

• [Custom Port Style]
Customizes the port display.

[Left]
Sets the number of ports to be displayed on the left.

[Right]
Sets the number of ports to be displayed to the right.

• [Audio Port (Classic Style)]
Displays all audio ports.

• [Edit Port Label and Type]
Sets the label and type for each port. Click to display the [Edit Port Label] dialog.
 See “Edit port Label and Type” dialog box on page 223.

Compile Priority
Here you can make compile settings for the configuration.

• [Resource]
Compiles arrangable components in order based on their component numbers. The Delay
values differ depending on the signal lines.

• [Fixed Delay]
Fixes the Delay value (number of Samples) for the signal lines. However, it also reduces the
number of components that can be arranged.

[Auto Delay Compensation]
This turns ON or OFF a function that automatically corrects the component delay when
[Fixed Delay] is selected.
NOTE
Auto Delay Compensation will not function properly in configurations that have a loop connection.
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Cascade
Turns the DME 64N cascade ON or OFF.

• Show Cascade Port on Configuration Window
Checking this enables cascade.

• [Cascade Setting]
Here you can make settings that apply when cascade is enabled. Clicking here displays the
“Cascade Setting” dialog box.
 See “Cascade Setting” dialog box on page 221.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

 “Cascade Setting” Dialog Box
Click the [Cascade Setting] button to display the “Cascade Setting” dialog box via which DME64N
cascade connections can be verified and edited as required. Make sure that the Head Margin and
Mixer I/O settings are the same for multiple cascaded DME64N units. These settings are matched
automatically for DME64N units that are connected via their [CAS IN] and [CAS OUT] terminals in
the Zone window.
NOTE
Refer to “Cascade (DME64N only)” (page 489) for input/output and cascade bus assignments.

Unit No. (Cascade Connection Number)
These settings automatically produce appropriate delay compensation for cascade-connected
DME64N units. When DME64N units are connected via their [CAS IN] and [CAS OUT] terminals in
the Zone window, DME64N units other than the first unit (default unit no. 1) are automatically
assigned sequential unit numbers. If the number of the first unit is changed the numbers of the
other units are automatically changed accordingly. If multiple “first units” exist in the same device
group, those first units can all be assigned Unit No. 1. Unit numbers are also automatically
assigned for cascade connections that span device groups.
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Device group 1
DME64N
Unit No.1

OUT

DME64N
Unit No.1

IN

DME64N
Unit No.2

OUT

OUT
IN

DME64N
Unit No.2

Device group 2
DME64N
Unit No.3
DME64N
Unit No.4

IN
OUT
IN

NOTE
When multiple DME64N units are cascade connected, each additional unit introduces a delay of a few samples that is
automatically compensated for. The Unit No. settings determine the amount of automatic compensation to be applied for
each unit.

Head Margin
Sets the CASCADE bus signal head margin. This setting only applies when the unit is cascade
connected to a mixer. Since Yamaha provides a CASCADE bus head margin of 18 dB, this
parameter should normally be set to “18dB”.
The margin for cascade connected DME64N units is always “18dB” regardless of the setting. The
head margin settings for DME64N units other than the first unit are automatically set to the same
value as the first unit when cascade connections are made, and are thereafter grayed out and can’t
be changed.
No head margin is provided when a cascade connected PM5D is set up to send the slot output
signals via its CASCADE OUT terminal, so the Head Margin parameter must be set to “0dB”.

Mixer I/O Channel
Determines whether a direct cascade connection between a DME64N unit and mixer will be
bidirectional (bus sharing) or not on a channel-by-channel basis. Make sure that the checkboxes
for cascade connected DME64N units are all set the same. The settings are matched automatically
when DME64N units are connected via their [CAS IN] and [CAS OUT] terminals in the Zone
window.
OFF: The connection with other DME64N units is bus sharing bidirectional. Since the mixer does
not support bidirectional connection the connection between the mixer and DME64N unit is
unidirectional CASCADE IN -> CASCADE OUT, regardless of the checkbox setting.
ON: The connection with other DME64N units is unidirectional CASCADE IN -> CASCADE OUT. For
DME64N units connected between two other DME64N units the connection is internally set to
bidirectional, regardless of the checkbox setting.
NOTE
The following settings are made automatically when cascade connections are made, regardless of the checkbox setting.
• DME64N unit between two other DME64N units: bidirectional.
• DME64N between two mixers: unidirectional.
• One mixer connected to one DME64N unit: unidirectional.
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[Check All] Button
Checks all checkboxes.

[Clear All] Button
Clears all checkboxes.

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
“Cascade Setting” Dialog Box Setting Chart
Cascade Destination
Head Margin

PM5D/DM2000 CASCADE
Bus

PM5D Slot Output*

18dB
(automatic)

18dB

0 dB

OFF

ON

OFF

ON

OFF

2, 3

Always
Bidirectional

Unidirectional

Bidirectional

Unidirectional

Bidirectional

1, 4

—

Mixer I/O

Signal
Direction

DME64N
Only

Always Unidirectional

Always Unidirectional

* When a cascade connected PM5D is set up to send the slot output signals via its CASCADE OUT terminal.
Mixer
CASCADE OUT

DME64N #1

1
CASCADE IN

3

DME64N #2

2
CASCADE OUT

DME64N #3
CASCADE IN

CASCADE OUT

CASCADE IN

4

CASCADE OUT

Mixer
CASCADE IN

 Edit Port Label and Type Dialog Box
The Edit Port Label and Type dialog box will appear when the [Edit Port Label and Type] button is
clicked. Specifies the port labels and types to be displayed to the left and right of DME and
SP2060 objects.
To set labels enter the [Port Name] for [Left] and [Right]. Each name can be up to 100 characters in
length.
To set the port type use [Port Type] to select the [Left] and [Right] types.
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ICP
You can arrange DME Device objects in the Zone window. These can be controlled using User
Defined Button.
First click on an ICP object arranged in the Zone window to select it, then double-click the label. This
opens a “Control Panel Properties” window. If you right-click on the object, a context menu will be
displayed.

 ICP Object Context Menu
[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the control panel object that is on the clipboard. If the same control panel object exists on
the sheet where you are pasting, a new ICP object will be created.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the properties dialog box.
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 ICP Properties
To display the “DME Device Properties” dialog box, select a ICP object, then click the [Properties]
command on the [Edit] menu.

[Label] Box
You can enter up to 100 text characters to display above the object. Labels for identical ICP
objects that exist in other configurations will also be changed.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.

[Style]
Sets the object style. Select [Plain], [Raised], or [Sunken] from the list.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 265.

[Back Color] Button
Sets the object color. Click to display the Select Color dialog box.

Ethernet Port
Turns Ethernet port rendering on or off. Ethernet port display will appear when the checkbox is ON.
The radio buttons can be used to specify whether the display is on the left or right side.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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SP2060
SP2060 objects can be placed in the zone window.
When clicked an SP2060 in the zone window will be selected, and when double-clicked the
configuration window will open. A contextual menu will appear if the object is right-clicked.

 Scene Info and [On-line] Button
SP2060 objects include an object that provides scene info and an [On-line] button.

Scene Info

[On-line] Button

The scene info area displays the current scene number and name. Click the scene info area to open
the “Scene Manager” window.
The [On-line] button has the same function as the [On-line] button in the main panel window.
 “[On-line] Button” (page 59).

 The SP2060 Object Context Menu
[Open Configuration Window]
Opens the Configuration window.
 “Configuration Window” (page 301).

[Device Group Manager]
Opens the Device Group Manager window
 See “Device Group Manager” on page 293

[Configuration Manager]
Not available for SP2060 objects.

[Synchronization]
Opens the “Synchronization” dialog box.
 See “Synchronization (DME Designer and Unit Synchronization)” on page 97

[Cut]
Cuts the selected object and places it on the clipboard.
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[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the SP2060 object currently on the clipboard.

[Delete]
Deletes an object.

[Duplicate]
Creates a duplicate of an object.

[Display Order]
Changes the display order according to the selected submenu command.

[Recall Scene]
Selects and recalls a scene from the submenu.

[Flash Unit LEDs]
Select to flash all indicators on the SP2060 panel. Flashing will continue until this command is deselected.

[Output Level]
Not available for SP2060 objects.

[Properties]
Opens the “SP2060 Device Properties” window.
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 SP2060 Properties
Select an SP2060 object and click [Properties] in the [Edit] menu to open the “Speaker Processor
Device Properties” window. The SP2060 properties can be edited here.

[Label] Box
Up to 100 single-byte characters or 50 two-byte characters can be entered for display on the
object. One two-byte character is equivalent to two single-byte characters. Single-byte and twobyte characters can be mixed.
NOTE
The label specified in the [Label] box will appear in the Toolkit window, the [Import] and [Export] menu commands, and
window lists. When multiple SP2060 units are used they can be given different labels for easy identification and
differentiation.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.

[Style]
Specifies the object style: select [Plain], [Raised], or [Sunken] from the list.

Show Scene Display and On-line Indicator
When checked the current scene number and name and on-line indicator are displayed in the zone
window.

[Label Font] Button
Specifies the label font. The “Select Font” window will appear when this button is clicked.
See “The Select Font Window” on page 264 for details on using the Select Font window.

[Label Color] Button
Specifies the color of the label characters. The “Select Color” window will appear when this button
is clicked.
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[Port Label Color] Button
Species the color of the I/O port label characters. The “Select Color” window will appear when this
button is clicked.

[Color] Button
Specifies the color of the object. The “Select Color” window will appear when this button is clicked.

Port Style on Zone Window
Species how ports will be displayed on SP2060 objects in the zone window.

[Audio Port (Classic Style)]
Displays all audio ports. This command grayed out and cannot be selected for SP2060 objects.

[Custom Port Style]
Customizes the port display. This setting is always used for SP2060 objects.

• [Left]
Specifies the number of ports to be displayed on the left side of the object.

• [Right]
Specifies the number of ports to be displayed on the right side of the object.

• [Edit Port Label and Type]
Edits the label and type for each port.
The “Edit Port Label and Type” window opens when clicked.
 “Edit Port Label and Type” window (page 223).

[OK] Button
Applies the setting changes and closes the window.

[Cancel] Button
Closes the window without changing any settings.
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External Device
Arranges external device objects in the Zone window. External applications can be linked to the
devices arranged in the window. These links to external applications are set using the “External
Device Properties” dialog box.
To start the application linked to an external device object arranged in the Zone window, first click on
the object to select it, then double-click it. If you right-click on the object, a context menu will be
displayed.
NOTE
If no external application is linked to the an object, no application will start when the object is double-clicked.

 AD824/AD8HR
The AD824 is an eight-channel analog-to-digital converter. The AD8HR is an eight-channel analogto-digital converter that features a head amp with high quality sound.
You can connect Yamaha AD824 and AD8HR A/D converters to a DME unit and control them
remotely from DME Designer. DME Designer has a component editor for controlling [AD824] and
[AD8HR] units.
If you arrange an [AD824] or [AD8HR] from [External Device] in the Zone window, select the
connected DME unit in the properties dialog box, and double-click on an [AD824] or [AD8HR]
block, the component editor is displayed.
NOTE
If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click.
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 External Device Object Context Menu
[Open Component Editor]
Starts the application assigned to the object.
For the [AD824] and [AD8HR], it opens the component editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “External Device Properties” dialog box.
At the lowest position below [External Device], [AD824] and [AD8HR] display the “Serial Controlled
Device Properties” dialog box. The other objects display the “External Device Properties” dialog
box.
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 External Device Properties
To display the “External Device Properties” dialog box, select any external device object besides
AD824 or AD8HR, then click the [Properties] command on the [Edit] menu.

[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the object width in pixels.

[Height] Box
Specifies the object height in pixels.

[Style]
Sets the object style. Select [Plain], [Raised], or [Sunken] from the list.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Port Label Color] Button
Sets the color of the I/O port label. Click to display the Select Color dialog box.

[Back Color] Button
Sets the object color. Click to display the Select Color dialog box.
NOTE
For information about the “Select Color” dialog box, see page 265.
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Launch Application
The radio buttons determines whether an application or file will be linked to an external device.

• [Application] Box
The linked application will be displayed. Click the [Browse] button to locate and select an
application. Specifies the path to an application to be launched when an External Device
object is double-clicked.

• [File] Box
The linked file will be displayed. Click the [Browse] button to locate and select a file. Specifies
the path to a file to be launched when an External Device object is double-clicked.

Port
Specifies the number of ports displayed for an External Device object.

• [Left]
Sets the number of ports to be displayed on the left.

• [Right]
Sets the number of ports to be displayed to the right.

• [Edit Port Label and Type...] Button
Sets the label and type for each port. Click to display the [Edit Port Label] dialog box.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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 External Device Properties (AD824, AD8HR “Serial Controlled Device
Properties” Dialog Box)
To display the “Serial Controlled Device Properties” dialog box, select AD824 or AD8HR, then click
the [Properties] command on the [Edit] menu.
This dialog box is the same as the “External Device Properties” dialog box, except for [Remote].

Remote
Select the DME to control remotely AD824 and AD8HR.

• [DME Unit]
The DMEs in the current configuration will be displayed in a list. Select the DME you will
control remotely.

• [ID]
Selects an ID from 1 to 8. The default is 1.
AD824 and/or AD8HR units will be assigned beginning from “1” in the order that they are
connected. When combining AD824 and AD8HR units it is necessary to connect AD8HR units
before AD824 units.
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Component
Components are arranged in the Configuration window and the User Module window. They include
audio processors like mixers and compressors, and control parts like switches and sliders.
Component objects arranged in a configuration are displayed in block form.
To open the component editor for an arranged component, first select it by clicking on it, then doubleclick on it. If you right-click on the object, a context menu will be displayed.
Label
ID

Input Port
Output Port
Amount of DSP memory used
in the DME

NOTE
The amount of DSP memory used is not displayed for SP2060 units.

 Component Object Context Menu
[Open Component Editor]
Opens the component editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

DME Designer Owner’s Manual

235

Chapter 4 Designer

[Recall Component Library]
Recalls libraries with component parameters saved in them. Clicking here displays the submenu.
When a library is selected from the submenu, the library is read and the component parameters are
changed.
For more information about libraries, see “Library” (page 364).
NOTE
Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is
grayed out for users for whom [Control Component Editor] is turned OFF.

• [Open File Dialog]
Displays the file select dialog box. You can recall libraries saved in folders other than the user
module “Library” folder.

[Store Component Library]
Saves the component parameters. Click to display the “Store” dialog box. If you then save without
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 364 for more information.

[Add Component to Component Link]
Creates component link.
Refer to “Creating Component Links” on page 370 for more information.

[Properties]
Displays the “Component Properties” dialog box.

 Component Properties
Here you can set properties for each component. If multiple examples of the same component type
are arranged on a single sheet, changing the properties of a single component does not change
the others.
To display the “Component Properties” dialog box, select a component object, then click the
[Properties] command on the [Edit] menu.
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[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.
NOTE
For information about the “Select Color” dialog box, see page 265.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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SPX Component
SPX components are arranged in the Configuration window and the User Module window. Component
objects arranged in a configuration are displayed in block form.
Clicking on a positioned SPX component will select it, and right-clicking will display a contextual
menu.
Unlike normal components, SPX components use SPX-specific resources and therefore the usage
percentage display that appears to the lower right of normal components will not appear. Check the
SPX resource usage percentage via the SPX meter in the Resource Meter window.

 Context Menu for SPX Component Objects
[Open Component Editor]
Opens the component editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Recall Component Library]
Recalls libraries with component parameters saved in them. Clicking here displays the submenu.
When a library is selected from the submenu, the library is read and the component parameters are
changed.
For more information about libraries, see “Library” (page 364).
When you will change the effect type for the SPX component, select the desired type from the
[Effect Type] displayed in the submenu.
NOTE
Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is
grayed out for users for whom [Control Component Editor] is turned OFF.
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[Store Component Library]
Saves the component parameters. Click to display the “Store” dialog box. If you then save without
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 364 for more information.

[Add Component to Component Link]
This menu has no effect for SPX components.

[Properties]
Displays the “SPX Component Properties” dialog box.

 SPX Component Properties
SPX component properties are set for each component. If multiple examples of the same
component type are arranged on a single sheet, changing the properties of a single component
does not change the others.
To display the “SPX Component Properties” dialog box, select a component object, then click the
[Properties] command on the [Edit] menu.

[Label] Box
You can enter up to 100 characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see “Select Font” dialog box (page 264).

[Label Color] Button
Sets the color for the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.
NOTE
For information about the “Select Color” dialog box, see “'Select Color' Dialog Box” (page 265).

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Slot Component
If an inserted I/O card is selected in the DME properties settings, it will be displayed in the
Configuration window as a Slot component.
Slot component objects arranged in a configuration are displayed in block form.
If you select an arranged component by clicking on it, then double-click it, the component editor
opens. If you right click on the object, a context menu will be displayed.

 Slot Component Object Context Menu
[Open MY-Card Editor]/[Open HA Editor]/[Open CobraNet Editor]
Opens the editor for Slot components.

[Open Slot In Component Editor]/ [Open Slot Out Component Editor]/[Open Input
Component Editor]/[Open Output Component Editor]
Opens the component editor.

[Launch Application]
Launches linked application.

[Cut]/[Copy]/[Paste]/[Delete]/[Duplicate]
The functions cannot be used with Slot components.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Component Properties” dialog box.
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 Slot Component Properties
To display the “Slot Component Properties” dialog box, select a Slot component object, then click
the [Properties] command on the [Edit] menu.

[Label] Box
You can enter up to 100 characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Label Font] button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see “'Select Font' Dialog Box” (page 264).

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Label Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.
NOTE
For information about the “Select Color” dialog box, see “'Select Color' Dialog Box” (page 265).

[Edit I/O Port Label] Button
Specifies the I/O port label. The “Edit Port Label” window opens when this button is clicked.
 “Edit Port Label” Dialog box (page 242)
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Launch Application
Click the radio button and select whether an application or file is to be linked to the Slot
component.

• [Application] Box
Shows the linked application. Click the [Browse] button to browse and select an application. Set
the path of the application to be launched from the Slot component contextual menu.

• [File]
Shows the linked file. Click the [Browse] button to browse and select a file. Set the path of the
file to be opened from the Slot component contextual menu.

[OK] Button
Updates the settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

 “Edit Port Label” Dialog Box
When you click the [Edit I/O Port Label] button, the “Edit Port Label” dialog box is displayed. Here
you can set the port labels displayed for components. Enter a [Short Name] and [Long Name]. You
can enter up to 100 English characters for each name. If you click the [Use default names] button,
all port labels return to the default settings.
You can switch between long and short port names displayed in the configuration window with the
[Port Long Name] command in the [View] menu. When you select this command, a checkmark
appears next to it and long names are displayed. If you select this command while a checkmark is
next to it, the checkmark disappears and short names are displayed.
Labels specified here are always displayed in the Configuration Window.
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User Module
A user module combines a number of other components into a module that is treated as a single
component. It can be arranged in the Configuration window. A user object arranged in a window is
displayed as a single block. The User Module Design Window or User Module Window will open,
according to the “Double Click Action” setting of “User Module Properties” dialog box when you
double click the user module (page 314).
If you right-click on the object, a context menu will be displayed.

 User Module Object Context Menu
[Open User Module Design Window]
Opens the User Module Design Window.

[Open User Module Editor]
Opens the User Module Editor.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

DME Designer Owner’s Manual

243

Chapter 4 Designer

[Recall Component Library]
Recalls a library into which component parameters have been saved. Click to display a sub-menu.
Select a library from the sub-menu to load the parameters into the component.
Refer to “Library” on page 364 for more information.
NOTE
Libraries can be recalled only by users for whom [Control Component Editor] in security is turned ON. The command is
grayed out for users for whom [Control Component Editor] is turned OFF.

• [Open File Dialog]
Displays the file select dialog box. You can recall libraries saved in folders other than the user
module “Library” folder.

[Store Component Library]
Saves the component parameters. Click to display the “Store” dialog box. If you then save without
changing the folder, the parameters will be added to the library.
Refer to “Library” on page 364 for more information.

[Save User Module]
Saves the selected user module. See “Saving User Modules” on page 310.

[Properties]
Displays the “User Module Properties” dialog box.
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 User Module Properties
To display the “User Module Properties” dialog box, select a user module object, then click the
[Properties] command on the [Edit] menu.
NOTE
The “User Module Properties” dialog box is also displayed when a [Blank User Module] is arranged in the configuration
window.

[Label] Box
You can enter up to 100 English characters to display over the object.

[Width] Box
Specifies the width of the object in pixels.

[Height] Box
Specifies the height of the object in pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], [Sunken], or [Image]. When
[Image] is selected the “Open” dialog box will appear. Select an image file and click [Open] to
place the selected image as an object.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.

[Inputs/Outputs Labels Color] Button
Sets the color for the I/O port label text. Clicking here displays the “Select Color” dialog box.

[Color] Button
Sets the color of the object. Clicking here displays the “Select Color” dialog box.
NOTE
For information about the “Select Color” dialog box, see page 265.
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Inputs/Outputs Sets
Sets the number of input/output ports. Enter a number into the [Inputs] box and [Outputs] box, or
set a value using the [] and [] buttons at the right of each box. The maximum of both input and
output ports is 64.

Edit I/O Port Label
Input and output port names up to 100 characters in length can be entered.

Double-Click Action
Sets the action that occurs when you double-click on a user module object arranged in the
Configuration window.

• [Open User Module Design Window]
Opens the User Module window.

• [Open User Module Editor]
Opens the User Module editor.

Security Settings
Turns user module security ON or OFF, and sets a password.

• [Enable Security]
Enables user module security. If you turn this function ON when no password is currently set,
the “Set Password” dialog box appears. Enter a password, then click the [OK] button.

If you change the setting from OFF to ON, the “Input Password” dialog box appears. You
cannot turn Security OFF until you enter the correct password.

NOTE
When security is active the editor cannot be opened unless the appropriate password is entered. Once the
password has been entered security is temporarily disabled until the DME Designer is quit, or a different file is
opened.

• [Set Password] Button
Changes the password for user modules. Clicking this button displays the “Input Password”
dialog box. Enter the current password and click the [OK] button. The “Set Password” dialog
box will be displayed, and you can set a new password.
This button will be grayed out when [Enable Security] is turned OFF.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Picture
An image can be arranged as an object on a sheet. This specifies a file for this purpose. You can use
image files in the following formats: BMP (.bmp), PNG (.png), XBM (.xbm), XPM (.xpm), and JPEG
(.jpg).
Before placing a picture object, prepare an image file. Copy the image file to the folder specified in the
“Preferences” dialog box  [Application] tab  [ContentsFolder] in the Main Panel window.
In the project file, the location and name of the image file are registered in an relative path below the
[ContentsFolder] and the linked image file is read and displayed. If the image file is moved, renamed,
or the [ContentsFolder] is changed, the image cannot be displayed.
NOTE
Background images for sheets are specified in the “Sheet” dialog box. Pictures are arranged as objects on the sheets.

 Placing Pictures
There are three picture placement methods:
• You can drop the [Picture] item from the Toolkit window into each design window.
• You can double-click [Picture] on the Toolkit window.
• You can click [Picture] in the [Area Parts]/[Device List]/[Component List] on the [Tools] menu,
then click each design window.
When you place a picture object, the “Open” dialog box is displayed. Select the image file and
click the [Open] button. The picture will be placed in the design window.
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 Picture Object
When you click a picture object that is located in each design window, handles (small squares)
appear at the corners and sides of the object. You can expand or reduce the picture’s size by
dragging a handle.

If you double-click on the object, the “Picture Properties” dialog box opens.
If you right-click on a picture object, a context menu will be displayed.

 Picture Module Object Context Menu
[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Picture Properties” dialog box.
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 Picture Object Properties
To display the “Picture Properties” dialog box, select a picture object, then click the [Properties]
command on the [Edit] menu.

[Label] Box
You can enter up to 100 English characters to display over the object.
If the box is left blank, the label will disappear.

[Draw Picture Border]
Displays a border around picture objects.

[Label Font] Button
Sets the font for the label. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

[Label Color] Button
This sets the color of the label text. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 265.

[Port Label Color] Button
Sets the color of the I/O port label. Click to display the Select Color dialog box.

[File Name] Box
Displays the path to the graphic file.

[Browse] Button
Selects a graphic file.

[Link Component Editor]
When On a Picture object can be double clicked to open the component editor specified by the
[Select Component] button. If an object is placed in the Configuration Window and the Link
Component Editor is not active, Picture Properties will be displayed. This only affects the object
that has been placed in the Configuration Window. All others will be grayed out and cannot be
selected.
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[Select Component] Button
Specifies the component editor to be opened when a Picture object is double clicked. Only
effective when [Link Component editor] is On.

Port
Specifies the number of ports to be displayed for a picture object.

• [Left]
Sets the number of ports to be displayed on the left.

• [Right]
Sets the number of ports to be displayed to the right.

• [Edit Port Label and Type...] Button
Sets the label and type for each port. Click to display the [Edit Port Label] dialog box.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Text Box
Text objects can be arranged in all design windows. Text is entered into the “Text Properties” dialog
box. When first placed in the design window, the word “Text” is entered into the box.
If you click the text object, handles (small squares) appear at the corners and sides of the object. You
can adjust the size by dragging the handles. You can open the “Text Properties” dialog box by doubleclicking the box. If you right-click on the object, a context menu will be displayed.

 Text Object Context Menu
[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Text Properties” dialog box.
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 Text Object Properties
To display the “Text Properties” dialog box, double-click on a text object, or select a text object,
then click the [Properties] command on the [Edit] menu.

[Text] Box
You can enter up to 10,000 English characters to display in the text object box.

[Text Font] Button
Sets the font. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

[Text Color] Button
Sets the color of the text. Clicking here displays the “Select Color” dialog box.

[Draw Text Border]
Displays a frame around the text object. If this is not checked, only the text will be displayed on the
sheet.

[Text Border Style] Box
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Background Color]
Uncheck this item to make the background of text objects transparent. When this item is checked
the [Color] button to its right opens the “Select color” dialog box that can be used to select a
background color.
NOTE
For information about the “Select Color” dialog box, see page 265.

[Link Component Editor]
When On a Text object can be double clicked to open the component editor specified by the
[Select Component] button. If an object is placed in the Configuration Window and the Link
Component Editor is not active, Text Properties will be displayed. This only affects the object that
has been placed in the Configuration Window. All others will be grayed out and cannot be
selected.

[Select Component] Button
Specifies the component editor to be opened when a Text object is double clicked. Only effective
when [Link Component editor] is On.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Box (Rectangle)
You can arrange rectangles on the sheet.
If you click the box, handles (small squares) appear at the corners and sides of the object. You can
adjust the size by dragging the handles. You can open the “Box Properties” dialog box by doubleclicking the box. If you right-click on the object, a context menu will be displayed.

 Box Object Context Menu
[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Box Properties” dialog box.
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 Box Object Properties
To display the “Box Properties” dialog box, double-click on a box object or select a box object,
then click the [Properties] command on the [Edit] menu.

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.

[Style]
Sets the style of the object. From the list, select [Plain], [Raised], or [Sunken].

[Round Corner]
Creates a rectangular box with rounded corners.

Line
Sets the line that frames the box.

• [Type]
Displays a list where you can select the type of line to frame the box. The following types are
available: [Solid], [Dash], [Dot], [DashDot], and [DashDotDot].

• [Size] Box
Sets the width of the line that frames the box. This setting can range from 1 to 100 pixels.

• [Select Color] Button
Sets the color of the line that frames the box. Clicking here displays the “Select Color” dialog
box.
For information about the “Select Color” dialog box, see page 265.

[Fill Color]
Uncheck this item to make the background of objects transparent. When this item is checked the
[Color] button opens the “Select color” dialog box that can be used to select a background color.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.

254

DME Designer Owner’s Manual

Chapter 4 Designer

Ellipse
[Ellipse] in the Toolkit window places a elliptical shape on the sheet.
When you click an Ellipse object that is located in the sheet, handles (small squares) appear at the
corners and sides of the object. You can adjust the size by dragging the handles. You can open the
“Ellipse Properties” dialog box by double-clicking the ellipse. If you right-click on the object, a context
menu will be displayed.

 Ellipse Object Context Menu
[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the object you clicked on.

[Duplicate]
Duplicates the object you clicked on.

[Display Order]
Changes the display order of the objects, according to a command in the submenu.

[Properties]
Displays the “Ellipse Properties” dialog box.
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 Ellipse Object Properties
To display the “Ellipse Properties” dialog box, double-click on an ellipse object, or select an ellipse
object, then click the [Properties] command on the [Edit] menu.

[Width] Box
Specifies the width of the object in pixels. The default is 50 pixels.

[Height] Box
Specifies the height of the object in pixels. The default is 50 pixels.

Line
Sets the line that frames the ellipse.

• [Type]
Displays a list where you can select the type of line to frame the ellipse. The following types
are available: [Solid], [Dash], [Dot], [DashDot], and [DashDotDot].

• [Size] Box
Sets the width of the line that frames the ellipse. This setting can range from 1 to 100 pixels.

• [Select Color] Button
Sets the color of the line that frames the ellipse. Clicking here displays the “Select Color”
dialog box.
For information about the “Select Color” dialog box, see page 265.

[Fill Color]
Uncheck this item to make the background of objects transparent. When this item is checked the
[Color] button opens the “Select color” dialog box that can be used to select a background color.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Wire
Draws lines (wires) for connecting components and creating shapes. For instructions on drawing
wires, see “Drawing and Editing Wires” on page 279.
First click on an wire object arranged on the sheet to select it, then double-click the object. This opens
a “Wire Properties” window.

Node Line Segment
Termination

If you right-click on a wire object, one of three types of context menus will be displayed, depending
where you clicked.

 Wire Object Context Menu (Line Segment)

Line Segment Context Menu

[Start Wire]
Begins drawing a line segment from the location where you clicked.

[Delete Wire]
Deletes the entire wire.

[Cut]
Cuts the selected object and moves it to the clipboard.

[Copy]
Copies the selected object to the clipboard.

[Paste]
Pastes the object that is on the clipboard.

[Delete]
Deletes the line segment where you right-clicked.

[Duplicate]
Duplicates the wire object.
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[Wire Color]
Specifies the wire color.

[Properties]
Displays the “Wire Properties” dialog box.

 Wire Object Context Menu (Node)

Node Context Menu

[Start Wire]
Begins drawing a wire segment from the location where you right-clicked.

[Delete Wire]
Deletes the entire wire.

[Delete]
Deletes the node. The nodes before and after will become directly connected.

[Properties]
Displays the “Wire Properties” dialog box.

 Wire Object Context Menu (Termination)

Termination Context Menu

[Continue Wire]
Begins drawing wire from a termination node.

[Start Wire]
Begins drawing a wire from the location where you right-clicked.

[Delete Wire]
Deletes the entire wire.

[Properties]
Displays the “Wire Properties” dialog box.
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 Wire Object Properties
To display the “Wire Properties” dialog box, double-click on a wire object. You can also select a
wire object, then click the [Properties] command on the [Edit] menu.

[Line Width] Box
Set the line width. This setting can range from 1 to 10 pixels.

[Line Type]
Displays a list where you can select the type of line. The following types are available: [Solid],
[Dash], [Dot], [DashDot], and [DashDotDot].

[Line Color] Button
Sets the color of the line. Clicking here displays the “Select Color” dialog box.

[Selected Color] Button
Sets the color of the selected line. Clicking here displays the “Select Color” dialog box.
NOTE
For information about the “Select Color” dialog box, see page 265.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Legend (Descriptive Fields)
Displays a legend for all sheets except the User Module window.
When you click the [Edit Legend] command on the [Edit] menu or double-click on one of the Legend
fields displayed on the sheet, the “Edit Legend” dialog box is displayed. If you right-click on the
Legend, the displayed context menu will have the [Edit Legend] command only. If you click there it will
display the “Edit Legend” dialog box.

The “Edit Legend” dialog box is used to enable/disable Legend display and to set the contents
displayed there. You can display the [Edit Legend] command from the [Edit] menu.

 “Edit Legend” Dialog Box

[Project] Box, [Title] Box, [No.] Box, [Author] Box, [Company] Box, [Address1] Box, and
[Address2] Box
Used to enter the Project, Title, Number, Author, Company, Address1, and Address2. You can enter
up to 100 English characters for each field.
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[Date] Box and [Revisions] Box
You can enter up to five dates and five revisions. You can enter up to 100 English characters for
each field.

[Legend Base Font Style]
Displays a list where you can select the font.

[Show Legend]
Place a checkmark here to display the legend on the sheet.

[Save as Default Legend]
Saves this legend as the default legend used when a new sheet is created. When a new
configuration is created, it will have a legend with the same contents as this one.

[Change for All Legends In Area]
Place a checkmark here to have the changes made here reflected in sheets in all design windows
included in the area.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Sheet
There is one sheet in each design window for arranging objects. The size of the sheet and its
background image are specified with the “Sheet Settings” dialog box. This dialog box is displayed
using the [Sheet] command from the [Tools] menu.
Make the window where you are going to change sheet settings active, then click [Tools] menu 
[Sheet].

 “Sheet Settings” Dialog Box

[Preset Size]
Displays a list where you can select preset paper sizes.
When you select a paper size, numerical values are set for [Horizontal] and [Vertical].

[Custom Sizes]
Set a custom size by specifying the vertical and horizontal sizes of the sheet.

• [Horizontal] Box
Sets the horizontal width of the sheet.

• [Vertical] Box
Sets the vertical height of the sheet.

• [Fixed Aspect Ratio]
When this is checked the relationship between horizontal and vertical is fixed. When the value
for [Horizontal] or [Vertical] changed, the size of the other direction changes so that the
proportions of the paper remain the same.
NOTE
The upper left is the starting point for measuring sheet size. Therefore, in the [Horizontal] box set the number of
pixels to the right edge, and in the [Vertical] box, set the number of pixels to the lower edge. The boundaries in
which items are already arranged on the sheet will form the minimum sheet size.
Because any objects that are moved, cut, or deleted will return to the same location if the [Undo] command is
used, the minimum sheet size will be determined by the boundaries in which any objects were located, now or in
the past.
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Background Effect
Sets the background for the sheet.

• [Color] Button
Sets the color of the background. Clicking here displays the “Select Color” dialog box.
For information about the “Select Color” dialog box, see page 265.

• [Draw Image] Button
When this check box is checked, an image file is displayed as the sheet background. You can
use image files in the following formats: BMP (.bmp), PNG (.png), XPM (.xpm), and JPEG
(.jpg). Clicking the [Image] button displays the “Select Image” dialog box.
For information about the “Select Image” dialog box, see page 267.

• [Change for All Sheets]
Changes all sheets so that they are the same.

[Save As Default Sheet Size]
When turned ON, the current values will become the default for creating sheets. New sheets will be
created at the same size.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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“Select Font” Dialog Box
When you click the [Font] or [Label Font] button in an object’s properties dialog box, the “Select Font”
dialog box is displayed. Sets the font.

 Font
Selects the font. The currently selected font name is displayed in this box. Select a font by clicking
its name on the list.

 Font Style
Sets the style of the text. The currently selected style is displayed in the box. Select a style by
clicking its name on the list below.
• Normal ..........Standard style
• Italic ..............Italic or slanted text
• Bold ..............Bold text
• Bold Italic......Bold italic text

 Size
Sets the text size. The currently selected size is displayed in the box. Select a size by clicking it in
the list below.

 Effects
Sets effects for the text. Check the effects you wish to set.
• Strikeout........Adds a strikeout line through the center of the text.
• Underline ......Adds an underline to the text.

 Script
From the list, select the script (language) for the text. There is no need to change the language
setting unless you want to specify a specific language.

 Sample
Displays an example of the current settings.
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“Select Color” Dialog Box
When you click the [Color] or [Label Color] button in an object’s properties dialog box, the “Select
color” dialog box is displayed. Sets the color of objects and text.

 Setting Basic Colors
There are 48 basic colors provided in the [Basic colors] section. When you select a basic color by
clicking on it, the position of that color in the color palette to the right is indicated by a cross (+).
Information about the selected color is displayed below the color palette.
Click the [OK] button to set the color you selected.

 Setting Colors That Are Not in the [Basic colors] Section.
You can select any color in the color palette displayed at the upper-right of the dialog box by
clicking on it in the palette. Color information is displayed below the color palette. If you like the
color you selected, click the [OK] button. If you don’t like the color, you can select a new color by
clicking in another location in the color palette, or by dragging the cross symbol to another location
there.
Grey colors can be selected on the tall, thin chart to the right of the palette.
Click the [OK] button to set the color you selected.

 Saving Colors You Have Created
In the custom color section, you can save up to 16 colors you have created. When you save a
custom color, it can be selected by clicking on its color button, in the same way as for the [Basic
colors].
Even if you open the “Select color” dialog box from the Properties of another object, any custom
color you save will be displayed and you can use that same color for the other object.
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1 Click the [Custom colors] box where you will save the color you create.
The box you clicked will be selected and a frame will appear around it.

2 Set the color on the color palette.
3 Click the [Add to Custom Colors] button.
The selected color will be added to [Custom colors].

NOTE
You can save another color in a box that already has an original color saved in it. Just click on the box to select it.
The new color will overwrite the previous color, which will be lost.
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“Select Image” Dialog Box
You can display an image for the background of sheets or objects. You can use image files in the
following formats: BMP (.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg).
In the project file, the location and name of the image file are registered in an relative path below the
[ContentsFolder] and the linked image file is read and displayed. If the image file is moved, renamed,
or the [ContentsFolder] is changed, the image cannot be displayed.
If you click the [Image] button in the properties dialog box for an object that can display a background
image or in the “Sheet” dialog box, the “Select Image” dialog box will be displayed. Specify an image
file and set its display method.

Image Layout
Selects the manner in which the image file will be displayed.

• [Center]
Centers the image in the object or sheet.

• [Tile]
Displays multiple copies of the image side-by-side until the available space is filled. If the
image file is smaller than the sheet, it will be displayed repeatedly like tiles on a wall.

• [Fit]
Expands or reduces the size of the image to match the size of the sheet where it will be
displayed.

[File] Box
Specifies a path for the image file. A path can be directly entered in the box. You can also click the
[Browse] button and select the image file. It will be entered automatically.
To stop display of an image, delete all characters in the box, leaving the field blank.

[Browse] Button
Specifies a path for the image file. Clicking here displays the “Open” dialog box. Select a file with
one of the following extensions: “.bmp,” “.png,” “.xpm,” or “.jpg,” then click the [Open] button.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Design Window Shared Settings and Operations
Preferences
You can set the operating environment for the Designer window in the “Preferences” dialog box. This
dialog box is opened using the [Preferences] command in the Designer window [Tools] menu.

 Graphics
Ports & Wires
Specifies wire color, thickness, and type for each port type.

• [Color]
Sets the default color for the port and wire.

• [Width]
Sets the default wire width from a range of 1 to 5.

• [Type]
Sets the port type.
NOTE
The initial color and thickness of the wires produced when drawing connections are specified here. The color and
thickness of drawn wires can be changed via the Wire Properties dialog box.
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Crosshairs
• [Show Crosshairs While Dragging]
Place a checkmark here to have crosshairs displayed for guidance when dragging the wire
endpoint.

• [Select Crosshair Length]
Specifies the length of the crosshair lines.
Enter a number into the [Arbitrary Crosshair Length] box to specify the length in pixels.
[Infinite Crosshairs] causes the lines to go all the way to the edge of the window.

Offset Paste/Duplicate from Original By
Sets the position when pasting or duplicating objects.

• [Auto-size (based on original object)]
If you place a checkmark here, the paste/duplicate position will be automatically adjusted so
that the object does not overlap the original object.

• [Horizontal Pixels] Box
Sets the horizontal distance.

• [Vertical Pixels] Box
Sets the vertical distance.

Auto Suffix Number
Turns automatic appending of sequentially-numbered suffixes to the names of placed objects on or
off.

• [DME/Speaker Processor]
When ON numbered suffixes will automatically be appended to added DME, SP2060 and ICP
objects.

• [Component]
When ON numbered suffixes will automatically be appended to added SPX and user module
objects.

• [Other Objects]
When ON numbered suffixes will automatically be appended to added objects not covered by
the above two categories.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Grid
Displays a grid on the sheet in each design window to guide the placement of objects. You can also
have the objects “snap to” (automatically align with) the grid when dragging them. When you click the
[Grid] command on the [Tools] menu, the “Grid” dialog box is displayed. Here you can enable or
disable display of the grid and set the grid interval and form.

[Snap to Grid]
Makes objects align the grid when dragging them.

Spacing
This sets the spacing of the grid. This setting can range from 2 to 99 pixels.

• [X:] Box
This sets the spacing of the grid in the horizontal direction.

• [Y:] Box
This sets the spacing of the grid in the vertical direction.

[Show Grid]
Displays the grid. Place a checkmark here to enable display and select the type of grid.

• [Line]
Displays the grid using lines.

• [Dot]
Displays the grid using dots.

[Save As Default Setting]
Place a checkmark here to make the current grid settings the default when a new sheet is created.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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Exporting Each Design Window
Instead of saving projects in their entirety, you can output the information contained in the active
window using the Designer Window [Print]  [Export DXF] command and save it in a DXF format file.
These files have “.dxf” as their filename extension.
Because the DXF format uses the standard CAD file format, it can be opened using CAD software.
DXF format files can also be opened by graphics software that support vector graphics, such as
Adobe Illustrator®.
NOTE
Configurations are saved in project files. This is done using the [File] menu  [Save] and [Save As] commands in the Main
Panel window. For information about saving project files see “Project Files” on page 34.

• Symbols are substituted for external devices in the following three types of folders.
Microphone  mike symbol
Power Amp  amp symbol
Speaker  speaker symbol
• Text decoration except for size will be eliminated.
• Picture objects and background images for the sheet or objects will all be eliminated.
[Style] attributes for boxes will be eliminated.
When you select this command, the “Export DXF” dialog box will be displayed.
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“Export DXF” dialog box

 DXF File Name
Enter a filename for the DXF file. The default file name entered here will vary according to the
currently active window.
If you click the [...] button at the right of the box, the “DXF File Name” dialog box is displayed.
Specify the DXF file filename and the folder where the file will be saved.

Enter the filename, specify the folder where the file will be saved, then click the [Save] button.
When you return to the “Export DXF” dialog box, the specified filename will be displayed in the
[DXF File Name] box.
NOTE
When you click on the [Save] button in the “DXF File Name” dialog box, the DXF file is not saved. Only when you click on
the [OK] button in the “Export DXF” dialog box, does the DXF file become saved.

 Scale
Sets the reduction ratio. When the size of the sheet is large, you can reduce it before exporting it.

 Text Style
Specifies the text font for output in DXF format. The default is the “TXT” (drawing font used in CAD).
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 Block
Sets the block form used in the sheet. Displays a list where you can select the form.

[Block]
Makes the blocks rectangular and groups the text in the port icons and port names.

[Explode]
Makes the blocks into sets of four lines, and does not group the text in the port icons and port
names.

 [Paper Size]
Sets the size of the paper.

[Preset Size]
Displays a list where you can select preset paper sizes. When you select a paper size, numerical
values are set for [Horizontal] and [Vertical].

[Custom Sizes]
Set a custom size by specifying the vertical and horizontal sizes of the sheet.

• [Horizontal] Box
Sets the horizontal width of the sheet.

• [Vertical] Box
Sets the vertical height of the sheet.

[Unit]
Selects the unit used for setting the sheet size.

[OK] Button
Saves the DXF file according to the settings in the dialog box.

[Cancel] Button
Cancels the DXF file export process.
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Printing Each Design Window
You can print out the content of each design window just as it appears on the screen. The content in
the window will be expanded or reduced in size as necessary to match the size and orientation of the
paper, and printed onto a single sheet of paper. Commands related to printing are found on the
Designer Window [Print] menu.

 [Print Setup]
When you select this command, the “Print Setup” dialog box will be displayed. Sets the paper size
and orientation.

[Paper Size]
Displays a list where you can select the paper size.

Orientation
Sets the orientation of the paper.

• [Portrait]
Prints on the paper with its long sides vertical.

• [Landscape]
Prints on the paper with its long sides horizontal.

[OK] Button
Accepts the changed settings and closes the dialog box.

[Cancel] Button
Closes the dialog box without changing the settings.
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 [“Print Preview” window]
Displays a print preview of the active design window. You can check the appearance of the page
before printing it.

[Print]
Displays the “Print” dialog box.

[Close]
Closes the print preview window.

Arranging Objects
Multiple object placement methods are available.

 Dragging from the Toolkit Window
You can drag items from the Toolkit window to the location where you want to place them in each
design window.

 Double-Clicking an Object in the Toolkit Window
You can double-click an object in the Toolkit window to place it in each design window.

 Selecting from the [Tools] Menu
Available objects are displayed on the [Area Parts List]/[Device List]/[Component List] submenus
which are accessed from the [Tools] menu. When you click an object name, the mouse pointer
changes shape. Click the location on the sheet where you want to place the object.

 Selecting from the Context Menu
If you right-click on the sheet, you will see the [Area Parts List]/[Device List]/[Component List]
commands displayed on the context menu that appears. When you click an object name on the
submenu, the mouse pointer changes shape. Click the location on the sheet where you want to
place the object.
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Device Group Selection
When laying out DME, SP2060, and ICP1 objects the “Device Group and Sampling Frequency” will be
showing.

 “Device Group and Sampling Frequency Settings” Window

Group Assignment
Selects a device group.

• Existent Group
Allows an existing group to be selected from a list. If a group does not exist it will be grayed out
in the list and cannot be selected.

• New Group
Creates a new group. The initial color of the new group's name and added devices can be
edited as required.

Sampling Frequency
Specifies the sampling frequency.
NOTE
The sampling frequency can be changed from that specified in the “Word Clock” window. Refer to “Word Clock” on
page 139 for information on the “Word Clock” window.

NOTE
A sampling frequency cannot be set for ICP1 units.
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Selecting Objects
Objects can be selected when the mouse cursor appears as crosshairs.

 Selecting with a Click
You can select an object by clicking on it. If you click another object or an empty location on the
sheet, it will cancel selection of the object you previously clicked.

 Selecting with Click + <Ctrl> Key
When you want to select multiple objects, hold down the <Ctrl> key as you click each new object
you want to select. If you hold down the <Ctrl> key and click again on one of the objects that is part
of the multiple selection, it will cancel selection of that single object.

 Selecting by Dragging
If you position the mouse in an empty location on the sheet and start dragging from there, a frame
will be displayed as the pointer moves.
Any objects within this frame will be selected.

 Changing the Selected Object Using the <Tab> Key
When a single object is selected, you can change the selection to the next object by pressing the
<Tab> key. If you press <Shift> + <Tab>, the selection moves to the previous object. The selection
order moves from left to right.
NOTE
Wires cannot be selected with the <Tab> key.

Editing Objects
Objects that have been arranged on the sheet can be edited using the [Cut], [Copy], [Paste],
[Duplicate], and similar commands in the [Edit] menu. These edit commands will also appear in the
context menu displayed when you right-click an object in the design window. Buttons for [Cut],
[Copy], and [Paste] are also available on the Designer window toolbar.
NOTE
Some objects cannot be edited.

 Undoing and Redoing Operations
You can undo operations using the [Undo] command on the [Edit] menu. You can use the [Redo]
command to redo operations that have been undone.

 Deleting Objects
Objects can be deleted by selecting them and pressing the <Delete> key.
NOTE
Some objects cannot be deleted. With some other objects, you must first make appropriate settings in a dialog box
before you can delete them.

 Moving Objects
You can move objects by dragging them with the mouse. If [Snap to Grid] is ON in the “Grid” dialog
box, the dragged objects will automatically align with the grid.
You can also move a selected object using the arrow keys. If [Snap to Grid] is ON in the “Grid”
dialog box, the selected object will move from grid line to grid line. If [Snap to Grid] is OFF, the
object will move pixel to pixel.
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Changing the Order
Objects newly placed on the sheet will be displayed above any previously placed objects they
overlap. You can change this behavior using the [Display Order] command on the [Edit] menu. Select
the object for which you want to change the display order, then select the appropriate command from
the [Display Order] submenu on the [Edit] menu.

[Top]
Moves the selected object to the top of the stack.

[Bottom]
Moves the selected object to the bottom of the stack.

[Front]
Moves the selected object up one level in the stack.

[Back]
Moves the selected object down one level in the stack.

Uppermost Object

Bottom
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Drawing and Editing Wires
Wire
Objects that are arranged on sheets in the Configuration or User Module windows can be connected
to each other by wires. Not only does this let you logically connect signal sources (output side) and
destinations (input side), it also lets you draw connections and independent lines on the display. Each
wire has at least two wire nodes. Between the nodes are line segments.

Wire Node

Line Segment

 Selecting Wires and Canceling Selection
You can select a line segment by clicking on it.
If you hold down the <Alt> key while clicking, you will select the entire wire.
NOTE
The color used when a wire object is selected can be set with [Selected Color] in the “Wire Properties” dialog box.

 Line Segment
The line width default value is set from one to five pixels in the Designer window “Preferences”
dialog box. In the “Wire Properties” dialog box, the line thickness and color can be adjusted as
required for the various wires arranged on the sheet.

Line Segment Selection
When you select a line segment by clicking on it, only that line segment is selected. If you hold
down the <Ctrl> key while clicking, you can select multiple line segments. Furthermore, if you drag
the mouse from an empty location on the sheet so that nodes are enclosed by a box, line segments
between those nodes will be selected.
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Canceling Line Segment Selection
If you select another object or an empty location on the sheet, it will cancel selection of the object
you previously clicked.
You can also cancel selections by holding the <Ctrl> key while clicking.

<Ctrl> + Click

Canceling Selection of a Line Segment
Selected with <Ctrl> + Click

 Wire Nodes
Both ends of a wire, the location where wires bend, and the location where wires diverge are called
“Nodes.” When a wire object is not selected, its nodes are not displayed. When a wire is selected,
the nodes are displayed with a red circle.

Node Selection
When you click on a node, only that node itself is selected. You can select multiple nodes by
holding down the <Ctrl> key while clicking. Furthermore, if you drag the mouse from an empty
location on the sheet so that nodes are enclosed by a box, the enclosed nodes will be selected.

Canceling Node Selection
If you select another object or an empty location on the sheet, it will cancel selection of the object
you previously clicked.
You can also cancel node selections by holding the <Ctrl> key while clicking. With this technique,
you can cancel only the node you clicked on when multiple nodes are selected.

<Ctrl> + Click
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Hotspot
The small white rectangles at the edge of objects are called “Hotspots.” Wires usually connect to
hotspots.

Hotspots

• Some hotspots do not have a connection to a logical signal within the hardware.
• Component and user module hotspots normally include logical connections.
• External device hotspots do not include logical connections.

 Selecting Hotspots
If you click a hotspot, drawing will start. To select, press <Shift> + click.
You can select multiple hotspots as follows: Select a hotspot with <Shift> + click, then select
additional hotspots using <Ctrl> + <Shift> + click.

Using Shortcuts
Press the [F2] key to select the uppermost open hot spot to the right of the selected object and
begin drawing a wire.

Press <Shift> + [F2] to select the uppermost open hot spot to the left of the selected object and
begin drawing a wire.
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Drawing Settings
Several functions are available to help ensure accurate wire drawing.

 Grid
To accurately draw in relation to the grid, turn ON [Snap to Grid] in the “Grid” dialog box.

 Draw Exact Vertical and Horizontal Lines
When [Prohibit Diagonal Connections] in the [Tools] menu is turned ON, wires will be drawn using
horizontal and vertical lines only. Diagonal wires cannot be drawn. To activate this function, select it
from the menu so that a checkmark appears next to the command name in the menu. Selected the
command again to remove the checkmark and deactivate the function.
You can also limit wire drawing to horizontal and vertical lines by holding the <Shift> key while
drawing the wires.
NOTE
You can change the positions of existing components or nodes while converting the existing wires to wires composed only of
horizontal and vertical lines by activating the [Prohibit Diagonal Connections] function. You can draw diagonal lines holding
the <Shift> key while dropping the objects.

Wire Drawing
Wire drawing starts at the positions shown in the following table:
Drawing Start Location
Hotspot

Start Method
Click

Wire End Terminal

Right-click  click [Continue Wire] on the menu

Node

Right-click  click [Start Wire] on the menu

Line Segment

Right-click  click [Start Wire] on the menu

Anywhere on the Sheet

Right-click  click [Start Wire] on the menu

NOTE
When creating diagrams the keyboard cursor keys can be used to move the mouse cursor, and the <Enter. Key can be used
to create nodes.
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 Connecting Hotspots with Hotspots
Method 1 Clicking
Click the hotspot where the connection originates to begin drawing, then click the destination
hotspot. The two hotspots will be connected by a wire.
NOTE
A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME
object's Cascade port.

NOTE
When creating diagrams horizontally aligned hot spots can be automatically connected by pressing the <Shift> + <>
keys or <Shift> + <> keys.

Method 2 Dragging
Drag from the origin hotspot to the destination hotspot.
NOTE
A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME
object's Cascade port.

Using Shortcuts
Press the [F4] key to connect the uppermost open hot spot to the right of the selected object and
the uppermost open hot spot to the left of the object on the right.

Press <Shift> + [F4] to connect the uppermost open hot spot to the left of the selected object and
the uppermost open hot spot to the right of the object on the left.
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 Connect with Bent Line
Method 1 From Hotspot to Hotspot
Click the hotspot where the connection originates to begin drawing, then click the location (which
will become a node) where you want the line to bend. Finally, click the destination hotspot to
complete the connection.

Method 2 From Hotspot to Node or Line Segment
Click the hotspot where the connection originates to begin drawing, then click the location (node)
where you want the line to bend. Click an already drawn wire node or line segment to complete the
connection. If you connect to a line segment, a node will be created there.
NOTE
A termination cannot be connected to a terminal that will be shorted. Multiple connections cannot be made to a DME
object's Cascade port.
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 Connect Multiple Hotspots in a Single Operation
Method 1 <Ctrl> Key Combinations
If you hold down the <Ctrl> key when finishing dragging, a wire will be drawn at all origin hotspots.
The wire will be connected to the destination hotspot you dragged and those that come after.
Begin dragging from the connection origin hotspot, then press the <Ctrl> key after aligning the
mouse pointer with the hotspot you will connect too. A wire will be displayed below the destination
hotspot. Finish dragging while holding the <Ctrl> key down.

Press <Ctrl> Key

Method 2 Connect Multiple Selected Hotspots
Select multiple hotspots using <Shift> + <Ctrl> + click or <Shift> + drag, then drag from one of the
selected hotspots to the destination hotspot. The selected multiple origin hotspots will all be
connected.

Multiple Hotspots Selected
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Press the [F5] key to connect the uppermost open hot spot to the right of the selected object and
the uppermost open hot spot to the left of the object on the right, and continue automatically
making sequential connections until no more open ports are available on either object. Automatic
connections will not be made over other objects.

Press <Shift> + [F5] to connect the uppermost open hot spot to the left of the selected object and
the uppermost open hot spot to the right of the object on the left, and continue automatically
making sequential connections until no more open ports are available on either object. Automatic
connections will not be made over other objects.

Press the [F8] key to clear all wires connected to the selected object.
NOTE
When multiple objects are selected these operations apply to the first object selected.

NOTE
These shortcuts can be changed as required.
 See Chapter 3 Main Panel Window, “Shortcut Keys” on page 156.
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 Starting Drawing from the End Point/Node/Line Segment of an Existing Wire
You can draw from the end or midway point of an existing wire. If you start from a node or line
segment, a branch line will be created.

Method 1 Continue Drawing from a Wire End Point
When continuing an existing wire, right-click on the wire end point, then click [Continue Wire] on
the displayed context menu.

Method 2 Start Drawing from a Node
Right-click on a wire node, then click [Start Wire] on the displayed menu. You can start a branch
wire from the node you clicked on.

Method 3 Start Drawing from a Line Segment
Right-click on a wire line segment, then click [Start Wire] on the displayed menu. A node will be
created at the point you right-clicked, and you can start a branch wire from that node.

 Drawing from Anywhere on the Sheet
Right-click the start position for drawing, the click [Start Wire] on the context menu that is
displayed. Click the location where the line should bend, then double-click at the end location to
finish drawing.
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 Finishing Drawing
When the hotspots or already drawn wires are connected, drawing is finished.
To finish drawing without connecting to a hotspot, use one of the following methods:
• Right-click the mouse
• Double-click
• Press the <Esc> key
Drawing also finishes if another window is made active.

Wire Editing
You can delete wires, change node positions, connect to other wires, and perform other wire edit
operations.

 Delete
Deleting an Entire Wire
Right-click the wire then click [Delete Wire] in the context menu

Deleting Nodes
Nodes can be deleted by selecting them and pressing the <Delete> key. Nodes on both sides of
the deleted node will become directly connected.
Selected Node

 Editing by Dragging
Moving Nodes
You can move nodes by dragging them with the mouse.

When multiple nodes are selected and dragged with the mouse, you can move all selected nodes
simultaneously.

288

DME Designer Owner’s Manual

Chapter 4 Designer

Moving Line Segments
To move a line segment, select the nodes on both sides of the segment, and drag one of the
nodes.

 Connecting to Other Wires
If you drag a node and lay it over another wire, the two will be connected at that position. If you
drag it to a line segment, a node will be created.
Created Node

Logical connection
A connection from a source (output side) signal to a destination (input side) signal is called a “logical
connection.” If a logical connection is present in a configuration, the actual hardware signal will be
connected. A single wire can make a single logical connection.
Logical connections are possible only in the Configuration window and the User Module window.
Wires in the Area window or Zone window can be drawn for display only. Even in the Configuration
window and User Module window, you can also draw wires for display only.
Window
Area Window

Wire
Drawing for display only

Zone Window

Drawing for display only

Configuration Window

Logical connection and drawing for display only

User Module Window

Logical connection and drawing for display only

 Situations Where No Logical Connection Is Created
•
•
•
•

Both sides are source (output side) signals
Both sides are destination (input side) signals
Two source (output side) signals are connected to a destination
There are two destination (input side) signals, and the wire is not connected to a source (output
side) signal.
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Show Unconnected Node
Turn [Show Unconnected Node] in the [Tools] menu ON to display unconnected nodes as red dots.
The [Show Unconnected Node] ON/OFF settings are individually saved with each Configuration
Window.
The ON/OFF status of this feature in other Configuration Windows will not affect the current
window. If [Show Unconnected Node] is ON, it will automatically be turned OFF if the configuration is
edited.
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Adding, Deleting, and Renaming a Zone
At least one zone is included within an area. In the default Area window that zone will be named
[Zone1]. Multiple zones can be arranged in an Area.
When you click the [Zone Manager] command on the [Tools] menu, the “Zone Manager” dialog box is
displayed. Here you can add, delete, or rename a zone.

“Zone Manager” dialog box

Zone List
Lists the zones included in the project. To change settings for a zone, select it by clicking it in the
list.

[Add] Button
Adds a zone. Clicking here displays the “Please enter new name” dialog box. Enter a new name,
then click [OK]. A zone will be added.

[Delete] Button
Deletes the zone selected on the list. Clicking here displays the “Are you sure?” dialog box. Click
the [OK] button, and the zone will be deleted. Click the [Cancel] button, and the deletion will be
cancelled.

NOTE
A minimum of one zone is required. When only one zone remains, deletion is impossible.
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[Rename] Button
Changes the name of the zone selected on the list. Clicking here displays the “Enter new name for
the current zone name” dialog box. Enter a zone name, then click the [OK] button.
NOTE
The current name of the zone you will be renaming is displayed in the “Current Zone Name” box of the “Enter new name
for current zone name” message.

[Close] Button
Closes the “Zone Manager” dialog box.
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Changing Device Groups
A zone can include up to 32 device groups, and all devices will belong to one of those groups.
Click [Device Group Manager] in the [Tools] menu to open the “Device Group Manager” window, via
which device groups can be changed as required.

“Device Group Manager” Window

Device Group
All device groups in the zone being edited appear in the list. Click the Slick a device group to
select it for editing.

• Name
The name of the device group.

• Attribute
The type of device group.

• Default Color
The default color for devices that are added to the group.

[Delete] Button
Deletes the device group currently selected in the list. An “Are you sure” confirmation box will
appear when this button is clicked. The selected device group will be deleted when the [OK]
button is clicked. Click the [Cancel] button to abort the delete operation.

NOTE
Device groups cannot be deleted when they include assigned devices.
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[Rename] Button
Renames the device group currently selected in the list. The “Enter new name for current device
group” window will appear when this button is clicked. Enter a new name for the device group and
click the [OK] button.
NOTE
The current name of the selected device group will appear in the name entry window, in place of “current device group”
in the window name: “Enter new name for current device group”.

[Color] Button
Species the default color for new devices added to the currently selected device group. The
“Select Color” window will appear when this button is clicked.
Refer to “The Select Color Window” on page 265 for information on the “Select Color” window.

Apply Default Color to All Existing Devices
When checked the color of all existing devices will change accordingly when the initial default
device color is edited.

[OK] Button
Closes the “Device Group Manager” window.
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Adding, Deleting, and Renaming a Configuration
A device group will include at least one configuration, and others can be added as required.
When you click the [Configuration Manager] command on the [Tools] menu, the “Configuration
Manager” dialog box is displayed. Here you can add, delete, or rename a configuration.
NOTE
Simply adding a new configuration does not make the new configuration active. To switch to the new configuration it must be
clicked in the Navigator window (page 197).

“Configuration Manager” dialog box

Device Group
Select the device group to be edited from the list.

Configurations
Lists the configurations included in the device group being edited. To change settings for a
configuration, select it by clicking it in the list.

[Add] Button
Adds a configuration. Clicking here displays the “Please enter new name” dialog box. Enter a
configuration name, then click [OK]. A configuration will be added.

[Delete] Button
Deletes the configuration selected on the list. Clicking here displays the “Are you sure?” dialog
box. Click the [OK] button, and the configuration will be deleted. Click the [Cancel] button, and the
deletion will be cancelled.

NOTE
A minimum of one configuration is required. When only one configuration remains, deletion is impossible.
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[Rename] Button
Changes the name of the configuration selected on the list. Clicking here displays the “Enter new
name for the current configuration” dialog box. Enter a configuration name, then click the [OK]
button.
NOTE
The current name of the configuration you will be renaming is displayed in the “Current Configuration Name” box of the
“Enter new name for current configuration name” message.

[Duplicate] Button
Copies the configuration selected on the list. Clicking here displays the “Please enter new name”
dialog box. Enter a configuration name, then click the [OK] button.

[Close] Button
Closes the “Configuration Manager” dialog box.
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Area Window
In the Area window, the area is designed by arranging objects on a design sheet, When you click
“Area” in the Navigator window, the Area window becomes active. You can also open the Area window
using the [Area] command in the [View] menu.
The following objects can be arranged in the Area window:
• Zone
• External Device
• Picture
• Text
• Box
• Ellipse
• Wire
Title Bar
Menu Bar
Tool Bar
Wire (Line)

Zones

Picture
(Image)
Text (Text Object)

Toolkit Window

Ellipse (Circle)
Wire
Box
(Rectangle)

Legend

Sheet

 Title Bar
You can move windows by dragging the title bar.

 Zone
Zones are added and deleted using the “Zone Manager” dialog box. You cannot perform
operations such as deletion, cut, or copy. You can change the position and design of zone objects
in the Area window. Double-click to open a Zone window.

 Objects
Various types of objects can be placed, cut, copied, pasted, deleted, moved, and manipulated in
other ways.

 Legend
Double-click “Legend” to show the “Edit Legend” dialog box where the title fields can be edited.
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Arranging Objects
Various types of objects can be placed in the window by dragging them from the Toolkit window. You
can also place objects by double-clicking them in the Toolkit window. You can also display the [Area
Parts List] from the [Tools] menu or from the context menu that appears when you right-click on the
sheet.

Zone Window
In the Zone window, the zone configuration is designed by arranging zone devices on a design sheet,
A zone configuration can be created that is the same as the actual hardware arrangement.
To display the Zone window, double-click in the Area window. When you click a configuration in the
Navigator window, it becomes active.
The following objects can be arranged in the Zone window:
• DME
• ICP
• SP2060
• External Device
• Picture
• Text
• Box
• Ellipse (Circle)
Title Bar
Menu Bar
Tool Bar
DME

ICP

Picture (Image)

Text
(Text Object)

Toolkit Window
Box (Rectangle)

External Device

Ellipse (Circle)

Legend
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 Title Bar
Displays the zone name you have in the “Zone Manager” dialog box. There is always one zone
named [Zone 1] in a newly created project.

 Configuration
You can create multiple configurations within a zone, but they cannot be arranged within the Zone
window. The devices can be arranged in the Zone window common to multiple configurations. To
switch configurations, click the desired configuration in the Navigator window.
You can add, delete, and rename configurations in the “Configuration Manager” dialog box.

 Objects
You can perform edit operations such as place, cut, copy, paste, delete, and move to devices and
shapes. If you double-click on a device arranged in the window, a Configuration window or dialog
box will open.
Device

Action When Double-Clicked

DME/SP2060

Displays Configuration Window.

ICP

Displays “Control Panel Properties” dialog box. (Double-click the label)

External Device

Opens external application linked to the device.

Arranging Objects
You can place objects by dragging them from the Toolkit window. You can also place objects by
double-clicking them in the Toolkit window. The same objects are displayed in the [Device List]
submenu on the context menu that appears when you right-click the [Tools] menu or on the sheet.
For information about the “Device List,” see page 201.
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 Placing DME or SP2060
In the Toolkit window [DME24N], [DME64N], [DME8i-C], [DME8o-C], [DME4io-C], [DME8i-ES],
[DME8o-ES], and [DME4io-ES] icons are located in the [DME] folder, and an [SP2060] icon is
located in the [Speaker Processor] folder. These icons can be dragged to the zone window.

 ICP Placement
Just like for a DME or SP2060, placing an ICP is to drag the icon from the Toolkit window. If there
are multiple ICPs in a hardware configuration, create an equivalent number of ICP objects.

In the Toolkit window [ICP1] icons are located in the [ICP1] folder. This icons can be dragged to the
zone window.
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Configuration Window
The Configuration window is used for arranging components on the sheet and making logical
connections. It is displayed when you double-click on a DME or SP2060.
NOTE
SP2060 configurations cannot be edited.

Tool Bar

Component

Sheet

Wire
User Module

I/O Component
Legend

 Title Bar
Displays “Device name (Zone name/Device Group name/Configuration name).” The configuration
window using Configuration1 for a DME64N placed in Device Group1 of Zone1 will be “DME64N
(Zone1/DME Group1/Configuration1).” The device name is set in the properties for the device
placed in the Zone window.

 Objects
Objects such components, user modules, and shapes are arranged in the Configuration window.
When you double-click a component placed in the window, the editor set in “Double Click Action”
in “User Module Properties” will open.

 I/O Component
Depending on the settings for the DME placed in the Zone window, I/O components will be
automatically placed or added.
• I/O components can be arranged in the DME24N, DME Satellite and SP2060 configuration
window.
• When “Show Cascade Port” is ON in the DME64N “DME Device Properties” dialog, Cascade I/O
is added automatically.
• When you set a slot in the properties for a DME placed in the Zone window, Slot I/O will be
automatically added.
You cannot apply edit operations like cut/copy/paste/duplicate to I/O components, Slot I/O, and
Cascade I/O.
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Placing Components
You can place objects by dragging them from the Toolkit window. You can also place objects by
double-clicking them in the Toolkit window. The same objects are displayed in the [Component List]
submenu on the [Tools] menu or on the context menu that appears when you right-click on the sheet.
For information about the [Component List] in the Configuration window, see page 201.

NOTE
The components that can be placed in the configuration window vary according to the device type. For details, see
“Component List” on page 372.

NOTE
If the [Matrix Mixer 64 input 64 output] or the [Matrix Mixer 64 input 32 output] components are placed in the DME64N
configuration window, you will not be able to use other components, even though the window does not reach 100 percent.
The [Matrix Mixer 64 input 64 output] or [Matrix Mixer 64 input 32 output] components cannot be used in the DME24N and
DME Satellite.

 Arranging a Number of Components of the Same Type
You can arrange a number of components of the same type. If there are two or more of the same
component, numbers will be attached to their names as follows: “Compressor (2),” “Compressor
(3)” and so on. Multiple components placed in the configuration are independent, and you can set
different parameters for each of them.
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 SP2060 Configuration Window

[Input A/B Link] Button
Although SP2060 configurations cannot be edited, the [Input A/B Link] status can be changed.
Clicking this button alternately turns INPUT A/B linking ON and OFF. When switched ON the input
level, EQ, and Delay component parameters are copied from Input A to Input B, and are thereafter
linked.

Probe Monitor
Probe monitor is a function that lets you monitor output ports in your configuration with headphones.
You can turn it ON or OFF using [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on
the toolbar. The probe monitor can be set to ON or OFF for each DME64N/24N.
The probe monitor can be used only when online with the DME64N/24N and Configuration window or
user module active.
NOTE
DME Satellite and SP2060 do not support the probe monitor.

 Probe Monitor Procedure

1 Turn the probe monitor ON.
Click [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on the toolbar.
The shape of the mouse pointer changes.

2 Click the output port you want to monitor.
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The output port you clicked will be selected and monitoring will begin.
Monitor object

If you click another output port, the location being monitored will change.

 L/R Selection
To monitor the left channel and right channel simultaneously, <Shift> + click on the left channel,
then do the some for the right channel.

 Exiting the Probe Monitor
Click [Probe Monitor] in the [Tools] menu or the [Probe Monitor] button on the toolbar to turn OFF
the probe monitor. When probe monitor is turned off, the mouse pointer returns to its normal shape.

 Monitoring the Second or Later Time
The software remembers the location being monitored even when probe monitoring is turned OFF.
The next time probe monitoring is turned ON, the location that was being monitored previously will
be selected.
NOTE
When you go offline probe monitoring is disengaged and the monitor point will not be restored when you go online again.
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Show Signal Delay (Delay Display Value)
The signal delays according to the processing time in the audio processor. The [Show Signal Delay]
command from the [Tools] menu calculates a delay value and displays it for the component. Selecting
this command switches delay value display between ON and OFF. The mark is lit when display is
turned ON.
When turned ON, the settings are compiled to obtain a delay value, which is displayed for
components and lines. The delay value obtained through compilation remains valid until the
configuration is edited. Sample units are used to display the delay value.
This is linked with the [Show Signal Delay] button on the toolbar.
ON and OFF settings for [Show Signal Display] are saved for each configuration window. Switching
the setting between ON and OFF in another configuration window has no effect on the current window.
If you edit the configuration while [Show Signal Delay] is turned ON, it will be automatically turned off.

When you turn ON [Show Signal Delay], the delay value appears
above the object.

Delay values for components and I/O components are displayed at the lower center of the object.

Delay values for wires are displayed beside the input port of the connected object.
NOTE
Delay values for SPX components vary depending on the Bypass ON/OFF status, because SPX components add the effect
signal to the original signal. When [Show Signal Delay] is turned ON, the delay value for the Bypass ON status will be
displayed.

NOTE
Delay values for Wav File Player components are displayed for external inputs. Delay values for local Wave files cannot be
displayed.

NOTE
If there is an obvious problems with the connections the “Some errors occurred while compiling. Please try Analyze, and the
error of the reason is displayed” error message will appear. Use the “Analyze” dialog box to determine the reason for the
error.

NOTE
A progress bar will appear during compilation, but in some cases it may not exactly match the progress of the compilation
process. Also, the appearance of the progress bar is no guarantee that compilation will be completed successfully. If
compilation continues for an inordinately long period of time, click the [Abort] button to stop processing. Try eliminating
unnecessary components and connections, and replacing components that place a heavy load on resources with more
efficient ones, then compile again.
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Monitoring Point List
When you click [Monitoring Point List] in the [Tools] menu, the “Monitoring Point List” dialog box is
displayed. This allows registering and editing “monitoring points” that can be monitored via the
DME64N/DME24N PHONES jack. Monitoring points can be specified not only at the slot and analog
inputs and outputs, but also at points between the components.
NOTE
Monitoring points can be edited only by users for whom the [Edit] security checkbox has been turned ON.

 [Cut] Button
Cuts the selected monitoring point information. When monitoring point information is cut,
information below that point moves up.

 [Copy] Button
Copies the selected monitoring point information.

 [Paste] Button
Pastes the copied monitoring point information at the selected line.

 [Insert] Button
The copied monitoring point information is inserted at the selected point.

 [Clear] Button
Deletes the selected monitoring point information.
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 Monitoring Point List
Displays and allows editing of monitoring point information.

[No.]
Displays the numbers for monitor link points. Numbers are assigned in order from the top.

[Label]
Displays and allows editing of monitoring point names. Clicking here selects the text. You can then
enter a new name.

[Component L]
Sets the monitoring point L channel component. Clicking here displays a list of components
arranged in the active configuration window. You can then select components for monitoring.
NOTE
Components arranged in user modules are also displayed in the list. However, components for user modules for which
security is set will not be displayed.

[Port L]
Sets the monitoring point L channel port. Clicking here displays a list of ports for the component
selected in the [Component L] field. Click the port you want to monitor.
NOTE
If you click a port in the designer window while the “Monitoring Point List” dialog box is displayed, the port will be
registered to the monitoring point of current selected row. If you will register the monitoring points as stereo, click a port
while holding down the <Shift> key to register Component L and Port L, then click a port again while holding down the
<Shift> key to register Component R and Port R. If you will set Label automatically, click a port while holding down the
<Ctrl> key to assign the component name and port name to Label.

[Component R]
Sets the monitoring point R channel component. Clicking here displays a list of components
arranged in the active configuration window. You can then select components for monitoring.
NOTE
Components arranged in user modules are also displayed in the list. However, components for user modules for which
security is set will not be displayed.

[Port R]
Sets the monitoring point R channel port. Clicking here displays a list of ports for the component
selected in the [Component R] field. Click the port you want to monitor.

 [OK] Button
Updates the settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing the settings.
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Analyze (Configuration Analysis)
When you click the [Analyze] command on the [Tools] menu or the [Analyze] button on the toolbar, the
“Analyze” dialog box is displayed. The wire connections in the currently active configuration window
are analyzed, and the results are displayed in the “Analyze” dialog box.
Because this function allows you to make sure there are no problems with component arrangement
and wires without connecting to the DME unit, it is useful for eliminating complier errors before
executing Synchronization.
NOTE
The [Analyze] command on the [Tools] menu can be selected only when a configuration window is active.

 Message Box
Displays the progress of the analysis operation. When the analysis finishes, the results are
displayed.
If errors are detected during analysis, they will display as shown below.

 [Close] Button
Closes the dialog box.

 Progress Bar
A progress bar will appear during analysis, but in some cases it may not exactly match the
progress of the analysis process. Also, the appearance of the progress bar is no guarantee that
analysis will be completed successfully. If analysis continues for an inordinately long period of time,
click the [Abort] button to stop processing.
NOTE
If the analysis process fails, try eliminating unnecessary components and connections, and replacing components that
place a heavy load on resources with more efficient ones, then run the analysis again.

NOTE
Once a configuration has been analyzed or compiled successfully, subsequent analysis or compilation will run quicker
unless changes are made to the configuration. Also, if you save the project file the analysis/compilation data is saved as
well.
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User Module
User Modules
A module treated as a single component that combines a number of other components is called a
“user module.” A user module can be arranged in the Configuration window just like any other
component. User module editing consists of placing the component and making logical connections
with wires, the same as for configurations.
Saved user modules are displayed in the Toolkit window and can be used as templates. User modules
are saved in project files, but user module templates can also be exported as files and used in other
projects.
A “UserModule” folder will be created in the folder specified in [Contents Folder] in the “Preferences”
dialog box in the Main Panel window. User modules will be saved there.
Refer to “User Module Editor” on page 330 for more information on the dedicated user module control
window.
NOTE
The Main Panel Menu “Preferences” dialog box is displayed using [Preference] in the [File] menu.

Creating User Modules
When you place a blank user module in the Configuration window, a new user module is created.
When the project is saved, the user modules are also saved in the project file.

1 Make the Configuration window active.
2 Click the [+] next to [User Module] in the Toolkit window.
The items in the level below the [User Module] folder will be displayed.

3 Drag the [Blank User Module] to the Configuration window.

When you release the mouse button at the location where you will place the user module, the “User
Module Properties” dialog box is displayed.
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4 Here you can set object properties.
[Inputs/Outputs Sets] is set to 1. Set the required number of ports.

5 Click the [OK] button.
A user module will be created, and placed in the Configuration Design window.

The user module properties can also be changed later. For information about the “User Module
Properties” dialog box, see “User Module” on page 243.

Saving User Modules
When user modules are saved using the [Save User Module] command, they are displayed
below [User Module] in the Toolkit window and can be used as templates.
• User modules placed in the configuration window can be saved with project files, but user
module templates are saved as files in a specific folder on the computer.
• User module templates can be exported and imported as user module template files. The export
file includes the component wiring/connection, library, and user module editor data.
• If a user module template is placed in the configuration window and then edited and saved with a
project file, the template will not be changed. Using the [Save User Module] command you can
either overwrite the original template or save the template with a new name.
• User modules created from templates use the same library as the original template. User module
templates that use the same library are categorized as a “user module group.” User module
templates are displayed in the appropriate group in each window.
• If a project is opened on a different computer, only user modules placed in the configuration
window will reappear. Export and import the data as a DME Designer All file in order to reproduce
the user module templates as well.
NOTE
Parameter links (local links) and component links are saved with user modules.
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Save the User Module using the [Save User Module] command on the [Tools] menu. The [Save User
Module] command can be used only when a user module is selected in the Configuration window.
When you select the command, the “Save User Module” dialog box will be displayed. Enter a name for
the User Module, then click the [OK] button.

Set [Double Click Action], [Security Settings], [Default Library], and [User Module Group] at the right
part of the “Save User Module” dialog box.
They correspond to the same items in the “User Module Properties” dialog box. When saved with
different settings than the “User Module Properties” dialog box, the saved settings are immediately
applied.

 Double Click Action
Initial setting of the window that opens when you double-click on a user module placed in the
component editor.

[Open User Module Design Window]
Opens the User Module Design window.

[Open User Module Editor]
Opens the User Module editor.

 Security Settings
Initial settings of user module security.

[Enable Security]
Enables user module security.
If you place a checkmark here, the “Set Password” dialog box appears. Enter the same password
into the [Password] box and [Confirm Password] box, and click the [OK] button.
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[Set Password] Button
Changes the password. Clicking here displays the “Input Password” dialog box. Enter the current
password and click the [OK] button. The “Set Password” dialog box will be displayed. Enter the
same password into the [Password] box and [Confirm Password] box, and click the [OK] button.

 Default Library
Specifies the library file to be imported when creating a user module from a template.
Refer to “Library” on page 364 for information.

 User Module Group
Sets the user module group (a group of user modules that use the same library).
When saving a new user module, enter a name for the user module group in the User Module
Group Name field.
When saving a user module created from a template you can specify whether it is saved in the
same group as the original template or a new group. To save the user module in a new group
check the [Save in New User Module Group] checkbox, and enter the name of the new group in
the User Module Group Name field.
If you try to save a user module with the same name as an already saved user module, a message
asking “xxxxx already exists. Do you wish to overwrite it?” will be displayed. To overwrite, click the
[Yes] button. To abort saving, click the [No] button to close the “Save User Module” dialog box. To
change the name, click the [Cancel] button, and change the file name in the “Save User Module”
dialog box.

NOTE
When the “Save User Module” dialog box is displayed, the name set in the user module’s “User Module Properties”
dialog box will be entered into the [File name] box. If you change the name of a user module and save it using the “Save
User Module” dialog box, the filename in the user module and the user module name displayed in the Toolkit window will
also change.
The [Label] box displayed in the “User Module Properties” dialog box will not change.
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Editing User Modules
User modules can be edited in the User Module window. Components layout and logical connections
are set up in the design worksheet. The design worksheet can be opened by selecting [Open User
Module Design Window] from the contextual menu of user modules in the configuration window. If
[Open User Module Design Window] is selected as the [Double Click Action] in the “User Module
Properties” window, the design worksheet can also be opened by double-clicking a user module.
 “User Module Properties” (page 245).
Menu Bar
Tool Bar
Title Bar
Component

Wire

 Title Bar
The user module name (Zone name/Device Group name/Configuration name/Device name) is
displayed on the title bar. User module names are set in the “User Module Properties” dialog box.

 Objects
You can place, cut, copy, paste, delete, and move component and shape objects. When you
double-click an object placed in the window, the component editor will open.

 Placing Components
Components are placed the same as in the Configuration window.
You can place objects by dragging them from the Toolkit window to the User Module window. You
can also place objects by double-clicking them in the Toolkit window. The same objects are
displayed in the [Component List] submenu on the [Tools] menu or on the context menu that
appears when you right-click on the sheet.
For information about the User Module window [Component List], see page 202.
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 Placing a Number of Components of the Same Type
You can arrange a number of components of the same type. If there are two or more of the same
component, numbers will be attached to their names as follows: “Compressor (2),” “Compressor
(3)” and so on. Multiple components placed in the configuration are independent, and you can set
different parameters for each of them.

User Module Manager
When you click [User Module Manager] on the [Tools] menu, the “User Module Manager” dialog box is
displayed. Edits, renames and deletes user module templates.

 User Modules
User modes saved as templates are displayed in the list. Select the target user module by clicking
on it.
NOTE
Only user modules saved can be displayed. User modules placed in the component editor are saved in project files, and
can be used without being saved as files. However, they will not be displayed in the “User Module Manager” dialog box
list.

NOTE
When a user module to which security has been applied is selected, a password will be required for all operations other
than [Delete] and [Import].
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 User Module Settings
Displays the settings for the user module selected on the list. To change the settings, click the
[Change settings] button to open the “User Module Settings” dialog box (page 316).

Double Click Action
Displays the default action when user modules in the configuration window are double-clicked.

Security Settings
Displays the security setting for the user module selected on the list.

Default Library
Displays the default library file for newly-created user modules.

 [Import Library] Button
Loads a file from the specified folder into the library.

 [Export Library] Button
Saves the library to a file.

 [Rename User Module Group] Button
Changes the User Module Group name selected on the list. Click this button to open the “Rename
User Module Group” dialog box, enter the group name at the [Name] box, and then click [OK].

 [Delete User Module] Button
Deletes the user module selected on the list.

 [Import] Button
Imports the user module settings and library from the user module export file.
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 [Export] Button
Saves the user module data (component wiring/connection, library, and user module editor data) to
a user module export file.
Click to display the Export dialog, All features of this dialog window are the same as the standard
Windows file save dialog, except for the [Export Library] option.
[Export Library] can be sued to select the library to be saved.

 [Close] Button
Closes the dialog box.

“User Module Settings” Dialog Box
Click the [Change Settings] button in the “User Module Manager” dialog box to open the “User
Module Settings” dialog box. Here you can edit the user module template name, group name, and
security settings.
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 Group/Name
Displays the pre-edit user module group name and user module name.

 User Module Name
Specifies the user module name.
NOTE
Since the user module name is used as a file name, characters that cannot be used for file names cannot be used for user
module names.

 Double Click Action
Specifies the default action when user modules in the configuration window are double-clicked.

[Open User Module Design Window]
Opens the User Module Design window.

[Open User Module Editor]
Opens the User Module editor. The user module editor is a window where controls for components
that are placed in a user module can be laid out and their parameters changed. For more
information about the user module editor, see “User Control Editor”/User Module Editor” on
page 325.

 Security Settings
Makes security initial settings for the user module selected on the list.

[Enable Security]
Enables user module security. If security is enabled, a password is requested when attempting to
open the User Module window. If the correct password is not entered, the window will stay closed.
When you place a checkmark here, the “Set Password” dialog box appears. Enter the same
password into the [Password] box and [Confirm Password] box, and click the [OK] button.

To disable user module security, turn OFF the checkbox. If you click the checkbox when it already
has a checkmark, the “Input Password” dialog box appears. Enter the password set for this user
module, and click the [OK] button. You can disable security in this way. If you do not enter the
correct password, you will not be able to disable security.

[Set Password] Button
Changes the password. Clicking here displays the “Input Password” dialog box. Enter the current
password and click the [OK] button. The “Set Password” dialog box will be displayed. Enter the
same password into the [Password] box and [Confirm Password] box, and click the [OK] button.
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 Default Library
Specifies the library file to be imported when creating a user module from a template.
Refer to “Library” on page 364 for information.

 User Module Group
Sets the user module group. To change the user module group, check the [Save in New User
Module Group] checkbox, and enter the name of the new group in the User Module Group Name
field.
NOTE
User module groups cannot be changed to an existing group.

NOTE
If the user module group is changed without changing the user module name, no libraries can be referenced. To use a
new library you will also need to change the user module name.

 [OK] Button
Applies the settings and closes the dialog box.

 [Cancel] Button
Closes the dialog box without changing any settings.
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Component Editor Window
Component parameters are edited in the component editor. The same component can be placed
multiple times on the same sheet in a Configuration or User Module window. If there are multiple
examples of the same component in a configuration window or user module window, each component
is independent and its parameters are set individually in a separate Component Editor window.
When you double-click on a component located in a Configuration window, the Component Editor
window will open. There is not just one window that is called the component editor. The contents of the
editor and the name on the title bar will differ according to type of component for which the window
was opened.

Names and Functions
The contents of the Component Editor window vary according to the component.
Library

Back Button

Title Bar
Snap
Graph

Meter

[ON] Button

Slider

Edit Box
Knob
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 Title Bar
Displays the label. Label settings are made in the “Component Properties” dialog box. For
information about component labels see “Component” (page 235) in “Objects.”.

 Back Button
This button appears in the child window of windows that have a parent-child relationship, and can
be clicked to return the parent window.

 Status Bar
Component ID

Component Name

Parameter ID

Component Name
Displays the component name.

Component ID
Displays the component ID.
NOTE
When controlling the DME64N/24N by connecting an RS-232C compatible controller to the [REMOTE] terminal, a
component ID is required for distinguishing the same components in the DME64N/24N. The component ID is included in
the signal that controls the component parameters. For details about control methods, contact your nearest Yamaha
representative or the authorized distributor at the end of the DME64N/24N Owner’s Manual.

Parameter ID
Displays the parameter ID for controls that are being operated.

 Snap
Up to four component editor parameter sets can be recorded temporarily. You can switch between
parameter sets using buttons.
Parameter sets can be copied by dragging and dropping a button onto any other button. Copy can
also be carried out from the contextual menu that appears when a button is right-clicked.
 See “Snap” on page 362

 Library
Saves and recalls component editor parameter sets as files.
 See “Library” on page 364.
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 Knob

Drag to adjust the parameter.
You can change the way knobs operate, using the [Component Editor] tab  [Knob Mode] setting
in the “Preferences” dialog box.

“Preferences” dialog box

 “Component Editor” tab (page 73)
NOTE
To make a finer setting, press the <Shift> key while dragging the knob when [Knob Mode] is “Linear”.
If you click a knob while pressing the <Ctrl> key, the setting will return to its default value.

 Slider

Slider
Scale

You can change the parameter by dragging the slider.
You can set the action that results from using the mouse on the scale area with [Component Editor]
tab  [Slider Mode] in the “Preferences” dialog box.
“Preferences” dialog box  “Component Editor” tab (page 73)
NOTE
To make a finer setting, press the <Shift> key while dragging the slider.
If you click a slider while pressing the <Ctrl> key, the setting will return to its default value.

 Buttons
There are several types of buttons.
• Switches between ON/OFF. When turned on, the button lights up. The color depends on the button’s
function.

When turned ON

When turned OFF

• In button sets of this type, you can select one of several buttons. When you do all other buttons in the
set turn off.

DME Designer Owner’s Manual

321

Chapter 5 Components

• Click here to execute a command.

Click this button

to switch all channels
in the block.

• Displays a menu.

• Displays another window.
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 Edit Box

Displays current values for settings. You can modify values by typing from the keyboard or using
the mouse. When a value is changed, the knob or slider moves.

Mouse-over
When [Edit Box Zoom] in the [Component Editor] tab of the “Preferences” dialog box is checked,
the edit box will zoom when the mouse is positioned over it (mouse-over).
“Preferences” dialog box
 “Component Editor” tab (page 73)

Click
Text in the selected edit box will turn red. Values can be entered and edited via the keyboard. It is
not necessary to enter the unit. Press the <ENTER> key to confirm the entry and display the unit.

Changing Values Using Spin Boxes
When the mouse pointer is placed over an edit box, a spin box appears. Clicking the up arrow
button [] increases the value, while clicking the down arrow [] decreases it.

Double-click
Selects a number. You can change the selected number using the keyboard. There is no need to
enter units. When you press the <Enter> key, the numbers you entered will be set and the units
displayed.

Enter a number from
the keyboard.

Set the value with
the <Enter> key.

Moving with the <Tab> Key
If you press <Tab> key while an edit box is selected, the selection will move to the next edit box.
If you press <Shift> + <Tab>, the selection moves to the previous edit box.

DME Designer Owner’s Manual

323

Chapter 5 Components

Changing Selections with the Key/Mouse Wheel
You can modify values in selected edit boxes using the direction keys or the mouse wheel.

• Up and Down Arrow Keys
Increases or decreases number settings.

• <PageUp> Key/<PageDown> Key
Increases or decreases number settings in large increments. The <PageUp> key increases
and the <PageDown> key decreases the setting.

• <Enter> Key
When you press the <Enter> key, the numbers you entered will be confirmed.

• <Ctrl> Key + <Enter> Key
When you press the <Ctrl> + <Enter> key, the setting will return to its default value.

• Mouse Wheel
Rolling the mouse wheel upward (away from you) increases the value. Rolling it down
(towards you) decreases the value.

• Dragging
Dragging upward increases the value, while dragging downward decreases it.

• <ESC> Key
The <ESC> key can be used to cancel a value being entered.

 Graph
Control Point

Displays parameters graphically. When parameters are changed, the graph also changes.
In graphs that have control points, you can adjust parameters by dragging the points. On graphs
with control points that are limited to movement in one direction only, aligning the mouse pointer
with the control point and pressing the mouse button causes the mouse pointer to change to a
double-headed arrow pointing in both directions of movement. Change the parameter by dragging
in the directions of the arrow.
Control points that can be dragged in any direction usually have their position determined by
multiple parameters in the component editor. These multiple parameters can be adjusted by
dragging the point.
When there are multiple control points in the graph, they are identified by their colors. A bar with the
same color as each control point can be found below the corresponding knob or edit box.
NOTE
When a graph that has control points is copied to the User Control Editor or User Module Editor, the controls points will
not be displayed. The controllers assigned to the corresponding parameters must also be copied to display the control
points.
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User Control Editor/User Module Editor
User Control Editor
The user control function lets you lay out a set of component controls in the Configuration window or
User Module window, and create a control window with them. The controls in the user control editor
are linked to the controls for the original component. If the parameters are changed in the user control
editor, the parameters will change in the same way in the component editor. If parameters are
changed in the component editor, the controls in the user control window will also change in the same
way.
You can create a compact control window by only including controls for parameters that are used
frequently.
You can also lay out controls for multiple components, so that you can adjust parameters for them from
a single window.
Component Editor

User Control Editor

Laid Out Controls

Controls Laid Out
in the User Control

Edit Palette

There is also a [Library] button in the user control editor, which you can use to save parameters to the
library.
User controls are created by selecting [View] menu  [User Control]  [New User Control] in the
Main Panel window. Created user controls are displayed in the [View] menu  [User Control]
submenu. If you select one, a window will open for it. The controls which can be opened by the user
control editor are automatically set according to the user security settings of the currently logged in
user.
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 [User Control] Menu
User controls are displayed in the [View]  [User Control] submenu of the Main Panel window. If
you click the [User Control] button in the Main Panel window, you will display the same menu as the
[View] menu  [User Control] submenu.

User Control Name
Displays a menu of user controls included in the current configuration of the current zone. Clicking
one of the user controls opens the user control editor. A checkmark appears next to already open
windows.

New User Control
When you select the “New User Control” command, the “New User Control” dialog box will be
displayed.

 Creating New User Controls
New user controls are added in the “User Control Manager” dialog box.

1 Click [User Control Manager] on the Main Panel window [Tools] menu.
The “User Control Manager” dialog box will be displayed.

2 Click the [New] button.
The “New User Control” dialog box will be displayed.

3 Enter the name for the new user control into the [Name] box.
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4 Sets security for User Control.
Different settings are provided for individual security levels and users.
Security cannot be set higher than the user security level.
NOTE
If the [Open User Control at startup] checkbox is checked, the user control will open automatically when the project file
is opened.

Click the [User Level] [] button to select a security level.

Use [User Name] to select a user.

5 Click the [OK] button.
The user control will be created and displayed on the list in the “User Control Manager” dialog box.
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6 Click the [OK] button in the “User Control Manager” dialog box.
When a new user control is created, it will be displayed in the [View] menu  [User Control]
submenu in the Main Panel window. If you click the control, it will be displayed in a user control
editor window.
[Snap] and [Library] appear appears in a new user control.

 User Control Security
Security can be set independently for each User Control. User Control levels higher than the user
security level will not be displayed in the menu or the User Control Manager dialog box.
The security level settings for both the user control and the user affect editing and display of user
controls.

 User Control Security Level
Security 1 ~ 10 can be set for each level or user. Level 1 is the highest level and 10 is the lowest.
If the security level for a user control is set to 2, only users at level 1 or level 2 can display or edit it
Security levels for user controls can be changed in the “User Control Manager” dialog box by a
user who has logged on at a security level equal to or higher than the user control.

1 Click [User Control Manager] on the Main Panel window [Tools] menu.
The “User Control Manager” dialog box will be displayed.

2 Changing User Control Security
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• To Change the Security level
Click the [Security Level] box of the User Control to be changed.
The security level list will appear.

NOTE
The levels displayed on the list will differ according to the security level of the user.

Click the level to be set for the User Control.
The selected level will be displayed in the [Security Level] box.

• Setting Security for Individual Users
Click the [User] box of the User Control to be changed.
The user list will appear.

NOTE
The users that can be selected will depend on the user security level.

Click the user to be set for the User Control.
The selected user name will be displayed in the [User] box.

3 Click the [OK] button.
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 User Security Settings
In the “Security” dialog box in the Main Panel window, you can set the user control levels at which
to allow or disallow editing and display.
A user can edit user controls if a check has been placed for that user in the [Operation Security] 
[Edit] checkbox. User controls at a level equal to or lower than the level set in [Operation Security]
 [User Control Level] will be displayed in the menu.
For information about the “Security” dialog box, see “Security (Creating Users and Making User
Settings)” on page 82.

User Module Editor
The user module editor lets you make a layout of controls for components arranged in the user module
window. For each user module there is one user module editor. The name of the user module is
displayed in the title bar. Only components that are arranged in a particular user module can be laid
out in the specific control window that is associated with that user module. Both the user module and
the control window will have the same name.
Refer to “User Modules” on page 309 for more information about user modules.
NOTE
You can copy controls from a user module to the user control editor.
Component Editor

User Module Editor

Laid Out Controls

Controls Laid Out
in the User Control

Status Bar

Edit Palette

 Opening a User Module Editor Window
In the designer window, the user module editor can be opened by selecting [Open User Module
Editor] from a user module contextual menu. User modules for which [Open User Module Editor] is
selected as the [Double Click Action] in the “User Module Properties” window can be opened by
double clicking. For information about the “User Module Manager” dialog box, see page 314. For
information about the “User Module Properties” dialog box, see page 243.
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Names and Functions
 Status Bar
The lock icon will appear in the User Module when security is active.
 User Module properties (page 243).
 User Module (page 309).
The lock icon will appear locked when the password has not been entered, and layouts cannot be
edited in the Design Mode.

The lock icon will not appear if the [Enable Security] checkbox in the “Properties” dialog box is not
checked.
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 Edit Palette
The edit palette is automatically displayed whenever the user control editor/user module editor is
active in design mode. Whenever you move the user control editor/user module editor, the edit palette
moves together with it. When you turn OFF design mode, the palette disappears.
Commands for editing in the user control editor/user module editor are provided on the edit palette.
[Design Mode Off] Button
Control Alignment

[Undo] Button
[Redo] Button

Grid Setting

[Paste] Button
[Copy] Button
[Cut] Button

 [Design Mode Off] Button
Turns OFF the design mode.

 [Undo] Button/[Redo] Button
Used to undo/redo operations.

 [Cut] Button/[Copy] Button
Cuts or copies the selected controls.
 See “Cut/Copy/Paste Controls” on page 343.

 [Paste] Button
Pastes cut or copied controls.
 See “Cut/Copy/Paste Controls” on page 343.

 Alignment of Controls
Aligns the positions of multiple controls.
[Picture] Button
[Align Left] Button
[Align Right] Button
[Align To Top] Button
[Align To Bottom] Button

[TEXT] Button
[Box] Button
[Ellipse] Button
[Frame] Button

[Vertical/Center Align] Button
[Horizontal/Center Align] Button
[Align Vertically] Button
[Align Horizontally] Button

[Scene Recall Button]
Button
[Line] Button

[Align Left] Button
Aligns all selected controls with the left edge of the leftmost selected control.

[Align Right] Button
Aligns all selected controls with the right edge of the rightmost selected control.
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[Align To Top] Button
Aligns all selected controls with the top edge of the uppermost selected control.

[Align To Bottom] Button
Aligns all selected controls with the bottom edge of the lowermost selected control.

[Align Horizontally] Button
This button can be used only when three or more controls are selected.
It arranges the controls in a uniform horizontal line. Without changing the position of the leftmost
and rightmost control, this button arranges the controls between them at uniform intervals. It puts
the same amount of space between each control and its neighbor.

[Align Vertically] Button
This button can be used only when three or more controls are selected.
It arranges the controls in a uniform vertical line. Without changing the position of the uppermost
and lowermost control, this button arranges the controls between them at uniform intervals. It puts
the same amount of space between each control and its neighbor.

[Horizontal/Center Align] Button
Aligns the selected controls horizontally with the center position.

[Vertical/Center Align] Button
Aligns the selected controls vertically with the center position.

 [Picture] Button
Places a graphic file.

 [TEXT] Button
Places a text box.

 [Box] Button
Places a square.

 [Ellipse] Button
Places an ellipse.

 [Frame] Button
Places a frame.

 [Line] Button
Places a line.

 [Scene Recall Button] Button
Places a Scene Recall button.
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 Grid Setting
When arranging controls, you can align them along the grid. This menu sets the spacing of the
grid.

Grid=10

Grid=20

Clicking the [] button displays a menu. Click the menu to set the grid spacing. Select [OFF] to
turn OFF the grid.
NOTE
When the grid is turned ON (when any grid item besides OFF is selected), clicking any control that is not aligned with the
grid position, will cause it to align with the nearest grid.
Please note that after copying multiple controls in one operation from the component editor and adjusting their positions
manually, their positions could become disarranged when you select them by clicking on them, if they do not already
align with the grid interval.
Furthermore, if you change the grid spacing after aligning the positions of controls in the user control editor/user module
editor, the controls will be placed into positions that do not align with the grid even if they are arranged using the align
buttons. When there are controls that do not align with the grid, turn the grid OFF.

Changing the Window Size
In design mode, you can change the window size of the user control editor. If you align the mouse
pointer with a side or corner of the window, its shape will change into a double-headed arrow. When
the arrow is shaped like this, dragging it will change the size of the window.

Even if you change the width of the window, the library button will remain where it is, in the upper right
corner.
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Window Size and Background Settings
The size and background of the User Control Editor/User Module Editor window can be changed as
required. A color or image file can be specified as the window background. These settings are made
in the “User Control Editor Settings” dialog box. To display this dialog box, right-click in the user
control editor window while in design mode, then click “User Control Editor Settings” on the displayed
context menu.

Size
 [Width]
Sets the width of the User Control Editor/User Module Editor window in pixels, up to a maximum of
2,500 pixels.

 [Height]
Sets the height of the User Control Editor/User Module Editor window in pixels, up to a maximum of
2,500 pixels.

Background Image
 [Default]
Sets the background color to black, the same as the component editor. Select this if you have set
the background with [Color] or [Image], and you want to return to the original background.

 [Color]
Sets the color of the background. Use the [Select Color] button to select a color.

[Select Color] Button
Clicking here displays the “Select color” dialog box. This sets the color of the background. For
information about the “Select color” dialog box, see page 265.

NOTE
If you select a light color, it may be difficult to see the grid.
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 [Image]
Displays an image for the background. You can use image files in the following formats: BMP
(.bmp), PNG (.png), XPM (.xpm), and JPEG (.jpg). Use the [Select Image] button to select an
image file.

[Select Image] Button
Clicking here displays the “Select Image” dialog box. Here you can select an image file to be
displayed as the window background.

[Layout] Box
This box displays a list where you can select how the image file will be displayed.

• [Center]
Centers the image in the window.

• [Tile]
Displays multiple copies of the image side-by-side until the available space is filled. If the
image file is smaller than the window, it will be displayed repeatedly like tiles on a wall.

• [Fit]
Expands or reduces the size of the image to match the size of the window where it will be
displayed.

[File] Box
Displays a path for the image file.
Click the [Select Image] button and select an image file. The path will be automatically entered.
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Placing Controls
Controls can be placed when you are in the design mode. You can turn the design mode ON and OFF
by right-clicking in the user control editor/user module editor, or component editor, then clicking the
[Design Mode] command in the context menu that is displayed.
You can place controls by dragging them from the component editor or by using the copy and paste
commands.
Knob

Edit Box
Slider

Text
Button

Solid Frame
Graph

[Library]

Edit Palette

 Selecting Controls
If you click a control in the component editor while in design mode, the control will be selected and
a red frame will be displayed around it. Controls like knobs, sliders, edit boxes, and labels are all
separate objects. Only the item clicked will be selected.

If you hold down the <Ctrl> key while clicking, you can select multiple controls and labels. If you
use <Ctrl> + click on a selected control, it will cancel that control’s selection.
If you position the mouse in an empty location on the sheet and start dragging from there, a frame
will be displayed as the pointer moves. All controls enclosed by that frame will be selected.

NOTE
If you drag controls like knobs and sliders, edit boxes and labels that show parameter types, and place them one-by-one
in the user control editor, they must be arranged in the user control editor. If you select multiple items and drag them, you
can copy them as a group into the user control editor, keeping their original arrangement.
When copying multiple controls from a single component editor, if you select all the controls you want copy and drag
them together as a unit, their original positional relationship and tab order will be maintained.
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 Placing Controls by Dragging Them (User Control Editor)
You can drag the controls you want to copy from the component editor to the user control editor.

1 Open the component edit window that has the controls you will be placing in the user
control box.

2 Open the user control editor.
User control names are displayed in the [View]  [User Control] submenu in the Main Panel
window Click a user control name to open its window.

3 Right-click in the component editor or the user control editor.
The context menu will be displayed.

4 Click [Design Mode] on the menu.

Design mode will be turned ON.

5 Drag the controls from the component editor to the user control editor.

Arrange the controls in the user control editor.
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 Placing Controls by Dragging Them (User Module Editor)
You can drag the controls you want to copy from the component editor window in the user module
to the user module editor.

1 Create a user module, then arrange and connect the components for it.
2 Double-click the components and leave the component editor windows that appear
open.

3 Store the user module by checking [Double Click Action]  [Open User Module Editor]
in the Store dialog box (see “Saving User Modules” on page 309 for details about storing
user modules).

4 Double-click a user module in the Configuration window.
The user module editor will be displayed.

5 Right-click in the component editor or user module editor, then click the [Design Mode]
command in the context menu.
Design mode will be turned ON.

6 Drag the controls from the component editor to the user module editor.
Arrange the controls in the user control editor.
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 Placing Controls Using Copy and Paste
Copy the controls in the component editor and paste in the user control editor or user module
editor.
To copy controls in the component editor, press the [Copy] command shortcut keys, <Ctrl> + <C>.
To paste in the user control editor or user module editor, press the [Paste] command shortcut key,
<Ctrl> + <V>, or the [Paste] button on the edit palette.

1 Click on the source component editor window to make it active, then select the control or
controls you want to copy.

2 Press the <C> key while holding down the <Ctrl> key.
The selected controls will be copied to the clipboard.

3 With the target user control editor or user module editor active, press the <V> key while
holding down the <Ctrl> key.
You can also paste by clicking the [Paste] button on the edit palette.
The controls will be copied.
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 When You Cannot Copy
Regardless of whether you drag or use copy and paste, you cannot create multiple copies from the
same single component. If you drag controls that are already copied into the user control editor or
user module editor, the mouse pointer will change into the “unavailable” mark (a circle with a
diagonal slash), indicating that you cannot copy.

You can copy more than one component of the same type into the user control editor, as long as
they come from different components located in the configuration or user module.
Controls for components arranged in the configuration can be copied only to the user control
editor.
Controls for components arranged in a user module can be copied to both the user control editor
and the user module.

 Order of Controls
Controls newly pasted in the user control editor will be displayed above any previously pasted
controls they overlap. The tab order for edit boxes will be the order in which they were pasted.
NOTE
In the component editor, you can select multiple controls using <Ctrl> + click or by dragging. Once controls are copied,
they will be pasted in the order in which they were copied.
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Moving and Aligning Controls
In the user control editor or user module editor, you can move or align copied controls.

 Selecting Controls
In the user control editor or user module editor, controls are selected in the same way as in the
component editor. Click a control to select it, or press <Ctrl> + click to select multiple controls. If
you use <Ctrl> + click on a selected control, it will cancel that control's selection. If you position the
mouse in an empty location in the user control editor or user module editor and start dragging from
there, a frame will be displayed as the pointer moves. All controls enclosed by that frame will be
selected.
A red frame will be drawn around the selected controls.

 Moving Controls
Move selected controls by dragging them or by pressing the arrow keys on your keyboard. When
you select multiple controls using <Shift> + click, you can move all of them at the same time.

Dragging
When grid is ON, the upper left of the dragged controls will automatically align with the grid. When
dragging, the coordinates displayed here refer to the upper left corner of the object being
dragged. The “Distance to Right” and “Distance to Bottom” are displayed in pixel units, using the
upper-left of the window as a reference point.

When multiple controls are selected and dragged, the coordinates are those of the upper-left
corner of the control where the mouse is aligned.

Arrow Keys
When the grid is ON, the arrow keys move controls a grid unit at a time. When the grid is OFF,
controls are moved one pixel at a time.

 Alignment
You can align controls using the following alignment buttons on the edit palette: [Align Left], [Align
Right], [Align To Top], [Align To Bottom], [Align Horizontally], [Align Vertically], [Horizontal/Center
Align], and [Vertical/Center Align].
You can only use the [Align Horizontally] or [Align Vertically] buttons when three or more controls
are selected.
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Cut/Copy/Paste Controls
You can edit controls arranged in the user control editor or user module editor using the [Cut], [Copy],
and [Paste] commands in the edit palette.

 Cut
Cuts controls arranged in the user control editor. Select one or more controls, then press the [Cut]
button on the edit palette

 Copy
Copies controls arranged in the user control editor or user module editor. Select one or more
controls, then press the [Copy] button on the edit palette.

 Paste
Pastes cut or copied controls. Click the [Paste] button on the edit palette. If you cannot paste, the
button color turns pale.

 Delete
Controls can be deleted by selecting them and pressing the <Delete> key.

Knob/Slider Conversion
This function makes it possible to convert knobs placed in the user control editor or user module editor
to sliders, or vice-versa.
Right-click on a knob or slider and select [Convert] [Slider] or [Convert] [Knob], as appropriate.
The [Convert] item will not appear for certain special knobs and sliders that cannot be converted.

DME Designer Owner’s Manual

343

Chapter 5 Components

Undo and Redo Commands During Editing
The [Undo] and [Redo] commands in the main panel window [Edit] menu, and the [Undo] and [Redo]
commands in the editing palette, can be used to undo or redo controller move, size change, or delete
operations.
NOTE
If you close an editor window, you will no longer be able to undo and redo operations performed there.

Control Properties
A properties dialog box will open when you either double click a controller in the User Control Editor or
User Module Editor, or right-click the controller and select [Properties] from the contextual menu. Here
you can specify a design for the controller.
Multiple properties of the same type can be set at the same time by clicking the controllers while
holding the <Ctrl> key and then opening the properties dialog box.
Edited items are shown in bold text until you either click [OK] or [Cancel].

 “Knob Properties” Dialog Box
When you right-click on a knob, then select [Properties] from the context menu, the “Knob
Properties” dialog box will be displayed. This dialog box sets the size of the knob.

[Size]
Displays a list where you can select the knob size. Select [Large], [Medium], [Small], or [Very
Small].
NOTE
You can change the size of a knob by dragging one of the marks at the four corners (top, bottom, left, right) of the knob
in the user control editor.

Color Settings
• [Indicator]
Select an indicator color from the list: [White]/[Red]/[Yellow]/[Green]/[Blue]/[Violet]/[Black]/
[Light Blue]

• [Thumb]
Select a knob color from the list: [Black]/[Gray]/[White]/[Red]/[Yellow]/[Green]/[Blue]/[Violet]

• [Background Color]
Uncheck this item to make the background transparent. When this item is checked the [Color]
button to its right opens the “Select color” dialog box that can be used to select a background
color.
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 “Slider Properties” Dialog Box
The “Slider Properties” dialog box will appear when you either double-click a slider or right-click it
and select [Properties] from the contextual menu. This lets you change the size, orientation, and
other characteristics of the related slider.

Size
[Width] and [Height] set the width and height of the slider in pixel increments.
NOTE
The size of sliders can also be changed by dragging any of the slider’s corners in the user control editor.

[Direction]
Set the slider’s orientation to [Vertical] or [Horizontal] as required.

[Background Color]
Uncheck this item to make the background transparent. When this item is checked the [Color]
button to its right opens the “Select color” dialog box that can be used to select a background
color.

[Number of Lines]
Sets the number of scale markings (lines) between the minimum and maximum values.

Line Color
Click the [Select Color] button and select the desired scale line color in the “Select Color” dialog
box.

[Cap Size]
Select a knob cap size from the list: [Very Large]/[Large]/[Middle]/[Small]/[Very Small].

[Cap Color]
Select a knob cap color from the list: [Black]/[Gray]/[White]/[Red]/[Yellow]/[Green]/[Blue]/[Violet]

[Show Scale]
Check this item to show the numeric scale values.

Number Color
Click the [Select Color] button and select the desired scale number color in the “Select Color”
dialog box.
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 “Toggle Button Properties” Dialog Box
The Toggle Button Properties dialog box will appear when you either double click the ON/OFF
button or right-click it and select [Properties] from the contextual menu. This sets the text displayed
by the button, along with the color of the button.

[Color]
Displays a list where you can select the color of the button. If you click the [], a list of button
colors will be displayed.

[Size]
Select a button size from the list: [Small (37x11)], [Small (51x11], [Medium (74x11)], [Medium
(74x22)], or [Large (111x33)].

[Text] box
Enter the text to be displayed by the button. You can set different text for when the button is ON and
for when it is OFF.

[Text Font] Button
Sets the font, size and style. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.
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 “Radio Button Properties” Dialog Box
The Radio Button Properties dialog box will appear when you either double click a radio button or
right-click it and select [Properties] from the contextual menu. You can set the button's color, size,
and font.

[Color]
Select a color from the list: [White], [Red], [Yellow], [Green], [Blue], or [Violet].

[Size]
Select a button size from the list: [Small (37x11)], [Small (44x11], [Medium (75x11)], [Medium
(74x22)], or [Large (111x33)].

[Text] Box
Enter the text to be displayed by the button.

[Text Font] Button
Sets the font, size and style. Clicking here displays the “Select Font” dialog box.
For information about the “Select Font” dialog box, see page 264.

 “Edit Box Properties” Dialog Box
The Edit Box Properties dialog box will appear when you either double click an edit box or rightclick it and select [Properties] from the contextual menu. Here you can set the edit box size.

[Size]
Select an edit box size from the list: [Large], [Medium], or [Small].

 “Level Meter Properties” Dialog Box
The Level Meter Properties dialog box will appear when you either double click a level meter or
right-click it and select [Properties] from the contextual menu. Here you can specify the number of
meter segments and scale.

Size
The width is set using the [Width] and the height is set using [Height]. The units are pixels.

[Segment]
Select a number of meter segments from the list: [2], [6], or [60].

[Scale]
Select the type of scale to be displayed beside the meter from the list. This option is only available
when [Segment] is set to 60.

DME Designer Owner’s Manual

347

Chapter 5 Components

 Slider “Level Meter Properties” Dialog Box
The “Level Meter Properties” dialog box will appear when you either double-click a slider level
meter or right-click it and select [Properties] from the contextual menu. This lets you change the
size and orientation of the related level meter.

Size
[Width] and [Height] set the width and height of the level meter in pixel increments.
NOTE
The size of level meters can also be changed by dragging any of the meter’s corners in the user control editor.

[Direction]
Set the level meter’s orientation to [Vertical] or [Horizontal] as required.

 “Indicator Properties” Dialog Box
The “Indicator Properties” dialog box will appear when you either double-click an indicator or rightclick it and select [Properties] from the contextual menu. This lets you change the size and display
characteristics of the related indicator.

Size
[Width] and [Height] set the width and height of the indicator in pixel increments.
NOTE
The size of indicators can also be changed by dragging any of the indicator’s corners in the user control editor.

[Threshold Logic]
Determines whether the indicator will light or go out when the monitored parameter exceeds the
threshold. Select [Turn On] if you want the indicator to light when the threshold is exceeded, or
[Turn Off] if you want the indicator to go out when the threshold is exceeded.

[Color]
Click the [Select Color] button and select the desired indicator color in the “Select Color” dialog
box.
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 “Solid Frame Properties” Dialog Box
The Solid Frame Properties dialog box will appear when you right-click a solid frame and select
[Properties] from the contextual menu. Here you can enter the text to be displayed. Here you can
set the frame size and divider location.
Partition Line

Sub-Partition Line

Frame Size
The width is set using the [Width] and the height is set using [Height]. The units are pixels.
NOTE
You can change the size of a frame by dragging one of the marks at the four corners (top, bottom, left, right) of the frame
in the user control editor.

Partition Line/Sub-Partition Line
Sets partition lines within the frame. [Partition Line] is a long partition line displayed from end to
end, and [Sub-Partition Line] is a short partition line.

• [Direction]
Select the direction of a partition line from the list. [Vertical] inserts a vertical partition line and
[Horizontal] inserts a horizontal partition line. When [None] is select, partition lines are not
displayed.

• [Position]
Displays the currently set line position. Displays the number of pixels from the top of the solid
frame when [Vertical] is selected for the [Direction], and the number of pixels from the left of
the solid frame when [Horizontal] is selected.
NOTE
You can change the position of a partition line by dragging one of the marks on the line in the user control editor.

• [Add] Button
If you set the position of the partition line in the box on the right and click the [Add] button, the
partition line will be added and displayed in the [Position] list.

• [Delete] Button
Deletes the partition line selected in the [Position] list.
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 “Color Frame Properties” Dialog Box
The Color Frame Properties dialog box will appear when you right-click a solid frame and select
[Properties] from the contextual menu. Here you can enter the text to be displayed. Here you can
set the frame size and divider location.

Frame Size
The width is set using the [Width] and the height is set using [Height]. The units are pixels and the
minimum value is 3.
NOTE
You can change the size of a frame by dragging one of the marks at the four corners (top, bottom, left, right) of the frame
in the user control editor.

Line Width
Sets the thickness of the lines at [Top]/[Left]/[Right]/[Bottom]. Set “0” to display no lines.

Frame Color
Sets the color of the color frame.
Click this button to display the “Select color” dialog box. For information about the “Select color”
dialog box, see page 265.

Fill Color
Sets the frame fill color.
Click the [Select Color] button to display the “Select color” dialog box. Refer to “Select Color”
Dialog Box in the Object section on page 265 for information on this dialog box.

Arrows
Specifies the shape of line endpoints (terminals).
The [Left] and [Right] endpoints of [Top Line] and [Bottom Line] lines, and the [Top] and [Bottom]
endpoints of [Left Line] and [Right Line] lines, can be set independently.
None: No endpoint shape.
Arrow: Arrow-shaped endpoint.
Circle: Circle-shaped endpoint.
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 User Picture Properties Dialog Box
Right-click the image and select [Properties] from the contextual menu to display the User Picture
Properties dialog box.

[File Path] Box
Displays the path to the graphic file.

[Select File] Button
Selects a graphic file.

Size
• [Width]
Specifies the width in pixels.

• [Height]
Specifies the height in pixels.

• [Reset] Button
Click to display the graphic at it's original size.

• [Stretch]
When ON, the graphic will be enlarged when a size that is bigger than it's original size is
specified.

[Link Component Editor]
When ON, clicking the [Select Component] button selects the editor that is opened when the
graphic is clicked.
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 Text Properties Dialog Box
Right-click the text box and select [Properties] from the contextual menu to display the Text
Properties dialog box.

[Text] Box
Displays and edits the text to be displayed.

[Text Font]
Selects the font. Click to display the Select Font dialog box.
Refer to “Select Font” Dialog Box on page 264 for more information on the Select Font dialog box.

[Text Color] Button
Sets the text color. Click to display the Select Color dialog box. For information about the “Select
color” dialog box, see page 265

[Alignment]
Selects [Left], [Center], or [Right] text alignment.

[Rotate]
Rotates the text box.

[Background Color]
Uncheck this item to make the background of text transparent. When this item is checked the
[Color] button below the checkbox opens the “Select color” dialog box that can be used to select a
background color.

[Link Component Editor]
When ON, clicking the [Select Component] button selects the editor that is opened when the text
box is clicked.
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 Box Properties Dialog Box
Right-click the box and select [Properties] from the contextual menu to display the Box Properties
dialog box.

Box Size
• [Width]
Specifies the width in pixels.

• [Height]
Specifies the height in pixels.

Box Style
• [Style]
Sets the style of the object. Select [Plain], [Raised], or [Sunken] from the list.

• [Round Corner]
Turn ON to produce a round-cornered box. Use [Curve] to select the degree of roundness.

Line
• [Type]
Select a type of frame line from the list: [Solid], [Dash], [Dot], [Dash Dot]. Or [Dash Dot Dot].

• [Size]
Sets the thickness of the frame line in pixels. The range is from 1 to 100.

• [Select Color] Button
Sets the color of the frame line. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 265 for more information on the Select Color
dialog box.

Fill Color
• [Select Color] Button
Sets the frame fill color. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 265 for more information on the Select Color
dialog box.
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 Ellipse Properties Dialog Box
Right-click the ellipse and select [Properties] from the contextual menu to display the Ellipse
Properties dialog box.

Ellipse Size
• [Width]
Specifies the width in pixels.

• [Height]
Specifies the height in pixels.

Line
• [Type]
Select a type of frame line from the list: [Solid], [Dash], [Dot], [Dash Dot]. Or [Dash Dot Dot].

• [Size]
Sets the thickness of the frame line in pixels. The range is from 1 to 100.

• [Select Color] Button
Sets the color of the frame line. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 265 for more information on the Select color dialog
box.

Fill Color
Sets the ellipse fill color when ON.

• [Select Color] Button
Sets the ellipse fill color. Click to display the “Select color” dialog box.
Refer to “Select Color” Dialog Box on page 265 for more information on the Select color dialog
box.
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 “Line Properties” Dialog Box
Double-click a line or right-click it and select [Properties] from the contextual menu to display the
“Line Properties” dialog box. This lets you change the size and style of the related line.

Size
[Width] and [Height] set the width and height of the line in pixel increments.
NOTE
The size of lines can also be changed by dragging any of the line’s corners in the user control editor.

[Direction]
Set the line’s orientation to [Vertical] or [Horizontal] as required.

[Type]
Select a line type from the list: [Solid]/[Dash]/[Dash Dot]/[Dash Dot Dot].

[Size]
Sets the line width.

[Color]
Click the [Select Color] button and select the desired line color in the “Select Color” dialog box.

[Top/Left]
Select a line termination for the top or left end of the line from the list: [None]/[Arrow]/[Circle].

[Bottom/Right]
Select a line termination for the bottom or right end of the line from the list: [None]/[Arrow]/[Circle].
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 “Scene Recall Button Properties” Dialog Box
Double-click a Scene Recall button or right-click it and select [Properties] from the contextual
menu to display the “Scene Recall Properties” dialog box. This lets you specify the scene to be
recalled by the button, and other characteristics.

[Cap Color]
Select a button color from the list: [White]/[Red]/[Yellow]/[Green]/[Blue]/[Violet].

[Size]
Select a button size from the list] [Small (37x119)]/[Small (44x11)]/[Middle (75x11)]/[Middle
(74x22)]/[Large (111x33)]/[Large (222x66)].

[Text]
Enter the text to be displayed in the button.

[Edit Mark]
When this item is checked the specified text will be displayed when the assigned scene has been
edited. The additional text is entered via the [Text] box below.

[Text Font] Button
The “Select Font” dialog box will appear when this button is clicked. Select the required font, style,
and size. Refer to “Select Font Dialog Box” in the “Objects” section on page 264 for more
information about the “Select Font” dialog box.

[Alignment]
Select [Left], [Center], or [Right] alignment.

[Scene]
Specifies the scene that will be selected when the button is clicked. Click the [Select Scene] button
to open the scene selection menu.
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Changing the Tab Order
The tab order for edit boxes is determined by the order in which they were pasted into the user control
editor or user module editor. If you right-click the user control editor or user module editor, you can
check or change the tab order using the [Tab Order] command on the context menu.
If you select the [Tab Order] command, tab order numbers will be displayed at the upper-left of each
edit box. Clicking the displayed numbers changes the order.
NOTE
The tab order for other controls such as knobs, sliders, and buttons cannot be set.

1 Right-click in the user control editor or user module editor.
The context menu will be displayed.

2 Click [Tab Order] in the context menu.
Numbers for the current tab order are displayed to the upper-left of each edit box.

3 Click the tab order numbers in the order in which you want to set the tab order.
Even if you do not want to change tab order number 1, click all the numbers in the order you desire,
starting from number 1. When you click on each number, it will change to the number that reflects
the order in which it was clicked.

4 Once you have finished specifying the order, click somewhere within the window
where there is no tab number.
The tab order numbers will disappear.
The changed tab order will apply the next time user control editor or user module editor is started.
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Operation Mode and Design Mode
There are two modes for the user control editor/user module editor and the component editor:
“operation mode” and “design mode.” In operation mode you adjust parameters, while in design
mode you lay out controls.
You can switch between operation mode and design mode using the context menu that is displayed
when you right-click in the user control editor/user module editor or component editor.

Switches
between
operation mode
and design
mode

The [Design Mode] command switches the design mode between ON and OFF. A checkmark
appears when the design mode is turned ON. If you click in the context menu when the checkmark is
present, design mode will turn OFF, and the edit window will return to operation mode.
NOTE
Only users for whom the [Operation Security]  [Edit] checkbox in the “Security” dialog box has been checked can turn the
design mode ON.

NOTE
You can select controls in the component editor so that you can copy them into the user control editor/user module editor.
When you want to select multiple objects, hold down the <Ctrl> key as you click each new object you want to select.
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Context Menu
The context menus that appear when you right-click in a window will differ in operation mode and in
design mode. In design mode, other commands will be added, depending on where you click.

 Operation Mode Context Menu
Some commands that are displayed in the context menus for operation mode will also be
displayed in design mode.

[Design Mode]
Switches between design mode and operation mode. When you are in design mode, a checkmark
will appear to the left of the command name.

[Peak Hold]
Turns the peak hold meter ON or OFF and performs a reset. The ON or OFF setting for peak hold
applies to the whole zone.

• [On]
When you select this, peak hold is turned ON, and a checkmark appears next to it. If you
select this item while it is checked, peak hold is turned OFF.

• [Reset]
Resets peak hold.
NOTE
Peak hold is a function that makes it easy to see the maximum signal value by lighting up at the level of the
maximum value as the signal peak comes in.
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[Level Meter Enable]
Specifies whether the level meters will be enabled or disabled.

[Close All Editor Windows]
Closes all component editor windows.

[Open Parameter Link]
Opens the “Parameter Link” window. For information about the Parameter Link window, see
“Parameter Link” (page 94).

[Add Parameter to Parameter Link]
Creates a parameter link. See “Creating Parameter Links” (page 368).

[Add Component to Component Link] (Component editor only)
Creates a component link. See “Creating Component Links” (page 370).

 The Context Menu Displayed in Design Mode When You Right-Click an Empty
Location

[Tab Order] (User Control Editor and User Module Editor only)
When using user control editors or user module editors, this function displays the order in which
you move through them by pressing the <Tab> key. When you select this command, numbers are
displayed next to the edit boxes. A checkmark appears next to [Tab Order] in the context menu. To
exit tab order settings, click [Tab Order] the context menu or click anywhere besides a tab order
number in the user control editor.

Clicking the displayed numbers changes the order. The numbers are changed in the order that
they are clicked. To exit tab order settings, click [Tab Order] the context menu or click anywhere
besides a tab order number in the user control editor.
 See “Changing the Tab Order” on page 357.

[User Control Editor Settings] (User Control Editor and User Module Editor only)
Sets a background image for a window. Clicking here displays the “User Control Editor Settings”
dialog box.
 See “Window Size and Background Settings” on page 335.

360

DME Designer Owner’s Manual

Chapter 5 Components

 The Context Menu Displayed in Design Mode When You Right-Click a Control

[Open Original Component Editor] (User Control Editor and User Module Editor only)
It opens the component editor for the control you clicked.

[Display Order]
Specifies the vertical display order of the controllers.
It opens the component editor for the control you clicked.

[Properties]
Opens the properties dialog box for the control.
 See “Control Properties” on page 344.
NOTE
There some controls, such as sliders, that do not display the [Properties] command.

 The contextual menu that appears in when a controller is right-clicked in the
design mode.
[Properties] (User Control Editor & User Module Editor only)
Opens the controller properties window. Refer to “Control Properties” on page 344.
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Snap
The Snap function records parameters for the component editor, user control editor, and user module
editor temporarily. Clicking a button switches the parameter set, setting all parameters in the editor to
the status that existed when the parameters were recorded in the memory. You can record the current
values for parameters. Furthermore, when you recall a library, it is recorded to the Snap button that is
on at that time. For more information about libraries, see “Library” (page 364).

Snap Buttons

 Snap Buttons ([A] through [D])
The Snap buttons allow you to switch between parameter sets. The buttons change in appearance
according to their ON/OFF status and to whether or not there were changes to the parameter set
from when the editor was started.

When there has been no change to the parameter set since the editor was started
When a button is selected it lights up.

ON OFF

When a parameter set that is different than when the editor was started has been recorded
to a button
The color of the button name changes on buttons for which the parameter set has changed. When
a button is selected it lights up.

ON OFF

 Recording Parameter Sets
Recording parameters from the current window
The parameters present when the snap button is switched are recorded to the snap button before
the switch.

1 Click the snap button ([A] through [D]) that will record the parameter set. This turns it
ON.

2 Set the parameters in the editor to the settings you want to record.
3 Click another snap button.
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Recalling a Library

1 Click the snap button that has recorded the parameter set. This turns it ON.
2 The library is recalled.
 Switching Parameter Set
If you click a snap button that has a parameter set recorded, the system switches to the parameter
set recorded there.

 Copying Parameter Sets
Parameter sets can be copied between snap buttons [A]~[D].
• Select from the contextual menu.
• Drag and drop.
Drag-and-drop copy will also work between components of the same type.
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Library
Component editor, user control editor, and user module editor parameters can be saved as library
files. By reading back a saved library file, you can reset all the editor parameters to the status they had
when the file was saved. Saving in a library file is called “storing,” while bringing back the settings is
called “recalling” them.
Library files have the following file name extensions: “.cel” for component editors, “.ucl” for user
control editors, and “.uml” for user module editors.
[Store Library] Button
[Recall Library] Button

[Recall Library]
Menu

If you store library files in the “Library\component group names\component names” folders in the
[ContentsFolder] specified in the Main Panel window “Preferences” dialog box, they will be
automatically displayed in the component editor [Recall Library] menu.
The dialog box used for storing items in the library opens with the library folder displayed.

If you save like this without changing the folder, the item you saved will be displayed on the [Recall
Library] menu. When a library is saved, it can be displayed in the component editor for other project
files besides the currently open one, and also in new project files.
NOTE
In the “Save Library File” dialog box, you can specify another folder for saving library files, and save them there. Library files
that are saved in another folder also can be recalled by specifying the folder.
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 Library Filenames
Because the library filenames are displayed in the [Recall Library] menu, use a filename that helps
you understand the contents of the parameter set in the file. When saving in the default folder, there
is no need to include the component name in the filename.
For example, when you are storing a parameter set in the stereo compressor library, the “Save
Library File” dialog will be displayed with the “Library\Compressor\Compressor Stereo” folder in
the [ContentsFolder] selected. If you save in that folder, the file you save will be displayed only in
the [Recall Library” menu for stereo compressor components only. It will not be displayed in any
other library.
If you use a filename that makes it easy to understand the parameter contents or the conditions
under which they are used, you can select them without confusion when recalling.

Storing in the Library
The library is the place to store component editor parameters.

 Editor Window

1 Set the parameters to be stored in the library.
2 Click the [Store Library] button in the component editor.
The “Save Library File” dialog box will be displayed.

3 Enter the filename.
Select a filename that makes it easy to understand the contents of the parameter set.

4 Specify the folder for saving the file.
If you want the saved file displayed on the [Recall Library] menu, do not change the folder for
saving.

5 Click the [Save] button.
 Designer Window
Right-click a component or user module in the Designer window to show the contextual menu. Use
the [Store Component Library] command to store the library.
The menu that appears when the contextual menu [Store Component Library] command is clicked
is the same as the menu that appears when the Edit window [Store Library] button is clicked.
Specify a file name and save the file.
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Recalling a Library
The recall function reads stored parameters into the component editor.

 Editor Windows
You can recall libraries in the component editor, user control editor, and user module editor
windows by clicking the [Recall Library] button. When a library is recalled in an editor window, the
parameter set is recorded to the selected snap button.

1 Click the snap button ([A] through [D]) that will record the parameter set.
2 Click the [Recall Library] button in the component editor.
The [Recall Library] menu will be displayed.

3 Click the library name (filename) in the [Recall Library] menu.
The parameters in the library will be recalled.

 Designer Window
If you right-click on a component or user module in the design window, a context menu will be
displayed. You can recall a library using the [Recall Component Library] command.
If you click [Recall Component Library] in the context menu, the same menu is displayed as when
you click the [Recall Library] button in the editor window. If you select a library that is displayed in
the submenu, that library is recalled.

Not only the library name, but also the effect type is displayed in the submenu that appears when
you right-click on an SPX component.

366

DME Designer Owner’s Manual

Chapter 5 Components

 Recalling a Library Stored in a Folder Other Than the Default
Libraries not stored in the default folder do not appear on the [Recall Library] menu. You must
specify the file you want in order to recall it.

1 Click the [Recall Library] button in the component editor.
The [Recall Library] menu will be displayed.

2 Click the [Recall Library] menu [Open File Dialog].
The “Open” dialog box will be displayed.

3 Move to the correct folder and select a library file.
4 Click the [Open] button.
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Creating Parameter Links
You can group controls (parameters) and link their parameters. You can create parameter link groups
and add controls to them in the component editor. Parameter link settings are made in the Parameter
Link window. For information about parameter links and the Parameter Link window, see “Parameter
Link” (page 94).
NOTE
A parameter can belong to one group only. Furthermore, only parameters of the same type can be grouped.

 Creating Parameter Links
If you right-click on a control, a context menu will be displayed.
The [Add Parameter to Parameter Link] [Global Link]/[Local Link]  [Add Group] commands
create new groups. Controls can be added by right-clicking.

 Adding Controls to a Group
If you right-click a control in the component editor, a context menu will be displayed. You can
create groups or add controls using commands in the [Add Parameter to Parameter Link]
submenu. Groups that do not have the same type of parameters will be grayed out and cannot be
selected.

Global Link

The group names for global link groups are displayed in the [Global Link] submenu. When you
click a group name, a control is added to the group.
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Local Link

The group names for local like groups are displayed in the [Local Link] submenu. When you click a
group name, a control is added to the group.

 Adding Multiple Controls
You can select multiple controls in Design Mode. When multiple controls are selected, multiple
parameters can be added to a group simultaneously.
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Creating Component Links
The same types of parameters can be linked between the same types of component included in a
group. Component groups can be created using the component editor, and components can be
added to the group as required. Parameter linking is set up via the Parameter Link window. Refer to
“Parameter Link” on page 94 for information on the Component Link/Parameter Link window.
NOTE
SPX components and SP2060 units do not support component linking.

 Creating a New Group
Right-click a component in the component editor to display the contextual menu. [Add Component to
Component Link]  [Add Group] creates a new group.

 Add Components to a Group
Right-click a component in the component editor to display the contextual menu. [Add Component to
Component Link]  [group name] adds to an existing group. Groups that are not of the same type will
be grayed out and cannot be selected.
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Types of Components
Component Groups
When the Configuration window and User Module window are made active, a component list is
displayed in the Toolkit window, and you can use the [Component List] on the [Tools] menu.
Components can be separated into groups based on types. In the Toolkit window, component groups
are displayed as folders. Some of the groups in the Toolkit window are further divided into subgroups.
Click the [+]/[-] buttons to the left of the folders to display the components.

Group

Component

NOTE
When the User Module window is active, [User Module] is not present on the menu.
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In the Designer window [Tools] menu  [Component List] menu, component groups are displayed as
submenu items.
The items with small rightward-facing triangles are groups. Those without triangles are components.

Group

Component

NOTE
When the User Module window is active, [User Module] is not present in the menu.

Component List
Group
Ambient Noise Compensator

Component
Variations

DME64N

DME24N

DME
Satellite

Mono







Stereo













Mono







Stereo







2 Way







3 Way







4 Way







5 Way







6 Way







2 Way







3 Way







4 Way







5 Way







6 Way







2 Way







3 Way







Audio Detector
Auto Gain Control

Crossover

Crossover Processor

Crossover Processor II
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Component
Variations

Group
Crossover Processor II

Delay

Long

Short

Dynamics

Compander CompanderH

CompanderS

Compressor

De-Esser

Ducking

Expander

Gate

Limiter

Program Ducker

DME64N

DME24N

DME
Satellite

4 Way







5 Way







6 Way







1 Output







2 Output







3 Output







4 Output







5 Output







6 Output







7 Output







8 Output







1 Output







2 Output







3 Output







4 Output







5 Output







6 Output







7 Output







8 Output
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Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo
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Component
Variations

Group
EQ

GEQ

Mono

Stereo

PEQ

Mono

Stereo

Fader

DME64N

DME24N

DME
Satellite

7 Band







15 Band







31 Band







7 Band







15 Band







31 Band







2 Band







3 Band







4 Band







6 Band







8 Band







2 Band







3 Band







4 Band







6 Band







8 Band







1 Channel







2 Channel







4 Channel







8 Channel







12 Channel







16 Channel











Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Mono







Stereo







Feedback Suppressor
Filter

BPF

HPF

LPF

Notch

Programmable BPF

Programmable HPF

Programmable LPF
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Component
Variations

Group
Meter

Miscellaneous

Oscillator

DME64N

DME24N

DME
Satellite

1 Channel







2 Channel







4 Channel







8 Channel







12 Channel







16 Channel







Mono













2 Channel







4 Channel







8 Channel







12 Channel







16 Channel







8 Channel







16 Channel







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







1 Output







2 Output







1 Output







2 Output







4 Output







8 Output







16 Output







1 Output







2 Output







4 Output







8 Output







16 Output







Wav File Player
Mixer

Auto Mixer

Auto Mixer

Auto Mixer II

Delay Matrix 2 Input

4 Input

8 Input

Matrix Mixer 2 Input

4 Input

8 Input
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Component
Variations

DME64N

DME24N

DME
Satellite

32 Output







1 Output







2 Output







4 Output







8 Output







12 Output







1 Output







2 Output







4 Output







8 Output







12 Output







16 Output







32 Output







64 Output



24 Input

24 Output







32 Input

16 Output







32 Output







64 Output



32 Output



64 Output



16 Channel







24 Channel







1 Channel







2 Channel







4 Channel







8 Channel







12 Channel







16 Channel







1 Channel







2 Channel







4 Channel







8 Channel







12 Channel







16 Channel







3-1







5.1







6.1







Group
Mixer

Matrix Mixer 8 Input
12 Input

16 Input

16 Input

64 Input

Simple Mixer

Pan

LCR

LR

Surround

376

DME Designer Owner’s Manual

SP2060

Chapter 6 Component Guide

Group
Room Combiner

Mono

Stereo

Router

1 Input

2 Input

Router

2 Input

4 Input

8 Input

12 Input

16 Input

32 Input

Component
Variations

DME64N

DME24N

DME
Satellite

4 Room







8 Room







12 Room







16 Room







4 Room







8 Room







12 Room







16 Room







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







2 Output







4 Output







8 Output







12 Output







16 Output







32 Output







SP2060
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Group
Source Selector

Component
Variations

DME24N

DME
Satellite

SP2060

(*)

3 Position

1 Channel







4 Position

1 Channel







2 Channel







6 Channel







1 Channel







2 Channel







6 Channel







1 Channel







1 Way







(*)

2 Way







(*)

3 Way







(*)

4 Way







(*)

5 Way







(*)

6 Way







(*)





8 Position

16 Position
Speaker Processor

SPX
AEC

AEC Component
Editor





Slot

Slot In Component
Editor







Slot Out
Component Editor







Cascade In
Component Editor

(*)

Cascade Out
Component Editor

(*)

Analog Input
Component Editor

(*)

(*)

Analog Output
Component Editor

(*)

(*)

Cascade

Analog Input/Output

SP2060 Input/Output

CobraNet Input/Output

EtherSound Input/Output

SP2060 Input
Component Editor

(*)

SP2060 Output
Component Editor

(*)

CobraNet Input
Component Editor

(*)

CobraNet Output
Component Editor

(*)

EtherSound Input
Component Editor

(*)

EtherSound Output
Component Editor

(*)

MY-Card

Component Editor
of each card





Remote Controlled Head Amp

Component Editor
of each device





(*) Parameter edit only
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Ambient Noise Compensator
The Ambient Noise Compensator automatically adjusts program source level to compensate for
ambient noise levels. Mono and stereo components are provided.

Double-click the component to open the component editor. The component editor is the same for
stereo and mono types, the only difference being the number of channels.
2

34

6

7

!

1

5

Section
1

Ambient Noise

3

Parameter

Gap

8

Setting Range

Level Meter
Sense
Threshold

2

)

9

Function
Displays the ambient noise level.

-∞ to 0.00 dB

Detect

Sets the average ambient noise level. The
program source level is increased when this
threshold level is exceeded. The program
source level is lowered when this threshold level
is not reached.
Lights when a gap is detected in the program
source.

4

Threshold

-∞ to 0.00 dB

Sets the program source threshold level. A
“gap” is assumed if the program source level
remains below the threshold for a specified
amount of time.

5

Time

0.1 to 5.0 sec

Sets the time interval for gap detection.

-18.0 to 0.0 dB

Sets the minimum level for program source level
compensation.

6

Program Source Min Gain
Gain

7

Max Gain

0.0 to +18.0 dB

Sets the maximum level for program source
level compensation.

8

Gain Ratio

0.5:1 to 2.0:1

Sets the amount of program source level
compensation. This is specified as a ratio
between the amount of program source level
compensation, and the amount the ambient
noise level has exceeded the threshold.

9

Response Time 1 to 60 sec

Sets the response time for level compensation.
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Section

Parameter

)

Bypass

!

Level Meter

Setting Range
ON/OFF

Function
Turns compensation on or off.
Displays the program source output level after
compensation.

Program Source Input level

Gap
Threshold

Gap Time

Gap Time

Gap

Gap
Time

Ambient Noise Level

Sense
Threshold

Higher
Lower

Time

Program Source Gain

Response Time

Response Time

Max. Gain

Time
Min. Gain
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Audio Detector
The Audio Detector detects the presence of an audio signal and can light an indicator, trigger a GPI
output, or perform other functions. This function can be useful for checking cable connections, for
example.

Double-click the component to open the component editor.
1

Parameter
1

Detect

2

Threshold

Setting Range

2

Function
Lights when the signal level exceeds the threshold.

-90 to 0 dB

Sets the threshold level for signal detection.
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Auto Gain Control
The Auto Gain Control component automatically adjusts gain in response to input level, and is a
convenient way to maintain a constant output level with an input signal that varies in level. Mono and
stereo types are provided.

Double-click the component to open the component editor. The component editor is the same for
stereo and mono types, the only difference being the number of channels.
3

4

1

2

5

Name

6

Function

1

Input Meter

Displays the input signal level.

2

Output Meter

Displays the compensated output signal level.

Parameter

Setting Range

Function

3

Compensation Level

1 to 5

Sets the amount of gain compensation. Higher settings
produce more gain compensation. Caution: sudden
changes in this setting can result in output level
changes.

4

Response Time

*1

Sets the response time for gain compensation. Effective
for upward gain compensation (gain increase), this
parameter specifies the time it will take for a gain
increase of 6 dB. This parameter does not affect gain
reduction.

5

Noise Gate

ON/OFF

Turns the noise gate compensation on or off.

6

Bypass

ON/OFF

Turns gain compensation on or off.

*1 The setting range of Response Time varies according to the operating frequency as follows:
44.1kHz: 447 msec to 2.14 sec, 48kHz: 411 msec to 1.96 sec, 88.2kHz: 224 msec to 1.07 sec, 96kHz: 206 msec to 984 msec
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Crossover
Separates input signals into multiple frequency channels and outputs them. The following five types of
components are available in the Crossover group: 2 Way, 3 Way, 4 Way, 5 Way, and 6 Way.
Crossover components have a single input and multiple outputs.

Double-click a component to display the component editor for it.
Crossover component

1

6

3
4
2

5
7

)

!

@

8

9

Name
1

Function

Crossover Curve
Section

Displays the level of each frequency band,
distinguished by color.
Parameter

Setting Range

Function

2

Input

Level

-∞ to +10 dB

Sets the input signal level.

3

Output

Level

-∞ to ±0 dB

Sets the output signal level for each
frequency band.

4

Mute

ON/OFF

Mutes the output signal level for each
frequency band.

5

Phase

ON/OFF

Reverses the phase of the output signal for
each frequency band.

20 Hz to 20 kHz

Sets the cross frequency between each
frequency band.

6

Frequency
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Section

Parameter

Setting Range

Function

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

8

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

9

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

!

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

@

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

7

)

LPF

HPF

The number of output channels varies according to the component variation.
2 Way

Low/High

3 Way

Low/Mid/High

4 Way

Low/Low-Mid/High-Mid/High

5 Way

Sub-Low/Low/Low-Mid/High-Mid/High

6 Way

Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Set the attenuation curve for the lowest band and the middle bands with the Low Pass Filter (LPF) and
High Pass Filter (HPF), and the highest band with HPF. Each frequency band has its own color, with
Low being red, Mid being green, and so on. These correspond to the colors of the lines on the graph.
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 Graphic Control Points
The graph control points show [Output Level] and [Frequency]. As you modify the parameters
using the knobs and edit boxes, the control points move. Also, as you drag the points, the [Output
Level] and [Frequency] parameters reflect the changes you make.

You can adjust the [Output Level] parameter by vertically dragging the control point in the center of
each curve.

Changing the [Output Level] Parameter

You can adjust the [Frequency] parameter by horizontally dragging the control point at the
intersection of the curves for each frequency band.

Changing the [Frequency] Parameter
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 LFP/HPF
[Type] sets the attenuation slope and the filter type for the LPF and HPF. The selected items are
displayed on the buttons. Clicking these buttons displays a menu. Combinations of six slope types
and four filter types are available. [6dB/Oct], [12dB/Oct], [18dB/Oct], [24dB/Oct], [36dB/Oct], and
[48dB/Oct] set the attenuation per octave. A low value produces gentle attenuation. A large value
produces sudden attenuation.
Type

• THRU
No filter is applied. There is no attenuation, which produces a level line at all frequencies.

• AdjustGc (Adjustable Gc)
With this setting, you can adjust Gc (gain on the cutoff frequency) between -6 dB and +6 dB.
If you set -3 dB it becomes a Butterworth filter. If you set -6 dB, it becomes Linkwitz-Riley filter.
When you select Adjustable Gc, the Gc knob is displayed.

• Butrwrth (Butterworth)
This filter has the most general characteristics. The pass band is flat and the gain for the
cutoff frequency is -3 dB.

• Bessel
For curves where phase characteristics are important, Bessel has gentler attenuation than
Butterworth, and there is little distortion of the waveform when square waves are passed
through.

• Linkwitz (Linkwitz-Riley)
As second-order filters, the sum of the output voltages for LPF and HPF have a gain of 0 dB
across the entire band. The pass band is flat, but the cutoff frequency gain is -6 dB.
Butterworth

Linkwitz-Riley
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Crossover Processor
A crossover processor consists of a crossover, delay, parametric equalizer, and compressor. After the
input signal is processed by the crossover, effects of the delay, parametric equalizer, and compressor
are applied to each frequency band. The following two types are available in the Crossover Processor
group: Crossover Processor and Crossover Processor II.

Crossover Processor
The following five types of components are available in the Crossover Processor group: 2 Way, 3 Way,
4 Way, 5 Way, and 6 Way. Crossover processors have a single input and 2 to 6 outputs.

Double-click a component to display the component editor for it. Band numbers may vary depending
on the component, but they share a common configuration in the component editor.
If you click the [Crossover], [Compressor], [PEQ], or [Delay] button in the [Navigator] section, an
editor for the crossover, compressor, parametric equalizer, or delay will be displayed in a separate
window. A separate component editor will open for each output channel (such as Low or Mid) when
you click on the compressor, parametric equalizer, or delay.
Component editor for Crossover Processor

2

3

4

1
6
5
7
8

Section

Setting Range

Function

Crossover

–

This opens the crossover editor window.

2

Delay

–

This opens the delay editor window.

3

PEQ

–

This opens the parametric equalizer editor
window.

4

Compressor

–

This opens the compressor editor window.

1

Navigator

Parameter

5

Input

Level

-∞ to +10 dB

Sets the input signal level.

6

Output

Level

-∞ to +10 dB

Sets the output signal level for each
frequency band.

7

Mute

ON/OFF

Mutes the signal for each frequency band.

8

Phase

ON/OFF

Reverses the phase of the output signal for
each frequency band.
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The output number varies according to the component variation.
2 Way

Low/High

3 Way

Low/Mid/High

4 Way

Low/Low-Mid/High-Mid/High

5 Way

Sub-Low/Low/Low-Mid/High-Mid/High

6 Way

Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Set the attenuation curve for the lowest band and the middle bands with the Low Pass Filter (LPF) and
High Pass Filter (HPF), and the highest band with HPF. Each frequency band has its own color, with
Low being red, Mid being green, and so on. These correspond to the colors of the lines on the graph.

 Crossover
When you click the [Crossover] button for the crossover processor, it opens the crossover editor
window.
[Crossover Processor-Crossover] editor window

1

2

6

7
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Name
1

Function

Crossover Curve
Section

2

Frequency

3

LPF

Displays the level of each frequency channel,
distinguished by color.
Parameter

Setting Range

Function

20 Hz to 20 kHz

Sets the cross frequency between each
frequency band.

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

4

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

5

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

7

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

8

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

6

HPF
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 Delay
When you click the [Delay] button for the crossover processor, it opens the delay editor window.
Here you can set the delay for each frequency band.
[Crossover Processor - Delay] editor window

1
5
2
3
4

Parameter

Setting Range

Function

1

Delay

Sets the delay time.
ms: 0 to 500
Sample: the range
depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends
on the Frame value.
Beat: the range depends
on the Beat value.

2

Level

-∞ to ±0 dB

Sets the output signal level for each channel

3

On

ON/OFF

Turns delay ON.

4

Mute

ON/OFF

Mutes the signal for each frequency band.

5

Delay Scale

ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay time. The
selected button will light up, and the units in the [Delay]
edit box will change.
If [Beat] is selected, use the knob to set the BPM
(beats/minute).

NOTE
Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 94 for information on parameter
linking.
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 Parametric Equalizer
When you click [PEQ] button for the crossover processor, it opens the parametric equalizer editor
window. Here you can make parametric equalizer settings for each frequency band.
[Crossover Processor-PEQ] editor window

1

2
7
3
4
5
6

Name
1

Function

PEQ Curve
Parameter

Displays the PEQ curve.
Setting Range

Function

2

Type

PEQ
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF

Select the filter type from a menu.

3

Q:

0.1 to 16.0

Sets the frequency band width for each band.

4

Frequency

20 Hz to 20 kHz

Sets the frequency for each band.

5

Gain

-18 dB to +18 dB

Sets the gain for each band.

6

Bypass

ON/OFF

Turns ON bypass for each band.

7

PEQ On

ON/OFF

Turns the PEQ ON.
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 Compressor
When you click the [Compressor] button for the crossover processor, it opens the compressor
editor window. Here you can make compressor settings for each frequency band.
[Crossover Processor-Compressor] editor window

4

5

6

7

8

9

1

2 3

)

Name
1

Compressor Curve

Displays results graphically. The horizontal axis is the
input signal level, and the vertical axis is the output
level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

392

Function

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Ratio

1:1 to ∞:1

Sets the compression ratio.

6

Knee

HARD, 1, 2, 3, 4, 5

Sets the way compression is applied.

7

Attack

0 to 120 ms

Sets the attack time.

8

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the
operating frequency.

9

Gain

±0 dB to +18 dB

Sets the output gain.

)

On

ON/OFF

Turns the compressor ON. When you turn this button
OFF, the compressor is bypassed.
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Crossover Processor II
The following five types of components are available in the Crossover Processor II group: 2 Way, 3
Way, 4 Way, 5 Way, and 6 Way. Crossover processor II components have a single input and 2 to 6
outputs.

Double-click a component to display the component editor for it. The number of bands may vary
depending on the component, but they share a common configuration in the component editor.
There are input and output level meters in the upper part of the window. If you click the [Crossover],
[Delay], [PEQ], or [Compressor] button in the [Navigator] section, an editor for the crossover, delay,
parametric equalizer, or compressor will be displayed in a separate window. A separate component
editor will open for each output channel (such as Low or Mid) when you click on the delay, parametric
equalizer, or compressor.
Crossover Processor II

1

2

3
4

7

8

9

Name

5

6

)

Function

1

Input Meter

Displays the input signal level.

2

Output Meter

Displays the output signal level.

Section
3

Input

4
5
6

Output

Parameter

Setting Range

Function

Gain

-∞ to +10 dB

Sets the input signal level.

Mute

ON/OFF

Mutes the input signal.

Gain

-∞ to +10 dB

Sets the output signal level for each
frequency band.

Mute

ON/OFF

Mutes the output signal for each frequency
band.
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Name
Crossover

--

This opens the crossover editor window.

8

Delay

--

This opens the delay editor window.

9

PEQ

--

This opens the parametric equalizer editor
window.

)

Compressor

--

This opens the compressor editor window.

7

Navigator

Function

 Crossover
When you click the [Crossover] button for the crossover processor, it opens the crossover editor
window.
Crossover Processor II component editor

1

2
3
4
8

5

9

)

6

7

Name
1

Crossover Curve
Section

394

Function
Displays the level of each frequency band,
distinguished by color.

Parameter

Setting Range

Function

2

Frequency

20 Hz to 20 kHz

Sets the cross frequency between each
frequency band.

3

Polarity

Normal/Inverted

Reverses the output signal phase for each
frequency band.

4

Mute

ON/OFF

Mutes the signal for each frequency band.
This is linked to the Mute setting in the
original window. The display appears as a
dotted line when muted.
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Section

Parameter

Setting Range

Function

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

6

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

7

Gc

-6 dB to 6 dB

When [Adjustable Gc] is selected for [Type],
this sets the gain for the cutoff frequency.

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

9

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

)

Gc

-6 dB to 6 dB

When [Adjustable Gc] is selected for [Type],
this sets the gain for the cutoff frequency.

5

8

LPF

HPF
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 Delay
When you click the [Delay] button for the crossover processor, it opens the delay editor window.
Here you can set the delay for each frequency band.

1
4
2
3

Parameter

Setting Range

Function

1

Delay

ms: 0 to 500
Sample: the range depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends on the Frame value.
Beat: the range depends on the Beat value.

Sets the delay time.

2

Level

-∞ to ±0 dB

Sets the output signal level for each
channel.

3

On

ON/OFF

Turns delay ON.

4

Delay Scale

ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay
time. The selected button will light up,
and the units in the [Delay] edit box
will change.
If [Beat] is selected, use the knob to
set the BPM (beats/minute).

NOTE
Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 94 for information on parameter
linking.
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 Parametric Equalizer
When you click the [PEQ] button for the crossover processor, it opens the parametric equalizer
editor window. Here you can make parametric equalizer settings for each frequency band.

1

2
7
3
4
5
6

Name
1

Function

PEQ Curve
Parameter

Displays the PEQ curve.
Setting Range

Function

2

Type

PEQ
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF

Select the filter type from the menu.

3

Q

0.1 to 16.0

Sets the band width of each band.

4

Frequency

20 Hz to 20 kHz

Sets the frequency of each band.

5

Gain

-18 dB to +18 dB

Sets the frequency gain for each band.

6

Bypass

ON/OFF

Turns ON bypass for each band.

7

PEQ On

ON/OFF

Turn the PEQ ON.
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 Compressor
When you click the [Compressor] button for the crossover processor, it opens the compressor
editor window. Here you can make compressor settings for each frequency band.

1

23

4

5

6

7

8

9

)

Name
1

Compressor Curve

Displays results graphically. The horizontal axis is the
input signal level, and the vertical axis is the output
level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

398

Function

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Ratio

1:1 to ∞:1

Sets the compression ratio.

6

Knee

HARD, 1, 2, 3, 4, 5

Sets the way compression is applied.

7

Attack

0 to 120 ms

Sets the attack time.

8

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may vary, depending on the
operating frequency.

9

Gain

±0 dB to +18 dB

Sets the output gain.

)

On

ON/OFF

Turns the compressor ON. When you turn this button
OFF, the compressor is bypassed.
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Delay
This is a multi-tap delay that provides independent delay and level control for each output. You can
specify the delay time in milliseconds, samples, meters, feet, time code frames, or number of beats.
Within the delay group, there are two subgroups called Long and Short. Each has a different setting
range for the delay.
NOTE
The maximum delay time that can be set internally is approximately 43.6 seconds for the DME64N and 21.8 seconds for the
DME24N, regardless of the sampling frequency.

Delay Long
Delay long components are available with from one to eight outputs. Each has a single input and from
one to eight outputs.

Double-click a component to display the component editor for it. Only the number of outputs in each
component is different. The other parts are the same.
Delay Long Component Editor

8
1

4
5

2
6
7

3

Section

Parameter

Setting Range

Function

1

Delay

All Bypass

ON/OFF

Bypasses from input to output.

2

Input

Level

-∞ to ±0 dB

Sets the input signal level.

Mute

ON/OFF

Mute the input signal.

Delay

ms: 0 to 1300
Sample: the range depends
on the Fs value.
Meter: 0 to 446.7
Feet: 0 to 1465.4
Frame: the range depends on
the Frame value.
Beat: the range depends on
the Beat value.

Sets the delay time.
There are two edit boxes, displaying
milliseconds and the units selected for [Delay
Scale].

5

Level

-∞ to ±0 dB

Sets the output signal level for each channel.

6

On

ON/OFF

Turns ON each channel’s delay.

7

Mute

ON/OFF

Turns ON muting for each channel’s output.

3
4

Delay Tap
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Section
8

Parameter

Delay Scale

Setting Range

Function
Selects the units for setting the delay time.
The selected button will light up, and the
units in the [Delay] edit box will change.
If [Beat] is selected, use the knob to set the
BPM (beats/minute).

ms
Sample
Meter
Feet
Frame
Beat

NOTE
Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 94 for information on parameter
linking.

Delay Short
Delay short components are available with from one to eight outputs. Each has a single input and from
one to eight outputs.

Double-click a component to display the component editor for it. Only the number of outputs in each
component is different. The other parts are the same.
Delay-Short component editor

1

8
4
5

2
6
7

3

Section

Setting Range

Function

1

Delay

All Bypass

ON/OFF

Bypasses from input to output.

2

Input

Level

-∞ to ±0 dB

Sets the input signal level.

Mute

ON/OFF

Mute the input signal.

3

400

Parameter
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Section

Setting Range

Function

Delay

ms: 0 to 130
Sample: the range depends
on the Fs value.
Meter: 0 to 44.7
Feet: 0 to 146.5
Frame: the range depends on
the Frame value.
Beat: the range depends on
the Beat value.

Sets the delay time.
There are two edit boxes, displaying
milliseconds and the units selected for [Delay
Scale].

5

Level

-∞ to ±0 dB

Sets the output signal level for each channel.

6

On

ON/OFF

Turns ON each channel’s delay.

7

Mute

ON/OFF

Turns ON muting for each channel’s output.

ms
Sample
Meter
Feet
Frame
Beat

Selects the units for setting the delay time.
The selected button will light up, and the
units in the [Delay] edit box will change.
If [Beat] is selected, use the knob to set the
BPM (beats/minute).

4

8

Delay Tap

Delay Scale

Parameter

NOTE
Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 94 for information on parameter
linking.
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Dynamics
Components in the dynamic group adjust the dynamic range of the sound. There are eight types of
components, each of which is available in mono channel and stereo channel versions. The nine types
are: compander hard, compander soft, compressor, de-esser, ducking, expander, gate, limiter, and
program ducker.

 KeyIn
All components in the dynamic group, except the de-esser, have KeyIn input. This is used as a
trigger source that activates the effects of the component.

The trigger source is set in the [KeyIn] section of the component editor.

[KeyIn] Section

The currently selected trigger source is displayed on the button. Click the button and select the
trigger source from the menu.
Mono channel

Stereo channel

• [SELF]
Sets the input signal as the trigger source for mono channel components.

• [L]/[R]
Sets the left or right input signal as the trigger source for stereo channel components.

• [LR BOTH]
Sets both the left and right input signals as the trigger source for stereo channel components.
The strongest input signal will be the trigger source, whether from the left or right channel.

• [KEYIN]
The KeyIn input will be the trigger source.
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DME Designer Owner’s Manual

Chapter 6 Component Guide

Compander
The compander combines the effects of a compressor and an expander. A compressor compresses
signals that exceed the threshold, while the expander reduces signals that fall below the threshold.
There are two compander groups, CompanderH (compander hard) and CompanderS (compander
soft). Within each group, there are mono channel and stereo channel companders.
Mono channel companders have one input, one output, and one KeyIn input. Stereo channel
companders have two inputs, two outputs, and one KeyIn input.
CompanderH

CompanderS

Stereo channel
Mono channel

Stereo channel
Mono channel

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
The compander hard and compander soft differ in the compression ratio of their fixed expander. The
expander compression is expressed by the straight portion of the lower-left part of the compander
curve. The compression ratio of the compander hard is large. The slope is also large. The
compression ratio of the compander soft is small, with a gentle compression. The parameters in the
component editor are the same.
CompanderH Mono component editor

4

5

CompanderS Stereo component editor

6

1

4

5

6

7

8

9

1
7

23

)

8

9

!

2 3

Name

)

!

Function

1

Compander Curve

Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Ratio

1:1 to ∞:1

Sets the compression ratio.

6

Width

+1 dB to +90 dB

Sets the width of the expander.

7

Attack

0 to 120 ms

Sets the attack time.

8

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the
operating frequency.

9

Gain

-18 dB to ±0 dB

Sets the output gain.
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Parameter
)

!

KeyIn

On

Setting Range

Function

Mono

SELF
KEYIN

Stereo

L
R
LR BOTH
KEYIN

Selects the trigger source from a menu. The
currently selected trigger source is displayed on the
button.

ON/OFF

Turns the compander ON.
Ratio=4:1

+20

Width=25

Output Level (dB)

+10
0

–10
–20
–30
–40
–50

Threshold = –25dB

–60
–70
–70 –60 –50 –40 –30 –20 –10

0

+10 +20

Input Level (dB)

Compressor
Compresses signals that exceed a threshold. Narrows the dynamic range of the signal, making it
easier to mix or record signals with a wide dynamic range such as vocals or piano music. Both mono
channel and stereo channel compressors are provided.
Mono channel compressors have one input, one output, and one KeyIn input. Stereo channel
compressors have two inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.
Compressor component editor

4

5

6

7

8

9

1

2 3

Name

404

)

!

Function

1

Compressor Curve

Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.
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Parameter

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Ratio

1:1 to ∞:1

Sets the compression ratio.

6

Knee

HARD, 1, 2, 3, 4, 5

Sets the way compression is applied.

7

Attack

0 to 120 ms

Sets the attack time.

8

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the
operating frequency.

9

Gain

±0 dB to +18 dB

Sets the output gain.

)

KeyIn

Mono

SELF
KEYIN

Stereo

L
R
LR BOTH
KEYIN

!

On

ON/OFF

Selects the trigger source from a menu. The
currently selected trigger source is displayed on the
button.

Turns the compressor ON.

+20

Output Level (dB)

+10

Ratio=2:1

0
–10
–20

Knee = Hard

–30
–40
–50

Threshold = –20dB

–60
–70
–70 –60 –50 –40 –30 –20 –10

0

+10 +20

Input Level (dB)

De-Esser
Compresses the signal above a specified frequency. The de-esser controls sibilant (hissing) sounds
included in speech that are produced by the letter “S.” Both mono channel and stereo channel deessers are provided.
Mono channel de-essers have one input and one output each. Stereo channel de-essers have two
inputs and two outputs each.
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Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.
De-Esser component editor

4

5

6

1
7

8

2 3

9

)

9

Name

Function

1

De-Esser Curve

Displays results graphically. The horizontal axis is the
input signal level, and the vertical axis is the output
level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Ratio

1:1 to ∞:1

Sets the compression ratio.

6

Knee

HARD, 1, 2, 3, 4, 5

Sets the way the de-esser effect is applied.

7

Attack

0 to 120 ms

Sets the attack time.

8

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the
operating frequency.

9

Gain

±0 dB to +18 dB

Sets the output gain.

)

Frequency

80 Hz to 10 kHz

Sets the minimum signal frequency for compression.

!

On

ON/OFF

Turns the de-esser ON.

+20

Output Level (dB)

+10

Ratio =2 :1

0
–10
–20

Knee = Hard

–30
–40
–50

Threshold = –20dB

–60
–70
–70 –60 –50 –40 –30 –20 –10

Input Level (dB)
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Ducking
Attenuates the output a particular amount, when an input signal exceeds its threshold. Both mono
channel and stereo channel duckers are provided.
Mono channel duckers have one input, one output, and one KeyIn input. Stereo channel duckers have
two inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.
Ducking component editor

4

5

6

1
7

2 3

9

8

)

Name

Function

1

Ducking Curve

Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Range

-70 dB to ±0 dB

Sets the amount by which the level is reduced.

6

Attack

0 to 120 ms

Sets the attack time.

7

Hold

44.1 kHz: 0.02 ms to 2.13 s
48 kHz: 0.02 ms to 1.96 s
88.2 kHz: 0.01 ms to 1.06 s
96 kHz: 0.01 ms to 981 ms

Sets the hold time.
The setting range may very, depending on the
operating frequency.

8

Decay

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the decay time.
The setting range may very, depending on the
operating frequency.

9

KeyIn

Mono

SELF
KEYIN

Stereo

L
R
LR BOTH
KEYIN

Selects the trigger source from a menu.
The currently selected trigger source is displayed
on the button.

)

On

ON/OFF

Turns the ducking ON.
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+20

Output Level (dB)

+10
0

Threshold = –20dB

–10
–20

Range = –25dB

–30
–40
–50
–60
–70

–70 –60 –50 –40 –30 –20 –10

0

+10 +20

Input Level (dB)

Expander
Widens the dynamic range of the signal. Low-level signals such as noise are diminished. Both mono
channel and stereo channel expanders are provided.
Mono channel expanders have one input, one output, and one KeyIn input. Stereo channel expanders
have two inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.
Expander component editor

4

5

6

7

8

9

1

2 3

)

!

Name
1

Expander Curve

Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

408

Function

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Ratio

1:1 to ∞:1

Sets the compression ratio.

6

Knee

HARD, 1, 2, 3, 4, 5

Sets the way the expander is applied.

8

Attack

0 to 120 ms

Sets the attack time.
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Parameter

Setting Range

Function

8

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time.
The setting range may very, depending on the
operating frequency.

9

Gain

±0 dB to +18 dB

Sets the output gain.

)

KeyIn

Mono

SELF
KEYIN

Stereo

L
R
LR BOTH
KEYIN

!

On

Selects the trigger source from a menu. The
currently selected trigger source is displayed on the
button.

ON/OFF

Turns the expander ON.

+20

Output Level (dB)

+10
0

Knee = Hard

–10
–20

Ratio =2 :1

–30
–40

Threshold = –10dB

–50
–60
–70
–70 –60 –50 –40 –30 –20 –10

0

+10 +20

Input Level (dB)

Gate
Attenuates signals that are lower than the threshold level. Both mono channel and stereo channel
gates are provided.
Mono channel gates have one input, one output, and one KeyIn input. Stereo channel gates have two
inputs, two outputs, and one KeyIn input.

Double-click a component to open the component editor for it. The parameters are the same for mono
channel and stereo channel components.
Gate component editor

4

5

6

1

2 3

7

8

9

)
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Name

Function

1

Gate Curve

Displays results graphically. The horizontal axis is
the input signal level, and the vertical axis is the
output level.

2

Gain Reduction Meter

Displays the gain reduction attenuation.

3

Output Meter

Displays the output signal level.

Parameter

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Range

-70 dB to ±0 dB

Sets the amount by which the level is reduced.

6

Attack

0 to 120 ms

Sets the attack time.

7

Hold

44.1 kHz: 0.02 ms to 2.13 s
48 kHz: 0.02 ms to 1.96 s
88.2 kHz: 0.01 ms to 1.06 s
96 kHz: 0.01 ms to 981 ms

Sets the hold time.

8

Decay

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the decay time.
The setting range may very, depending on the
operating frequency.

9

KeyIn

Mono

SELF
KEYIN

Stereo

L
R
LR BOTH
KEYIN

Selects the trigger source from a menu. The
currently selected trigger source is displayed on the
button.

)

On

ON/OFF

Turns the gate ON.

+20

Output Level (dB)

+10
0
–10

Threshold = –20dB

–20
–30

Range = –25dB

–40
–50
–60
–70
–70 –60 –50 –40 –30 –20 –10

0

+10 +20

Input Level (dB)

Limiter
Signals above the threshold are compressed at an ∞:1 ratio, preventing output of signals that exceed
the threshold level. Mono channel and stereo channel components are provided.
Mono channel components have a single input and output plus a key input, while stereo channel
components have two inputs and outputs and a key input.
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Double click the component to open the component editor. Mono channel and stereo channel
components have the same parameters.
Limiter component editor

4

1
5

23

6

7

8

Name

Function

1

Limiter Curve

Displays the limiter response in graph form. The
horizontal axis represents input signal level and the
vertical axis represents output level.

2

Gain Reduction Meter

Displays the amount of gain reduction.

3

Output Meter

Displays the output signal level.

Parameter

Setting Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold value.

5

Attack

0 to 120 ms

Sets the attack time.

6

Release

44.1 kHz: 6 ms to 46 s
48 kHz: 5 ms to 42.3 s
88.2 kHz: 3 ms to 23 s
96 kHz: 3 ms to 21.1 s

Sets the release time. The range varies according to
the operating frequency.

9

KeyIn

Mono

SELF
KEYIN

Stereo

L
R
LR BOTH
KEYIN

The trigger source can be selected from this menu.
The currently selected source is displayed in the
button.

On

ON/OFF

Turns the limiter ON.

+20

RATIO=20:1
+10
0

Output Level (dB)

)

Threshold=–20dB
–10
–20
–30
–40
–50
–60
–70

–70 –60 –50 –40 –30 –20 –10

0

+10 +20

Input Level (dB)
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Program Ducker
When the key-in signal level exceeds the threshold level, the output signal is attenuated (or the
attenuated output signal is returned to its original level).
Mono channel and stereo channel components are provided. Mono channel components have one
input and one output, and a single key-in input. Stereo channel components have two inputs and two
outputs, and a single key-in input.

Double click the component to open the component editor. The mono and stereo channel types have
the same parameters.
Program Ducker component editor

5
9
3

6

7

1

2

4

Function

Name
1

KeyIn Meter

Displays the key-in signal level.

2

Output Meter

Displays the output level.

Parameter

412

8

Range

Function

3

Detect Threshold

-60.0 – 0.0 dB

Sets the threshold level for the key-in signal. The set level is
indicated by a triangular marker next to the KeyIn Meter.

4

Hold Time

0.1 – 10.0 s

Sets the hold time during which operation will continue after
the key-in signal falls below the threshold level, in 0.1 second
increments.

5

Mode

6

Attack Time

0.0 – 10.0 s

Sets the time it takes to reach the target output level after a
key-in signal is detected, in 0.1 second increments.

7

Release Time

0.0 – 10.0 s

Sets the time it takes for the output to return to its normal predetect level after the key-in signal falls below the threshold
level and the Hold Time has elapsed, in 0.1 second
increments.
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: The output level is attenuated when the key-in signal is
detected. The normal output level is 0dB (nominal) and the
attenuated level is specified by the Range parameter.
: The output level is attenuated when no key-in signal is
detected, and the output returns to its original level when a
key-in signal is detected. The normal attenuation level is
specified by the Range parameter, and the output level when a
key-in signal is detected is 0dB (nominal).
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Function

Name
8

Range

-∞ – 10.0 s

Sets the attenuation level: the attenuation level while a key-in
signal is detected in the
mode, or the attenuation level
while no key-in signal is detected in the
mode.

9

Bypass

On/Off

Attenuation is bypassed when “On”.

Level
0 dB

Range

Time
Attack

Hold

Release

Hold

Release

Key-in signal is detected

Level
0 dB

Range

Time
Attack
Key-in signal is detected
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Equalizer (EQ)
The equalizer boosts or cuts the levels of specified frequencies. The EQ group contains graphic
equalizers (GEQ) and parametric equalizers (PEQ).
The frequency bands in the graphic equalizer are fixed. The graphical interface lets you visually check
the gain of each frequency. There are three different types of equalizers, each with a different number
of frequency bands. Mono channel and stereo channel equalizers are available for each type.
With the parametric equalizer, you can freely adjust the frequency bands, their amplitudes, and
bandwidths. There are six different types of parametric equalizers, each with a different number of
frequency bands. Mono channel and stereo channel equalizers are available for each type.

Graphic Equalizer (GEQ)
Boosts or cuts signals within the specified frequencies. The mono group contains 7 band, 15 band,
and 31 band mono channel components. The stereo group contains 7 band, 15 band, and 31 band
stereo channel components.
Mono channel GEQs have one input and one output each. Stereo channel GEQs have two inputs and
two outputs each.
Mono channel

Stereo channel

Double-click a component to display the component editor for it. The number of bands varies
depending on the component, but all share a common configuration in the component editor.
Component editor for GEQ

2

1

3

4

6
7

5
8
!

9

)

#

@

$

Name

414

*
%

^

&

%

^

&

%

^

&

%

^

(

&

Function

1

Input Meter

Displays the input signal level.

2

EQ Curve

Displays the equalizer effect.

3

Output Meter

Displays the output signal level.
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Section

Setting Range

Function

Bypass

ON/OFF

Turns ON bypass for each band.

5

Gain

Set by [Range].

Sets the output gain for its band.

6

GEQ ON

ON/OFF

Turns the GEQ ON.

7

Range

±15
±12
±6
-24

Selects the gain adjust width.

8

EQ Flat

--

Returns the faders of all bands to 0dB.

Level

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

Bypass

ON/OFF

Turns bypass ON.

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

Bypass

ON/OFF

Turns bypass ON.

Frequency

20 Hz to 20 kHz

Sets the notch filter frequency.

^

Q:

0.1 to 63.0

Sets the width of the frequency band that will
be changed by the filter.

&

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the signal level.

On

ON/OFF

Turns output ON.

4

9

Equalizer

Parameter

Input

)
!

HPF

@
#

LPF

$
%

*
(

Notch

Output

 EQ Graph [Bypass] Button
A number for each frequency band is displayed on these buttons. When you click the button, it
lights up and the bypass turns ON. When you turn this ON, bypassed sound (unchanged sound) is
output. When you turn this OFF, the sound is output with effects applied.

Bypass ON

Bypass OFF
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Parametric Equalizer (PEQ)
Boosts or cuts signals within specified frequencies. In both the Mono group and Stereo group there
are 2 band, 3 band, 4 band, 6 band, and 8 band components available.
Mono channel PEQs have one input and one output each. Stereo channel PEQs have two inputs and
two outputs each. The number of bands varies depending on the component, but all share a common
configuration in the component editor.

Double-click a component to display the component editor for it. The number of bands varies
depending on the component, but all share a common configuration in the component editor.
PEQ component editor

1

4
9
5

)

2
6
7
8

!

3

Name
1

EQ Curve

Displays the equalizer effect.
You can change the parameter by dragging
the control point with the mouse.

Section
Input

Parameter

Setting Range

Function

Level

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Type

PEQ
L.SHELF 6 dB/Oct
L.SHELF 12 dB/Oct
H.SHELF 6 dB/Oct
H.SHELF 12 dB/Oct
HPF
LPF

Select the filter type from the menu.

5

Q

0.1 to 16.0

Sets the band width for each frequency
band.

6

Frequency

20 Hz to 20 kHz

Sets the frequency for each band.

7

Gain

-18 dB to +18 dB

Sets the level of the frequency that will be
changed.

8

Bypass

ON/OFF

Turns ON bypass for each band.

2
3
4

416

Function

Equalizer
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Section

Parameter

Setting Range

Function

9

Equalizer

PEQ ON

ON/OFF

Turns the PEQ ON

)

Output

Level

-∞ to ±0 dB

Sets the output signal level.

On

ON/OFF

Turns output ON.

!

 Filter Type
Various types of curves are available for changing the level. Click the [Type] button and select the
type from the menu.

• PEQ
This is a general parametric equalizer.

• L. SHELF (Low Shelving)
There is no sound attenuation at low frequencies. The sound is attenuated at a constant rate
from the cutoff frequency towards the higher frequencies. The attenuation rate per octave can
be set to [6 dB/Oct] or [12 dB/Oct].

• H.SHELF (High Shelving)
There is no sound attenuation at high frequencies. The sound is attenuated at a constant rate
from the cutoff frequency towards the lower frequencies. The attenuation rate per octave can
be set to [6 dB/Oct] or [12 dB/Oct].

• HPF
This is a high-pass filter (Q=0.7). Attenuates the low frequencies with a gentle curve (12 dB/
Oct).

• LPF
This is a low-pass filter (Q=0.7). Attenuates the high frequencies with a gentle curve (12 dB/
Oct).
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Fader
Controls the output level for each channel. Fader components are available for 1, 2, 4, 8, 12, and 16
channels.

Double-click a component to display the component editor for it. The number of channels varies, but
all components share a common configuration in the component editor.
Fader component editor

1
2

3

4

Parameter

Setting Range

Function

1

Phase

ON/OFF

Reverses the phase of the output signal for each
channel.

2

On

ON/OFF

Turns ON each channel’s output.

3

Fader

-∞ to +10 dB

Sets the output signal level for each channel.

4

Fade

ON/OFF

Sets fade during scene recall ON or OFF.

 [Fade]
Sets the action of the fader when there is a large change in its position during scene recall. When
you turn this ON, the fader moves gradually to the position after the jump. If you turn this OFF, it
immediately jumps to the parameters saved in the recalled scene.
See “The ‘Scene Manager’ Dialog Box” (page 82) for details about settings for the components to
be faded and the time period when the [Fade] is On.
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Feedback Suppressor
The Feedback Suppressor effectively suppresses acoustic feedback.

1

2

3

Parameter
1

Mode

Setting Range

Function

Selects the type of input signal to be processed.
Speech
Select this mode when the
input source is speech.
Music
Select this mode when the
input source is music.

2

Suppression Level

0~9

Sets the degree of feedback suppression. Higher
values produce greater feedback reduction.
Further, the amount of pitch changed produced by the
effect is displayed in cents.

3

Bypass

ON/OFF

Turns bypass on.
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Filters
A filter passes specific frequencies and attenuates all others.
There are seven types of filters available in the filter group: band pass filter (BPF), high pass filter
(HPF), low pass filter (LPF), notch filter (Notch), programmable BPF, programmable HPF, and
programmable LPF.

Band Pass Filter (BPF)
The band pass filter passes the signal from a specified frequency band, while attenuating frequencies
outside that band. There are two types of BPF components: mono channel and stereo channel. Mono
channel BPFs have one input and one output. Stereo channel BPFs have two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
BPF component editor

1

2

Section

6

5

Setting Range

Function

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the center frequency.

4

Q:

0.1 to 16.0

Sets the band width of a frequency band.

5

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

2
3

6

420

4

Level

1

Input

Parameter

3

BPF

Output
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High Pass Filter (HPF)
The high pass filter passes frequencies in the signal that are higher than a specified frequency, while
attenuating lower frequencies in the signal. There are two types of HPF components: mono channel
and stereo channel. Mono channel HPFs have one input and one output. Stereo channel HPFs have
two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
HPF component editor

1

2

Section

4

6

5

Setting Range

Function

Level

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the cutoff frequency.

4

Slope

6 dB/Oct
12 dB/Oct

Sets the attenuation for each octave.

5

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

1

Input

Parameter

3

2
3

6

HPF

Output
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Low Pass Filter (LPF)
The low pass filter passes frequencies in the signal that are lower than a specified frequency, while
attenuating higher frequencies in the signal. There are two types of LPF components: mono channel
and stereo channel. Mono channel LPFs have one input and one output. Stereo channel LPFs have
two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
LPF component editor

1

2

Section

6

5

Setting Range

Function

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the cutoff frequency.

4

Slope

6 dB/Oct
12 dB/Oct

Sets the attenuation for each octave.

5

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

2
3

6

422

4

Level

1

Input

Parameter

3

LPF

Output
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Notch Filter (Notch)
The notch filter attenuates the signal within a specified frequency band, while passing frequencies
outside that band. There are two types of notch filter components: mono channel and stereo channel.
Mono channel notch filters have one input and one output. Stereo channel notch filters have two of
each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
Notch component editor

1

2

Section

4

6

5

Setting Range

Function

Level

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the center frequency.

4

Q:

0.1 to 63.0

Sets the band width of the frequency band
that will be changed

5

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

1

Input

Parameter

3

2
3

6

Notch

Output
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Programmable BPF
The band pass filter passes the signal from a specified frequency band, while attenuating frequencies
outside that band. With the programmable band pass filter you can set the filter type and the slope
between the frequency band that is passed and the band that is cutoff.
There are two types of programmable BPF components: mono channel and stereo channel. Mono
channel programmable BPFs have one input and one output. Stereo channel programmable BPFs
have two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
Programmable BPF component editor

1

2

Section

5

9

6

)

Setting Range

Function

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

4

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

5

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

6

Bypass

ON/OFF

Turns bypass ON.

2
3
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7 8

Level

1

Input

Parameter

!
3 4

HPF
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Section

Setting Range

Function

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

8

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

9

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

)

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

7

!

LPF

Parameter

Output
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Programmable HPF
The high pass filter passes frequencies in the signal that are higher the specified frequency, while
attenuating lower frequencies in the signal. With the programmable high pass filter you can set the
filter type and the slope between the frequency band that is passed and the band that is cutoff.
There are two types of programmable HPF components: mono channel and stereo channel. Mono
channel programmable HPFs have one input and one output. Stereo channel programmable HPFs
have two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
Programmable HPF component editors

7

1
3

4
5

2

Section

Function

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

5

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

6

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

7

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

2
3

8
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Setting Range

Level

1

Input

Parameter

6

HPF

Output
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Programmable LPF
The low pass filter passes frequencies in the signal that are lower than the specified frequency, while
attenuating higher frequencies in the signal. With the programmable low pass filter you can set the
filter type and the slope between the frequency band that is passed and the band that is cutoff.
There are two types of programmable LPF components: mono channel and stereo channel. Mono
channel programmable LPFs have one input and one output. Stereo channel programmable LPFs
have two of each.

Double-click a component to display the component editor for it. The parameters are the same for
mono channel and stereo channel components.
Programmable LPF component editor

7

1

3
4
5

2

Section

Setting Range

Function

Level

-∞ to +10 dB

Sets the input signal level.

Phase

ON/OFF

Reverses the phase of the input signal.

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

5

Type

Thru
6 dB/Oct
12 dB/Oct AdjustGc
12 dB/Oct Butrwrth
12 dB/Oct Bessel
12 dB/Oct Linkwitz
18 dB/Oct AdjustGc
18 dB/Oct Butrwrth
18 dB/Oct Bessel
24 dB/Oct AdjustGc
24 dB/Oct Butrwrth
24 dB/Oct Bessel
24 dB/Oct Linkwitz
36 dB/Oct AdjustGc
36 dB/Oct Butrwrth
36 dB/Oct Bessel
48 dB/Oct AdjustGc
48 dB/Oct Butrwrth
48 dB/Oct Bessel
48 dB/Oct Linkwitz

Sets the attenuation for each octave and the
filter type.
[THRU] turns off the filter.

6

Gc

-6 dB to +6 dB

When [AdjustGc] (Adjustable Gc) is selected
for [Type], this sets the gain for the cutoff
frequency.

7

Bypass

ON/OFF

Turns bypass ON.

Level

-∞ to ±0 dB

Sets the output signal level.

1

Input

Parameter

6

2
3

8

LPF

Output

DME Designer Owner’s Manual

427

Chapter 6 Component Guide

Meter
Displays signal levels. Meter components are available with 1, 2, 4, 8, 12, and 16 channels.

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.
Meter component editor

1

Name
1

428

Meter
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Miscellaneous
In the Miscellaneous group, there are the Oscillator subgroup and the Wav File Player.

Oscillator
The Oscillator subgroup contains a monochannel oscillator component. The oscillator generates sine
waves at fixed frequencies of 100 Hz, 1 kHz, and 10 kHz, a variable frequency sine wave, pink noise,
and burst noise.

Double-click a component to display the component editor for it.
Oscillator component editor

2

1

6
4

5

3

Section

Setting Range

Function

Sine

100 Hz
1 kHz
10 kHz
Vari

2

Noise

Pink
Burst

3

Frequency

20 Hz to 20 kHz

When [Vari] is selected for [Sine], this sets
the frequency of the generated sine wave.

Level

-∞ to +6 dB

Displays the signal level.

5

On

ON/OFF

Turns ON the oscillator.

6

Meter

--

Displays the output signal level.

1

4

Wave Form

Parameter

Output

Selects the frequency and waveform that will
be generated. Only one of the six [Sine] and
[Noise] buttons can be selected.

Pink Noise
A standard signal used for sound measurement.
This sound covers a frequency range of 20 Hz to 20 kHz. As the frequency doubles, the energy of
the sound is cut in half. The sound level is equal at all frequencies.

Burst
Outputs pink noise Outputs a pink noise burst signal.
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Wav File Player
The Wav File Player is a component for playing Wave files. Only one Wav File Player component can
be arranged for each single DME unit.
Add Wave files via the Wav File Manager (page 108).
NOTE
If you switch the effect type for SPX components while playing Wave file by Wav File Player, drop-outs in the sound played in
the Wav File Player may occur.

NOTE
When a Wave file is played back while the DME is set to operate at 88.2 kHz or 96 kHz, only the OUT1 output of the Wav File
Player will be delivered via the Left channel. There will be no output from OUT2.

Double-click the component to display the component editor for it.
Wav File Player component editor

1

2 4

Section

Parameter

5

6

Setting Range

Function

1

Ex. Input

Level

-∞ to 0 dB

Sets the input level from an input port. Only effective
when “External Input” is selected as the playback file.

2

Wav File Player

Play

001 to 100

Selects and displays the playback file.
Only files set in the DME unit in which this component
is placed by the Wav File Manager can be selected.

3

List

--

Open the Wav File Manager to display a list of files set
in the DME unit in which this component is located.
This list functions as a play list.

4



--

Selects the previous file in the play list.

5



--

Selects the next file in the playsuit.

6



--

Plays the selected Wave file. Mute is turned OFF when
“External Input” is selected.

7



--

Stops playback of the Wave file. Muted when
“External Input” is selected.

NOTE
Playback will be stopped if synchronization is carried out during playback.
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Mixer
The Mixer group contains the Auto Mixer, Auto Mixer II, Delay Matrix, Matrix Mixer, and Simple Mixer.

Auto Mixer
There is a noise gate for each input channel, which passes only signals that exceed a specified
threshold. There are five mixer types, each with a different number of inputs.

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor. The auto
mixer component editor consists of two sections: input channels and master output.
Auto Mixer component editor

1

2
3
9

4
5
6

7

)

8

!

Section

Setting Range

Function

Phase

ON/OFF

Reverses the phase of each channel’s
input signal.

2

Gate Indicator

--

When the gate is open, the light turns
green. When the gate is closed, the light
turns yellow.

3

Threshold

-54 dB to ±0 dB

Sets the threshold value for each gate.

4

Hold

44.1 kHz: 110 ms to 2.13 s Sets the gate hold time.
48 kHz: 101 ms to 1.96 s
The setting range may vary, depending
88.2 kHz: 55.1 ms to 1.06 s on the operating frequency.
96 kHz: 50.6 ms to 981 m

1

Input Channels

Parameter

DME Designer Owner’s Manual

431

Chapter 6 Component Guide

Section

Parameter

Setting Range

Function

5

Decay

44.1 kHz: 110 ms to 46 s
48 kHz: 101 ms to 42.3 s
88.2 kHz: 55 ms to 23 s
96 kHz: 51 ms to 21.1 s

Sets the speed for closing the gate.
The setting range may vary, depending
on the operating frequency.

6

Solo

ON/OFF

Turns solo ON. If Solo is engaged for
even one channel, all non-Solo channels
will be muted.

7

On

ON/OFF

Turns ON each channel’s input.

8

Fader

-∞ to +10 dB

Sets the input signal level for each
channel.

Gain Correct

ON/OFF

Automatically adjusts the master output
level to maintain a constant level
according to the number of input
channels with open gates. (*1)

)

On

ON/OFF

Turns ON each channel’s output.

!

Master

-∞ to +10 dB

Sets the output signal level.

9

Master Output

*1 The amount of gain compensation varies according to the number of input channels with open gates as follows:

432

Number of channels
with open gates

Amount of gain
compensation

0

0.0 dB

1

0.0 dB

2

-3.0 dB

3

-4.8 dB

4

-6.0 dB

5

-7.0 dB

6

-7.8 dB

7

-8.5 dB

8

-9.0 dB

9

-9.5 dB

10

-10.0 dB

11

-10.4 dB

12

-10.8 dB

13

-11.1 dB

14

-11.5 dB

15

-11.8 dB

16

-12.0 dB
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Auto Mixer II
This component detects the presence of signals at the input channels, and automatically adjusts the
master output level to maintain a constant level according to the number of active input channels. 8input and 16-input types are provided.

Double-click the component to open the component editor. The component editor is the same for the
8-input and 16-input types, the only difference being the number of channels. The Auto Mixer II
component editor is organized into input channel and master output sections.

1
2
9

3
4
6
5

)

7

!

8

@
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Section

Setting Range

Function

Phase

ON/OFF

Inverts the phase of each input channel.

2

Auto

ON/OFF

Specifies whether each channel is applied to
automatic compensation or not.

3

Input Detect

4

Detect Gain

-54 to 0 dB

Sets the threshold level above which input
signals will be detected. The master output
level is automatically adjusted (reduced) to
maintain a constant level according to the
number of channels for which input is
detected. (*1)

5

O/Ride

ON/OFF

The corresponding channel is given output
priority when this parameter is ON. All other
channels are muted.

6

Mode

Last/Mix

Determines whether only the last channel
given priority via the O/Ride parameter is
turned ON (Last), or whether multiple
channels can be turned ON (Mix).

7

On

ON/OFF

Turns the input to each channel ON.

8

Fader

-∞ to +10 dB

Sets the input level for each input channel.

1

Input Channel

Parameter

Level Meter

Displays the master output level.

)

Response Time *2

Sets the response time for reducing the
amount of output level compensation (gain
increase).

!

On

ON/OFF

Turns the master output ON.

@

Fader

-∞ to +10 dB

Sets the master output level.

9

Master Output

Lights when the input level exceeds the
Detect Gain setting.

*1 The amount of gain compensation varies according to the number of channels for which input is detected as follows:

Number of detected
input channels

Amount of gain
compensation

0

0.0 dB

1

0.0 dB

2

-3.0 dB

3

-4.8 dB

4

-6.0 dB

5

-7.0 dB

6

-7.8 dB

7

-8.5 dB

8

-9.0 dB

9

-9.5 dB

10

-10.0 dB

11

-10.4 dB

12

-10.8 dB

13

-11.1 dB

14

-11.5 dB

15

-11.8 dB

16

-12.0 dB

*2 The setting range of Response Time varies according to the operating frequency as follows:
44.1kHz: 110 msec to 46.0 sec, 48kHz: 101 msec to 42.3 sec, 88.2kHz: 55 msec to 23.0sec, 96kHz: 51 msec to 21.1 sec
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Delay Matrix
This is a matrix mixer that allows you to set an independent delay time and level adjustment for each
output. There are three groups of delay matrix, based on the number of inputs: 2 Input, 4 Input, and 8
Input. In each of the three groups there are five mixers available with 2, 4, 8, 12, or 16 outputs, for a
total of 15 components.

2 Input

4 Input

8 Input

Double-click a component to display the component editor for it. The number of input and output
channels varies depending on the component, but all share a common configuration in the
component editor.
The delay matrix component editor consists of four sections: input, output, matrix, and block. The
[Master] buttons in the [Input] and [Output] sections display windows where you can make master
input and output settings. Delay and level for each channel are set in separate windows that display
four channels each.
Delay Matrix component editor

2

4
6

1

5
7

3

Section

Name

Function

1

Input

Master

Opens the Input Master window.

2

Output

Master

Opens the Output Master window.

3

Matrix

Delay meters
Send level meters

Displays send level and delay time from each input
channels to output buses. Clicking here displays the
Crosspoint window.
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Section

Function

On

Turns ON send from all input channels to output buses.
The [ON] button lights up.

5

Off

Turns OFF send from all input channels to output
buses.

6

Nominal

Resets all send levels, making them 0 dB. The delay
settings are not changed.

7

Minimum

Resets all send levels, making them -∞ dB. The delay
settings are not changed.

4

Block

Name

 Matrix (Delay Meter/Output Level Meter)
The upper row has delay meters, while the middle row has send level meters. You can view
parameters for all output channels at once.

Delay Meter
Send Level Meter

When you click the output channel number on the matrix, the [Delay Matrix - All Inputs to One
Output] editor window opens. When you click the input channel number on the left side of the
matrix, the [Delay Matrix - One Input to All Outputs] editor window opens.

Click to open the [Delay Matrix - All Inputs
to One Output] editor window.

Click to open the [Delay Matrix - One Input
to All Outputs] editor window.

The matrix is divided into groups. For the 2 Input matrix, each group has two input channels and
four output channels. For the 4 Input matrix, each group has four input channels and four output
channels. Groups in matrixes with more than four inputs are the same as for the 4 Input matrix.
When you place the mouse pointer over a group, its channel numbers are highlighted. Click to
open the [Delay Matrix - Crosspoint] editor window.

Click to open the “In 1-4 x Out
1-4” Crosspoint window.
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Click to open the “In 5-8 x Out
5-8” Crosspoint window.

For 2 input matrix, click to
open the “In 1-2 x Out 1-4”
Crosspoint window.
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 Input Master
If you click the [Input Master] button in the delay matrix component editor, it will open the [Delay
Matrix - InputMaster] editor window. Here you can turn the master input for each channel ON and
OFF and set the level.
[Delay Matrix - InputMaster] editor window

1
2

5
7

3
4

Section

Parameter

8

Function

Phase

ON/OFF

Reverses the phase of each channel’s signal.

2

Level

-∞ to +10 dB

Sets the level of the signal from each channel’s
input.

3

Solo

ON/OFF

Turns ON solo for each channel. If Solo is engaged
for even one channel, all non-Solo channels will be
muted.

4

On

ON/OFF

Turns ON each channel’s input.

On

--

Turns ON input for all channels in the Input Master
window. When turned ON, the [On] button lights up.

6

Off

--

Turns OFF input for all channels in the Input Master
window.

7

Nominal

--

Resets all input signal levels in the Input Master
window, making them 0 dB.

8

Minimum

--

Resets all input signal levels in the Input Master
windows, making them -∞ dB.

1

5

Input

Setting Range

6

Block

 Output Master
If you click the [Output Master] button in the delay matrix component editor, it will open the [Delay
Matrix - OutputMaster] editor window. Here you can turn the master output for each channel ON
and OFF and set the level.
[Delay Matrix - OutputMaster] editor window

1
4
6
2

5
7

3

Section

Setting Range

Function

Meter

--

Displays the output signal level for each channel.

2

Level

-∞ to +10 dB

Sets the output signal level for each channel.

3

On

ON/OFF

Turns ON each channel’s output.

1

Output

Parameter
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Section

Setting Range

Function

On

--

Turns ON output for all channels in the Output
Master window. When turned ON, the [On] button
lights up.

5

Off

--

Turns OFF output for all channels in the Output
Master window.

6

Nominal

--

Resets all output signal levels in the Output Master
window, making them 0 dB.

7

Minimum

--

Resets all output signal levels in the Output Master
window, making them -∞ dB.

4

Block

Parameter

 All Inputs to One Output
When you click the output channel number on the matrix, the [Delay Matrix - All Inputs to One
Output] editor window opens. One output channel and the send levels from each input channel to
the output bus are displayed. The output channel is the one you have clicked on in the delay mixer
component editor.
4

1
7
9

2

8
)

3

5

Section
1

Bus Send Level Delay

2
3

Setting Range

Function

0 to 500ms

Sets the delay time from each input channel to the
output bus.

Level

-∞ to +10 dB

Sets the send level from each input channel to the
output bus.

On

ON/OFF

Turns ON the send from each input channel to the
output bus.

Channel

--

Displays the selected output channel. Select
another channel from a menu.

5

On

ON/OFF

Turns ON the output for the channel displayed in the
window.

6

Meter

--

Displays the output signal level of the channel
displayed in the window.

On

--

Turns ON send from all input channels. When
turned ON, the [On] button lights up.

8

Off

--

Turns OFF send from all input channels.

9

Nominal

--

Resets all of send levels, making them 0 dB.

)

Minimum

--

Resets all send levels, making them -∞ dB.

4

7

438

Parameter

6

Output

Block
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Output Channel Switching
The [Delay Matrix - All Inputs to One Output] editor window displays the output channel clicked on
in the delay matrix component editor. The [Channel] buttons in the [Output] section of the [Delay
Matrix - All Inputs to One Output] editor window switch the channel group that is displayed in the
window.

If you make the delay matrix component editor active while the [Delay Matrix - All Inputs to One
Output] editor window is displayed, and then click another output channel, that channel group will
be displayed in the [Delay Matrix - All Inputs to One Output] editor window.
One [Delay Matrix - All Inputs to One Output] editor window is displayed for each delay matrix
component editor.

 One Input to All Outputs
When you click the input channel number on the left side of matrix, the [Delay Matrix - One Input to
All Outputs] editor window opens. One input channel and the send levels from the input channel to
all output buses are displayed. The input channel is the one you have clicked on in the delay mixer
component editor.

6

1
2

9
7

3
4
5

)
@

8

Section

Parameter

Setting Range

Function

Channel

--

Displays the selected input channel. Select another
channel from a menu.

2

Phase

ON/OFF

Reverses the phase of the input signal.

3

Level

-∞ to +10 dB

Sets the input signal level.

4

Solo

ON/OFF

Turns solo ON. If Solo is engaged for even one
channel, all non-Solo channels will be muted.

5

On

ON/OFF

Turns input ON.

0 to 500 ms

Sets the delay time from the input channel to each
output bus.

1

Input

!

6

Bus Send Level Delay

7

Level

-∞ to +10 dB

Sets the send levels from the input channel to each
output bus.

8

On

ON/OFF

Turns ON the send from the input channel to each
output bus.
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Section

Setting Range

Function

On

--

Turns ON send to all channel buses. When turned
ON, the [On] button lights up.

)

Off

--

Turns OFF send to all channel buses.

!

Nominal

--

Resets all send levels, making them 0 dB.

@

Minimum

--

Resets all send levels, making them -∞ dB.

9

Block

Parameter

Input Channel Switching
The [Delay Matrix - One Input to All Outputs] editor window displays the input channel for the
channel number clicked on in the delay matrix component editor.
The [Channel] buttons in the [Input] section of the [Delay Matrix - All Inputs to One Output] editor
window switch the channel group that is displayed in the window.

If you make the delay matrix component editor active while the [Delay Matrix - One Input to All
Outputs] editor window is displayed, and then click another input channel, that channel will be
displayed in the [Delay Matrix - One Input to All Outputs] editor window.
One [Delay Matrix - One Input to All Outputs] editor window is displayed for each delay matrix
component editor.
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 Crosspoint

[Delay Matrix - Crosspoint] editor window

If you click a level meter in the delay
matrix component editor, that group's
[Delay Matrix - Crosspoint] editor
window will be displayed. Adjusts the
send levels from each input channel to
output buses and turns them ON and
OFF. Just like the delay matrix
component editor, the input channels
are arranged vertically while the output
channels are arranged horizontally.

2

3
4

6

5

8

7
9

1

Section

Parameter

Setting Range

Function

1

Input

Channel

--

Switches to another channel group.

2

Output

Channel

--

Switches to another channel group.

3

Bus Send Level Delay

0 to 500 ms

Sets the delay time for each crosspoint.

4

Level

-∞ to +10 dB

Sets the send level for each crosspoint.

5

On

ON/OFF

Turns ON send for each crosspoint.

On

--

Turns ON all sends in the Crosspoint window. The
[On] button lights up.

7

Off

--

Turns OFF all sends in the Crosspoint window.

8

Nominal

--

Resets all send levels in the Crosspoint window,
making them 0 dB.

9

Minimum

--

Resets all send levels in the Crosspoint window,
making them -∞ dB.

6

Block
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Channel Group Switching
The [Delay Matrix - Crosspoint] editor window displays four channels each for Input and Output.
It displays the channel group you click on in the delay matrix component editor. The [Channel]
buttons in the [Input] and [Output] sections of the [Delay Matrix - Crosspoint] editor window switch
the channel group that is displayed in the window.

[Input] section
[Channel] menu

[Output] section
[Channel] menu

If you click another channel group when the delay matrix component editor is active and an [Delay
Matrix - Crosspoint] editor window is displayed, that channel group will be displayed in the open
[Delay Matrix - Crosspoint] editor window.
Only one [Delay Matrix - Crosspoint] matrix window is displayed for each delay matrix component
editor.

Matrix Mixer
In the matrix mixer, the input channels and output buses are arranged in a checkerboard
configuration. You can adjust the group balance for each output bus. There are 32 components in the
in the Matrix Mixer group, each with different numbers of input and output channels. There are eight
groups based on the number of inputs, as follows: 2 Input, 4 Input, 8 Input, 12 Input, 16 Input, 24
Input, 32 Input, and 64 Input.
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NOTE
If a 64 input 64 output Matrix Mixer component or a 64 input 32 output Matrix Mixer component is placed in the DME64N
configuration window, no other components can be used even though the resource meter does not reach 100%.

Double-click a component to display the component editor for it. The number of input and output
channels varies depending on the component, but all share a common configuration in the
component editor.
The matrix mixer component editor consists of four sections: input, output, matrix, and block. The
[Master] buttons in the [Input] and [Output] sections display windows where you can make master
input and output settings. The level for each channel is set in separate windows that display four
channels each.
Matrix Mixer component editor

2
3

4
6

5
7

1

Section

Name

Function

1

Input

Master

Opens the Input Master window.

2

Output

Master

Opens the Output Master window.

3

Matrix

Send level

These meters display the send levels from each input
channel to all output buses. Clicking here displays the
Crosspoint window.

4

Block

On

Turns ON send from all input channels to output buses.
The [ON] button lights up.

5

Off

Turns OFF send from all input channels to output buses.

6

Nominal

Resets all send levels, making them 0 dB.

7

Minimum

Resets all send levels, making them -∞ dB.
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 Matrix (Output Level)
In the matrix, you can view send levels from all output channels to output buses at once. The level
will be grayed out when the corresponding send is set to Off.

Send level

When you click an output channel number on the matrix, the [Matrix Mixer - All Inputs to One
Output] editor window opens. When you click the input channel number on the left side of the
matrix, the [Matrix Mixer - One Input to All Outputs] editor window opens.

Click to open the [Matrix Mixer - All
Inputs to One Output] editor window.

Click to open the [Matrix Mixer - One
Input to All Outputs] editor window.

The matrix is divided into groups, each with four input channels and four output channels. When
you place the mouse pointer over a group, its channel numbers are highlighted. Click to open the
[Matrix Mixer - Crosspoint] editor window.

Click to open the “In 1-4 x Out 5-8”
[Matrix Mixer - Crosspoint] editor window

444

DME Designer Owner’s Manual

Chapter 6 Component Guide

 Input Master
If you click the [Input Master] button in the matrix mixer component editor, it will open the [Matrix
Mixer - InputMaster] editor window. Here you can turn the master input for each channel ON and
OFF and set the level.
[Matrix Mixer - InputMaster] editor window

1
5

2

7

3
4

Section

Setting Range

8

Function

Phase

ON/OFF

Reverses the phase of each channel’s signal.

2

Level

-∞ to +10 dB

Sets the input level to each input channel.

3

Solo

ON/OFF

Turns ON solo for each channel. If Solo is engaged
for even one channel, all non-Solo channels will be
muted.

4

On

ON/OFF

Turns ON each channel’s input.

On

--

Turns ON input for all channels in the Input Master
window. When turned ON, the [On] button lights up.

6

Off

--

Turns OFF input for all channels in the Input Master
window.

7

Nominal

--

Resets all output signal levels in the Input Master
window, making them 0 dB.

8

Minimum

--

Resets all output signal levels in the Input master
window, making them -∞ dB.

1

5

Input

Parameter

6

Block

 Output Master Window
If you click the [Output Master] button in the matrix mixer component editor, it will open the Output
Master window. Her you can turn the master output for each channel ON and OFF and set the level.
[Matrix Mixer - OutputMaster] editor window

1
4
6

5
7

2
3
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Section

Setting Range

Function

Meter

--

Displays the output signal level for each channel.

2

Level

-∞ to +10 dB

Sets the output signal level for each channel.

3

On

ON/OFF

Turns ON each channel’s output.

On

--

Turns ON output for all channels in the Output
Master window. When turned ON, the [On] button
lights up.

5

Off

--

Turns OFF output for all channels in the Output
Master window.

6

Nominal

--

Resets all output signal levels in the Output Master
window, making them 0 dB.

7

Minimum

--

Resets all output signal levels in the Output Master
window, making them -∞ dB.

1

4

Output

Parameter

Block

 All Inputs to One Output
When you click the output channel number on the matrix, the [Matrix Mixer - All Inputs to One
Output] editor window opens. One output channel and the send levels from each input channel to
the output bus are displayed. The output channel is the one you have clicked on in the matrix mixer
component editor.
3

6

1

8

2

4

Section

Bus Send Level Level

Setting Range

5

Function

-∞ to +10 dB

Sets the send level from each input channel to the
output bus.

On

ON/OFF

Turns ON the send from each input channel.

Channel

--

Displays the selected output channel. Select
another channel from a menu.

4

On

ON/OFF

Turns ON the output for the channel displayed in the
window.

5

Meter

--

Displays the output signal level of the channel
displayed in the window.

On

--

Turns ON send from all input channels. When
turned ON, the [On] button lights up.

7

Off

--

Turns OFF send from all input channels.

8

Nominal

--

Resets all send levels, making them 0 dB.

9

Minimum

--

Reset all send levels, making them -∞ dB.

1
2
3

6

446

Parameter

7
9

Output

Block
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Output Channel Switching
[Matrix Mixer - All Inputs to One Output] editor window displays the output channel clicked in the
matrix mixer component editor. The [Channel] buttons in the [Output] section of the [Matrix Mixer All Inputs to One Output] editor window switch the channel group that is displayed in the window.

If you make the matrix mixer component editor active while the [Matrix Mixer - All Inputs to One
Output] editor window is displayed, and then click another output channel, that channel group will
be displayed in the [Matrix Mixer - All Inputs to One Output] editor window.
One [Matrix Mixer - All Inputs to One Output] editor window is displayed for each matrix mixer
component editor.

 One Input to All Outputs
When you click the input channel number on the left side of the matrix, the [Matrix Mixer - One Input
to All Outputs] editor window opens. One input channel and the send levels from the input channel
to all output buses are displayed. The input channel is the one you have clicked on in the delay
mixer component editor.

1
2
3

8

6

)

7

9
!

4
5

Section

Setting Range

Function

Channel

--

Displays the selected input channel. Select
another channel from a menu.

2

Phase

ON/OFF

Reverses the phase of the input signal.

3

Level

-∞ to +10 dB

Sets the input signal level.

4

Solo

ON/OFF

Turns solo ON. If Solo is engaged for even
one channel, all non-Solo channels will be
muted.

5

On

ON/OFF

Turns input ON.

Level

-∞ to +10 dB

Sets the send level from the input channel to
each output bus.

On

ON/OFF

Turns ON the send from the input channel to
each output bus.

On

--

Turns ON send to all channel buses. When
turned ON, the [On] button lights up.

9

Off

--

Turns OFF send to all output buses.

)

Nominal

--

Resets all send levels, making them 0 dB.

!

Minimum

--

Resets all send levels, making them87 -∞ dB.

1

6

Input

Parameter

Bus Send Level

7
8

Block
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Input Channel Switching
The [Matrix Mixer - One Input to All Outputs] editor window displays the input channel for the
channel number clicked on in the matrix mixer component editor.
The [Channel] buttons in the [Input] section of the [Matrix Mixer - All Inputs to One Output] editor
window switch the channel group that is displayed in the window.

If you make the matrix mixer component editor active while the [Matrix Mixer- One Input to All
Outputs] editor window is displayed, and then click another input channel, that channel will be
displayed in the [Matrix Mixer - One Input to All Outputs] editor window.
One [Matrix Mixer - One Input to All Outputs] editor window is displayed for each matrix mixer
component editor.
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 Crosspoint
If you click a level meter in the matrix mixer component editor, the output crosspoint window for the
group will be displayed. Adjusts the send levels from each input channel to output buses and turns
them ON and OFF. Just like the matrix mixture component editor, the input channels are arranged
vertically while the output channels are arranged horizontally.
[Matrix Mixer - Crosspoint] editor window

2
3

5

4

7

6
8

1

Section

Parameter

Setting Range

Function

1

Input

Channel

--

Switches to another channel group.

2

Output

Channel

--

Switches to another channel group.

3

Bus Send Level Level

-∞ to +10 dB

Sets the send level for each crosspoint.

On

ON/OFF

Turns ON send for each crosspoint.

On

--

Turns ON all sends in the Crosspoint window. When
turned ON, the [On] button lights up.

6

Off

--

Turns OFF all sends in the Crosspoint window.

7

Nominal

--

Resets all send levels in the Crosspoint window,
making them 0 dB.

8

Minimum

--

Resets all send levels in the Crosspoint window,
making them -∞ dB.

4
5

Block
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Channel Group Switching
The [Matrix Mixer - Crosspoint] editor window displays four channels each for Input and Output.
It displays the channel group that was clicked on in the matrix mixer component editor. The
[Channel] buttons in the [Input] and [Output] sections of the [Matrix Mixer - Crosspoint] editor
window switch the channel group that is displayed.

[Output] section
[Channel] menu

[Input] section
[Channel] menu

If you click another channel group when the matrix mixer component editor is active and an [Matrix
Mixer - Crosspoint] editor window is displayed, that channel group will be displayed in the open
[Matrix Mixer - Crosspoint] editor window.
Only one [Matrix Mixer - Crosspoint] matrix window is displayed for each matrix mixer component
editor.

Simple Mixer

PFL

ON

METER
ON
IN1(...24)

METER

PFL

Simple Mixer

AUX 1
AUX 2

STEREO L
STEREO R

This is a simple mixer with AUX and PFL facilities. 16-channel and 24-channel types are provided.

3BAND
EQ

LEVEL

LEVEL BAL
ST L

PAN
AUX
PRE/POST

Same as stereo master L

ST R

LEVEL
AUX 1
AUX 2
METER
PFL
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Double-click the component to open the component editor. The component editor is the same for the
16-input and 24-input types, the only difference being the number of channels. The Simple Mixer
component editor is organized into input channel and master output sections.

1
2
3
4
5

$
7

6

%
8

9

^

)
!

&
*

@

#

Section
1

Input Channel

Parameter

Setting Range

EQ Details

Function
Opens the EQ editor window.

2

High Gain

-18.0 to +18.0 dB

Sets the gain of the EQ High band.

3

Mid Gain

-18.0 to +18.0 dB

Sets the gain of the EQ Mid band.

4

Low Gain

-18.0 to +18.0 dB

Sets the gain of the EQ Low band.

5

AUX1 Send

-∞ to +10.0 dB

Sets the AUX1 send level.

6

AUX2 Send

-∞ to +10.0 dB

Sets the AUX2 send level.

7

AUX1 Send Point

Pre/Post

Switches the AUX1 send point to prefader (Pre) or post-fader (Post).

8

AUX2 Send Point

Pre/Post

Switches the AUX2 send point to prefader (Pre) or post-fader (Post).

9

Pan

L63 – Center – R63 Sets the pan position.

)

Pair

ON/OFF

Engages paired operation for odd
and even channel pairs. (excluding
Pan, PFL, and AUX Send operation).
When turned ON the odd-channel
parameters are copied to the even
channel. When ON Pan functions in
LR Nominal mode (nominal level
when pan is full left or right) and when
OFF Pan functions in Center Nominal
mode (nominal level when pan is
center).

!

On

ON/OFF

Turns the input of each channel ON.

@

Fader

-∞ to +10.0 dB

Sets the input level for each input
channel.
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Section

Parameter

Setting Range

Function

PFL

ON/OFF

Engages PFL send. The last selected
channel is given priority.

AUX1 Master

-∞ to +10.0 dB

Adjusts the AUX1 master level.

%

AUX2 Master

-∞ to +10.0 dB

Adjusts the AUX2 master level.

^

Bal

L63 – Center – R63 Sets the pan position of the stereo
output.

&

On

ON/OFF

Turns master output ON.

*

Fader

-∞ to +10.0 dB

Sets the master output level.

#
Master Output

$

 EQ Editor Window
Click the Simple Mixer EQ Details [EQ] button to open the EQ editor window via which EQ can be
adjusted for each channel.

1
2

3

4

Parameter

452

Setting Range

Function

1

Type

PEQ, L.SHELF 6dB/oct,
L.SHELF 12dB/oct,
H.SHELF 6dB/oct,
H.SHELF 12dB/oct

Selects the filter type for the Low and High bands.

2

Q

16.0 to 0.1

Sets the Q for each band.

3

Frequency

20 Hz to 20 kHz

Sets the center frequency for each band.

4

Gain

-18.0 to +18.0 dB

Sets the gain for each band.
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Pan
The Pan group contains the following subgroups: LCR, LR, and Surround.

 Pan Nominal Position
Component editors contain the “Pan Nominal Position” parameter.
The button for that parameter displays its current setting. Clicking the button displays a menu with
[Center] and [LR], which are used to set the pan 0 dB reference.

Center (Center Nominal)
Level is nominal when pan is at center position. Level is +3dB when pan is full left or right.

LR (LR Nominal)
Level is nominal when pan is full left or right.

LCR
In the LCR component, one input is divided into left, center, and right outputs. The number of outputs
is triple the inputs. Components are available with 1, 2, 4, 8, 12, and 16 channels.

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.
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LCR component editor

1
2
3

Parameter

Setting Range

Function

1

CSR

0 to 100%

Sets the signal level sent to the center channel, in
relation to the signal level sent to the L and R
channels.

2

Pan

L63 - Center - R63

Sets LR orientation.

3

Pan Nominal Position

Center
LR

Selects the nominal position from a menu.

LR
Separates a single input into left and right outputs. Components are available with 1, 2, 4, 8, 12, and
16 channels.

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.
Pan component editor

1
2

Parameter

454

Setting Range

Function

1

Pan

L63 - R63

Sets the LR orientation.

2

Pan Nominal Position

Center
LR

Selects the nominal position from a menu.
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Surround
There are three types of surround pan components in the Surround subgroup: 3-1, 5.1, and 6.1.
The surround pan component editor has a two-dimensional surround pan graph where you can set the
location of the sound image.
Surround 6.1 component editor

2

3

4

6

7

8

9
1
)

5

9 )

Name

Location,
Setting Range

Function

1

2D Surround Pan Graph

--

Sets the sound image orientation. You can
move the sound image by clicking and
dragging.

2

Speaker
Button

Clicking here moves the sound image to the
button location.

L

Left

L63 F63

C

Center

C F63

4

R

Right

R63 F63

5

Ls

Left Surround

L63 R63

6

Bs

Back Surround

C R63

7

Rs

Right Surround

R63 R63

8

LFE

Low Frequency
-Effect (Sub Woofer)

9

Left-Right Position

L63 - C - R63

Displays and edits the LR sound image.

)

Front-Back Position

L63 - C - R63

Displays and edits the front-back sound
image.

3

Indicates that there is a sub woofer. Clicking
makes the LFE level 0 dB. The sound image
does not move by clicking.

You can set the sound location using the mouse in the two-dimensional surround pan graph.
The sound position cannot be changed via the numbers below the two-dimensional surround pan
graph. To specify position numerically use the Position X/Y knobs to the left of the graph.
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Dragging
You can move the control by dragging it with the mouse.

Click
If you click within the graph, the control point will move to that position.

Click

Speaker Button
If you click any speaker button besides the [LFE] button, the control point will jump to that
speaker’s position.

Click

456

DME Designer Owner’s Manual

Chapter 6 Component Guide

 Surround 3-1
Surround 3-1 has four channel surround pan, with three channels in front, and one in the rear. There
is one input and four outputs.

Double-click a component to display the component editor for it.
Surround 3-1 component editor

2
5

3
1
4

2

6

3 4

Section
1

2D Surround
Pan Graph

2
3

Position

4

Name/Parameter

Setting Range

Function

2D Surround
Pan Graph

--

Sets the sound image orientation. You can
move the sound image by clicking and
dragging.

Speaker Button

--

Clicking here moves the sound image to the
button location.

Left-Right Position

L63 - C - R63

Displays and edits the LR surround location.

Front-Back Position

F63 - C - R63

Displays and edits the front-back surround
location.

Front

0 to 100%

Sets the ratio for sending the front-center
signal to front L and front R.

Center
LR

Selects the nominal position from a menu.

5

Divergence

6

Pan Nominal Position
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 Surround 5.1
Surround 5.1 has surround pan with three channels in front, two in the rear, and one sub woofer
channel. There is one input and six outputs.

Double-click a component to display the component editor for it.
Surround 5.1 component editor

2
2
5
3
1
4
6

2

7

3 4

Section
1

2D Surround
Pan Graph

2
3

Position

4
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Name/Parameter

Setting Range

Function

2D Surround
Pan Graph

--

Sets the sound image orientation. You can
move the sound image by clicking and
dragging.

Speaker Button

--

Clicking here moves the sound image to the
button location.

Left-Right Position

L63 - C - R63

Displays and edits the LR surround location.

Front-Back Position

F63 - C - R63

Displays and edits the front-back surround
location.

5

Divergence

Front

0 to 100%

Sets the ratio for sending the front-center
signal to front L and front R.

6

LFE

Level

-∞ to +10 dB

Sets output level to the sub woofer.

7

Pan Nominal Position

Center
LR

Selects the nominal position from a menu.
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 Surround 6.1
Surround 6.1 has surround pan with three channels in front, three in the rear, and one sub woofer
channel. There is one input and seven outputs.

Double-click a component to display the component editor for it.
Surround 6.1 component editor

2
2
5
3

6

1
4
7

2

8

3 4

Section
1

2D Surround
Pan Graph

2
3

Position

4
5

Divergence

6

Name/Parameter

Setting Range

Function

2D Surround
Pan Graph

--

Sets the sound image orientation. You can
move the sound image by clicking and
dragging.

Speaker Button

--

Clicking here moves the sound image to the
button location.

Left-Right Position

L63 - C - R63

Displays and edits the LR surround location.

Front-Back Position

F63 - C - R63

Displays and edits the front-back surround
location.

Front

0 to 100%

Sets the ratio for sending the front-center
signal to front L and front R.

Rear

0 to 100%

Sets the ratio for sending the rear-center
signal to rear L and rear R.

Level

-∞ to +10 dB

Sets output level to the sub woofer.

Center
LR

Selects the nominal position from a menu.

7

LFE

8

Pan Nominal Position
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Room Combiner
The Room Combiner component is for use in facilities where movable partitions allow rooms to be
divided or combined. The audio feeds can be easily adjusted to match the physical room
configuration.
For example, if Room 1 and Room 2 are to be combined to create a single large room, the audio feed
for Room 1 can be connected to IN 1 of the component, and the audio feed for Room 2 can be
connected to IN 2 of the component. Then when “Combine” for Room 1 and Room 2 is “ON,” the audio
signals connected to IN 1 and IN 2 are summed and output via OUT 1 and OUT 2. When “Combine”
for Room 1 and Room 2 is “OFF,” the IN 1 signal is sent to OUT 1 only, and the IN 2 signal is sent to
OUT 2 only.
Components are available for combining up to 4, 8, 12, or 16 rooms.

Double-click the component to open the component editor. The component editor is the same for all
types, the only difference being the number of rooms.

1

Parameter

2

Setting Range

Function

1

Combine

ON/OFF

Specifies whether the rooms are to be combined or not.

2

Room No.

*1

Specifies the room number to be combined. “Room
No.” refers to the numbers that are the component’s
input port names.

*1 Depends on the number of rooms provided by the placed component.
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Router
The router assigns inputs to outputs. Each of the six router groups has a different number of inputs.
The groups are 1 input, 2 input, 4 input, 8 input, 12 input and 16 input. Each group has five
components, with 2, 4, 8, 12, and 16 outputs. 32 input group has only 32 outputs component.
1 Input

8 Input

2 Input

12 Input

4 Input

16 Input

32 Input

Double-click a component to display the component editor for it. The number of channels varies
depending on the component, but all share a common configuration in the component editor.

Routers let you route signals from various [Input] locations by connecting them to various [Output]
locations.
One output can be connected to one input only. A single input can be output to multiple channels, but
multiple inputs cannot be output over a single channel. In other words, you can distribute the inputs,
but you cannot mix them. You cannot setup routing for more signals than the number of output
channels.
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 Routing Settings
To change an assignment, click at the position where the desired input and output channels
intersect. When the mouse pointer is moved over a cell, the input and output channels are
highlighted, and a red line is displayed connecting them. Click to set routing for that position. If
another output channel has been assigned to the clicked input channel, the original assignment
will not be cleared. If another input channel has been assigned to the clicked output channel, the
original assignment will be cleared.

Click

Cleared

Not Cleared

 Clearing Routing Settings
If you click the dot that indicates routing, the routing indicated by that dot will be cleared and the
dot will be erased.

Click
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Source Selector
This component selects a single input source from multiple input sources.
“Position” is the number of input sources, and “Channel” is the number of channels included in the
source. For example, a “4 Position 2 Channel” component allows you to select a single 2-channel
source from four 2-channel input sources.
3 Position and 16 Position components are all 1 Channel types, while 1, 2, and 6 Channel versions of 4
Position and 8 Position components are provided.

Double-click a component to open the component editor. The component editor is the same for all
types, the only difference being the number of sources.
Source Selector Component

The Source Selector connects the selected input to the output. For example, if you select [1] for a 4
Position 2 Channel component, IN1-1 will be connected to OUT-1 and IN1-2 will be connected to
OUT2. If you select [2] IN2-1 will be connected to OUT-1 and IN2-2 will be connected to OUT2.
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Speaker Processor
The Speaker Processor is a crossover processor that includes APF (All Pass Filter), horn EQ, and
limiter functions. Six component types are available: 1 Way, 2 Way, 3 Way, 4 Way, 5 Way, and 6 Way.
Speaker Processor components have one input and one or multiple outputs.

Double-click a component to open the component editor.
1

Speaker processor Component

2

4

5

3

6
5

9

)

Name

464

7

!

@

#

8

$

%

Function

1

Library name

Displays library name.

2

Crossover response (phase)

Crossover phase response, color coded for
output channel.

3

Crossover response (level)

Crossover level response, color coded for
each output channel.

4

Input meter

Displays the input signal level.

5

Output meter

Displays the output level for each band.

6

Crossover Curve Display Button

Turns crossover curve display for each output
channel on or off.
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Section

Parameter

Range

Function

7

Delay

Delay

ON/OFF

Applies delay to the crossover response.

8

PEQ

PEQ

ON/OFF

Applies PEQ to the crossover response.

9

Navigator

Input Level

-∞ to +10 dB

Specifies the input signal level.

)

Crossover

–

Opens the crossover editor window.

!

Delay

–

Opens the delay editor window.

@

PEQ

–

Opens the parametric equalizer editor
window.

#

Output Level

-∞ to +10 dB

Sets the output level from each output
channel.

$

Mute

ON/OFF

Mutes the output of each output channel.

%

Limiter

–

Opens the limiter editor window.

Different numbers of channels are provided by each component variation.
1 Way

ALL

2 Way

Low/High

3 Way

Low/Mid/High

4 Way

Low/Low-Mid/High-Mid/High

5 Way

Sub-Low/Low/Low-Mid/High-Mid/High

6 Way

Sub-Low/Low/Low-Mid/Mid/High-Mid/High

Each frequency band has its own color, with Low being red, Mid being green, and so on.
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 Graph Control Points
The crossover level control points indicate [Output Level] and [Frequency]. The control points will
move in response to [Output Level] changes made via the knobs or edit boxes. The [Output Level]
and [Frequency] parameters can also be changed by directly dragging the control points.
Changes to the [Frequency] parameter are shown on the crossover phase response graph.

The control point in the center of the graph can be dragged vertically to change the [Output Level]
parameter.

The [Output Level] parameter changes.

Control points at the intersections between the frequency bands can be dragged horizontally to
change the [Frequency].

The crossover phase response will change.
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 Crossover
Click the Speaker Processor [Crossover] button to open the crossover editor window.
[Speaker Processor - Crossover] editor window

3
1
2
7

4

8

Section

9

5

Parameter

6

Range

Function

1

Polarity

Normal/Inverted

Inverts the polarity of each output channel.

2

Mute

ON/OFF

Mutes the output of each output channel.
This parameter is linked to the Mute setting in
the original window.

3

Frequency

20 Hz to 20 kHz

Sets the crossover frequency between output
channels.
The display appears as a dotted line when
muted.

4

LPF

Type

Thru
6dB/Oct
12dB/Oct AdjustGc
12dB/Oct Butrwrth
12dB/Oct Bessel
12dB/Oct Linkwitz
18dB/Oct AdjustGc
18dB/Oct Butrwrth
18dB/Oct Bessel
24dB/Oct AdjustGc
24dB/Oct Butrwrth
24dB/Oct Bessel
24dB/Oct Linkwitz
36dB/Oct AdjustGc
36dB/Oct Butrwrth
36dB/Oct Bessel
48dB/Oct AdjustGc
48dB/Oct Butrwrth
48dB/Oct Bessel
48dB/Oct Linkwitz

Sets the roll-off slope and filter type for each
octave.
The filter is bypassed when [Thru] is
selected.

5

Frequency

20 Hz to 20 kHz

Sets the LPF cutoff frequency.

6

Gc

-6 dB to +6 dB

Sets the cutoff frequency gain when the
[Type] setting is [AdjustGc] (Adjustable Gc).
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Section

Parameter

Range

Function

Type

Thru
6dB/Oct
12dB/Oct AdjustGc
12dB/Oct Butrwrth
12dB/Oct Bessel
12dB/Oct Linkwitz
18dB/Oct AdjustGc
18dB/Oct Butrwrth
18dB/Oct Bessel
24dB/Oct AdjustGc
24dB/Oct Butrwrth
24dB/Oct Bessel
24dB/Oct Linkwitz
36dB/Oct AdjustGc
36dB/Oct Butrwrth
36dB/Oct Bessel
48dB/Oct AdjustGc
48dB/Oct Butrwrth
48dB/Oct Bessel
48dB/Oct Linkwitz

Sets the roll-off slope and filter type for each
octave.
The filter is bypassed when [Thru] is
selected.

8

Frequency

20 Hz to 20 kHz

Sets the HPF cutoff frequency.

9

Gc

-6 dB to +6 dB

Sets the cutoff frequency gain when the
[Type] setting is [AdjustGc] (Adjustable Gc).

7

HPF

 Delay
Click the Speaker Processor [Delay] button to open the window. Delay can be set independently
for each output channel.
[Speaker Processor - Delay] editor window

1
3
2

Parameter

Range

Function

1

Delay

ms: 0 to 500
Sample: the range
depends on the Fs value.
Meter: 0 to 171.8
Feet: 0 to 563.6
Frame: the range depends
on the Frame value.
Beat: the range depends
on the Beat value.

Sets the delay time.
Two edit boxes show milliseconds and the unit
specified in the [Delay Scale] section.
Sets the output level for each band.

2

On

ON/OFF

Turns delay ON.

3

Delay Scale

ms
Sample
Meter
Feet
Frame
Beat

Selects the delay time units. The selected button will
light and the [Delay] edit box will change accordingly.
When [Beat] is selected the knobs can be used to
adjust BPM.

NOTE
Delay Scale does not support the parameter link feature. Refer to “Parameter Link” on page 94 for information on parameter
linking.
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 Parametric Equalizer
Click the Crossover Processor [PEQ] button to open the window. Parametric equalization is
provided for each crossover band.
[Speaker Processor - PEQ] edit window

1

2

3
4

9

5
6

7
8

Name

Function

1

Crossover response (phase)

Shows crossover phase response.

2

Crossover response (level)

Shows crossover level response.

Parameter

Range

Function

3

Type

PEQ
L.SHELF 6dB/Oct
L.SHELF 12dB/Oct
H.SHELF 6dB/Oct
H.SHELF 12dB/Oct
HPF
LPF
APF*1 1st
APF*1 2nd
Horn EQ*2

Select a filter type from the menu.

4

B/W

0.023 ~ 6.672

Sets the octave bandwidth for each band.

5

Q

63.0 ~ 0.10

Sets the Q for each band.

6

Frequency

20 Hz to 20 kHz

Sets the frequency for each band.

7

Gain

-18 dB to +18 dB

Sets the gain for each band.

8

Bypass

ON/OFF

Bypasses the PEQ for each band.

9

PEQ On

ON/OFF

Turns PEQ ON.

*1 APF: The APF (All Pass Filter) is a filter that passes all frequency bands while affecting only the phase. This is mainly used to
correct the phase at the crossover band.
APF 1st will invert the phase at the specified frequency by 90° and for entire frequency bands by 0°–180°, while APF 2nd will
invert the phase at the specified frequency by 180° and for entire frequency bands by 0°–360°. For APF 2nd, you can adjust the
Q setting.
*2 Horn EQ: CD (Constant Directivity) horn speakers exhibit a roll-off in high-frequency level.
Horn EQ is provided to compensate for this roll-off. For this reason the gain can only be set to higher than 0dB, and the
frequency higher than 500Hz.
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 Limiter
Click the Speaker Processor [Limiter] button to open the window. Limiter settings are provided for
each output channel.
[Speaker Processor - Limiter] Editor Window

4

5

6

1

23

Name

Function

1

Limiter Curve

A graphic representation of limiter response. The
horizontal axis represents input level, and the vertical
axis represents output level.

2

Gain Reduction Meter

Displays the amount of gain reduction.

3

Output Meter

Displays the output level.

Parameter

470

7

Range

Function

4

Threshold

-54 dB to ±0 dB

Sets the threshold level.

5

Attack

Fast
Mid
Slow
Manual (0 to 120ms)

Selects the attack speed of the limiter. If the Manual
setting is selected, specify the attack time in msec
units. If Fast/Mid/Slow is selected, the attack time is
specified roughly according to the HPF cutoff
frequency of Speaker Processor’s Crossover.
Fast : 1/4 wavelength of cutoff frequency
Mid : 1/2 wavelength of cutoff frequency
Slow : 1 wavelength of cutoff frequency

6

Release

Fast
Mid
Slow
Manual
(44.1kHz: 6ms to46s
48kHz: 5ms to 42.3s
88.2kHz: 3ms to 23s
96kHz: 3ms to 21.1s)

Selects the release speed of the limiter. If the Manual
setting is selected, specify the release time in msec. If
Fast/Mid/Slow is selected, the release time is specified
roughly according to the HPF cutoff frequency of
Speaker Processor’s Crossover.
Fast : 4 wavelength of cutoff frequency
Mid : 8 wavelength of cutoff frequency
Slow : 16 wavelength of cutoff frequency

7

On

ON/OFF

Turns the limiter ON. The limiter is bypassed when the
button is turned OFF.
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SPX
SPX is an effect component that supports many different effect applications, such as reverb, delay,
and modulation effects, along with complex combinations of multiple effects. Although the SPX
component is a single component, it encompasses 43 effect types.
When you change the effect type, right-click the SPX component to display the context menu, click
[Recall Component Library], then select the effect type from the [Effect Type] submenu.

Double-click this component to display the component editor for it.
SPX component editor

1

4

5

Name/Parameter

2

3

Function

1

Input Meter

Displays the input signal level.

2

[Mix Balance] Control

Adjusts the balance between the fundamental tone and the effect tone.

3

[Bypass] button

When turned ON, the input signal is output without change.

4

Output Meter

Displays the output signal level.

5

Other Parameters

Other parameters vary according to the effect type.
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Other effect parameters vary according to the selected effect type, as shown below.
Effect Type
Reverb Hall
Reverb Room
Reverb Stage
Reverb Plate
One input, two
output hall, room,
stage, and plate
reverb simulations,
all with gates.

Early Ref.
One input, two
output early
reflections.

Gate Reverb
Reverse Gate
One input, two
output early
reflections with
gate, and early
reflections with
reverse gate.

Parameter

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Lo.Ratio

0.1 to 2.4

Low-frequency reverb time ratio

Diff.

0 to 10

Reverb diffusion (left-right reverb spread)

Density

0 to 100%

Reverb density

E/R Dly

0.0 to 100.0 ms

Delay between early reflections and reverb

E/R Bal.

0 to 100%

Balance of early reflections and reverb (0% = all
reverb, 100% = all early reflections)

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Gate Lvl

OFF, -60 to 0 dB

Level at which gate kicks in

Attack

0 to 120 ms

Gate opening speed

Hold

44.1kHz: 0.02ms to 2.13s
48kHz: 0.02 ms to 1.96s
88.2kHz: 0.01ms to 1.06s
96kHz: 0.01ms to 981ms

Gate open time

Decay

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Gate closing speed

Type

S-Hall, L-Hall, Random, Revers,
Plate, Spring

Type of early reflection simulation

RoomSize

0.1 to 20.0

Reflection spacing

Liveness

0 to 10

Early reflections decay characteristics (0 = dead,
10 = live)

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Diff.

0 to 10

Reflection diffusion (left-right reflection spread)

Density

0 to 100%

Reflection density

ER Num.

1 to 19

Number of early reflections

FB.Gain

-99 to +99%

Feedback gain

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Type

Type-A, Type-B

Type of early reflection simulation

RoomSize

0.1 to 20.0

Reflection spacing

Liveness

0 to 10

Early reflections decay characteristics (0 = dead,
10 = live)

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Diff.

0 to 10

Reflection diffusion (left-right reflection spread)

Density

0 to 100%

Reflection density

ER Num.

1 to 19

Number of early reflections

FB.Gain

-99 to +99%

Feedback gain

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

LPF

DME Designer Owner’s Manual

Function

0.3 to 99.0 s

Mono Delay
Delay
One input, one
FB.Gain
output basic repeat
delay.
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Setting Range

Rev Time

0.0 to 2730.0 ms

Delay time

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency
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Effect Type

Parameter

Setting Range

Function

Stereo Delay
Delay L
Two input, two
Delay R
output basic stereo
delay.
FB.Gain L

FB.Gain R

-99 to +99%

Right channel feedback (plus values for normalphase feedback, minus values for reverse-phase
feedback)

Left channel delay time

0.0 to 1350.0 ms

Right channel delay time

-99 to +99%

Left channel feedback (plus values for normalphase feedback, minus values for reverse-phase
feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

LPF
Mod.Delay
Delay
One input, two
FB.Gain
output basic repeat
delay with
modulation.
Hi.Ratio
Freq.

Delay LCR
One input, two
output 3-tap delay
(left, center, right).

0.0 to 1350.0 ms

0.0 to 2725.0 ms

Delay time

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

0.1 to 1.0

High-frequency feedback ratio

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Wave

Sine, Tri

Modulation waveform

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Delay L

0.0 to 2730.0 ms

Left channel delay time

Delay C

0.0 to 2730.0 ms

Center channel delay time

Delay R

0.0 to 2730.0 ms

Right channel delay time

Delay FB

0.0 to 2730.0 ms

Feedback delay time

Level L

-100 to +100%

Left channel delay level

Level C

-100 to +100%

Center channel delay level

Level R

-100 to +100%

Right channel delay level

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

0.0 to 1350.0 ms

Left channel delay time

LPF
Echo
Delay L
Two input, two
Delay R
output stereo delay
with crossed
FB.Dly L
feedback loop.
FB.Dly R

0.0 to 1350.0 ms

Right channel delay time

0.0 to 1350.0 ms

Left channel feedback delay time

0.0 to 1350.0 ms

Right channel feedback delay time

FB.Gain L

-99 to +99%

Left channel feedback gain (plus values for normalphase feedback, minus values for reverse-phase
feedback)

FB.Gain R

-99 to +99%

Right channel feedback gain (plus values for
normal-phase feedback, minus values for reversephase feedback)

L->R FBG

-99 to +99%

Left to right channel feedback gain (plus values for
normal-phase feedback, minus values for reversephase feedback)

R->L FBG

-99 to +99%

Right to left channel feedback gain (plus values for
normal-phase feedback, minus values for reversephase feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency
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Effect Type
Chorus
Two input, two
output chorus
effect.

Parameter
Freq.

Phaser
Two input, two
output 16-stage
phaser.

Auto Pan
Two input, two
output autopanner.
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Function
Modulation speed

AM.Depth

0 to 100%

Amplitude modulation depth

PM.Depth

0 to 100%

Pitch modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

Wave

Sine, Tri

Modulation waveform

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

EQ F

100 Hz to 8.00 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain

Flange
Freq.
Two input, two
Depth
output flange effect.
Mod.Dly

Symphonic
Two input, two
output symphonic
effect.

Setting Range
0.05 to 40.00 Hz

0.05 to 40.00 Hz

Modulation speed

0 to 100%

Modulation depth

0.0 to 500.0 ms

Modulation delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Wave

Sine, Tri

Modulation waveform

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

EQ F

100 Hz to 8.00 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

Wave

Sine, Tri

Modulation waveform

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

EQ F

100 Hz to 8.00 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Offset

0 to 100

Lowest phase-shifted frequency offset

PHASE

0.00 to 354.38 degrees

Left and right modulation phase balance

Stage

2, 4, 6, 8, 10, 12, 14, 16

Number of phase shift stages

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Direction

L<->R, L->R, L<-R, Turn L, Turn
R

Panning direction

Wave

Sine, Tri, Square

Modulation waveform

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

EQ F

100 Hz to 8.00 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain
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Effect Type
Tremolo
Two input, two
output tremolo
effect.

HQ.Pitch
One input, two
output high-quality
pitch shifter.

Dual Pitch
Two input, two
output pitch shifter.

Rotary
One input, two
output rotary
speaker simulator.

Ring Mod.
Two input, two
output ring
modulator.
Mod.Filter
Two input, two
output modulation
filter.

Distortion
One input, two
output distortion
effect.

Parameter
Freq.

Setting Range
0.05 to 40.00 Hz

Function
Modulation speed

Depth

0 to 100%

Modulation depth

Wave

Sine, Tri, Square

Modulation waveform

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

EQ F

100 Hz to 8.00 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain

Pitch

-12 to +12 semitones

Pitch shift

Fine

-50 to +50 cents

Pitch shift fine

Delay

0.0 to 1000.0 ms

Delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Mode

1 to 10

Pitch shift precision

Pitch 1

-24 to +24 semitones

Channel #1 pitch shift

Fine 1

-50 to +50 cents

Channel #1 pitch shift fine

Pitch 2

-24 to +24 semitones

Channel #2 pitch shift

Fine 2

-50 to +50 cents

Channel #2 pitch shift fine

Level 1

-100 to +100%

Channel #1 level (plus values for normal phase,
minus values for reverse phase)

Pan 1

L63 to R63

Channel #1 pan

Level 2

-100 to +100%

Channel #2 level (plus values for normal phase,
minus values for reverse phase)

Pan 2

L63 to R63

Channel #2 pan

Delay 1

0.0 to 1000.0 ms

Channel #1 delay time

FB.Gain 1

-99 to +99%

Channel #1 feedback gain (plus values for normalphase feedback, minus values for reverse-phase
feedback)

Delay 2

0.0 to 1000.0 ms

Channel #2 delay time

FB.Gain 2

-99 to +99%

Channel #2 feedback gain (plus values for normalphase feedback, minus values for reverse-phase
feedback)

Mode

1 to 10

Pitch shift precision

Rotate

STOP, START

Rotation stop, start

Speed

SLOW, FAST

Rotation speed (see SLOW and FAST parameters)

Slow

0.05 to 10.00 Hz

SLOW rotation speed

Fast

0.05 to 10.00 Hz

FAST rotation speed

Drive

0 to 100

Overdrive level

Accel

0 to 10

Acceleration at speed changes

Low

0 to 100

Low-frequency filter

High

0 to 100

High-frequency filter

Source

OSC, SELF

Modulation source: oscillator or input signal

Osc.Freq.

0.0 to 5000.0 Hz

Oscillator frequency

FM Freq.

0.05 to 40.00 Hz

Oscillator frequency modulation speed

FM Depth

0 to 100%

Oscillator frequency modulation depth

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Phase

0.00 to 354.38 degrees

Left-channel modulation and right-channel
modulation phase difference

Type

LPF, HPF, BPF

Filter type: low pass, high pass, band pass

Offset

0 to 100

Filter frequency offset

Reso.

0 to 20

Filter resonance

Level

0 to 100

Output level

DST.Type

DST1, DST2, OVD1, OVD2,
CRUNCH

Distortion type (DST = distortion, OVD = overdrive)

Drive

0 to 100

Distortion drive

Master

0 to 100

Master volume

Tone

-10 to +10

Tone

N.Gate

0 to 20

Noise reduction
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Effect Type
Amp Simulate
One input, two
output guitar amp
simulator.

Dyna.Filter
Two input, two
output dynamically
controlled filter.

Dyna.Flange
Two input, two
output dynamically
controlled flanger.

Dyna.Phaser
Two input, two
output dynamically
controlled phaser.
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Parameter

Setting Range

Function

AMP.Type

STK-M1, STK-M2, THRASH,
MIDBST, CMB-PG, CMB-VR,
CMB-DX, CMB-TW, MINI, FLAT

Guitar amp simulation type

DST.Type

DST1, DST2, OVD1, OVD2,
CRUNCH

Distortion type (DST = distortion, OVD = overdrive)

Drive

0 to 100

Distortion drive

Master

0 to 100

Master volume

Bass

0 to 100

Bass tone control

Middle

0 to 100

Middle tone control

Treble

0 to 100

High tone control

Cab Dep

0 to 100%

Speaker cabinet simulation depth

EQ F

100 to 8.0 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

N.Gate

0 to 20

Noise reduction

Sense

0 to 100

Sensitivity

Direction

UP, DOWN

Upward or downward frequency change

Decay

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Filter frequency change decay speed

Type

LPF, HPF, BPF

Filter type

Offset

0 to 100

Filter frequency offset

Reso.

0 to 20

Filter resonance

Level

0 to 100

Output Level

Sense

0 to 100

Sensitivity

Direction

UP, DOWN

Upward or downward frequency change

Decay

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Decay speed

Offset

0 to 100

Delay time offset

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

EQ F

100 Hz to 8.00 kHz

EQ (peaking type) frequency

EQ G

-12 to +12 dB

EQ (peaking type) gain

EQ Q

10.0 to 0.10

EQ (peaking type) bandwidth

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain

Sense

0 to 100

Sensitivity

Direction

UP, DOWN

Upward or downward frequency change

Decay

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Decay speed

Offset

0 to 100

Lowest phase-shifted frequency offset

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Stage

2, 4, 6, 8, 10, 12, 14, 16

Number of phase shift stages

LSH F

21.2 Hz to 8.00 kHz

Low shelving filter frequency

LSH G

-12 to +12 dB

Low shelving filter gain

HSH F

50.0 Hz to 16.0 kHz

High shelving filter frequency

HSH G

-12 to +12 dB

High shelving filter gain
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Effect Type
Rev+Chorus
One input, two
output reverb and
chorus effects in
parallel.

Rev->Chorus
One input, two
output reverb and
chorus effects in
series.

Rev+Flange
One input, two
output reverb and
flanger effects in
parallel.

Rev->Flange
One input, two
output reverb and
flanger effects in
series.

Parameter

Setting Range

Function

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev/Cho

0 to 100%

Reverb and chorus balance (0% = all reverb, 100%
= all chorus)

Freq.

0.05 to 40.00 Hz

Modulation speed

AM.Depth

0 to 100%

Amplitude modulation depth

PM.Depth

0 to 100%

Pitch modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

Wave

Sine, Tri

Modulation waveform

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev Bal.

0 to 100%

Reverb and chorused reverb balance (0% = all
chorused reverb, 100% = all reverb)

Freq.

0.05 to 40.00 Hz

Modulation speed

AM.Depth

0 to 100%

Amplitude modulation depth

PM.Depth

0 to 100%

Pitch modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

Wave

Sine, Tri

Modulation waveform

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev/Flg

0 to 100%

Reverb and flange balance (0% = all reverb, 100%
= all flange)

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Wave

Sine, Tri

Modulation waveform

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev Bal.

0 to 100%

Reverb and flanged reverb balance (0% = all
flanged reverb, 100% = all reverb)

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Wave

Sine, Tri

Modulation waveform
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Effect Type
Rev+Sympho.
One input, two
output reverb and
symphonic effects
in parallel.

Rev->Sympho.
One input, two
output reverb and
symphonic effects
in series.

Rev->Pan
One input, two
output reverb and
autopan effects in
parallel.

Delay+ER.
One input, two
output delay and
early reflections
effects in parallel.
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Parameter

Setting Range

Function

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev/Sym

0 to 100%

Reverb and symphonic balance (0% = all reverb,
100% = all symphonic)

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

Wave

Sine, Tri

Modulation waveform

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev Bal.

0 to 100%

Reverb and symphonic reverb balance (0% = all
symphonic reverb, 100% = all reverb)

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Mod.Dly

0.0 to 500.0 ms

Modulation delay time

Wave

Sine, Tri

Modulation waveform

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Rev Bal.

0 to 100%

Reverb and panned reverb balance (0% = all
panned reverb, 100% = all reverb)

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Direction

L<->R, L->R, L<-R, Turn L, Turn
R

Panning direction

Wave

Sine, Tri, Square

Modulation waveform

Delay L

0.0 to 1000.0 ms

Left channel delay time

Delay R

0.0 to 1000.0 ms

Right channel delay time

FB.Dly

0.0 to 1000.0 ms

Feedback delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Dly/ER

0 to 100%

Delay and early reflections balance (0% = all delay,
100% = all early reflections)

Type

S-Hall, L-Hall, Random, Revers,
Plate, Spring

Type of early reflection simulation

RoomSize

0.1 to 20.0

Reflection spacing

Liveness

0 to 10

Early reflections decay characteristics (0 = dead,
10 = live)

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

ER Num.

1 to 19

Number of early reflections
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Effect Type
Delay->ER.
One input, two
output delay and
early reflections
effects in series.

Delay+Reverb
One input, two
output delay and
reverb effects in
parallel.

Delay->Reverb
One input, two
output delay and
reverb effects in
series.

Parameter
Delay L

Setting Range

Function

0.0 to 1000.0 ms

Left channel delay time

Delay R

0.0 to 1000.0 ms

Right channel delay time

FB.Dly

0.0 to 1000.0 ms

Feedback delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

DLY.BAL

0 to 100%

Delay and early reflected delay balance (0% = all
early reflected delay, 100% = all delay)

Type

S-Hall, L-Hall, Random, Revers,
Plate, Spring

Type of early reflection simulation

RoomSize

0.1 to 20.0

Reflection spacing

Liveness

0 to 10

Early reflections decay characteristics (0 = dead,
10 = live)

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

ER Num.

1 to 19

Number of early reflections

Delay L

0.0 to 1000.0 ms

Left channel delay time

Delay R

0.0 to 1000.0 ms

Right channel delay time

FB.Dly

0.0 to 1000.0 ms

Feedback delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Delay Hi

0.1 to 1.0

Delay high-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Dly/Rev

0 to 100%

Delay and reverb balance (0% = all delay, 100% =
all reverb)

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Rev Hi

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density

Delay L

0.0 to 1000.0 ms

Left channel delay time

Delay R

0.0 to 1000.0 ms

Right channel delay time

FB.Dly

0.0 to 1000.0 ms

Feedback delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Delay Hi

0.1 to 1.0

Delay high-frequency feedback ratio

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency

Dly.Bal

0 to 100%

Delay and delayed reverb balance (0% = all
delayed reverb, 100% = all delay)

Rev Time

0.3 to 99.0 s

Reverb time

Ini.Dly

0.0 to 500.0 ms

Initial delay before reverb begins

Rev Hi

0.1 to 1.0

High-frequency reverb time ratio

Diff.

0 to 10

Spread

Density

0 to 100%

Reverb density
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Effect Type

Parameter

Dist->Delay
DST.Type
One input, two
output distortion
Drive
and delay effects in
series.
Master

Multi.Filter
Two input, two
output 3-band
multi-filter (24 dB/
octave).

Stereo Reverb
Two input, two
output stereo
reverb.
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Setting Range

Function

DST1, DST2, OVD1, OVD2,
CRUNCH

Distortion type (DST = distortion, OVD = overdrive)

0 to 100

Distortion drive

0 to 100

Master volume

Tone

-10 to +10

Tone control

N.Gate

0 to 20

Noise reduction

Delay

0.0 to 2725.0 ms

Delay time

FB.Gain

-99 to +99%

Feedback gain (plus values for normal-phase
feedback, minus values for reverse-phase
feedback)

Hi.Ratio

0.1 to 1.0

High-frequency feedback ratio

Freq.

0.05 to 40.00 Hz

Modulation speed

Depth

0 to 100%

Modulation depth

Dly.Bal

0 to 100%

Distortion and delay balance (0% = all distortion,
100% = all delayed distortion)

Type 1

HPF, LPF, BPF

Filter 1 type: high pass, low pass, band pass

Type 2

HPF, LPF, BPF

Filter 2 type: high pass, low pass, band pass

Type 3

HPF, LPF, BPF

Filter 3 type: high pass, low pass, band pass

Freq. 1

28.0 Hz to 16.0 kHz

Filter 1 frequency

Freq. 2

28.0 Hz to 16.0 kHz

Filter 2 frequency

Freq. 3

28.0 Hz to 16.0 kHz

Filter 3 frequency

Level 1

0 to 100

Filter 1 level

Level 2

0 to 100

Filter 2 level

Level 3

0 to 100

Filter 3 level

Reso. 1

0 to 20

Filter 1 resonance

Reso. 2

0 to 20

Filter 2 resonance

Reso. 3

0 to 20

Filter 3 resonance

Rev Time

0.3 to 99.0 s

Reverb time

Rev Type

Hall, Room, Stage, Plate

Reverb type

Ini.Dly

0.0 to 100.0 ms

Initial delay before reverb begins

Hi.Ratio

0.1 to 1.0

High-frequency reverb time ratio

Lo.Ratio

0.1 to 2.4

Low-frequency reverb time ratio

Diff.

0 to 10

Reverb diffusion (left-right reverb spread)

Density

0 to 100%

Reverb density

E/R Bal.

0 to 100%

Balance of early reflections and reverb (0% = all
reverb, 100% = all early reflections)

HPF

THRU, 21.2 Hz to 8.00 kHz

High-pass filter cutoff frequency

LPF

50.0 Hz to 16.0 kHz, THRU

Low-pass filter cutoff frequency
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Effect Type
M.Band Dyna.
Two input, two
output 3-band
dynamics
processor, with
individual solo and
gain reduction
metering for each
band.

Parameter
Low Gain

Setting Range

Function

-96.0 to +12.0 dB

Low band level

Mid Gain

-96.0 to +12.0 dB

Mid band level

Hi. Gain

-96.0 to +12.0 dB

High band level

Presence

-10 to +10

For positive values, the threshold of the high band is
lowered and the threshold of the low band is
increased. For negative values, the opposite will
occur. When set to 0, all three bands are affected
the same.

Cmp.Thre

-24.0 dB to 0.0 dB

Compressor threshold

Cmp.Rat

1:1 to 20:1

Compressor ratio

Cmp.Atk

0 to 120 ms

Compressor attack

Cmp.Rel

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Compressor release time

Cmp.Knee

0 to 5

Compressor knee

Lookup

0.0 to 100.0 ms

Lookup delay

Cmp.Byp

ON/OFF

Compressor bypass

L-M XOver

21.2 Hz to 8.00 kHz

Low/mid crossover frequency

M-H XOver

21.2 Hz to 8.00 kHz

Mid/high crossover frequency

Slope

-6 dB, -12 dB

Filter slope

Ceiling

-6.0 dB to 0.0 dB, OFF

Specifies the maximum output level

Exp.Thre

-54.0 dB to -24.0 dB

Expander threshold

Exp.Rat

1:1 to ∞:1

Expander ratio

Exp.Rel

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Expander release time

Exp.Byp

ON/OFF

Expander bypass

Lim.Thre

-12.0 dB to 0.0 dB

Limiter threshold

Lim.Atk

0 to 120 ms

Limiter attack

Lim.Rel

44.1kHz: 6.0ms to 46.0s
48kHz: 5.0ms to 42.3s
88.2kHz: 3ms to 23.0s
96kHz: 3ms to 21.1s

Limiter release time

Lim.Byp

ON/OFF

Limiter bypass

Lim.Knee

0 to 5

Limiter knee

Low

ON/OFF

Low band solo

Mid

ON/OFF

Mid band solo

High

ON/OFF

High band solo
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AEC – Acoustic Echo Canceller (MY4-AEC card
required)
This component is only available when an MY4-AEC Acoustic Echo Canceller is installed in a rearpanel I/O slot of the DME64N/24N.
To place the AEC component in a layout, select a DME64N or DME24N device, then select the MY4AEC card via [Select I/O Card] in the “DME Device Properties” dialog box. (Page 218).

How Acoustic Echo and Noise are Reduced
Acoustic echo occurs in a teleconferencing system when the sound from a speaker or reflections from
surfaces of the room are picked up by a microphone and transmitted to the other party, resulting in a
loss of intelligibility. Projectors and air conditioning systems also produce noise that can interfere with
clear teleconferencing. The echo canceling, noise reduction, and feedback suppressor capabilities of
the MY4-AEC help to achieve maximum clarity and intelligibility for smooth, effective communication.
Remote

Local
“Hello”

“Hello”
“How’s business?”
DME64N/24N
SCENE

HOME

UTILITY

LEVEL

MUTE

CANCEL

ENTER

“How’s business?”

+

MY4-AEC

“How’s business”
+ “Hello”
+ fan noise
Fan noise

NOTE
In order to reduce acoustic echo originating from the remote location, an echo canceller must be installed and active at the
remote location.
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MY4-AEC Signal Flow
The local and remote locations in a teleconferencing system are referred to as the “near end” and “far
end”, respectively. The MY4-AEC acoustic echo canceller (AEC) works by comparing the reference
signal received from the far-end with the signal from the microphone in order to determine which
components of the signal are echo, and then subtracts only the far-end echo component from
microphone signal. The near-end sound is thus clearly transmitted to the far end without echo
From Far-end A
From Far-end B
From Far-end C
From Far-end D

Far-end Voice A
Far-end Voice B
Far-end Voice C
Far-end Voice D

NR
NR
NR
NR

Matrix Router

To Far-end 4

To Far-end 3

To Far-end 2

To Far-end 1

NR

Near-end Mic. 3
FBS

Reference signal

Near-end Voice 3
Near-end Mic. 2

AEC

AEC

Near-end Voice 4

FBS

AEC

NR

NR

Near-end Mic. 4

AEC

NR

FBS

Near-end Voice 2
Near-end Mic. 1

FBS

Near-end Voice 1

FBS: Feedback suppressor

NR: Noise reduction

 NR (Noise Reduction)
Automatically detects and reduces constant environmental noises such as projector fans or air
conditioning.

 FBS (Feedback Suppressor)
Automatically detects the frequencies at which feedback is occurring and applies notch filters at those
frequencies to stop the feedback. 42 notch filters are available for each AEC channel. The notch filters
are reset (i.e. returned to “not applied” status) when the DME64N/24N power is turned off.
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 AEC Component Editor
The AEC component editor includes meters that aid in setting optimum microphone levels and
microphone/speaker positioning, as well as in adjusting for optimum echo cancellation effect.

NOTE
The echo cancellation effect is disturbed due to off-balance of Mic. inputs and
reference signals when the components which sounds are dynamically changed
(ex. Dynamics and Auto Mixer) and the volumes which users control are inserted to
the points where cross marks indicate in the right figure. To avoid these issues, the
components above should be inserted to the points where circles indicate.

Double-click the component to open the component editor.

1

2

3

5
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Name
1

Mic In. meters

These meters display the signal levels from the
corresponding near-end microphones.

Ref In meters

Display the level of the far-end input signals that are used
for AEC reference individually for each channel.
Maintaining the reference signals at optimum levels leads
to maximum echo cancellation efficacy.

Echo Attn. meters

Display the echo cancellation strength for each channel.
The higher the level the stronger the echo cancellation
effect.

ERL meters

Display the ERL (Echo Return Loss = the amount of
speaker output that is picked up by the microphone) for
each channel. Echo cancellation will be most effective if
the microphone and speaker positions/orientations are
adjusted so that this level is minimal.

Section
2

Function

AEC

Parameter

Range

Function

AEC On

ON/OFF

Turns the echo canceller function ON or OFF. When OFF,
AEC “learning” will also stop.

Effect

1, 2, 3, 4

Sets the strength of echo cancellation. Higher values
correspond to higher echo cancellation strength. Higher
values also result in reduced sound quality, so these
settings should always be made while checking the
sound.

Distance

2 ~ 40
(meters)

Specifies the distance between the microphone and
speaker used. If multiple microphones and speakers are
used, the distance between closest microphone and
speaker should be specified. If the microphone-tospeaker distance is less than 2 meters, use the 2 meter
setting.

Advanced button

Opens the Advanced Settings editor window (see
page 486).

NR On

ON/OFF

Turns the noise reduction function that automatically
reduces constant environmental noises such as projector
fans or air conditioning ON or OFF. These settings should
normally be ON.

3

Matrix Router

ON/OFF

Determines whether far-end input signals A~D will be
used as reference signals for AEC channels 1~4.

4

Far-end Noise Reduction

ON/OFF

These buttons individually turn noise reduction for far-end
input channels A~D ON or OFF. These settings should
normally be ON.

5

Feedback
Suppressor

FBS On

ON/OFF

Turn feedback suppression for the corresponding signal
ON or OFF. Turning this function ON can prevent
unwanted feedback that may occur when the near-end
microphone input is being monitored via the local speaker
system.

Width

1/10, 1/60,
1/93 (oct)

Specifies the width of the notch filter that will be applied at
the detected feedback frequency. This function makes it
possible to reduce the bandwidth of the feedback
suppressor notch filters when the filters begin to have
noticeable negative impact on sound quality. A setting of
“1/93” results in the narrowest notch filter bandwidth.
Reducing bandwidth can also reduce the effectiveness of
feedback suppression. The default setting is “1/10”.

Depth

-6, -12, -18
(dB)

Specifies the attenuation of the notch filter that will be
applied at the detected feedback frequency. A setting of
“-18” results in the strongest feedback suppression, but
this can also lead to a reduction in sound quality. The
default setting is “-6”.

DME Designer Owner’s Manual

485

Chapter 6 Component Guide

 Advanced Settings Editor Window
Click the [Advanced] button in the AEC component editor window to open this window. The Advanced
Settings editor window includes microphone settings for each AEC channel.
When a microphone with a PTT (Push To Talk) switch is used, a small amount of noise may be
produced when the PTT switch is off. The AEC system may mistakenly “learn” the noise, resulting in an
unwanted echo when the PTT switch is turned on and speech is resumed. This window includes
settings that can prevent this type of problem, as well as specify how the microphones will be used.
3

1

2

4

Parameter

486

Range

1

PTT On

2

Mic In. meters

3

PTT Threshold

-80 ~ -20

Specifies the base level for AEC learning. When the (1) PTT
On parameter is turned ON, AEC “learning” is suspended
when the input to the near-end microphone falls below the
specified threshold, and resumes when the threshold is
exceeded. AEC learning will resume when the input level
exceeds the specified threshold. The input signal level can be
checked visually via the (2) Mic In. meters.

4

Mic. Type

Fixed, Moving

Specifies the way in which the connected microphone will be
used. If the microphone is placed in a stand, for example, and
the distance between it and the speakers will not change
select “Fixed.” If the distance between the microphone and
speaker will vary, select “Moving.” Depending on the
environment, the “Moving” setting may result in optimum echo
cancellation effect even when the microphone is fixed and,
conversely, the “Fixed” setting can sometimes produce the
best results with a hand-held microphone. Set this parameter
for optimum results in your application.
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ON/OFF

Function
When this button is turned ON and the microphone level is
below the specified (3) PTT Threshold setting, the system
determines that the PTT switch is ON and AEC “learning” is
suspended. When the noise level is low or a microphone that
does not have a PTT switch is used, this function can be
turned OFF for improved learning performance.
Display the input levels from the near-end microphones (these
meters perform the same functions as the Mic In. meters in the
AEC component editor window). These meters can also be
used to judge the level of noise being produced when the
microphone PTT switch is OFF.
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Slot
 Slot In
The Slot In Component only has outputs. 4, 8, and 16 channel types are provided.

Either double-click the component, or select [Open Slot In Component Editor] from the contextual
menu that appears when the component is right-clicked to open the component editor.
The component editor is the same for all types.

Name
1

Meter

Function
Shows the signal level for each channel.
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 Slot Out
The Slot Out component has only an input. There are three types of Slot In components: fourchannel, eight-channel, and 16 channel types.

Either double-click the component, or select [Open Slot Out Component Editor] from the contextual
menu that appears when the component is right-clicked to open the component editor.
Slot Out component editor

1
3
4
2
5

Parameter

488

Setting Range

Function

1

Phase

ON/OFF

Reverses the phase of the output signal for each
channel.

2

On

ON/OFF

Turns ON each channel's output.

3

Delay

0 to 24 Samples

Sets the delay time.

4

Level

-∞ to ±0 dB

Sets the output level.

5

Dither

Off
16
20
24

Sets the quantization bit rate for conversion.
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Cascade (DME64N only)
Up to eight DME64N units can be cascade connected to provide bus sharing of up to 32 channels in
order to distribute DSP resources and/or increase input/output capacity. If [Show Cascade port on
Configuration Window] in the “DME Device Properties” dialog box is checked, Cascade I/O
components will appear in the Configuration window. Refer to “When the DME64N Cascade Setting is
Turned ON” (page 215), and to “’Cascade Setting’ Dialog Box” (page 221) for further information.
NOTE
Be careful to avoid loop connections both when connecting via physical cables and in the Designer window.

 Cascade In
Signals received from the CASCADE bus are assigned to the Cascade In component. Any
cascade connected DME64N unit is capable of outputting the same signals. The meter displays
the signal levels received at the rear-panel CASCADE IN terminal.

Right-click the component and select [Open Component Editor] from the contextual menu to open
the component editor. The component editor is the same for all types.

Name
1

Meter

Function
Shows the signal level for each channel.
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 Cascade Out
Ports output to the CASCADE bus are assigned to the Cascade Out component. Make connections
for signals to be output to the CASCADE bus here. Signals from multiple DME64N units input to the
same channel are summed. The meter displays the signal levels being sent to the rear-panel
CASCADE OUT terminal.

NOTE
When multiple DME64N units are cascade connected, each additional unit introduces a delay of a few samples that is
automatically compensated for. This compensation is independent from the compensation within each unit.

Right-click the component and select [Open Component Editor] from the contextual menu to open
the component editor. The component editor is the same for all types.

Name
1

490

Meter
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Function
Shows the signal level for each channel.
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The following diagram shows an example in which three DME64N units are cascaded. Signal
transmission and reception between cascade connected DME64N units is bidirectional. Using BUS 1,
the signal from component 1 of DME64N #1 is distributed to DME64N #2 and DME64N #3. Using
BUS 32, the signals from component 4 of DME64N #2 and component 6 of DME64N #3 are summed
and returned to component 2 of DME64N #1.

CASCADE bus

DME64N #1
Parallel

CASCADE IN

CASCADE OUT
1

1

Summing

1

DME Designer
32

2

32

DME64N #2
CASCADE IN
1

CASCADE OUT
3

1

DME Designer
4

32

32

DME64N #3
CASCADE IN
1

CASCADE OUT
5

1

DME Designer
32

Physical connection

6

32

Signal flow between components

IN

BUS 1
1

DME64N #1

3

OUT
5

IN

DME64N #2
OUT

BUS 32
4

2

IN

DME64N #3

6
OUT

NOTE
Be careful to avoid loop connections both when connecting via physical cables and in the Designer window.
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Analog Input and Output
In the DME24N/DME Satellite configuration window, there are [Analog Input] and [Analog Output]
blocks.

 Analog Input
Right-click the component and select [Open HA Editor] from the contextual menu to open the
editor.
NOTE
The DME24N, DME8i-C, DME4io-C, DME8i-ES and DME4io-ES have analog inputs. The DME24N, DME8i-C and DME8i-ES
have eight analog inputs, while the DME4io-C and DME4io-ES have four.

1
2

Either double-click the component, or select [Open Input Component Editor] from the contextual menu
that appears when the component is right-clicked to open the component editor.

Parameter

Setting Range

Function

1

+48

ON/OFF

Turns ON phantom power (+48V).

2

Gain

+10 to -60 dBu

Sets the rated input level.

Caution
• If you don’t need phantom power, be sure to turn this button off.
• Before you turn phantom power on, make sure that no equipment other than phantom-powered devices
such as condenser microphones are connected to that jack. Otherwise, you risk damaging your external
equipment. Balanced dynamic microphones, however, will not be affected by phantom power.
• Do not connect or disconnect a device to [IN]/[INPUT] jacks while phantom power is applied. Doing so
can damage the connected device and/or the unit itself.
• To protect your speaker system, leave the power amps (powered speakers) turned off when switching the
phantom power on/off. We also recommend that you set all output levels to minimum. Otherwise, highvolume output may damage your hearing or equipment.
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 Analog Output
Double-click [Analog Output] to display the component editor for it. The displayed parameters are
the same as for Slot Out component editor.
NOTE
The DME24N, DME8o-C, DME4io-C, DME8o-ES and DME4io-ES have analog outputs. The DME24N, DME8i-C and
DME8o-ES have eight analog outputs, while the DME4io-C and DME4io-ES have four.

NOTE
To output signals at the same level at which they were input, set the Analog Input Gain to +4dBu, and the Analog Output
Level to 0dB.

DME Designer Owner’s Manual

493

Chapter 6 Component Guide

SP2060 Input and Output
The SP2060 configuration window includes [SP2060 Input] and [SP2060 Output] blocks.

 SP2060 Input
Either double-click [SP2060 Input] or select [Open Component Editor] from the contextual menu that
appears when the component is right-clicked to open the editor.
SP2060 Input Component Editor

2

3

4

1

Name/Parameter

494

Range

Function

1

Input Select

Selects the input signal(s).
Analog IN A/B
Selects analog input channels A and B
as the input signal sources.
Analog IN A/A
Selects analog input channel A as the
source for both input signals.
Digital IN L/R
Selects digital input channels L and R as
the input signal sources.
Digital IN L/L
Selects the digital L input channel as the
source for both signals.

2

Input Level

-~ +10 dB

Set the input signal level for the
corresponding input channel.

3

Meter

-

Display the input signal level for the
corresponding input channel.

4

Mute

ON/OFF

Mute the input of the corresponding input
channel.
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CobraNet Input and Output
The DME8i-C/DME8o-C/DME4io-C configuration window includes [CobraNet Input] and [CobraNet
Output] blocks.

 CobraNet
Either double-click the block, or select [Open Input Component Editor] or [Open Output Component
Editor] from the context menu that appears when the block is right-clicked to open the component
editor. The displayed parameters are the same as for Slot In and Slot Out component editors.
Right-click the block and select [Open CobraNet Editor] from the contextual menu to open the editor.
CobraNet Input/Output Component Editor

1
2

3

4
5
6
7

Section

Name/Parameter

Range

Function

1

Setting from this Editor

Disable/Enable

When “Disable” is selected settings made via the
CobraNet network take priority. When “Enable” is
selected settings made from the DME Designer
take priority.*

2

High
Sampling
Mode

Input Format

DOUBLE
CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz sampling rates.
Linked to Output Format.

Output Format

DOUBLE
CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz sampling rates.
Linked to Input Format.

Input

0 ~ 65279

Specifies the input bundle number.

Output

0 ~ 65279

Specifies the output bundle number.

Rx

OFF, 1 ~ 15

Specifies the serial receive channel.

Tx

OFF, 1 ~ 15

Specifies the serial transmit channel.

Bit Length

Bit Off
16bit
20bit
24bit

Specifies the output bit rate.
Output is muted when “Bit Off” is selected.

6

Latency

5.33ms
2.67ms
1.33ms

Specifies the latency.

7

Advanced

-

Opens the “Advanced Settings” window.

3

4

5

Bundle
Number
Serial
Channel
Properties

* Select “Disable” if you intend to make settings via the CobraNet network using the CobraNet Manager, for example. In such
cases selecting “Enable” may result in incorrect settings.

DME Designer Owner’s Manual

495

Chapter 6 Component Guide

NOTE
Refer to “DME8i-C/DME8o-C/DME4io-C Owner's Manual” for mote information on CobraNet.

“Advanced Settings” Window

1
2
3

Section
1

Channel per Bundle

Name/Parameter

1, 2, 4, 8

Specifies the number of channels per
input bundle (*1).

Output

1, 2, 4, 8

Specifies the number of channels per
output bundle (*1).

Auto
0 ~ 255

Sets the conductor priority.[255] is the
highest priority. [Auto] means [32] on
DME8i-C/DME8o-C/DME4io-C

-

Resets all settings to their default values.
A confirmation dialog box will appear.
Only available when online.(*2)

Conductor Priority

Initialization of All
Parameters

Function

Input

2

3

Range

Execute

(*1) Fewer channels may be available, depending on the settings. Refer to the “MY16-CII Owner's Manual” or “DME8i-C/
DME8o-C/DME4io-C Owner's Manual” for details.
(*2) All internal parameters will be set to factory presets as well as parameters that can be set via editor.
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EtherSound Input and Output
The DME8i-ES/DME8o-ES/DME4io-ES configuration window includes [EtherSound Input] and
[EtherSound Output] blocks.

 EtherSound
Either double-click the block, or select [Open Input Component Editor] or [Open Output Component
Editor] from the context menu that appears when the block is right-clicked to open the component
editor. The displayed parameters are the same as for Slot In and Slot Out component editors.
Routing and other EtherSound settings cannot be made via EtherSound Input/Output components.
Make EtherSound settings using the AVS-ESMonitor software available from Auvitran.
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MY-Card
This shows the input and output for the card inserted into the DME expansion slot. The following
components are available, depending on the card types:

Input Format/Output Format
This is the I/O mode for high sample rate operation (88.2/96 kHz).
In the Double Channel Mode, high sampling rate data (88.2/96 kHz) is transmitted and received by
two channels, each channel handling the digital audio data at half the sampling rate. For this reason
the total number of available channels is halved, and even-numbered channels are unavailable.
In the Double Speed Mode digital audio data is transmitted and received at the current high sampling
rate (88.2/96 kHz).
In the Single Mode digital audio data is transmitted and received at half the current high sampling rate
(88.2/96 kHz).
Setting Examples
Operation clock of related equipment
88.2/96 kHz (Double Channel)

The DME operation clock
88.2/96 kHz

Input Format/Output Format
Double Channel

88.2/96 kHz (Double Speed)

Double Speed

44.1/48kHz

Single

When the MY card word clock is used as the master word clock, Double FS determines whether the
speed of that word clock is to be doubled and used as the DME clock. The Double Fs setting is only
available the word clock from an MY Card is used.

 MY-Others
Right-click the block and select [Open MY-Card Editor] from the context menu to display the editor
for it. This editor can be used for generic MY card editing, but some parameters are not available.
Use a card specific editor when available.

1
3

Parameter

498

2

Setting Range

Function

1

Input Format

DOUBLE SPEED/
DOUBLE CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz.

2

Double Fs

ON/OFF

When ON the speed of the word clock from the MY
Card is doubled. Only displayed when this card is
functioning as the word clock master.

3

Output Format

DOUBLE SPEED/
DOUBLE CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz.
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 MY8-AE96S
Right-click the block and select [Open MY-Card Editor] from the context menu to display the editor
for it.
MY8-AE96S component editor

1
3

2

4

Parameter

Setting Range

Function

1

Input Format

DOUBLE SPEED/
DOUBLE CHANNEL

Selects the format for 88.2/96 kHz.

2

Double Fs

ON/OFF

When ON the speed of the word clock from the MY
Card is doubled. Only displayed when this card is
functioning as the word clock master.

3

Output Format

DOUBLE SPEED/
DOUBLE CHANNEL

Selects the format for 88.2/96 kHz.

4

Sampling Rate
Converter

ON/OFF

Turns the sampling rate converter ON.

 MY16-AE/MY8-AE96/MY8-AE/MY8-AT/MY8-TD/MY16-TD/MY16-AT
Right-click the block and select [Open MY-Card Editor] from the context menu to display the editor
for it.
Example: MY16-AE component editor

1
3

Parameter

Setting Range

2

Function

1

Input Format

DOUBLE SPEED/
DOUBLE CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz. For MY8-AE96, the
setting range is Double Speed/Double Channel. For
other cards, it is Double Channel/Single.

2

Double Fs

ON/OFF

When ON the speed of the word clock from the MY
Card is doubled. Only for MY16-AE/MY8-AE96/MY16TD. When On is set for the MY8-AE96, the Input Format
is Double Channel. When Off is set, the input format is
Double Speed. Only displayed when this card is
functioning as the word clock master.

3

Output Format

DOUBLE SPEED/
DOUBLE CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz. For MY8-AE96, the
setting range is Double Speed/Double Channel. For
other cards, it is Double Channel/Single.
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 MY16-C
Right-click the block and select [Open MY-Card Editor] from the context menu to display the editor
for it.
MY16-C component editor

1
2

3
4
5
6

Section

Parameter

Setting Range

Function

1

Setting Priority

Setting Priority

Hardware/
Software

The MY16-C switch settings take priority when
“Hardware” is selected, and the DME Designer
settings take priority when “Software” is
selected.

2

High Sampling
Mode

Input Format

DOUBLE
CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz sampling
rates.
Linked to Output Format.

Double FS

ON/OFF

When turned ON the speed of the MY card word
clock output is doubled. Only available when
the card is set as the word clock master.

Output Format

DOUBLE
CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz sampling
rates.
Linked to Input Format.

0 to 65279

Sets the input bundle number.

Output

0 to 65279

Sets the output bundle number.

Rx

OFF, 1 - 16

Sets the serial channel for the receive side.

Tx

OFF, 1 - 16

Sets the serial channel for the send side.

Bit Length

Bit Off
16 bit
20 bit
24 bit

Sets the bit rate for output. Mutes the signal if
[Bit Off] is set.

Latency

5.33 ms
2.67 ms
1.33 ms

Sets the delay.

3

4

5

Bundle Number Input

Serial Channel

Properties

6

NOTE
The parameters will not link immediately when Setting Priority is switched.
Please edit another parameter after switching Setting Priority.
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 MY16-CII
Right-click the block and select [Open MY-Card Editor] from the context menu to display the editor for it.

1

2

3
4
5
6

Section

Name/Parameter

Range

Function

1

Setting from this Editor

Disable/Enable

When “Disable” is selected settings
made via the CobraNet network take
priority. When “Enable” is selected
settings made from the DME Designer
take priority.*

2

High Sampling
Mode

Input Format

DOUBLE CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz
sampling rates.
Linked to Output Format.

Double FS

ON/OFF

When turned ON the speed of the MY
card word clock output is doubled. Only
available when the card is set as the
word clock master.

Output Format

DOUBLE CHANNEL/
SINGLE

Selects the format for 88.2/96 kHz
sampling rates.
Linked to Input Format.

Input

0 ~ 65279

Specifies the input bundle number.

Output

0 ~ 65279

Specifies the output bundle number.

Rx

OFF, 1 ~ 15

Specifies the serial receive channel.

Tx

OFF, 1 ~ 5

Specifies the serial transmit channel.

Bit Length

Bit Off
16bit
20bit
24bit

Specifies the output bit rate.
Output is muted when “Bit Off” is
selected.

6

Latency

5.33ms
2.67ms
1.33ms

Specifies the latency.

7

Advanced

-

Opens the “Advanced Settings”
Window. Refer to “Advanced Settings”
Window on page 496 for details.

3

4

5

Bundle
Number

Serial
Channel

Properties

* Select “Disable” if you intend to make settings via the CobraNet network using the CobraNet Manager, for example. In such
cases selecting “Enable” may result in incorrect settings.

NOTE
Refer to the “MY16-CII Owner's Manual” or “CobraNet Manager Lite for YAMAHA Owner's Manual” for mote information on
CobraNet.
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 MY4-AEC
This editor will appear when you click [Open MY-Card Editor] in the contextual menu that appears
when you right-click the block.

2

1

3

Section

502

Range

Function

On(In)

ON/OFF

Turns the sample rate converter for input
channels 1/2 or 3/4 ON or OFF.

2

On(Out)

ON/OFF

Turns the sample rate converter for output
channels 1/2 or 3/4 ON or OFF.

3

Fs Type

44.1k
48k
88.2k
96k
AES/EBU_IN_CH1/2
AES/EBU_IN_CH3/4

Sets the sampling rate for output channels 1/2
or 3/4. This parameter is only available when
(2) On(Out) is ON.
When set to [AES/EBU_IN_CH1/2] or [AES/
EBU_IN_CH3/4], the output audio signal is
synchronized to the clock of the signal
received at the MY4-AEC card’s AES/EBU [IN
1/2] or [IN 3/4] input connector, respectively.

1

Sampling
Rate
Converter

Name
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Remote Controlled Head Amp
There are AD824 and AD8HR components arranged in the zone window.

 AD824
Controls the Yamaha A/D converter AD824. The AD824 is an eight channel analog to digital
converter.

Double-click the component to display the component editor for it.
NOTE
If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click
(page 230).
AD824 component editor

1
3

Parameter

2

Setting Range

Function

1

+48V

ON/OFF

Turns ON phantom power (+48V).

2

Gain

+10 to -62 dBu

Sets the head amp gain.

3

Word Clock

48 kHz
44.1 kHz
BNC
Slot

Sets the operating frequency for the Word Clock.
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 AD8HR
Controls the Yamaha A/D converter AD8HR. The AD8HR is an eight channel analog to digital
converter.

Double-click this component to display the component editor for it.
NOTE
If a DME is not selected in the properties dialog box, the component editor will not be displayed even if you double-click
(page 230).
AD8HR component editor

1
2
3

5

4
6

Parameter

Function

1

+48V

ON/OFF

Turns ON phantom power (+48V).

2

HPF

ON/OFF

Turns output ON.

3

Frequency

20 to 600Hz

Sets the cutoff frequency.

4

Gain

+10 to -62 dBu

Sets the head amp gain.

5

Word Clock

96 kHz
88.2 kHz
48 kHz
44.1 kHz
Word Clock In
Digital Out A

Sets the operating frequency for the Word
Clock.

Double Speed
Double Channel

Selects the operation for 88.2/96 kHz.

6
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Setting Range

+48V Master
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Shows the on/off status of the master phantom
power.
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Component Glossary
Adjustable Gc (AdjustGc)
One type of filter characteristic. With this setting, you can adjust Gc (gain on the cutoff frequency)
between -6 dB and +6 dB. If you set -3 dB it becomes a Butterworth filter. If you set -6 dB, it becomes
Linkwitz-Riley filter.

Attack (Attack Time)
In dynamic components, sets the time period for compressing or expanding the signal after the
component operates. As the attack time is made faster, compression or expansion becomes more
instantaneous. As it is made slower, the initial attack part of the sound will not be compressed or
expanded.

Bessel
One type of filter characteristic. For curves where phase characteristics are important, Bessel has
gentler attenuation then Butterworth, and there is little distortion of the waveform when square waves
are passed through.

Butterworth (Butrwrth)
One type of filter characteristics. This filter has the most general characteristics. The pass band is flat
and the gain for the cutoff frequency is -3 dB.

Bypass
Passes the signal without changing it. When you turn this ON, bypassed sound (unchanged sound) is
output. When you turn this OFF, the sound is output with effects applied.

Decay (Decay Time)
Sets the time period until gain returns to normal after a trigger signal level falls below the threshold
value.

Delay
Sets the time period by which a signal is delayed.

Delay Scale
Sets the units used for specifying the delay time.

Divergence
Sets the ratio for sending the center signal to LR. When 100 percent is set, the signal will be sent to LR
only. When zero percent is set, the signal is sent to center only.
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Fade
Sets the action of the fader when there is a large change in its position during scene recall.
When you turn this ON, the fader moves gradually to the position after the jump. If you turn this OFF, it
immediately jumps to the parameters saved in the recalled scene.

Frequency
Sets a frequency. In the de-esser, this sets the lowest frequency of the signal to be compressed when
the component is operating. In the BPF, HPF, and LPF filters, this sets the cutoff frequency. In the
graphic equalizer, it is also used as the frequency band button.

Gain
Sets the amplification factor for the entire signal level.

Gain Correct
In the Auto-Mixer, automatically controls the output level for the number of open channels. In
situations, where multiple microphones are used, feedback may occur because many channels are
open at the same time. Feedback can be avoided by using gain correct.

Hold (Hold Time)
Sets how long the gate stays open or the ducking remains active once the trigger signal has fallen
below the threshold level.

KeyIn
Turns an input signal connected to a component's KeyIn port into a trigger that activates the
component. You can select the trigger source in components that have KeyIn ports.

Knee
In compressors, de-essers, and expanders, sets the way in which compression or expansion will be
applied after the signal exceeds the threshold. The following range of settings is available: HARD, 1,
2, 3, 4, 5.
If Hard is set, the signal level changes to a straight line following the specified slope when the trigger
signal exceeds the threshold.
If a value between 1 and 5 (5 = softest) is specified, the curve gradually changes when the threshold
is exceeded, producing a more natural sound.

LFE (Sub Woofer Speaker)
This is a special speaker for playing back low frequency sounds.
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Linkwitz-Riley (Linkwitz)
One type of filter characteristics. As second-order filters, the sum of the output voltages for LPF and
HPF have a gain of 0bB across the entire band. The pass band is flat, but the cutoff frequency gain is
-6 dB.

Pan
Sets the distribution ratio of the input signal between right and left.

Pan Nominal Position
Sets the 0 dB reference for pan. There are two selections available, [Center] and [LR] (LR Nominal).
With the “Center Nominal” setting, level is nominal when pan is set to center, and level is +3dB when
pan is set fully left or right.
With the “LR nominal” setting, level is -3dB when pan is set to center, and nominal when pan is set fully
left or right.

Phase
Reverses the phase of the signal. If you turn this ON, signal is inverted. If you turn this OFF, the signal
is not inverted.

Q
Sets the frequency bandwidth that will change the sound. As the value gets larger, the width gets
narrower and the curve becomes steeper.
In the parametric equalizer, this sets the frequency width where the gain will be cut or boosted. When
Q is widened, the gain is boosted or cut along a wide range centering on the frequency set by the
frequency setting, resulting in a large change in the tone quality. When Q is narrowed, only a specific
frequency is boosted or cut.

Range
Set for Ducking and Gate. Sets the amount by which the level is reduced when signal is ducked/
gated. It can be set within the range of -70 to 0 dB. At -70 dB the entire signal above the threshold
value is cut. At 0 dB, there is no effect.

Ratio
Sets the ratio of change in the output signal level with respect to the input signal level.
At 1:1, there is no compression.
At 2:1, when a trigger signal level that exceeds the threshold changes by 10 dB, the output level will
change by 5 dB.
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Release (Release Time)
Sets the time period until gain returns to normal after a trigger signal level falls below the threshold
value and operation of a component ceases.
If the release time is short, the sound will seem like it is jumping (the ear will notice the change)
because the gain suddenly returns to normal. If the release is set too long, compression might not be
applied properly because the next high level signal will be input before the gain returns to normal from
the previous high. It’s a good ideal to try an initial release time setting in the range of 0.11 to 0.5
milliseconds.

Slope
In a high pass filter (HPF) or low pass filter (LPF), this sets the attenuation amount for each octave.
A large value results in rapid attenuation. Clicking the [Slope] button displays a menu.
You can select [6 dB/Oct] or [12 dB/Oct] in the HPF or LPF.
In the crossover that is part of the crossover processor, in the stand-alone crossover, the
programmable BPF, the programmable LPF, and the programmable HPF, you can select from [6 dB/
Oct], [12 dB/Oct], [18 dB/Oct], [24 dB/Oct], [36 dB/Oct], and [48 dB/Oct].

Threshold
Sets the signal level that causes the component to operate.

Width
Sets how much lower the level must be than the threshold level for the expansion effect to begin. When
the trigger signal level changes by 2 dB with the expansion ratio of the expander set at 5:1, the output
level will change by 10 dB.
In the compander, if the width is set at 90 dB, the expander effect will be essentially be turned OFF.
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Options
The ICP1, CP4SW, CP1SF, and CP4SF controllers are optionally available for remote external control of
the DME The ICP1 connects via Ethernet, while the CP4SW, CP1SF, and CP4SF connect via the GPI
interface.

ICP1 settings and operation
This controller connects to the DME series via Ethernet. Like the DME series, each ICP1 unit has it’s
own IP address. With a display that replicates the display on the DME series, the ICP1 allows
comprehensive, familiar control from remote locations.

ICP1 Controls
1

2

3

7

8

!

@

4

5

6

9

)

1 [F1] Key
When the Main display is showing this button calls the Parameter Edit display for the User Defined
Button in the upper left corner of the display.
When the Utility display is showing it has the same function as the Left button.

2 [F2] Key
When the Main display is showing this button calls the Parameter Edit display for the middle User
Defined Button in the upper part of the display.
When the Utility display is showing it has the same function as the Up button.

3 [F3] Key
When the Main display is showing this button calls the Parameter Edit display for the User Defined
Button in the upper right corner of the display.
When the Utility display is showing it has the same function as the right button.

4 [F4/UTILITY] Key
When the Main display is showing this button calls the Parameter Edit display for the User Defined
Button in the lower left corner of the display. If this button is pressed and held for longer than
2 seconds when the Main display is showing the Utility display will appear. Pressing the [F4] button
while the Utility display is showing sequentially steps through the various Utility pages.
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5 [F5] Key
When the Main display is showing this button calls the Parameter Edit display for the middle User
Defined Button in the lower part of the display.
When the Utility display is showing it has the same function as the Down button.

6 [F6/MUTE] Key
When the Main display is showing this button calls the Parameter Edit display for the User Defined
Button in the lower right corner of the display.
If this button is pressed and held for more that 2 seconds the Mute display will appear.

7 [HOME] Key
Directly recalls the home (main) display. If pressed while the main display is showing the [HOME]
button steps through the User Defined Button display pages (page 514).

8 [SCENE] Key
Calls the scene recall display (page 515). Calls the scene store confirmation display if pressed and
held from longer than 2 seconds (page 515). The indicator will light green while the scene recall/
store display is showing.

9 [CANCEL] Key
Closes the window on the display.

) [ENTER] Key
Confirms and enters a value or setting.

! Display
Displays scene information and device parameters.

@ Dial
Adjusts the value of selected parameters. The ICP1 dial functions in the same way as the DME64N/
24N dial.
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Main Display

4 Edit Indicator

The Main display will appear in a few seconds after
the power is turned on. The Main display shows
information about the current scene.

5 Mute Indicator

If a parameter is changed after recalling a scene,
“EDIT” will appear in the display.

Shows the current mute ON/OFF status.

NOTE
Nothing will appear on the display if no scene data is stored in the
DME series scene memory (this is the case when the unit is
initially shipped, for example).

: Mute ON
: Mute OFF

2

6 Output Level Indicator
4
5
6

1
3
2

1 Scene Information
The current scene number and name. Scene names
can be entered by using the DME Designer
application.
A maximum of 12 one-byte (Roman) characters can
be displayed in a scene name. When “two-byte”
characters are to be used for languages such as
Japanese, the total number of displayable characters
is reduced accordingly.
When the power is turned on the last scene selected
before the power was turned off is automatically
recalled.

Displays the current output level in 10 increments.
The longer the “bar,” the higher the output level.

7 Panel Lock Icon
This icon appears when the panel lock function is
turned ON.
: Panel Lock ON (Panel controls locked)

Panel Lock
The panel controls can be “locked” to prevent
accidental mis-operation.
To activate the panel lock function simultaneously
press and hold the [HOME] and [ENTER] keys for
longer than 2 seconds.
The panel lock icon will appear on the Main
display when the panel is locked.

2 User Defined Button Names
Displays the User Defined Button. The User Defined
Button is specified by using the DME Designer
application.
A maximum of 24 buttons can be made available for
user control, but only six buttons can be shown in any
one display page. Press the [HOME] key to switch to
other available button pages. A maximum of 8 onebyte (Roman) characters can be displayed in a
parameter name. When “two-byte” characters are to
be used for languages such as Japanese, the total
number of displayable characters is reduced
accordingly.
Parameters are selected for editing by using [F1]/[F2/
[F3]/[F5] keys to select the parameter, and then
pressing [ENTER].

Panel lock icon

Panel Lock can be disengaged by pressing the
[CANCEL] key for longer than 2 seconds.
NOTE
You can select whether or not the panel lock function is
automatically engaged when the unit is initially turned on.
This selection can be made via the Utility display “Lock”
page (refer to the page 518).

3 Page Scroll Bar
The scroll bar provides an indication of which
parameter page is currently being displayed. 4 pages
are available, and the scroll bar moves one position to
the right each time the [HOME] key is pressed and a
new page of parameters is selected, and then back to
the leftmost position after the rightmost position has
been reached.
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Parameter Edit Displays
Parameter Edit displays will appear when the
[SCENE], [F6/MUTE] or other key is pressed to allow
scene changes, level adjustment, and other settings
to be edited as required. Parameter Edit displays are
also used to edit utility parameters.
In most cases the desired parameter edit page can
be accessed by selecting the item you want to edit in
the appropriate display by using the [F1]/[F2/[F3]/[F5]
keys and then pressing the [ENTER] button.
There are basically three types of parameters that can
be accessed via a Parameter Edit display:
Numeric values
Lists
ON/OFF switches

Parameter Edit Display with One Numeric
Parameter

1. Numeric values can be changed by rotating
the dial. Dial rotation produces an
immediate, corresponding change in the
selected value.

Numeric Parameters
Numeric parameters can be edited in a number of
ways, and depending on the parameter a fader, knob,
or minimum and maximum values may appear to the
left of the numeric value.

A Numeric Value with a fader
1

5

2. Press the [ENTER] key to close the
Parameter Edit display after the value(s)
have been edited as required.
2

Parameter Edit Display with Multiple
Numeric Parameters
4

A Numeric Value with a Knob
1

5

3

1. Use the [F1]/[F2/[F3]/[F5] keys to select the
value to be edited.
4

1 Name of parameter selected for editing
2 Fader
3 Knob
4 Minimum and maximum values
5 Current value
Some Parameter Edit displays have just one numeric
parameter, while other may have two or more.

512

DME Designer Owner’s Manual

!

Appendix

2. Rotate the dial to edit the value as required.

List Parameters
List parameters allow you to make one selection from
a list of possibilities.
Rotate the dial to scroll up or down the list. In some
cases the centermost item on the display will be
always highlighted as the list is scrolled, and in others
the same item will remain highlight as the list is
scrolled up or down.

List Parameter with Scrolling Highlight

3. Repeat step 1 to select the next value to be
edited, use the dial to edit as required, and
repeat until all values have been edited as
required.

4. When all values have been edited, press the
[ENTER] key. A confirmation window will
appear: press [ENTER] one more time to
confirm the edits and close the window.

1. Use the dial to scroll up or down the list.
As you scroll the highlighted selection will remain
highlighted, and will scroll up or down with the list.

2. Press the [ENTER] key to highlight the
centermost item on the display.

ENTER

NOTE
In some cases a confirmation dialog will appear when the
[ENTER] key is pressed. If this occurs press the [ENTER] key a
second time to continue.

3. Press the [ENTER] key to select the
highlighted item and close the window.

ENTER

NOTE
You can return to the Parameter Edit display without changing
any values by pressing the [CANCEL] key rather than the
[ENTER] key.
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ON/OFF Parameters

Mute Switching

Parameters that are either ON or OFF are edited via
this type of display (e.g., Mute Parameter Edit display
in “Mute Switching”).

Turns the DME series output mute function ON or OFF.

1. Rotate the dial clockwise to select ON, or

1. Press the [F6/MUTE] key for longer than 2
seconds.
The Mute Parameter Edit display will appear.

counterclockwise to select OFF.

2. Press enter to confirm the selection and
close the window.
Parameter Edit displays will also appear when the
[SCENE], [F6/MUTE] or other key is pressed.
These allow scene changes and other settings to
be edited as required.

2. Select Mute ON or OFF.
The mute function is turned on or off as described
in “ON/OFF Parameters”.

Editing User Defined Button
1. If the Main display is not showing, press
the [HOME] key to recall it.

2. Press the [HOME] key until the page
containing the parameter to be edited
appears.

3. Use the [F1]/[F2/[F3]/[F5] keys select the
parameter to be edited.
The Parameter Edit display for the selected User
Defined Button will appear.
NOTE
User Defined Button can be of all three types: numeric, list,
and ON/OFF.

4. User Defined Button as required.
Refer to “Parameter Edit Displays” on page 512 for
editing procedures.
NOTE
Any changed User Defined Button values will be lost if the
power is turned off or if scenes are changed. To preserve the
changed values, store the scene data.
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Scene Recall

Scene Store

This procedure recalls a new scene (refer to
page 512).

Stores the current scene data for later recall.

1. Press the [SCENE] button.
The Scene Recall display will appear.

2. Select a new scene.
Scenes are selected as described in the “List
Parameters” section on page 513.

1. Press the [SCENE] button for longer than
2 seconds.
A confirmation window will appear on the display.

2. Press the [ENTER] key.
This stores the scene data in the current scene
memory.
NOTE
Press the [CANCEL] key if you want to abort the scene store
operation.

3. Press the [ENTER] button.
A confirmation message will appear.

4. Press the [ENTER] button again.
The new scene will be selected.

NOTE
If head amplifier parameters are included in the recalled scene
data, the head amplifier settings will be changed accordingly.
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Utility Displays
Most basic ICP1 functions can be accessed via the Utility Display.

Items accessible via the Utility display
Page

Item

Info

Description
Current status and settings for the devices basic parameters.

Label

Name display.

Version

The device’s current version number.

Net

Current status and settings for the Ethernet network.
Master/Slave

Displays current status whether the device is device group master or not.

IP Adr.

Current status and setup for the device’s IP address.

Master ID

Displays and sets the device group master host address.

Link Mode

Current status and setup for the [NETWORK] connector.

MAC Adr.

Displays the device’s MAC address.

Disp

Current status and setup for the display mode, etc.
LCD Contrast

Current status and setup for display panel contrast.

LCD Backlight

Current status and setup for the display panel backlight.

Lock

Current status and setup for panel lock and related functions.
Utility

Current status and setup for the Utility display settings.

Panel Lock Boot

Current status and setup for the ICP1's power-on panel lock status.

Panel Lock Target

Current status and setup for the panel lock target.

User Defined Lock

Panel lock and setup for each page of user-defined parameters.

Misc

Current status and setup for settings not included in other pages.
Scene Store

Current status and setup for scene store accessibility.

Last Mem. Resume Indicates whether the previous memory contents will be retained when the
unit is restarted.
Event Scheduler

516

DME Designer Owner’s Manual

Current status whether an event schedule setup in the DME Designer will be
executed or not.
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Utility Display Operation

Network Settings (Net) Page

The general procedure for operating the Utility
displays is outlined below.

Shows the Ethernet network address and other
parameters.

1. Press the [F4/UTILITY] Key for longer than
2 seconds from the Main display to go to
the Utility display.

2. Press the [F4/UTILITY] Key as many times
as necessary until the desired parameter
page appears.

3. Use the [F1]/[F2/[F3]/[F5] keys to select the
parameter you want to edit.

4. Press the [ENTER] key.
This either confirms a selection or edit, or calls the
appropriate parameter edit page.

1
2
3
4
5

1 Master/Slave
Indicates whether or not the device is functioning as
the device group master.
Device Group status of ICP1 is fix to “Slave.”

2 IP Adr.
This is the device’s IP address.
Edit using the “Numeric Parameters” editing
procedure described on page 512.

Info Page

1
2

Network Address

Host Address

NOTE
The network addresses of devices in the same device group
must be the same.

NOTE
The date and time (3) and the internal battery status (4) are
not shown on the ICP1 control panel display.

1 Label
Shows the user ID. The user ID can be changed via
the DME Designer application running on a computer
connected to the unit.
NOTE
The label can not be changed from the ICP1 controls.

2 Program Version
This is the current firmware version number.

3 Master ID
Displays and sets the device group master host
address.

4 Link Mode
Shows the status of the [NETWORK] connector. The
[NETWORK] connector can be set to operate in
“10Base-T” or “100Base-TX” mode.
10Base-T: The [NETWORK] connector is
compatible with 10Base-T operation.
100Base-TX: The [NETWORK] connector is
compatible with 100Base-TX operation.
Edit using the “List Parameters” editing procedure
described on page 513.

5 MAC Adr.
This is the device’s MAC (Media Access Control)
address.
NOTE
The MAC address is also known as the Ethernet address, and
is an independent address assigned to all Ethernet devices.
No two devices anywhere in the world can have the same
address.
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Display Setup (Disp) Page

Security Setup (Lock) Page

Provides access to a number of display parameters.

Panel lock and related settings.

1
2

1
2
3
4

1 LCD Contrast

1 Utility

The current LCD contrast setting. This parameter can
be adjusted from 0% through 100%.
Edit using the “Numeric Parameters” editing
procedure described on page 512.

The lock status for the Utility display settings. This
parameter can be set to “Unlock” or “Lock.”

2 LCD Backlight
Specifies LCD backlight operation. Two settings are
available: “ON,” and “OFF.”
ON: The display is continuously lit.

Unlock: The Utility display can be accessed without
a password.
Lock: A password must be entered to access the
Utility display.
When “Lock” is selected a password entry window will
appear when the [F4/UTILITY] key is pressed to
access the utility pages.

OFF: The display lights when a control is operated,
and will go out 10 seconds after panel operation
ceases.
Pressing the [ENTER] key alternately selects “ON”
and “OFF”.

Use the [F1] and [F3] buttons to position the cursor,
and the dial to enter the desired character at the
cursor location. When all of the password’s characters
have been entered as required press the [ENTER]
key.
The password will also be required when switching
from the “Unlock” mode to the “Lock” mode.
NOTE
Password security and management is very important!
If you forget your password the unit cannot be operated!
If you forget your password contact the system administrator.
If the password become unrecoverable for some reason and
you need to unlock the system, please contact your Yamaha
representative.
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2 Panel Lock Boot
Determines whether or not panel lock will be on when
power to the device is turned on. This parameter can
be set to “Unlock” or “Lock.”
Unlock: Panel lock is OFF when power to the
device is turned on.
Lock: Panel lock is ON when power to the device is
turned on.

3 Panel Lock Target
Displays the controls (control functions) to be affected
by panel lock. Panel Lock Target status of ICP1 is fix
to “Key Only.”
NOTE
See page 511 for details on how to use the Panel lock feature.

Miscellaneous Setup (Misc)
Page
This page includes parameters not available in any
other page.

1
2
3

1 Scene Store
Determines whether or not scene store operations are
allowed. This parameter can be set to “Enable” or
“Disable.”

4 User Defined Lock

Enable: Scene store operations are allowed.

Sets the lock status individually for each of the four
User Defined Button pages.

Disable: Scene store operations are prohibited.

ON: The corresponding User Defined Button will
not appear on the display.
OFF: The corresponding User Defined Button will
appear on the display.
To change the settings use the [F1] and [F3] keys to
move the cursor to the setting for the desired page,
the press the [ENTER] button to alternately turn the
setting “ON” and “OFF.”
NOTE
The User Defined Button are accessed as described in the
“Parameter Edit Display” section on page 512.

Edit using the “List Parameters” editing procedure
described on page 513.
NOTE
See page 515 for scene store procedure.

NOTE
This setting applies to individual devices only. Even if one ICP1
unit is set to “Disable,” scene store operations will be possible
via another DME series in the same device group that is set to
“Enable.”

2 Last Mem. Resume
This parameter displays whether the ICP1 will recall
the current scene when started up, or whether the
memory contents at the time the unit was turned off
will be recalled.
ON: The memory contents at the time the unit was
turned off will be recalled at startup.
OFF: The current scene will be recalled at startup.
The Last Men. Resume status can not be changed
from ICP1 controls.

3 Event Scheduler
Displays the current status of an event schedule setup
in the DME Designer will be executed or not.
ON: The event will be executed.
OFF: The event schedule will not be executed.
Edit using the “List Parameters” editing procedure
described on page 513.
NOTE
The event schedule status can not be changed from the ICP1
controls.
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Initializing the ICP1
Follow the steps below to initialize the internal
memory.

CAUTION

When the internal memory is initialized, all data
stored in the memory will be lost. Use caution when
you execute this function.

1. Turn off the power to the ICP1.
2. Plug the PA-300 AC adaptor while holding
down the [SCENE] and [ENTER] buttons.
Release keys after YAHAMA logo
disappears.
The Initialization display appears.

3. Press the [F2]/[F5] keys to select a type of
initialization.
NOTE
To cancel the initialization operation, select “==> Exit Diag
Mode” and confirm the cancellation. Alternatively, simply turn
off the power to the ICP1.

Initialize DME:
Deletes all user settings except component data.
The Utility settings will be set to default values.
Delete All Data:
Component data will be deleted. The Utility
settings will be set to default. After initialization,
transfer necessary components from DME
Designer.
==> Exit Diag Mode:
Leaves this screen and restarts.

4. Press the [ENTER] key.
Do not turn off the power during initialization. Doing
so can damage the device.
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Troubleshooting
For the latest information about DME Designer, visit the Yamaha pro audio site at
http://www.yamahaproaudio.com.
Symptom
A compile error occurs during
synchronization.

Possible Causes
DSP total resource consumption has
exceeded the upper limit.

Corrective Actions
Delete unneeded components.

The wiring between components is
Change the connections so that a single
connected from multiple output terminals output is connected to a single input
to a single input.
terminal. Using a matrix mixer or similar
component, gather multiple outputs into
one signal.
Cannot place component. Cannot place
wiring.

You are in online status.

Execute [Go Off-line] on the
synchronization screen to go into offline
status.

The Designer window in not in edit mode. Place a checkmark next to [Edit] on the
[Tool] menu.
The currently logged on user is restricted Logoff, then log in again as a new user,
from editing.
or as the Administrator. If edit restrictions
are required for a user, place a check in
the [Security]  [Edit] checkbox
A user module is not displayed on the
list.

The [File] menu  [Preference] 
[ContentsFolder] has been changed, or
the “User Module” folder has been
moved.

Check that there are user module files
(.umf) in the “ContentsFolder” and “User
Module” folders.

Cannot switch configurations in the
Navigator Window.

While online, you cannot not switch to a
configuration different from the current
scene.

If you can switch between scenes, you
will be able to switch configurations.

The user module window does not open, This is a user module saved by selecting Open the save dialog, select [Open] 
even when a user module is double[Open]  [User Module Design
[User Module Editor], and resave the
clicked.
Window].
user module.
No editor displays after right-clicking on Some cards do not have editors.
a card component, and selecting [Open]
from the context menu.

No special corrective action.

This is not abnormal. If many scenes are Wait until processing finishes.
The message “Reset Config…” is
displayed for a long time in the message entered into the DME, processing takes
area of the “Synchronization” dialog box. time.
Cannot set the monitor output.

This is because channels connected with Select an unconnected channel.
wiring cannot be used as monitor output.

Poor meter response.

A large number of DME units displaying
meters in the same device group.

• Close or minimize the component
editor window to reduce the dumber of
DME displays.
• Divide the device group containing
DME units displaying meters.

When the computer connection was
If LAN cable connections are changed
Either quit DME designer before
changed the connection to the DME unit while DME Designer is running, the DME changing the LAN connections, or set
was lost.
units will continue to attempt to connect the Port parameter to No Assign.
to the original computer.
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paste ................................................................................... 343
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Ducker ......................................................................................... 407
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Offline ............................................................................................ 97
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